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CAPITOLO 1

Preamble

Questo documento è la guida originale del software Quantim GIS, qui descritto. In molti casi, il software e
l’hardware descritti in questo documento sono marchi registrati e sono pertanto soggetti ai relativi requisiti legali.
Qauntum GIS è soggetto alla licenza GNU General Public License. Maggiori informazioni sono disponibili sulla
homepage di Quantum GIS http://www.qgis.org.

I dettagli, i dati, i risultati ecc. presenti n questo documento sono sati scritti e verificati al meglio delle conoscenze
e della responsabilità degli autori e degli editori. Ciononostante, possono essere presetni errori nei contenuti.

Pertanto, nessun dato è soggetto ad alcun obbligo o garanzia. Gli autori, i redattori e gli editori non si assumono
alcun obbligo o responsabilità per malfunzionamenti e loro conseguenze. Sono tutti invitati a segnalare eventuali
errori.

Questo documento è stato scritto tramite reStructuredText. E’ disponibile come codice sorgente reST tramite
github è disponibile online in formato HTML e PDF tramite http://documentation.qgis.org. Versioni tradotte di
questo documento possono anche essere scaricate in diversi formati dall’area di documentazione del progetto
QGIS. Per ulteriori informazioni su come contribuire a questo documento e su come tradurlo, visitate l’indirizzo
http://www.qgis.org/wiki/.

Collegamenti presenti in questo dicumento

Questo documento contiene collegamenti interni ed esterni. Cliccando su un collegamento interno ci si sposta
all’interno del documento, mentre cliccando su un collegamento esterno si apre un indirizzo internet. In formato
PDF, i collegamenti interni ed esterni sono mostrati in colore blu e sono gestiti dal browser del sistema. In frmato
HTML, il browser gestisce e mostra entrambi allo stesso modo.

Autori e redattori delle guide per l’utente, l’installazione e la programmazione in codice

Tara Athan Radim Blazek Godofredo Contreras Otto Dassau Martin Dobias
Peter Ersts Anne Ghisla Stephan Holl N. Horning Magnus Homann
Werner Macho Carson J.Q. Farmer Tyler Mitchell K. Koy Lars Luthman
Claudia A. Engel Brendan Morely David Willis Jürgen E. Fischer Marco Hugentobler
Larissa Junek Diethard Jansen Paolo Corti Gavin Macaulay Gary E. Sherman
Tim Sutton Alex Bruy Raymond Nijssen Richard Duivenvoorde Andreas Neumann

Sponsors

L’aggiornamento di questo manulae per l’utente è stato gentilmente sponsorizzato da Kanton Solothurn,
Switzerland.

Copyright (c) 2004 - 2013 QGIS Development Team

Internet: http://www.qgis.org

License of this document

Permission is granted to copy, distribute and/or modify this document under the terms of the GNU Free Docu-
mentation License, Version 1.3 or any later version published by the Free Software Foundation; with no Invariant
Sections, no Front-Cover Texts and no Back-Cover Texts. A copy of the license is included in Appendix GNU
Free Documentation License.
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CAPITOLO 2

Convenzioni

Questa sezione descrive le convenzioni di rappresentazione grafica usate nel manuale. Le convenzioni sono le
seguenti:

Convenzioni per l’interfaccia grafica (GUI)

Le convenzioni stilistiche per l’interfaccia grafica hanno lo scopo di imitarne l’effettivo aspetto. In generale, si
e evitato di usare immagini o indicazioni che compaiono solo al passaggio del mouse sopra l’indicazione stes-
sa, in modo che l’utente possa scorrere visivamente l’interfaccia grafica per trovare quello che piu assomiglia
all’istruzione rappresentata nel manuale.

• Opzioni da menu: Layer → Aggiungi un layer raster oppure Impostazioni → Barre degli strumenti →
Digitalizzazione

• Strumenti: Aggiungi raster

• Pulsante: [Salva come predefinito]

• Titolo casella di dialogo: Proprieta layer

• Scheda (tab): Generale

• Casella di controllo: Render

• Pulsante di scelta: Postgis SRID EPSG ID

• Scelta numerica:

• Selezione testuale:

• Carca file:

• Scelta colore:

• Barra di scorrimento:

• Inserimento testo:

L’ombreggiatura caratterizza un componente della GUI cliccabile.

Convenzioni per il testo o per la tastiera

Il manuale include anche convenzioni relative al testo, all’inserimento da tastiera e alle parti di codice per indicare
diverse entita come classi o metodi. Non hanno alcuna corrispondenza visuale con l’applicativo.

• Collegamenti web: http://qgis.org

• Combinazioni di tasti: premere Ctrl+B significa la pressione del tasto B mentre si tiene premuto il tasto
Ctrl.

• Nome di un file: lakes.shp

• Nome di una classe: NewLayer

3
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• Metodo: classFactory

• Server: myhost.de

• Inserimento di testo da parte dell’utente al prompt dei comandi: qgis --help

Le porzioni di codice sono indicate con un formato carattere a spaziatura fissa

PROJCS["NAD_1927_Albers",
GEOGCS["GCS_North_American_1927",

Istruzioni specifiche per sistema operativo

Sequenze della GUI e piccole porzioni di testo possono essere formattate in sequenza lineare, ad es.: Clicca

File QGIS → Esci per chiudere QGIS.

Questa notazione indica che sui sistemi operativi Linux, Unix e Windows, bisogna cliccare innanzitutto sul menù
File, quindi su Esci nel menu a tendina, mentre su Macintosh OSX bisogna cliccare prima sul menu QGIS, poi su
Esci dal menu a tendina. Grosse porzioni di testo possono essere formattate come un elenco:

• fai questo;

• fai quello;

• fai qualcos’altro.

o come paragrafi.

Fai questo e questo e questo. Quindi fai questo e questo, e questo... .

Fai quello. Poi fai quello e quello, e quello, ... .

Le schermate riportate nella guida sono state create su diversi sistemi operativi, indicati da apposite icone alla fine
della didascalia.
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CAPITOLO 3

Premessa

Benvenuti nel meraviglioso mondo dei Sistemi Informativi Geografici (GIS)!

Quantum GIS (GIS) è un Sistema Informativo Geografico Open Source. Il progetto è nato nel maggio 2002 ed è
stato costituito come progetto su Source Forge nel giugno dello stesso anno. Abbiamo lavorato sodo per rendere
i GIS (software tradizionalmente costosi e soggetti a licenze proprietarie) una prospettiva accessibile a chiunque
abbia un accesso basilare a un personal computer. Attualmente QGIS funziona su diverse piattaforme Unix,
Windows e OS X. QGIS viene sviluppato utilizzando il tookt Qt (http://qt.digia.com) e il linguaggio C++. Questo
significa che QGIS trasmette una senzazione di utilizzo brillante, con un’interfaccia grafica (GUI) piacevole e
semplice da usare.

QGIS punta ad essere un GIS dotato delle più comuni funzioni e caratteristiche, e facile da usare. L’obiettivo
iniziale era quello di fornire un viewer per dati GIS. QGIS ha raggiunto quel punto nella sua evoluzione in cui
viene utilizzato da molti utenti per le loro esigenze di visualizzazione di dati geografici. QGIS supporta molti
formati vettoriali e di tipo raster, il supporto a nuovi formati può essere facilmente ampliato usando l’achitettura
dei plugin.

QGIS è rilasciato sotto licenza GNU General Public License (GPL). Questo significa che potete analizzare e
modificare il codice sorgente, e garantisce che voi, i nostri felici utenti, possiate sempre aver accesso ad un
programma GIS gratuito e che può essere modificato liberamente. Dovreste avere ricevuto una copia completa
della licenza insieme alla vostra copia di QGIS, e potete sempre trovala nell’Appendice GNU General Public
License.

Suggerimento: Documentazione aggiornata
La versione più aggiornata di questo documento è disponibile nell’area documentazione del sito web QGIS,
all’indirizzo http://documentation.qgis.org

3.1 Introduzione al GIS

Un Sistema Informativo Geografico (GIS) (Mitchell 2005 Literature and Web References) é un insieme di software
che permette di creare, visualizzare, interrogare ed analizzare dati geospaziali. Con dati geospaziali ci si riferisce
ad informazioni sulla posizione geografica di un oggetto. Questo comporta spesso l’uso di coordinate geografiche,
come i valori di latitudine o di longitudine. Un altro termine comunemente usato é dati spaziali, come lo sono
anche: dati geografici, dati GIS, dati di posizione, dati di coordinate e dati di geometria spaziale.

Le applicazioni che usano dati geospaziali eseguono una varietà di funzioni. L’applicazione più facilmente com-
prensibile é la produzione di carte geografiche. I programmi di questo genere ricevono i dati geospaziali e li elabo-
rano in un formato visualizzabile, di solito sullo schermo di un computer o su una pagina stampata. Le applicazioni
possono generare carte statiche (una singola immagine) o carte dinamiche, che possono essere personalizzate dalla
persona che le visualizza tramite un programma o una pagina web.

Molte persone pensano erroneamente che le applicazioni geospaziali si limitino a produrre carte geografiche, ma
un’altra delle loro funzioni principali é l’analisi geospaziale. Alcune tipiche forme di analisi includono:

1. distanza fra punti geografici
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2. il calcolo dell’area della superficie (ad es. in metri quadri) racchiusa entro una certa regione geografica

3. quali forme sono sovrapposte ad altre forme

4. il calcolo dell’area di sovrapposizione fra due forme

5. il numero di punti contenuti entro una certa distanza da un altro

6. e così via...

Questo può sembrare semplicistico, ma può essere applicato a molte discipline in ogni sorta di modo. I risultati di
un’analisi possono essere mostrati su una mappa, ma sono spesso riportati in forma tabellare, come supporto alle
decisioni.

Il recente fenomeno dei servizi basati sulla geolocalizzazione promette di introdurre ogni sorta di altre caratter-
istiche, ma molte di queste saranno basate su una combinazione di mappe e analisi spaziale. Per esempio: il
vostro telefono cellulare, che è in grado di tracciare la vostra posizione geografica. Col software appropriato a
disposizione, il vostro cellulare può indicarvi i ristoranti raggiungibili a piedi dal punto in cui vi trovate. Pur es-
sendo un’applicazione relativamente nuova della tecnologia della geolocalizzazione, essenzialmente non fa altro
che analizzare dati geografici e comunicarvi il risultato dell’analisi compiuta su di essi.

3.1.1 Perché è tutto così nuovo?

In realtà non lo è. Ci sono molti nuovi dispositivi hardware che consentono servizi geospaziali in mobilità.
Sono disponibili molte applicazioni geospaziali open source, ma l’esistenza di hardware e software dedicati non
è nulla di nuovo. I ricevitori per il Sistema di Posizionamento Globale (GPS) stanno diventando comuni, ma sono
diffusi in vari ambiti professionali da più di un decennio. Parimenti, anche gli strumenti desktop per l’analisi
e la mappatura hanno costituito un mercato primario in ambito commerciale, concentrandosi principalmente su
industrie come quella della gestione delle risorse naturali.

Quello che è nuovo è il modo in cui l’hardware e il software più recenti sono stati applicati. Gli utenti tradizionali
degli strumenti di analisi e mappatura erano analisti GIS altamente addestrati, o tecnici della cartografia digitale
esperti nell’uso di strumenti CAD. Ora, la potenza di calcolo degli home PC e dei pacchetti software open source
(OSS) ha reso capaci eserciti di hobbysti, professionisti, sviluppatori web, ecc, di interagire coi dati geospaziali.
La curva di apprendimento si è appiattita. I costi sono scesi. Il livello di saturazione della tecnologia geospaziale
è cresciuto.

Come vengono conservati i dati geospaziali? In poche parole, al giorno d’oggi, vengono usati due tipi di dato.
Questo in aggiunta al dato tabellare tradizionale, anch’esso ampiamente usato nelle applicazioni geospaziali.

3.1.2 Dati Raster

Un tipo di dato geospaziale è chiamato dato raster, o più semplicemente “un raster”. La forma di dato raster
più facile da riconoscere è costituita dalle immagini satellitari o dalle foto aeree. L’ombreggiatura altimetrica o
i modelli di elevazione del terreno sono anch’essi timpicamete rappresentati da dati raster. Qualunque tipo di
caratteristica cartograrica può essere rappresentata da un dato raster, ma ci sono delle limitazioni.

Un raster è una griglia regolare costituita da celle o, in caso di immagini, da pixel. C’è un numero prefissato di
righe e colonne. Ogni cella ha un valore numerico e ha una certa dimensione geografica (ad es. 30x30 metri).

Diversi raster sovrapposti vengono usati per rappresentare immagini che hanno più di un colore (ad es. un raster
per ogni valore rosso, verde e blu, combinati per ottenere un’immagine a colori). Anche le immagini satellitari rap-
presentano dati in “bande” multiple. Ogni banda è essenzialmente un raster separato, sovrapposto spazialmente,
che contiene una certa lunghezza d’onda della luce. Come potrete immaginare, un raster di grandi dimensioni
occuperà molto spazio in memoria.

Un raster con celle più piccole fornisce un maggior dettaglio, ma occupa più spazio. Il trucco sta nel trovare il
giusto equilibrio fra la dimensione della cella ai fini dell’archiviazione e la dimensione della cella ai fini della
mappatura o dell’analisi cartografica.

6 Capitolo 3. Premessa



QGIS User Guide, Release 1.8

3.1.3 Dati vettoriali

Nelle applicazioni geospaziali sono usati anche i dati vettoriali. Se siete rimasti svegli durante le lezioni di
trigonometria e sui sistemi di coordinate, sarete già abituati ad alcune qualità dei dati vettoriali. Nella loro
definizione più semplice, i vettori sono un modo di descrivere un punto tramite un insieme di coordinate. Ogni
coordinata fa riferimento a una posizione geografica usando un sistema di valori x e y.

Lo si può immaginare facendo riferimento a un piano cartesiano - i diagrammi con gli assi x,y che si vedevano
a scuola. Potreste averli usati per rappresentare la diminuzione dei risparmi da metter da parte per la pensione,
o l’aumento degli interessi composti del mutuo, ma il concetto è essenziale per la cartografia l’analisi dei dati
geospaziali.

Ci sono diversi modi di rappresentare questo tipo di coordinate geografiche, in base al vostro scopo. Questa è
un’intera area di studio che riserveremo per un’altra volta - le proiezioni cartografiche.

I dati vettoriali hanno tre forme, ognuna progressivamente più complessa e che è costruita partendo dalla
precedente.

1. Punti - Una singola coppia di coordinate (x y) rappresenta un singolo punto geografico

2. Linee - Diverse coppie di coordinate (x1 y1, x2 y2, x3 y3, ... xn yn) unite in un certo ordine, come se si
disegnasse una linea dal Punto (x1 y1) al Punto (x2 y2) e così via. Le parti fra un punto e l’altro sono
considerate segmenti di una linea. Questi hanno una data lunghezza e la linea viene definita dalla sua
direzione in base all’ordine in cui si susseguono i punti. Tecnicamente, una linea è una singola coppia di
punti connessi l’un l’altro, mentre una spezzata è una serie di linee connesse fra di loro.

3. Poligoni - Quando diverse linee sono unite da più di due punti, con l’ultimo punto che ha la stessa posizione
del primo, si parla di poligono. Un triangolo, un cerchio, un rettangolo, ecc. sono tutti poligoni. La
caratteristica principale dei poligoni è che racchiudono una definita area.

3.1. Introduzione al GIS 7
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CAPITOLO 4

Caratteristiche

QGIS offre molte delle comuni funzionalità GIS grazie alle sue caratteristiche di base e ai plugin. Per averne una
prima visione, sono state brevemente riassunte in sei categorie.

4.1 Visualizzazione dati

E’ possibile visualizzare e sovrapporre dati vettoriali e dati raster in diversi formati e proiezioni, senza che sia
necessaria una conversione in un formato interno o comune. I formati supportati includono:

• Tabelle spaziali e viste tramite PostGIS, SpatiaLite e MSSQL Spatial, formati vettoriali supportati dalla
libreria OGR, inclusi gli shapefile ESRI, MapInfo, SDTS, GML e molti altri, cfr. la sezione Lavorare con i
dati vettoriali.

• Formati raster e immagine supportati dalla libreria GDAL (Geospatial Data Abstraction Library), come
GeoTiff, Erdas Img., ArcInfo Ascii Grid, JPEG, PNG e altri ancora, cfr. la sezione Lavorare con i dati
raster.

• Dati raster e vettoriali GRASS dai relativi database (location/mapset), cfr. la sezione Integrazione con
GRASS GIS.

• Dati spaziali online distribuiti secondo gli standard OGC, Web Map Service (WMS) o Web Feature Service
(WFS), cfr. la sezione Lavorare con i dati OGC.

• Dati OpenStreetMap, cfr. la sezione OpenStreetMap.

4.2 Esplorare dati e comporre mappe

Si possono comporre mappe ed esplorare interattivamente i dati spaziali grazie a un’interfaccia grafica (GUI)
facile da usare. I molti strumenti utili disponibili nella GUI includono:

• Browser QGIS

• Proiezione on the fly

• Composizione mappe

• Pannello vista generale

• Segnalibri spaziali

• Funzioni di identificazione/selezione

• Modifica/visualizzazione/ricerca degli attributi

• Etichettatura degli oggetti

• Modifica della simbologia vettoriale e raster

• Aggiunta di un layer graticcio - al momento come decorazione tramite il plugin fTools
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• Decorare le mappe con l’indicatore del Nord, la barra della scala cartografica e un’etichetta per il copyright

• Salvataggio e recupero dei progetti

4.3 Creazione, modifica, gestione ed esportazione dati

E’possibilie creare, modificare, gestire ed esportare mappe vettoriali in diversi formati. I dati Raster devono essere
prima importati in GRASS. QGIS offre:

• Strumenti per la digitalizzazione per i formati OGR e per i layer vettoriali GRASS

• Creazione e modifica di shapefile e di layer GRASS

• Immagini geocodificate grazie al plugin Georeferencer

• Strumenti GPS per importare ed esportare formati GPX, convertire altri formati GPS in GPX o scaricar-
li/caricarli direttamente su di una unità GPS (nella versione Linux, usb è stata aggiunta alla lista degli
strumenti GPS)

• Visualizzazione e modifica di dati OpenStreetMap

• Creazione di layer PostGIS partendo da shapefile, grazie al plugin SPIT

• Migliore gestione delle tabelle PostGIS

• Gestione delle tabelle degli attributi vettoriali grazie alla nuova tabella attributi (cfr. lasezione Lavorare con
la tabella degli attributi) o al plugin Table Manager

• Salvataggio di screenshot come immagini georiferite

4.4 Analsi dei dati

Si può eseguire un’analisi spaziale sui formati PostgreSQL/PostGIS e su altri formati OGR utilizzando il plugin
fTools Python. Attualmente, QGIS offre strumenti per: analisi vettoriale, campionamento, geoporcessing, gestione
delle geometrie e dei database. Si possono anche usare strumenti integrtati in GRASS, che includono la completa
funzionalità di oltre 400 moduli GRASS (cf. sezione Integrazione con GRASS GIS). Oppure si può lavorare
con SEXTANTE, che fornisce una potente architettura per l’analisi geospaziale, in grado di richiamare da QGIS
algoritmi di terze parti, come GDAL, SAGA, GRASS, fTools ed altri (cfr. la sezione SEXTANTE).

4.5 Pubblicazione di mappe su internet

QGIS può essere usto per esportare dati in un mapfile e quindi pubblicarli su internet usando un server web, grazie
alla funzione UMN MapServer. QGIS può anche essere usato come client per WMS, WMS-C, o WFS e WFS-T,
e come server WMS o WFS (cfr. la sezione Lavorare con i dati OGC).

4.6 Estendere le funzionalità di QGIS tramite i plugin

QGIS può essere adattato alle vostre specifiche esigenze grazie all’architettura dei plugin. QGIS fornisce librerie
che possono essere usate per creare plugin. Si possono anche creare nuove applicazioni in C++ o Python!

4.6.1 Plugin nativi

1. Add Delimited Text Layer (carica e visualizza file di testo contenenti coordinate x,y)

2. Coordinate Capture (cattura le coordinate, tramite il mouse, nei diversi Sistemi di Riferimento Cartografico
- CRS)
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3. DB Manager (scambia, modifica e visualizza layer e tabelle; esegue query in SQL)

4. Diagram Overlay (inserisce diagrammi su un layer vettoriale)

5. Dxf2Shp Converter (converte file DXF in Shapefile)

6. GPS Tools (carica e importa dati GPS)

7. GRASS (integrazione con GRASS)

8. GDAL Tools (integrazione in QGIS degli strumenti GDAL)

9. Georeferencer GDAL (aggiunge ai raster informazioni sulla proiezione cartografica utilizzando GDAL)

10. Heatmap (genera raster con mappe tipo heatmap dai dati puntuali)

11. Interpolation (interpolazione basata sui vertici in un layer vettoriale)

12. Mapserver Export (esporta un file di progetto QGIS in formato MapServer)

13. Offline Editing (consente le modifiche offline e la sincronizzazione con un database)

14. OpenStreetMap (visualizzatore ed editor per i dati openstreetmap)

15. Supporto per Oracle Spatial GeoRaster

16. Plugin Installer (scarica e installa i plugin di QGIS in python)

17. Raster terrain analysis (analisi del terreno su raster)

18. Road graph (analisi di rete del percorso più breve)

19. SPIT (importa uno Shapefile in PostgreSQL/PostGIS)

20. SQL Anywhere Plugin (immagazzina layer vettoriali in un database SQL Anywhere)

21. Zonal statictics (esegue il contegio, la somma, la media del raster per ogni poligono di un layer vettoriale)

22. Spatial Query (esegue query spaziali su layer vettoriali)

23. eVIS (strumento per la visualizzazione di eventi)

24. fTools (strumento per l’analisi e la gestione di dati vettoriali)

4.6.2 Plugin esterni in Python

QGIS offre un numero crescente di lugin esterni in python, che sono forniti dalla comunità di sviluppatori. Questi
plugin risiedono nel repository ufficiale, e possono essere facilmente installati usando il Python Plugin Installer
(cfr. la sezione Caricamento di un plugin esterno).

4.7 Novità nella versione 1.8

Attenzione! Questa è la nostra ‘versione di punta’. Come tale, contiene nuove caratteristiche ed espande
l’interfaccia di QGIS 1.0 e QGIS 1.7.0. Si raccomanda l’utilizzo di questa versione rispetto alle altre.

Questa versione include centinaia di correzioni agli errori, molte nuove caratteristiche e miglioramenti.

Browser QGIS

Un’applicazione stand alone e un nuovo pannello in QGIS. Il browser consente di navigare facilmente nel file
system e nei dataset connessi (PostGIS, WFS, ecc.), avere una preview degli oggetti e trascinarli nelle finestre.

DB Manager

Il DB manager è ora ufficialmente parte del cuore di QGIS. Ora è possibile trascinare layer dal Browser QGIS nel
DB Manager, importando il layer nel database spaziale. Si possono importare tabelle trascinandole da un database
all’altro. Si può usare il DB Manager per eseguire query in SQL sul database spaziale e visualizzarne il risultato
sotto forma di un layer. Si possono anche creare, modificare, cancellare e svuotare tabelle, per spostarle poi in un
altro schema.
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Plugin Terrain Analysis

E’ stato aggiunto un nuovo plugin per l’analisi del terreno (con indici di pendenza, aspetto, ombreggiatura, rilievo
e scabrosità).

Nuovi tipi di simbolo per i layer

• Retinatura con pattern a linee

• Retinatura con pattern a punti

• Rendering delle ellissi (esegue il rendering di ellissi, rettangoli, triangoli e croci)

Nuovo repository per i plugin

Attenzione, il vecchio repository non è più supportato, gli autori sono gentilmente invitati a spostare i loro plugin
sul nuovo repository. La lista dei plugin QGIS è disponibile su http://plugins.qgis.org/plugins/.

Ulteriori nuove caratteristiche

• Supporto ai progetti annidati entro altri progetti, in modo da accorpare il contenuto proveniente da altri file
progetto

• Group Selected: opzione per raggruppare layer

• Message Log: consente di tenere d’occhio i messaggi che QGIS genera durante il caricamento e l’operatività

• Personalizzazione della GUI: consente di allestire un’interfaccia QGIS semplificata, nascondendo varie
componenti dalla finestra principale e i widget dalle finestre di dialogo

• Lo strumento Azione è ora accessibile dalla barra degli strumenti mappa, consente di cliccare su un vettore
e di eseguire un’azione

• Il nuovo selettore di scala: seleziona una scala da una lista predefinita

• Pan To Selected: sposta la panoramica della mappa sull’oggetto selezionato; non cambia il livello di zoom

• Copia e incolla gli stili fra i layer

• Selezione CRS aggiornata

• Definizione della legenda - indipendente dall’ordine di disegno

• Supporto a MSSQL spaziale - ci si può connettere, usando QGIS, a un database spaziale gestito da un server
Microsoft SQL

• Composizione di stampa consente di avere linee multiple sugli elementi della legenda, usando un carattere
specifico

• Etichettatura basata su espressioni

• Heatmap - un nuovo plugin nativo, aggiunto per generare mappe raster tipo heatmap partendo da dati
puntuali

• L’interfaccia per il tracciamento live GPS è stata rivista, correggendo molti errori e aggiungendovi molte
migliorie

• Il menù è stato leggermente riorganizzato - ora ci sono menù separati per Vettori, Raster e Web, molti plugin
sono stati aggiornati e inseriti nei livelli principali di tali manù

• Offser delle curve - è stato aggiunto un nuovo strumento di digitalizzazione per creare curve con un offset

• Nuovi strumenti nel menù Vettori per addensare geometrie e costruire indici spaziali

• Lo strumento Esporta/aggiungi geometria può esportare informazioni usando layer CRS, progetti CRS o
misure ellissoidali

• Un’alberatura per le regole basata su Modello/Vista per il rendering basato su regole

• Miglioramenti nei Segnalibri Spaziali

• Nuovi metadati per i Plugin presenti in metadata.txt
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• Provider per dati postgres: supporto per chiavi arbitrarie (incluse non numeriche e multi colonna), supporto
per la richiesta din un certo tipo di geometria e/o srid in QgsDataSourceURI

• Aggiunto gdal_fillnodata al plugin GDALT

• Supporto per i tipi di dato PostGIS TopoGeometry

• Binding python per il campo simboli del layer vettoriale e aggiornamenti generali ai binding python

• Aggiunto un programma Benchmark

• Aggiunta la cache Row per la tabella attributi

• Widget per generare UUID per la tabella attributi

• Aggiunto il supporto per le vedute modificabili nei database SpatiaLite

• aggiunto un widget basato su espressioni nel field calculator

• Creazione di layer evento nella libreria analisi, utilizzando riferimenti lineari

• Carica/salva stili di layer nel nuovo reder di simbologia da/verso un documento SLD

• Il server QGIS può funzionare come un Server WFS

• Il supporto al Client WFS è ora una caratteristica nativa di QGIS

• Opzione per saltare la geometria WTK copiando da una tabella attributi

• Supporto al caricamento di layer compressi in formato .zip e .gzip

• La suit QGIS test ora passa tutti i test sulle principali piattaforme, inclusi i test notturni

• E’ possibile definire la misura delle tile nei layer WMS
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CAPITOLO 5

Come Iniziare

Questo capitolo fornisce una veloce panoramica sull’installazione di QGIS, su alcuni dati campione scaricabili dal
sito QGIS e su come avviare una prima semplice sessione in cui visualizzare layer raster e vettoriali.

5.1 Installazione

L’installazione di QGIS è molto semplice. Pacchetti standard per l’installazione sono disponibili per MS Windows
e Mac OS X. Per le distribuzioni GNU/Linux sono disponibili pacchetti binari (rpm e deb) o archivi software da
aggiungere al gestore di installazione. Informazioni aggiornate possono essere reperite sul sito web di QGIS
http://download.qgis.org.

5.1.1 Installazione da codice sorgente

Se si rende necessario compilare QGIS da codice sorgente si può fare riferimento alla guida per la compilazione
disponibile su http://www.qgis.org/en/documentation/manuals.html. Le istruzioni per l’installazione sono anche
distribuite con il codice sorgente di QGIS

5.1.2 Installazione su supporti esterni

QGIS permette di specificare un’opzione di percorso --configpath che sovrascrive il percorso predefinito (es.
/.qgis in Linux) per le configurazioni utente. In tal modo è possibile portare l’installazione di QGIS, comprensiva
dei plugin e delle impostazioni, su un supporto di memoria esterno (es. penna USB).

5.2 Dati campione

La guida utente contiene esempi basati sul set di dati campione di QGIS.

L’installer per Windows comprende un’opzione per scaricare il set di dati campione di QGIS. Se selezionato,
i dati verranno scaricati nella vostra cartella Documenti e posizionati in una cartella denominata GIS Database.
Si può usare Windows Explorer per spostare questa cartella in qualunque altra posizione. Qualora non fosse stata
selezionata l’opzione per installare il set di dati campione durante l’installazione iniziale di QGIS è possibile

• usare dati GIS già posseduti;

• scaricare il set di dati dal sito di QGIS http://download.qgis.org; oppure

• disinstallare QGIS e reinstallarlo selezionando l’opzione per lo scaricamento dei dati, solo se la soluzione
precedente non ha successo.

Per GNU/Linux e Mac OSX non sono ancora disponibili pacchetti di installazione del set di dati campione
in formato rpm, deb or dmg. Per usare il set di dati campione scaricare il file qgis_sample_data come archivio
ZIP o TAR da http://download.osgeo.org/qgis/data/ e decomprimerlo sul vostro sistema. Il dataset Alaska include
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tutti i dati GIS usati come esempi e schermate nella guida utente, includendo anche un piccolo database GRASS.
La proiezione usata per il set di dati di QGIS è Alaska Albers Equal Area con unità in piedi. Il codice EPSG di
questa proiezione è 2964.

PROJCS["Albers Equal Area",
GEOGCS["NAD27",

DATUM["North_American_Datum_1927",
SPHEROID["Clarke 1866",6378206.4,294.978698213898,

AUTHORITY["EPSG","7008"]],
TOWGS84[-3,142,183,0,0,0,0],
AUTHORITY["EPSG","6267"]],

PRIMEM["Greenwich",0,
AUTHORITY["EPSG","8901"]],

UNIT["degree",0.0174532925199433,
AUTHORITY["EPSG","9108"]],

AUTHORITY["EPSG","4267"]],
PROJECTION["Albers_Conic_Equal_Area"],
PARAMETER["standard_parallel_1",55],
PARAMETER["standard_parallel_2",65],
PARAMETER["latitude_of_center",50],
PARAMETER["longitude_of_center",-154],
PARAMETER["false_easting",0],
PARAMETER["false_northing",0],
UNIT["us_survey_feet",0.3048006096012192]]

Se s’intende usare QGIS come interfaccia per GRASS, sono disponibili delle LOCATION campione (ad es.
Spearfish or South Dakota) sul sito ufficiale di GRASS GIS http://grass.osgeo.org/download/data.php.

5.3 Sessione di esempio

Ora che si è installato QGIS e si ha a disposizione un set di dati campione, dimostreremo una breve e semplice
sessione di QGIS. Visualizzeremo un layer raster ed uno vettoriale. Useremo il layer raster dell’uso del suolo
qgis_sample_data/raster/landcover.img e il layer vettoriale dei laghi qgis_sample_data/gml/lakes.gml.

5.3.1 Avvio di QGIS

• Avviare QGIS scrivendo: QGIS al prompt dei comandi, oppure se si utilizzano pacchetti binari
precompilati, utilizzando il menu delle applicazioni.

• Avviare QGIS usando il menu Start o l’icona sul desktop, oppure facendo doppio click su un file di
progetto QGIS.

• Doppio click sull’icona nella cartella Applicazioni.

5.3.2 Caricare dati raster e vettoriali dal set di dati campione

1. Cliccare sull’icona Aggiungi Raster.

2. Individuare la cartella qgis_sample_data/raster/, selezionare il file ERDAS Img landcover.img e cliccare
[Apri].

3. Se il file non appare nella lista, controllare se il tipo di file selezionato nel menu in basso della finestra di
dialogo è corretto, in questo caso Immagine ERDAS (*.img, *.IMG).

4. Ora cliccare sull’icona Aggiungi Vettore.

5. File deve essere selezionato come tipo di sorgente nella finestra di dialogo Aggiungi vettore . Ora cliccare
[Sfoglia] per selezionare il layer vettoriale.
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6. Individuare la cartella qgis_sample_data/gml/, selezionare “GML” dal menu tipo file, poi selezionare il file
GML lakes.gml e cliccare [Apri] , poi nella finestra di dialogo Aggiungi vettore cliccare [OK].

7. Ingrandire un la vista su un’area a vostra scelta con alcuni laghi.

8. Fare doppio click sul layer lakes nella legenda per aprire la finestra Proprietà layer.

9. Cliccare sulla scheda Stile e selezionare blu come colore di riempimento.

10. Cliccare sulla scheda Etichette e spuntare l’opzione Mostra etichette per abilitare l’etichettatura.
Scegliere il campo NOME come campo per l’etichetta.

11. Per migliorare la leggibilità dell’etichetta, è possibile aggiungere un contorno con sfondo colorato:
spuntare Contorno etichette e scegliere dimensione e colore del contorno.

12. Cliccare [Applica] , controllare se il risultato è buono ed infine premete il tasto [OK].

Visto come è facile visualizzare layer raster e vettoriali in QGIS ? Proseguiamo alla sezione seguente per imparare
ulteriori funzioni, caratteristiche ed impostazioni.

5.4 Avvio e chiusura di QGIS

Nella sezione Sessione di esempio abbiamo già imparato come avviare QGIS. Ripeteremo questa operazione qui
per mostrare come QGIS fornisca ulteriori opzioni all’avvio da riga di comando.

• Assumendo che QGIS sia installato nel vostro PATH, lo si può avviare digitando: qgis al prompt dei
comandi o facendo doppio click sul collegamento all’applicazione (o shortcut) sul desktop o nel menu delle
applicazioni.

• Avviare QGIS usando il menu Avvio (Start) o il collegamento sul desktop, o facendo doppio click su un
progetto QGIS precedentemente salvato.

• Fare doppio click sull’icona QGIS nella cartella Applicazioni (Applications). Se si vuole avviare QGIS
in una shell, eseguire /percorso-installazione-eseguibile/Contents/MacOS/Qgis.

Per uscire da QGIS, cliccare sul menu File QGIS → Esci, o usare la scorciatoia da tastiera Ctrl+Q .

5.5 Opzioni linea di comando

QGIS supporta un certo numero di opzioni se avviato da riga di comando. Per avere una lista delle opzioni
possibili, digitare “qgis —help” al prompt dei comandi. La sintassi d’uso di QGIS è la seguente:

qgis --help
Quantum GIS - 1.8.0-Lisboa ’Lisboa’ (exported)
Quantum GIS (QGIS) is a viewer for spatial data sets, including
raster and vector data.
Usage: qgis [options] [FILES]

options:
[--snapshot filename] emit snapshot of loaded datasets to given file
[--width width] width of snapshot to emit
[--height height] height of snapshot to emit
[--lang language] use language for interface text
[--project projectfile] load the given QGIS project
[--extent xmin,ymin,xmax,ymax] set initial map extent
[--nologo] hide splash screen
[--noplugins] don’t restore plugins on startup
[--nocustomization] don’t apply GUI customization
[--optionspath path] use the given QSettings path
[--configpath path] use the given path for all user configuration
[--help] this text
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FILES:
Files specified on the command line can include rasters,
vectors, and QGIS project files (.qgs):
1. Rasters - Supported formats include GeoTiff, DEM

and others supported by GDAL
2. Vectors - Supported formats include ESRI Shapefiles

and others supported by OGR and PostgreSQL layers using
the PostGIS extension

Suggerimento: Esempio di utilizzo delle opzioni da riga di comando
QGIS può essere avviato specificando uno o più file di dati da riga di comando. Per esempio, assunto che ci si
trovi nella directory qgis_sample_data, si può avviare QGIS con un layer vettoriale e un file raster inserendo il
seguente comando: qgis ./raster/landcover.img ./gml/lakes.gml

Opzioni linea di comando “–snapshot”

L’opzione consente di creare uno snapshot in formato PNG della vista corrente. Questo può essere utile quando si
hanno molti progetti e si vogliono generare schermate dai propri dati.

Il file PNG generato ha una risoluzione di 800x600 pixels. Questa può essere adattata usando gli argomenti da
riga di comando “–width” e “–height”. Dopo l’opzione “–snapshot” può essere specificato il nome del file con cui
si vuole salvare l’immagine.

Opzioni linea di comando “–lang”

L’interfaccia di QGIS si presenta nella lingua definita dalle impostazioni di localizzazione di sistema. Se
si desidera l’interfaccia in un’altra lingua, lo si può specificare all’avvio. Ad esempio: “–lang=en” fa
sì che QGIS si avvii localizzato in inglese. Un elenco delle lingue supportate è disponibile all’indirizzo
http://www.qgis.org/wiki/GUI_Translation_Progress

Opzioni linea di comando “–project”

E’ possibile avviare QGIS anche con un file di progetto. Basta semplicemente aggiungere l’opzione da riga di
comando “–project” seguita dal percorso e dal nome del progetto e QGIS si aprirà caricando tutti i layer indicati
nel file specificato.

Opzioni linea di comando “–extent”

Per fare sì che QGIS si avvii visualizzando una specifica porzione di mappa, è necessario specificare i limiti
dell’estensione (bounding box) che si intende visualizzare secondo il seguente ordine, con ogni valore separato da
virgole:

--extent xmin,ymin,xmax,ymax

Opzioni linea di comando “–nologo”

Questa opzione nasconde lo splash screen quando QGIS viene avviato.

Opzioni linea di comando “–noplugins”

Se si verificano problemi con i plugin all’avvio di QGIS, è possibile evitare di caricarli. Saranno comunque
disponibili in seguito nel Gestore plugin.

Opzioni linea di comando “–nocustomization”

Usando questa opzione le personalizzazioni dell’interfaccia non verranno applicate all’avvio.

Opzioni linea di comando “–optionspath”

Potreste avere più di una configurazione e con questa opzione potete decidere quale usare al momento di avviare
QGIS. Si veda la Sezione 3.8 per controllare dove il vostro sistema operativo salva i file d’impostazione. Al
momento non c’è modo di specificare in quale file salvare le impostazioni, per cui potete creare una copia del file
di impostazione e rinominarlo.

Opzioni linea di comando “–configpath”

18 Capitolo 5. Come Iniziare

http://www.qgis.org/wiki/GUI_Translation_Progress


QGIS User Guide, Release 1.8

Questa opzione è simile alla precedente, ma in più sovrascrive il percorso di default (~/.qgis) per le configurazioni
utente e forza anche QSettings ad usare questo percorso. Questo permette all’utente, ad esempio, di portare
l’installazione di QGIS su una flash drive (es. una chiave USB) insieme a tutti i plugin ed impostazioni.

5.6 Progetti

Lo stato di una sessione QGIS è considerato un progetto. È possibile lavorare su un progetto alla volta. Le
impostazioni possono essere definite per ogni singolo progetto oppure di default per tutti i nuovi progetti (vedi
sezione Opzioni dell’interfaccia grafica (GUI)). Lo stato della sessione corrente può essere salvato in un progetto

usando la voce di menu File → Salva progetto o File → Salva progetto con nome.

Per caricare progetti salvati usare File → Apri progetto or File → Apri progetti recenti.

Se si vuole eliminare la sessione corrente e ricominciare da zero, scegliere File → Nuovo progetto. Ognuna di
queste voci di menu chiederà se si vuole salvare la sessione corrente qualora fossero occorsi cambiamenti rispetto
all’ultima volta in cui la stessa è stata aperta o salvata.

Le informazioni salvate nel file di progetto includono:

• Layers aggiunti

• Proprietà dei layer, inclusa la loro rappresentazione grafica

• Proiezione usata per la vista mappa

• Ultima estensione della vista (scala e inquadramento)

Il file di progetto è salvato in formato XML, così da poter essere editato esternamente a QGIS con qualunque
editor, se si conosce la sintassi. Il formato del file di progetto è stato modificato parecchie volte rispetto a quello
delle precedenti versioni di QGIS, di conseguenza file di progetto salvati con precedenti versioni di QGIS potreb-
bero non funzionare più correttamente. Si può essere avvertiti preventivamente di ciò selezionando dalla scheda
Generale nel menu Impostazioni → Opzioni:

Richiedi di salvare i cambiamenti di progetto se necessario

Avvisa quando viene aperto un file di progetto salvato con una vecchia versione di QGIS

5.7 Output

Ci sono diversi modi per generare file di output da una sessione QGIS. Il primo è stato descritto alla Sezione
Progetti e consiste nel salvataggio su file di progetto. Altri modi di produrre file di output sono ad esempio:

• L’opzione di menu Salva come immagine permette di salvare la vista mappa come immagine in for-
mato PNG o JPG: insieme all’immagine viene salvato anche un file di georeferenziazione (world file) con
estensione rispettivamente PNGW o JPGW.

• L’opzione di menu File → Nuova composizione di stampa apre una finestra di dialogo dove è possibile
impaginare e stampare la vista mappa (vedi sezione Compositore di stampe).
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CAPITOLO 6

Interfaccia grafica di QGIS

All’avvio di QGIS viene visualizzata l’interfaccia grafica riprodotta dalla seguente immagine (i numeri da 1 a 5
negli ovali gialli fanno riferimento alle cinque principali aree dell’interfaccia come di seguito specificato):

Figura 6.1: QGIS GUI with Alaska sample data

Nota: L’aspetto delle finestre (barra del titolo, ecc.) può apparire diverso a seconda del sistema operativo e del
gestore di finestre utilizzato.

L’interfaccia di QGIS è divisa in cinque aree:

1. Barra dei Menu

2. Barra degli Strumenti

3. Legenda

4. Vista Mappa

5. Barra di Stato

Le cinque componenti dell’interfaccia di QGIS sono descritte con maggior dettaglio nelle sezioni seguenti. Due
ulteriori sezioni descriveranno le scorciatoie da tastiera e la guida contestuale.
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6.1 Barra dei Menu

La barra dei menu fornisce accesso alle varie caratteristiche di QGIS utilizzando un menu gerarchico standard.
Le voci gerarchicamente più elevate e una sintesi di alcune opzioni di menu sono elencate di seguito, assieme alle
icone degli strumenti corrispondenti così come appaiono nella barra degli strumenti ed alle scorciatoie da tastiera.
Le scorciatoie da tastiera possono essere configurate manualmente (quelle presentate in questa sezione sono quelle
predefinite), usando lo strumento [Configura le scorciatoie] nel menu Modifica.

Sebbene molte voci di menu abbiano uno strumento corrispondente e viceversa, i menu non sono organizzati
esattamente come le barre degli strumenti. La barra degli strumenti che contiene la voce descritta è indicata dopo
ogni voce di menu con l’aspetto di una casella di controllo (checkbox). Per ulteriori informazioni su strumenti e
barre degli strumenti si veda la Sezione Barra degli Strumenti.

6.1.1 File

Voce di Menu Scorciatoia Riferimento Barra degli Strumenti

Nuovo progetto Ctrl+N see Progetti File

Apri progetto Ctrl+O see Progetti File
Apri progetti recenti→ see Progetti

Salva progetto Ctrl+S see Progetti File

Salva progetto con nome Ctrl+Shift+S see Progetti File

Salva come immagine see Output

Nuova composizione di stampa Ctrl+P see Compositore di stampe File

Gestore di stampe see Compositore di stampe File
Stampe → see Compositore di stampe

Esci Ctrl+Q
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6.1.2 Modifica

Voce di Menu Scorciatoia Riferimento Barra degli
Strumenti

Annulla Ctrl+Z see Digitalizzazione
avanzata

Digitalizzazione
avanzata

Ripristina Ctrl+Shift+Zsee Digitalizzazione
avanzata

Digitalizzazione
avanzata

Taglia geometrie Ctrl+X see Modifica di un layer
esistente

Digitalizzazione

Copia elementi Ctrl+C see Modifica di un layer
esistente

Digitalizzazione

Incolla elementi Ctrl+V see Modifica di un layer
esistente

Digitalizzazione

Inserisci punto Ctrl+. see Modifica di un layer
esistente

Digitalizzazione

Muovi elemento/i see Modifica di un layer
esistente

Digitalizzazione

Elimina il selezionato see Modifica di un layer
esistente

Digitalizzazione

Semplifica geometria see Digitalizzazione
avanzata

Digitalizzazione
avanzata

Aggiungi un buco see Digitalizzazione
avanzata

Digitalizzazione
avanzata

Aggiungi una parte see Digitalizzazione
avanzata

Digitalizzazione
avanzata

Elimina buco see Digitalizzazione
avanzata

Digitalizzazione
avanzata

Elimina parte see Digitalizzazione
avanzata

Digitalizzazione
avanzata

Modifica la forma see Digitalizzazione
avanzata

Digitalizzazione
avanzata

Taglia geometrie see Digitalizzazione
avanzata

Digitalizzazione
avanzata

Spezza elemento see Digitalizzazione
avanzata

Digitalizzazione
avanzata

Unisci le geometrie selezionate see Digitalizzazione
avanzata

Digitalizzazione
avanzata

Unisci gli attributi delle geometrie
selezionate

see Digitalizzazione
avanzata

Digitalizzazione
avanzata

Strumento vertici see Modifica di un layer
esistente

Digitalizzazione

Ruota i simboli per i punti see Digitalizzazione
avanzata

Digitalizzazione
avanzata
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Quando si attiva la modalità Modifica per un layer, ulteriori voci vengono aggiunte nel menu Modifica in funzione
del tipo di geometria (punto, linea o poligono).

6.1.3 Modifica (extra)

Voce di Menu Scorciatoia Riferimento Barra degli Strumenti

Inserisci punto see Modifica di un layer esistente Digitalizzazione

Inserisci linea see Modifica di un layer esistente Digitalizzazione

Inserisci poligono see Modifica di un layer esistente Digitalizzazione

6.1.4 Vista Mappa

Voce di Menu Scorciatoia Riferimento Barra degli Strumenti

Sposta mappa Navigazione mappa

Zoom sulla selezione Navigazione mappa

Ingrandisci Ctrl++ Navigazione mappa

Rimpicciolisci Ctrl+- Navigazione mappa
Seleziona → see Selezionare e deselezionare elementi Attributi

Informazioni elementi Ctrl+Shift+I Attributi
Misura → see Misurazioni Attributi

Zoom completo Ctrl+Shift+F Navigazione mappa

Zoom sul layer Navigazione mappa

Zoom sulla selezione Ctrl+J Navigazione mappa

Ultimo Zoom Navigazione mappa

Zoom successivo Navigazione mappa

Rimpicciolisci Navigazione mappa
Proprietà → see Decorazioni

Suggerimenti mappa Attributi

Nuovo segnalibro Ctrl+B see Segnalibri geospaziali Attributi

Mostra segnalibri Ctrl+Shift+B see Segnalibri geospaziali Attributi

Aggiorna Ctrl+R Navigazione mappa
Slider per la scala delle tiles see Set di tile Scala delle tiles

6.1.5 Layer

Voce di Menu Scorciatoia Riferimento Barra degli Strumenti
Nuovo → see Creare nuovi layer vettoriali Gestione layer
Includi layer e gruppi see Progetti nidificati

Aggiungi vettore Ctrl+Shift+V see Lavorare con i dati vettoriali Gestione layer

Aggiungi raster Ctrl+Shift+R see Caricare dati raster in QGIS Gestione layer

Aggiungi vettore PostGIS Ctrl+Shift+D see Layer PostGIS Gestione layer
Continua alla pagina successiva
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Tabella 6.1 – continua dalla pagina precedente
Voce di Menu Scorciatoia Riferimento Barra degli Strumenti

Aggiungi un layer Spatialite Ctrl+Shift+L see Layer SpatiaLite Gestione layer

Aggiungi un vettore MSSQL Ctrl+Shift+M see Layer Spatial MSSQL Gestione layer

Aggiungi vettore WMS Ctrl+Shift+W see Client WMS Gestione layer

Aggiungi layer testo delimitato see Plugin Testo Delimitato Gestione layer

Crea nuovo vettore GPX see Plugin GPS Gestione layer

Aggiungi layer Oracle GeoRaster see Plugin Oracle Spatial GeoRaster Gestione layer

Add SQL Anywhere Layer see Plugin SQL Anywhere Gestione layer

Aggiungi vettore WFS Gestione layer

Copia elementi see Scheda Stile

Incolla elementi see Scheda Stile

Apri tabella attributi Attributi

Salva modifiche Digitalizzazione

Modifica Digitalizzazione
Salva come...
Salva selezione come vettore... See Lavorare con la tabella degli attributi

Elimina layer Ctrl+D
Imposta SR del/i layer Ctrl+Shift+C
Imposta SR progetto dal layer
Proprietà
Interrogazione

Etichettatura

Aggiungi alla panoramica Ctrl+Shift+O Gestione layer

Aggiungi tutto alla panoramica

Rimuovi tutto alla panoramica

Mostra tutti i layer Ctrl+Shift+U Gestione layer

Nascondi tutti i layer Ctrl+Shift+H Gestione layer

6.1.6 Impostazioni

Voce di Menu Scorciatoia Riferimento Barra degli Strumenti
Pannelli → see Pannelli e Barre degli strumenti
Barre degli strumenti → see Pannelli e Barre degli strumenti
Schermo intero Ctrl-F

Proprietà progetto Ctrl+Shift+P see Progetti

SR personalizzato see Sistemi di riferimento personalizzati
Gestore di stili see Gestore stile

Configura scorciatoie
Personalizzazione see Personalizzazione
Opzioni see Opzioni dell’interfaccia grafica (GUI)

Opzioni di snap
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6.1.7 Plugins

Voce di Menu Scorciatoia Riferimento Barra degli Strumenti

Recupero lugin python see Plugin di QGIS

Gestione plugins see Gestione dei plugin
Console python
GRASS → see Integrazione con GRASS GIS GRASS

6.1.8 Vector

Voce di Menu Scorciatoia Riferimento Barra degli Strumenti
Strumenti di Analisi → see Plugin fTools
Cattura coordinate → see Plugin Cattura coordinate
Strumenti di gestione dati → see Plugin fTools
Dxf2Shp → see Plugin Dxf2Shp Converter Vettore
Strumenti di geometria → see Plugin fTools
Strumenti di Geoprocessing → see Plugin fTools
GPS → see Plugin GPS Vettore
Strumenti di ricerca → see Plugin fTools
Road Graph (grafo strade) → see Plugin grafo strade
Interrogazione spaziale → see Plugin Spatial Query Vettore

6.1.9 Raster

Voce di Menu Scorciatoia Riferimento Barra degli Strumenti
Calcolatore raster see Calcolatore raster
Georeferenziatore → see Plugin Georeferenziatore Raster
Mappa di concentrazione → see Plugin Mappa di concentrazione Raster
Interpolazione → see Plugin Interpolazione Raster

Analisi geomorfologica see Plugin Analisi geomorfologica
Statistiche zonali → see Plugin Statistica zonale Raster
Proiezioni → see Plugin GDALTools
Conversione → see Plugin GDALTools
Estrazione → see Plugin GDALTools
Analisi → see Plugin GDALTools
Miscellanea → see Plugin GDALTools
Impostazioni GdalTools see Plugin GDALTools

6.1.10 Database

Voce di Menu Scorciatoia Riferimento Barra degli Strumenti
DB manager → see Plugin DB Manager Database
eVis → see Plugin eVis Database
Editing offline → see Plugin Offline Editing Database
Spit → see Plugin SPIT Database

6.1.11 Web

Voce di Menu Scorciatoia Riferimento Barra degli Strumenti
MapServer Export ... → see Plugin MapServer Export Web
OpenStreetMap → see OpenStreetMap OpenStreetMap
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6.1.12 Guida

Voce di Menu Scorciatoia Riferimento Barra degli Strumenti

Contenuti della guida F1 Guida

What’s This? Shift+F1 Guida
Documentazione sulle API

Home Page di QGIS Ctrl+H

Controlla versione di QGIS

Informazioni

Sponsor QGIS

Gli oggetti della barra dei Menu elencati sopra sono quelli di default se si usa KDE come ambiente desktop. In
GNOME, non è presente il menu Impostazioni e i suoi oggetti si possono trovare:

Proprietà progetto File
Opzioni Modifica
Configura scorciatoie Modifica

Gestore di stili Modifica

SR personalizzato Modifica
Pannelli → Visualizza
Barre degli strumenti → Visualizza
Schermo intero Visualizza
Slider per la scala delle tiles Visualizza
Tracciamento GPS in tempo reale Visualizza

6.2 Barra degli Strumenti

Le barre degli strumenti forniscono accesso alla maggior parte delle medesime funzioni presenti nei menu, oltre a
funzioni addizionali per interagire con la mappa. Ogni oggetto della barra degli strumenti ha un aiuto a comparsa
(popup). Lasciando il cursore del mouse sopra l’icona verrà visualizzata una breve descrizione della funzione
fornita da quello strumento.

Ogni barra può essere spostata secondo le preferenze personali. Inoltre ognuna di esse può essere disattivata dal
menu contestuale cliccando con il tasto destro del mouse sulla barra degli strumenti (leggi Pannelli e Barre degli
strumenti).

Suggerimento: Ripristinare le barre degli strumenti
Se avete accidentalmente disattivato tutte le barre strumenti, potete ripristinarle dalla voce di menu Visualizza →
Barre degli strumenti →. Se una barra degli strumenti scompare in Windows, il che sembra succedere di tanto in
tanto, è necessario rimuovere \HKEY_CURRENT_USER\Software\QuantumGIS\qgis\UI\state dal
registro. Quando si riavvia qgis viene ripristinato lo stato di default e le barre degli strumenti sono nuovamente
visibili.

6.3 Legenda

L’area di legenda è usata per impostare la visibilità e l’ordine di sovrapposizione dei layer. La casella di controllo
in ogni legenda può essere usata per attivare/disattivare la visibilità di un layer.

Un layer può essere selezionato e trascinato in modo da modificarne la visibilità (z-ordering). Z-ordering significa
che i layer in cima alla legenda coprono nella mappa quelli sottostanti.
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I layer presenti nella legenda possono essere organizzaati in gruppi. Ci sono due modi per farlo:

1. Cliccare con il tasto destro del mouse nell’area di legenda e selezionare Aggiungi gruppo →, quindi as-
segnare un nome al gruppo e premere il tasto Invio. Ora è possibile cliccare e trascinare layer esistenti
all’interno del gruppo.

2. Selezionare alcuni layer, cliccare con il tasto destro e selezionare Gruppo selezionato. I layer selezionati
saranno automaticamenti spostati in un nuovo gruppo.

Per rimuovere un layer da un gruppo è possibile cliccare e trascinare il layer al di fuori dello stesso o in alternativa
cliccare con il tasto destro del mouse sul layer e selezionare Muovi fuori dal gruppo →. I gruppi possono essere
nidificati all’interno di altri gruppi.

La casella di controllo di un gruppo può essere usata per mostrare/nascondere tutti i layer del gruppo con un
singolo clic.

Il contenuto del menu contestuale varia a seconda che si faccia click col tasto destro del mouse su un layer raster

o vettoriale. Per i layer vettoriali di GRASS la voce di menu Modifica non è abilitata. Si veda la sezione
Digitalizzare e modificare layer vettoriali GRASS per informazioni su come modificare layer vettoriali GRASS.

Menu contestuale per i raster

• Zoom all’estensione del layer →

• Zoom alla scala migliore (100 %) →

• Aggiungi alla panoramica →

• Rimuovi →

• Imposta il SR del layer →

• Imposta SR progetto dal layer

• Proprietà

• Rinomina →

• Copia stile

• Aggiungi nuovo gruppo →

• Espandi tutto →

• Racchiudi tutto →

• Aggiorna l’ordine del disegno

Inoltre, a seconda della posizione e della selezione del layer

• Crea un elemento al livello più alto

• Gruppo selezionato

Menu contestuale per i vettori

• Zoom all’estensione del layer →

• Aggiungi alla panoramica →

• Rimuovi →

• Imposta il SR del layer →

• Imposta SR progetto dal layer

• Apri tabella attributi

• Modifica (non disponibile per i layer GRASS)

• Salva come

• Salva selezione come
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• Interrogazione

• Mostra totale elementi

• Proprietà

• Rinomina →

• Copia stile

• Aggiungi nuovo gruppo →

• Espandi tutto →

• Racchiudi tutto →

• Aggiorna l’ordine del disegno

Inoltre, a seconda della posizione e della selezione del layer

• Crea un elemento al livello più alto

• Gruppo selezionato

Menu contestuale per i gruppi di layer

• Zoom al gruppo

• Rimuovi →

• Imposta il SR di gruppo

• Rinomina →

• Aggiungi nuovo gruppo →

• Espandi tutto →

• Racchiudi tutto →

• Aggiorna l’ordine del disegno

È possibile selezionare più di un layer o gruppo allo stesso tempo tenendo premuto il tasto Ctrl e selezionando
con il tasto sinistro del mouse. Tutti i layer così selezionati possono essere spostati contemporaneamente in un
nuovo gruppo.

E’ possibile anche rimuovere uno o più layer gruppi selezionandoli prima con il tasto Ctrl e premendo
successivamente Ctrl D. In questo modo tutti i layer selezionati saranno rimossi dalla lista.

6.3.1 Lavorare con la Legenda indipendentemente dall’ordine dei layer

Dalla versione 1.8 di QGIS, grazie ad un widget, è possibile impostare una legenda indipendentemente dall’ordine
di disegno. Si può attivare questa opzione dal menu Visualizza → Pannelli e determinare l’ordine di disegno dei
layer nella zona di visualizzazione. Cosi facendo si possono ordinare i layer in base, per esempio all’importanza,

pur mantenendo l’ordine di visualizzazione iniziale corretto (vedi figure_layer_order). Spuntando la casella
control rendering order collocata sotto l’elenco dei layer è possibile ritornare al comportamento iniziale.

6.4 Vista Mappa

Questa è l’area in cui le mappe vengono visualizzate. La mappa visualizzata in questa finestra sarà il risultato
dei layer vettoriali e/o raster che si è scelto di caricare (vedere le sezioni che seguono per ulteriori informazioni
su come caricare i layer). La zona di visualizzazione della mappa può essere modificata (spostando la messa a
fuoco dell’esposizione della mappa ad un’altra regione) ed è possibile effettuare operazioni di zoom in ed out (+
e -). Varie altre operazioni sono descritte nella sezione relativa alla barra dei menu. La vista nell’area di mappa e
la legenda sono strettamente legate l’un l’altra: le mappe che vengono visualizzate riflettono i cambiamenti fatti
nella area della legenda.
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Figura 6.2: Define a legend independent layer order

Suggerimento: ZOOM IN E ZOOM OUT CON LA ROTELLA DEL MOUSE
Per le operazioni di zoom è anche possibile utilizzare la rotella del mouse. Posizionando il puntatore del mouse
nell’area di visualizzazione delle mappe si aumenta lo zoom girando la rotella verso lo schermo, lo si riduce
girandola nel verso contrario. La posizione del puntatore costituisce il centro per l’ingrandimento. Il comporta-
mento della funzione di zoom con la rotella del mouse può essere regolata dalla scheda Map tools sotto il menu
Impostazioni → Opzioni .

Suggerimento: MUOVERE LA MAPPA CON I TASTI FRECCIA E LA BARRA SPAZIATRICE
È possibile usare i tasti freccia per muovere la mappa. Posizionando il puntatore del mouse nell’area di visualiz-
zazione delle mappe, ci si muove verso Est con la freccia destra, verso Ovest con quella sinistra, verso Nord con
la freccia su e verso Sud con la freccia giù. Si può spostare la mappa anche tenendo premuta la barra spaziatrice e
muovendo il mouse.

6.5 Barra di Stato

La barra di stato mostra le coordinate di mappa (es. metri o gradi decimali) alla posizione del mouse. Nella barra
di stato a sinistra del visore delle coordinate è presente un piccolo pulsante che consente di passare dalla visione
delle coordinate al movimento del mouse alla visione delle coordinate dell’estensione della vista mappa.

Accanto al display di visualizzazione delle coordinate si trova il display della scala. Questo mostra la scala della
vista mappa. Sia ingrandendo che rimpicciolendo la scala, QGIS mostrerà la scala corrente. Dalla versione 1.8 di
QGIS è possibile scegliere fra scale predefinite da 1:500 a 1:1000000.

Una barra di avanzamento nella barra di stato mostra il progredire della visualizzazione di ogni layer nella vista
mappa. In alcuni casi, come quando vengono raccolte informazioni statistiche su layer raster, questa barra è
utilizzata per mostrare lo stato di tali processi, in genere molto lunghi.

Se è disponibile un nuovo plugin o un aggiornamento ad un plugin installato, nella barra di stato apparirà un avviso.

L’icona disattiva temporaneamente la visualizzazione dei layer nella vista mappa (Sezione Visualizzazione).
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L’icona Nella parte destra della barra di stato è presente una casella di controllo che, se attivata, può essere
usata per impedire temporaneamente la visualizzazione dei layer.

All’estrema destra della barra di stato appare il codice EPSG del SR del progetto corrente; cliccando sull’icona a
forma di proiettore subito a destra del codice EPSG è possibile accedere alle proprietà del SR stesso.

Suggerimento: IMPOSTARE CORRETTAMENTE LA SCALA DELLA MAPPA
I gradi sono l’unità di misura predefinita di QGIS, quindi le coordinate di ciascun layer verranno visualizzate
in gradi decimali. Per ottenere valori di scala corretti, è possibile cambiarli manualmente in unità metriche nella
scheda Generale sotto il menu Impostazioni → Proprietà progetto oppure è possibile scegliere un Sistema di rifer-

imento (SR) cliccando sull’icona Stato SR nell’angolo in basso a destra della barra di stato. In quest’ultimo caso
le unità di misura sono impostate secondo le caratteristiche delle proprietà del progetto, ad esempio ‘+units=m’.
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CAPITOLO 7

Strumenti generali

7.1 Scorciatoie da tastiera

QGIS fornisce delle scorciatoie da tastiera predefinite per molte delle sue funzionalità: queste sono disponibili
nella sezione Barra dei Menu. Inoltre, l‘opzione di menu Impostazioni → Configura scorciatoie → permette di
modificare le scorciatoie da tastiera predefinite e di aggiungerne delle nuove.

Figura 7.1: Define shortcut options (KDE)

La configurazione è molto semplice; basta selezionare una funzionalità di interesse e cliccare [Cambia], [Elim-
ina] or [Selezione predefinita]. Le configurazioni possono essere salvate in un file XML e caricate in un’altra
installazione di QGIS.

7.2 Guide contestuali

Quando si ha necessità di maggiori informazioni su una funzionalità specifica è possibile utilizzare la guida con-
testuale disponibile in molte finestre di dialogo. Si noti che nel caso di plugin di terze parti la guida contestuale
potrebbe rimandare ad una pagina web dedicata.

7.3 Visualizzazione

Come impostazione di default QGIS ricarica nella vista tutti i layer visibili ogni qualvolta la vista vieneaggiornata.
Gli eventi che causano l’aggiornamento della vista includono:
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• Aggiunta di un layer

• Spostamento, ingrandimento o riduzione (pan e zoom)

• Ridimensionamento della finestra di QGIS

• Cambiamento della visibilità di uno o più layer

QGIS consente di controllare il processo di resa a video in diverse maniere.

7.3.1 Visualizzazione in funzione della scala

La visualizzazione in funzione della scala consente di specificare la scala minima e massima rispettivamenteal di
sotto e al di sopra della quale un layer resta visibile. Per impostare la visualizzazione in funzione dellascala, aprire
la finestra di dialogo Properties facendo doppio click sul layer nella legenda. Nella scheda Generale spuntare la

casella di controllo Visualizza in funzione della scala e impostare i valori per la scala massima e minima.

I valori di scala possono essere determinati usando prima lo zoom sul layer per il quale si vuole impostarel’opzione
e prendendo successivamente nota del valore di scala visualizzato nella barra di stato di QGIS.

7.3.2 Controllare la visualizzazione della mappa

La visualizzazione della mappa può essere controllata nei seguenti modi:

Sospensione della visualizzazione

Per sospendere la resa a video, cliccare sulla casella di controllo Aggiorna in basso a destra della barra di stato.

Quando la casella Aggiorna non è selezionata, QGIS non ridisegna la vista quando si verifica uno degli eventi
precedentemente descritti alla Sezione Visualizzazione. Casi in cui si potrebbe voler sospendere la visualizzazione
a video includono:

• Aggiunta di molti layer ed applicazione di uno stile visuale prima della visualizzazione

• Aggiunta di uno o più layer di grosse dimensioni e impostazione di una scala prima della visualizzazione

• Aggiunta di uno o più layer di grossa dimensione e zoom ad un’area specifica prima della visualizzazione

• Combinazioni delle precedenti

La selezione della casella di controllo Aggiorna abilita la visualizzazione e causa l’immediato aggiornamento
della vista mappa.

Controllare la visibilità dei layer quando sono caricati

Può essere scelta l’opzione di caricare i nuovi layer senza che essi vengano immediatamente resi a video.Ciò
significa che quando si aggiungerà un layer al progetto, la casella di controllo per la visibilità nella legendasarà
disabilitata di default. Per impostare questa opzione, scegliere l’opzione di menu Impostazioni → Opzioni → e

cliccare sulla scheda Visualizzazione in corso. Deselezionare la casella di controllo Per impostazione pre-
definita i nuovi layer aggiunti alla mappa vengono visualizzati subito. Ogni layer aggiunto alla mappa sarà quindi
spento (invisibile) di default.

Fermare la visualizzazione

Per fermare la visualizzazione della mappa premere il tasto ESC. Si bloccherà cosi l‘aggiornamento della vista
e la mappa rimarrà parzialmente disegnata. Dopo aver premuto il tasto ESC potrebbe passare un po‘ di tempo
affinchè l‘interruzione della visualizzazione della mappa sia effettiva.

Nota: Al momento non è possibile interrompere la visualizzazione in corso: questa opzione è stata disabilitata
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nella porta qt4 a causa di diversi problemi dell‘interfaccia utente (UI).

Aggiornamento della mappa durante la visualizzazione

Può essere impostata un’opzione per aggiornare la mappa man mano che gli elementi del layer vengono letti. Di
default QGIS non traccia alcun elemento a video fino a che l’intero layer non sia stato letto. Per aggiornare la
visualizzazione man mano che gli elementi vengono letti dall’archivio, selezionare la voce di menu Impostazioni→
Opzioni → e cliccare sulla scheda Visualizzazione in corso. Impostare il numero di elementi che si desidera
vengano letti prima che lo schermo venga aggiornato. Un valore pari a 0 disabilita l’aggiornamento durante il
disegno degli oggetti (impostazione predefinita). Un valore troppo basso diminuisce le prestazioni in quanto la
mappa viene continuamente aggiornata man mano che gli elementi del layer vengono letti. Un valore suggerito è
500.

Modificare la qualità della visualizzazione

Vi sono due opzioni per modificare la qualità della visualizzazione. Dal menu Impostazione → Opzioni → cliccare
sulla scheda Visualizzazione in corso e selezionare o deselezionare le seguenti caselle di controllo.

• Rendi le linee meno irregolari a spese delle prestazioni

• Risolvi problemi con i poligoni riempiti non correttamente

7.4 Misurazioni

È possibile effettuare misure unicamente nei sistemi di coordinate piane (es. UTM). Se la mappa caricata è definita
in un sistema di coordinate geografiche (es. latitudine/longitudine), il risultato della misura di linee o di aree sarà
errato. Per misurare è quindi necessario impostare correttamente il sistema di coordinate della mappa (si veda la
Sezione Lavorare con le proiezioni). Tutti i moduli di misura usano inoltre le opzioni di snapping del modulo di
digitalizzazione. Questo è utile se si desidera misurare lungo linee o aree di layer vettoriali.

Per selezionare uno strumento di misura cliccare su e scegliere lo strumento che si intende utilizzare.

7.4.1 Misurare lunghezze, aree ed angoli

QGIS è in grado di fornire la misura della distanza reale tra due punti in funzione di uno specifico ellissoide.
Ciò può essere configurato con l’opzione di menu Impostazioni → Opzioni → cliccando sulla scheda Strumenti
mappa e scegliendo l’ellissoide appropriato. Qui sarà possibile definire il colore elastico e l’unità di misura
preferita (metri o piedi). Lo strumento consentirà allora di cliccare punti sulla mappa: la misura di ogni segmento
verrà mostrata nella finestra dello strumento insieme alla misura totale. Per terminare la misura cliccare con il
tasto destro del mouse.

Figura 7.2: Measure Distance (KDE)
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Questo strumento consente di misurare aree; la finestra mostrerà unicamente l’area totale misurata.In aggiun-
ta, lo strumento di misura farà lo snap sul layer selezionato al momento, nel caso il layer abbia definita la sua
tolleranza di snap (Sezione Settare la tolleranza dello snapping e il raggio di ricerca degli elementi). Se, quindi,
si vuole misurare esattamente lungo una linea o un poligono è necessario prima definire la tolleranza di snap,
poi selezionare il layer. In questo modo, quando vengono usati gli strumenti di misura, ogni click del mouse
(all’interno della tolleranza definita) si aggancerà a quel layer.

Figura 7.3: Measure Area (KDE)

È possibile misurare angoli tramite lo strumento Misura angoli. Cliccare e disegnare il primo segmento
dell’angolo, poi spostare il mouse per disegnare l’angolo stesso; la misura apparirà in una finestra popup.

Figura 7.4: Measure Angle (KDE)

7.4.2 Selezionare e deselezionare elementi

QGIS fornisce diversi strumenti per la selezione di elementi nella vista mappa. Per selezionare uno o più elementi

cliccare e scegliere lo strumento di interesse:

• Seleziona il singolo elemento

• Seleziona elementi con un rettangolo

• Seleziona elementi con un poligono

• Seleziona elementi a mano libera

• Seleziona elementi con un cerchio

Per deselezionare tutti gli elementi selezionati cliccare su Deselect features from all layers.

7.5 Decorazioni

Le decorazioni includono l‘Etichetta Copyright, la Freccia Nord e la Barra di scala. Sono usati per decorare la
mappa aggiungendo elementi cartografici.

Nota: Prima di QGIS 1.8 le stesse funzionalità erano fornite dal Plugin Decorazione.
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7.5.1 Etichetta Copyright

Etichetta Copyright aggiunge un‘Etichetta Copyright personalizzata in base al testo che si preferisce far
apparire sulla mappa.

Figura 7.5: The copyright Dialog

1. Seleziona dal menu Visualizza → Decorazioni→ Etichetta copyright. Si aprirà un‘altra finestra (vedi
figure_decorations_1).

2. Digitare il testo che si vuole aggiungere alla mappa. Si può usare codice HTML come mostrato nell’esempio

3. Scegliere il posizionamento dell’etichetta dal menu a tendina Posizione In basso a destra

4. Assicurasi che la casella di controllo Abilita etichetta di Copyright sia selezionata

5. Cliccare [OK]

Nell’esempio (default) il simbolo di copyright è seguito dalla data ed è posto nell‘angolo in basso a destra della
vista.

7.5.2 Freccia Nord

North Arrow aggiunge alla mappa una semplice freccia indicante il nord. Al momento c’è un solo stile
disponibile. Si può modificare manualmente l’angolo della freccia o lasciare che QGIS imposti automaticamente
la direzione. Per il posizionamento della freccia si hanno quattro possibilità, corrispondenti ai quattro angoli della
mappa.

Figura 7.6: The North Arrow Dialog
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7.5.3 Barra di Scala

Scale Bar aggiunge una semplice barra di scala alla mappa. Si può controllare lo stile ed il posizionamento,
come anche l’etichettatura della scala.

Figura 7.7: The Scale Bar Dialog

QGIS supporta solamente la visualizzazione della scala nella stessa unità di misura della mappa. Se l’unità di
misura dei layer è il metro, non si può creare una barra di scala in piedi. Allo stesso modo, se si usano gradi
decimali, non si può creare una barra di scala che mostri le distanze in metri.

Per aggiungere una barra di scala:

1. Selezionare dal menu Visualizzazione → Decorazioni→ Barra di scale. Si aprirà cosi una finestra di dialogo
(see figure_decorations_3)

2. Scegliere il posizionamento dal menu a tendina Posizionamento In basso a sinistra

3. Scegliere lo stile dalla lista Stile della Barra di Scala Porta in basso

4. Scegliere il colore della barra di scala Colore della barra black o usare il colore nero di default

5. Impostare la dimensione della barra e la sua etichetta Dimensione della barra 30 gradi

6. Assicurarsi che la casella di controllo Abilitare barra di scala sia selezionata

7. Se si vuole, scegliere di arrotondare automaticamente il numero quando la mappa viene ridimensionata
Arrotonda automaticamente il numero durante il ridimensionamento

8. Cliccare [OK]

Suggerimento: Impostazioni delle decorazioni
Quando si salva un progetto .qgs, ogni impostazione relativa alle decorazioni viene salvata nello stesso progetto e
ripristinata alla successiva apertura del file .qgs.

7.6 Note testuali

Lo strumento note nella barra degli attributi permette di posizionare del testo formattato sulla vista mappa di
QGIS. Scegliere lo strumento note e cliccare nella vista mappa.

Facendo doppio-click sull’elemento aggiunto sulla mappa dallo strumento note si ha accesso ad una finestra di
dialogo con varie opzioni. C’è un editor di testo semplificato per l’inserimento del testo formattato; è possibile
scegliere se vincolare il testo alla mappa o solo allo schermo.

Il testo può essere spostato secondo le proprie esigenze tramite lo strumento muovi nota.

38 Capitolo 7. Strumenti generali



QGIS User Guide, Release 1.8

Figura 7.8: Annotation text dialog

7.6.1 Nota con modulo

È possibile creare moduli note personalizzati. Lo strumento Note con modulo è utile per visualizzare gli
attributi di un layer vettoriale in un modulo personalizzato qt designer(Figura figure_custom_annotation). È simile
alla finestra dello strumento ’Informazioni elementi’, ma il tutto viene mostrato in una nota. Si veda il blog
http://blog.qgis.org/node/143 per maggiori dettagli.

Figura 7.9: Customized qt designer annotation form

Nota: Nota: Premendo Ctrl+T con uno strumento nota attivo (Nota testuale, Nota con modulo, Muovi nota) lo
stato di visualizzazione delle note si inverte: se sono visibili diventano invisibili e viceversa.

7.7 Segnalibri geospaziali

I segnalibri geospaziali consentono di memorizzare una posizione geografica alla quale ritornare in un secondo
momento.
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7.7.1 Creazione di un segnalibro

Per creare un segnalibro:

1. Usare lo zoom o muovere la mappa all’estensione d’interesse.

2. Selezionare la voce di menu Visualizza→ Nuovo segnalibro→ oppure premere Ctrl-B.

3. Inserire un nome descrittivo per il segnalibro (fino a 255 caratteri).

4. Cliccare su [OK] per aggiungere il segnalibro o [Close] per uscire senza aggiungere il segnalibro.

Si noti che è possibile avere più di un segnalibro con lo stesso nome.

7.7.2 Uso e gestione dei segnalibri

Per usare o gestire i segnalibri, selezionare la voce di menu Visualizza→ Mostra segnalibri →. La finestra Seg-
nalibri geospaziali consente di usare lo zoom a un segnalibro o di eliminarne uno. Non è possibile editare il nome
o le coordinate di un segnalibro.

7.7.3 Zoom a un segnalibro

Dalla finestra Segnalibri geospaziali, selezionare il segnalibro desiderato cliccando su di esso, quindi cliccare su
[Zoom A]. Si può usare lo zoom su un segnalibro anche facendo doppio click su di esso.

7.7.4 Cancellare un segnalibro

Per cancellare un segnalibro dalla finestra Segnalibri geospaziali, cliccare su di esso e poi sul pulsante [Elimina].
Confermare la scelta cliccando su [OK] o annullare l’eliminazione cliccando su [Close].

7.8 Progetti nidificati

Per includere file di progetti diversi all‘interno del proprio progetto, scegliere Layer → Includi layer e gruppi →.

7.8.1 Layers inclusi

La finestra di dialogo permette di scegliere quali layer di altri progetti includere:

1. Scegliere per cercare un altro progetto del dataset Alaska.

2. Selezionare il file progetto grassland. E‘ possibile vedere il contenuto del progetto (Figura
figure_embed_dialog).

3. Premere Ctrl e cliccare sui layer grassland e regioni. I layers sono aggiunti sia nella legenda che nella
vista della mappa.

Figura 7.10: Select layers and groups to embed
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Non si possono modificare le proprietà, come stile e etichette, dei layers aggiunti.

Eliminare i layers

Cliccare con il tasto destro sul layer aggiunto e scegliere Rimuovi.
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CAPITOLO 8

Configurazione di QGIS

QGIS è altamente configurabile attraverso i menu Impostazioni → e Visualizza →. Scegliere rispettivamente fra
Opzioni, Personalizzazione e Pannelli, Barre degli strumenti.

8.1 Pannelli e Barre degli strumenti

Nel menu Pannelli → è possibile attivare e disattivare i widgets di QGIS. Il menu Barre degli strumenti → offre la
possibilità di attivare e disattivare gruppi di icone nella barra degli strumenti di QGIS (see figure_panels_toolbars).

Figura 8.1: The Panels and Toolbars menu

Suggerimento: Panoramica
Il pannello di panoramica della mappa fornisce una vista completa dei layer aggiunti ad essa. Può essere seleziona-
to nel menu Visualizza → Pannelli. All’interno della panoramica è presente un rettangolo che mostra l’estensione
corrente della mappa. Ciò permette di determinare rapidamente quale area della mappa si sta attualmente os-
servando. Si noti che le etichette non sono visualizzate nella panoramica anche se i layer hanno la funzione di
visualizzazione delle etichette attiva. Cliccando e trascinando nella panoramica il rettangolo rosso che mostra
l’estensione corrente della vostra vista, la mappa si sposta di conseguenza.

Suggerimento: Messaggi di log
Dalla versione 1.8 di QGIS è possibile tenere traccia dei messaggi di QGIS. E’ possibile attivare la casella di

controllo Messaggi di log nel menu Visualizza → Pannelli e seguire cosi i messaggi relativi alle varie operazioni
nella scheda Generale e Plugin.
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8.2 Proprietà progetto

Nella finestra delle proprietà del progetto sotto File → Proprietà progetto o Impostazioni → Proprietà
progetto possono essere impostate opzioni specifiche del progetto. Queste includono:

• Nella scheda Generale il titolo del progetto, il colore di selezione e dello sfondo, le unità di misura e
l’opzione per salvare i percorsi relativi ai layer. È possibile impostare le unità di misura (usato solo quando
la riproiezione è disabilitata) e la precisione per le cifre decimali.

• La scheda Sistema di riferimento (SR) permette di scegliere il sistema di proiezione delle coordinate e di
abilitare la riproiezione al volo dei layer vettoriali quando vengono visualizzati layer con differenti SR.

• La scheda Layer interrogabil permette di definire i layer che risponderanno allo strumento di interrogazione.
(Vedere il paragrafo Strumenti mappa nella sezione Opzioni dell’interfaccia grafica (GUI) per abilitare
l’interrogazione di layer multipli.)

• La scheda Server WMS permette di definire le informazioni del Service Capabilities, l’Estensione pubblicata

e le Restrizioni dei sistemi di coordinate del mapserver QGIS. Attivando Aggiungi geometria WKT alle
informazioni di risposta dell’oggetto il layer WMS risulterà interrogabile.

8.3 Opzioni dell’interfaccia grafica (GUI)

Alcune opzioni di base per QGIS possono essere impostate nella finestra Opzioni. Selezionare la voce di menu
Impostazioni → Opzioni. Le schede nelle quali possono essere regolate le opzioni sono:

8.3.1 Generale

• Richiedi di salvare i cambiamenti di progetto se necessario

• Avvisa quando viene aperto un file di progetto salvato con una vecchia versione di QGIS

• Cambia il colore della selezione e dello sfondo

• Cambia lo stile di QGIS

• Tema delle icone (scelta tra ‘default’, ‘classic’ e ‘gis’)

• Dimensione delle icone (scelta tra 16, 24 e 32).

• Carattere

• Azione eseguita in legenda sul comando doppio-click (scelta tra Apri proprietà del layer e Apri tabella degli
attributi).

• Rendi maiuscoli i nomi dei layer nella legenda

• Visualizza i nomi degli attributi della classificazione nella legenda

• Crea le icone raster nella legenda

• Nascondi lo splash screen all’avvio

• Mostra suggerimenti all’avvio

• Apri i risultati di un’interrogazione in una finestra agganciata (richiede il riavvio di QGIS)

• Apri le opzioni di snap in una finestra agganciata (richiede il riavvio di QGIS)
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• Apri la tabella degli attributi in una finestra agganciata (richiede il riavvio di QGIS)

• Aggiungi un layer PostGIS con un doppio click e seleziona la modalità estesa

• Aggiungi nuovi layer al gruppo selezionato

• Copia la geometria in formato WKT dalla tabella degli attributi

• Comportamento della tabella attributi (scelta tra Mostra tutti gli elementi, Mostra gli elementi selezionati,
Mostra gli elementi sulla mappa corrente)

• Cache riga attributi tabella

• Mostra i valori NULL come

• Richiedi i sublayer raster . Alcuni sublayers raster di supporto - vengono chiamati subdatasets in
GDAL. Un esempio sono i file netcdf - se ci sono diverse variabili netcdf, GDAL riconosce ogni variabile
come un subdataset. L’opzione permette di controllare la gestione dei sublayers quando uno di questi viene
aperto. Vengono proposte diverse scelte:

– ‘Sempre’: chiede sempre (se sono presenti sublayers)

– ‘Se necessario’ chiede se il layer non ha contorni, ma ha sublayers

– ‘Mai’ non chiede mai, non verrà caricato niente

– ‘Carica tutto’ non chiede niente, ma carica tutti i sublayers

• Ricerca elementi validi nella finestra del browser . L’opzione ‘Controlla l’esensione’ è stata pensata
per velocizzare il caricamento di una cartella, l’operazione potrebbe richiedere diverso tempo se l’opzione
‘Controlla il contenuto del file’ è attivata e vi sono molti file (decine o centinaia).

• Ricerca contenuto dei file compressi (.zip) nella finestra del browser . Anche questa opzione è stata
pensata per velocizzare il caricamento di una cartella. E’ possibile scegliere fra:

– ‘Scansione base’: controlla che l’estensione sia supportata da uno dei driver

– ‘Scansione completa’: apre ogni file per verificare che ogni file sia valido

– ‘Passthru’ non usare questa opzione, sarà rimossa nella prossima versione di QGIS

8.3.2 GDAL

GDAL è una libreria di scambio dati per file raster. In questa scheda potete scegliere quali driver di GDAL usare
per un caricare un file raster poiché a volte sono disponibili più driver GDAL.

8.3.3 Plugins

• Percorsi da aggiungere per cercare ulteriori librerie plugin C++.

8.3.4 Visualizzazione in corso

• Per impostazione i nuovi layer aggiunti alla mappa vengono visualizzati subito

• Numero di geometrie da disegnare prima di aggiornare lo schermo.

• Usa il caching di disegno quando possibile per velocizzare la visualizzazione

• Rendi le linee meno irregolari a spese delle prestazioni

• Risolvi problemi con i poligoni riempiti non correttamente
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• Utilizza la nuova generazione di simboli per la visualizzazione

• Definisci le impostazioni per la visualizzazione raster: ‘selezione banda RGB’, Usa deviazione standard
e ‘migliora contrasto’

• Percorso(i) dove cercare i simboli SVG (Scalable Vector Symbols)

È possibile definire se salvare i percorsi alle texture svg in modalità assoluta o relativa nella scheda Generale del
menu Impostazioni → Proprietà progetto.

8.3.5 Strumenti mappa

• L’impostazione Modalità determina quali layer saranno mostrati attraverso lo strumento ’Informazioni el-
ementi’. Passando a “Top down” o “Il primo attivo” invece di “Layer in uso” gli attributi di tutti i layer
selezionabili (Si veda la Sezione Proprietà progetto in: Progetti sulle modalità di impostazione dei layer
selezionabili) saranno visibili tramite lo strumento Informazioni elementi.

• Apri il modulo degli elementi se viene identificato un un singolo elemento

• Specificare il raggio di ricerca come percentuale della larghezze della mappa

• Ellissoide per calcoli di distanza

• Colore elastico

• Posizioni decimali

• Mantieni le unità di base

• Unità di misura preferita (Metri o Piedi)

• Unità preferita per gli angoli (Gradi, Radianti o Gradi Decimali)

• Define Mouse wheel action (‘Zoom’, ‘Zoom and recenter’, ‘Zoom to mouse cursor’, ‘Nothing’)

• Fattore di zoom

8.3.6 Sovrapposizioni

• Definizione dell’algoritmo di posizionamento delle etichette, dei simobli e dei diagrammi (scelta
tra ‘Punto centrale’, ‘Catena’, ‘Catena tabu’, ‘Popmusic’, ‘Tabu popmusic’, ‘Catena popmusic’)

8.3.7 Digitalizzazione

• Colore e spessore della linea

• Modalità di snap predefinita (‘al vertice’, ‘al segmento’ o ‘entrambe’)

• Tolleranza di snapping predefinita in unità di mappa o in pixel

• Raggio di ricerca per le modifiche dei vertici in unità di mappa o in pixel

• Utilizza indicatori solo per le geometrie selezionate

• Stile indicatore (‘croce’ (predefinita), ‘cerchio semitrasparente’ o ‘nessuno’) e della dimensione
per gli indicatori dei vertici.

• Non aprire la finestra degli attributi dopo la creazione di ogni geometria

• Ripeti i valori degli attributi usati per ultimi
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• Verifica le geometrie La digitalizzazione di linee o poligoni complessi con molti nodi può determinare una
visualizzazione molto lenta. Questo accade perché la procedura di verifica di default in QGIS impiega
molto tempo. Per velocizzare questo processo è possibile selezionare la validazione delle geometrie GEOS
(partendo da GEOS 3.3) oppure è possibile disattivarla del tutto. La validazione delle geometrie effettuata da
GEOS è molto veloce, lo svantaggio è che verrà riportato solamente il primo problema geometrico rilevato.

Le 3 opzioni successive si riferiscono allo strumento Curva di offset in Digitalizzazione avanzata. Attraverso i
vari settaggi è possibile influenzare la forma della linea di offset. Queste opzioni sono possibili da GEOS 3.3.

• Stile di unione per l’offset

• Segmenti di quadrante per l’offset

• Limite di smussatura per l’offset

8.3.8 SR

La scheda SR è divisa in due aree. La prima permette di impostare il SR predefinito per i nuovi progetti.

• Inizia un nuovo progetto sempre con questo SR.

• Effettua sempre la riproiezione al volo

La seconda area permette di definire cosa accade quando un nuovo layer viene creato o quando viene caricato un
layer senza SR.

• Richiedi SR

• Usa il SR del progetto

• Utilizza come predefinito il SR visualizzato sotto

8.3.9 Lingua

• Sovrascrivi lingua in uso

• Informazioni sulla lingua correntemente impostata nel sistema

8.3.10 Rete

• Utilizza un proxy per l’accesso web, definizione di host, porta, utente e password.

• Definizione del Tipo proxy .

– Default Proxy:Il proxy è determinato sulla base delle impostazioni in uso del proxy dell’applicazione

– Socks5Proxy: Proxy generico per ogni tipo di connessione. Supporta TCP, UDP, associazione a una
porta (connessione in entrata) e autenticazione.

– HttpProxy: Realizzato usando il comando “CONNECT”, supporta solamente connessioni TCP in
uscita; supporta l’autenticatione.

– HttpCachingProxy: Realizzato usando normali comandi HTTP, è utile solamente nel contesto di
richieste HTTP

– FtpCachingProxy: Realizzato usando un proxy FTP, è utile solamente nel contesto di richieste FTP

• Impostazioni della cache (cartella e dimensione)

• Indirizzo di ricerca WMS (Quello predefinito è “http://geopole.org/wms/search?search=%1&type=rss”)

• Timeout per le richieste di rete in ms - predefinito 60000

8.3. Opzioni dell’interfaccia grafica (GUI) 47

http://geopole.org/wms/search?search=%1&type=rss


QGIS User Guide, Release 1.8

Figura 8.2: Proxy-settings in QGIS

Si possono escludere alcuni URL aggiungendole nella casella di testo al di sotto delle impostazioni del proxy
(see Figure_Network_Tab) premendo il pulsante [Aggiungi] . In seguito fare doppio click nel campo URL appena
creato e inserire l’URL che si desidera escludere dall’utilizzo del proxy. Ovviamente il pulsante [Rimuovi] elimina
l’elemento selezionato.

Per informazioni più dettagliate sulle diverse impostazioni del proxy, si prega di fare riferimento al manuale della
documentazione delle librerie QT suhttp://doc.trolltech.com/4.5/qnetworkproxy.html#ProxyType-enum.

Suggerimento: UTILIZZO DEI PROXY
L’utilizzo dei proxy può a volte essere complicato. E’ utile testare i tipi di proxy succitati e controllare il loro
funzionamento nel vostro caso specifico.

Queste opzioni possono essere modificate in funzione delle proprie esigenze. Alcuni cambiamenti potrebbero
richiedere il riavvio di QGIS prima di essere attivi.

• Le impostazioni sono salvate in un file di testo: $HOME/.config/QuantumGIS/qgis.conf

• Le impostazioni vengono collocate in: $HOME/Library/Preferences/org.qgis.qgis.plist

• Le impostazioni vengono inserite nel registro di sistema alla voce:

\HKEY\CURRENT_USER\Software\QuantumGIS\qgis

8.4 Personalizzazione

Lo strumento di personalizzazione è una nuova implementazione di QGIS 1.8. Permette di attivare/disattivare
praticamente qualunque elemento dell’interfaccia di QGIS. Questa possibilità è molto utile se sono stati installati
molti plugins che vengono usati raramente e che riempiono lo schermo.

Il menu Personalizzazione di QGIS è diviso in cinque gruppi. In Docks si trovano le finestre dock. Queste
sono applicazioni che possono essare avviate e usate come finestre mobili, fisse oppure possono essere incorporate

nella finestra principale di QGIS come se fossero dei widget (see also Pannelli e Barre degli strumenti). In

Menu è possibile nascondere funzioni all’interno della Barra dei Menu. In Barra di stato è possibile disattivare

caratteristiche come le informazioni sulle coordinate. In Barra degli strumenti è possibile attivare/disattivare le

icone della barra degli strumenti di QGIS e in Widgets si possono attivare/disattivare i diversi pannelli presenti
in QGIS.
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Figura 8.3: The Customization dialog

Con Passa ai widget per la cattura nell’applicazione principale è possibile cliccare sugli elementi di QGIS
che si intendono nascondere dall’interfaccia e trovarli nel menu Personalizzazione (see figure_customization). E’
possibile anche salvare i diversi setaggi a seconda dei diversi utilizzi. Prima che i cambiamenti diventino effettivi
è necessario riavviare QGIS.
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CAPITOLO 9

Lavorare con le proiezioni

QGIS consente all’utente di definire un sistema di riferimento - SR - (Coordinate Reference System, ovvero Sis-
tema di Riferimento delle Coordinate) globale o a livello di singolo progetto per i layer privi di un SR predefinito.
Consente inoltre di definire sistemi di coordinate personalizzati e supporta la riproiezione al volo (on-the-fly,
OTF) dei layer vettoriali. Tutte queste caratteristiche permettono all’utente di visualizzare contemporaneamente e
correttamente sovrapposti i layer aventi SR differenti.

9.1 Panoramica sul supporto alle proiezioni

QGIS supporta all’incirca 2.700 SR. Le definizioni di ognuno di questi SR sono memorizzate in un database
SQLite che viene installato con QGIS. Normalmente non è necessario manipolare il database direttamente, infatti
questa operazione può causare il malfunzionamento del supporto alla proiezione. I SR personalizzati sono salvati
in un database utente. Si veda la Sezione Sistemi di riferimento personalizzati per informazioni sulla gestione dei
SR personalizzati.

I SR disponibili in QGIS sono basati su quelli definiti dall’European Petroleum Survey Group - EPSG - e dall’In-
stitut Geographique National francese (IGN) e sono per lo più tratti dalle tabelle di riferimento spaziale di GDAL.
Gli identificatori EPSG sono presenti nel database e possono essere usati per richiamare e definire i SR in QGIS.

Per usare la riproiezione al volo (OTF), i dati devono contenere informazioni sul proprio sistema di riferimento
oppure bisogna definire un SR a livello layer o a livello di progetto o globale. Per i layer PostGIS, QGIS usa
l’identificatore del riferimento spaziale specificato al momento della creazione del layer. Per i dati supportati da
OGR, QGIS fa affidamento sulla presenza di un mezzo, specifico per ciascun formato, che definisce il SR. Nel
caso degli shapefile, ad esempio, si stratta di un file contenente l’indicazione del SR in formato Well Known Text
(WKT). Il file della proiezione ha lo stesso nome dello shapefile, ma ha estensione prj. Per esempio uno shapefile
chiamato alaska.shp. avrà un corrispondente file di proiezione chiamato alaska.prj.

Ogni volta che si seleziona un nuovo SR, le unità utilizzate per il layer verranno automaticamente aggiornate
nella scheda Generale della finestra di dialogo Proprietà progetto sotto il menu Modifica (Gnome, OSX) o
Impostazioni (KDE, Windows).

9.2 Specificare una proiezione

QGIS imposta il SR di ogni nuovo progetto su quello definito a livello globale: il SR globale predefinito è
EPSG:4326 - WGS 84 (proj=longlat +ellps=WGS84 +datum=WGS84 +no_defs). Il SR predefinito può essere
modificato tramite il pulsante [Scegli...] mostrato in figura figure_projection_1: tale impostazione varrà per tutte
le sessioni successive di QGIS.

When you use layers that do not have a CRS, you need to define how QGIS responds to these layers. This can be
done globally or project-wide in the CRS tab under Edit → Options (Gnome, OSX) or Settings → Options
(KDE, Windows).

Le opzioni mostrate in figura figure_projection_1 sono:
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Figura 9.1: CRS tab in the QGIS Options Dialog

• Richiedi SR

• Usa il SR del progetto

• Utilizza come predefinito SR visualizzato sotto

Per definire il SR di un layer privo di tale informazione, si può anche agire nella scheda Generale della finestra di
dialogo delle proprietà dei raster (Sezione Scheda generale) e dei vettori (Sezione Scheda Generale). Se il SR è
già stato definito, lo stesso verrà mostrato come nella Figura Vector Layer Properties Dialog .

Suggerimento: SR NELLA LEGENDA
Il menu contestuale dei layer in legenda (tasto destro sul nome del layer) (Sezione Legenda) fornisce due scorci-
atoie per l’impostazione del SR: Imposta il SR del layer apre direttamente la finestra per la scelta del sistema di
riferimento (figura figure_projection_2), mentre Imposta il SR del progetto dal layer imposta il SR del progetto
sulla base di quello del layer

9.3 Definire la riproiezione al volo (OTF)

QGIS supporta la riproiezione al volo (OTF) sia per i raster che per i vettori, ma l’opzione non è abilitata di

default. Per usare la riproiezione OTF, bisogna attivare la casella di controllo Abilita la riproiezione al volo

nella scheda SR della finestra di dialogo Proprietà progetto.

Ci sono tre modi per aprire questa finestra:

1. Selezionare Proprietà progetto dal menu Modifica (Gnome, OSX) o Impostazioni (KDE, Windows)
menu.

2. Fare click sull’icona Stato SR nell’angolo in basso a destra della barra di stato.

3. Turn OTF on by default, by selecting the CRS tab of the Options dialog and selecting Enable ‘on the fly’
reprojection by default.

Se è già stato caricato un layer e si vuole abilitare la riproiezione, è buona norma aprire la scheda Sistema di
riferimento (SR) della finestra di dialogo Proprietà progetto selezionare nell’elenco il SR attualmente impostato,
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quindi attivare la casella di controllo Abilita la riproiezione al volo. Ogni layer caricato successivamente sarà

riproiettato al volo nel SR mostrato affianco al pulsante Stato SR.

Figura 9.2: Projection Dialog

La scheda Sistema di riferimento (SR) della finestra di dialogo Proprietà progetto contiene cinque importanti
componenti, illustrati in figura Figure_projection_2 e di seguito descritti.

1. Enable on the fly CRS transformation - this checkbox is used to enable or disable OTF projection. When
off, each layer is drawn using the coordinates as read from the data source and the components described
below are inactive.When on, the coordinates in each layer are projected to the coordinate reference system
defined for the map canvas.

2. Sistema di Riferimento - è la lista di tutti i SR supportati da QGIS, inclusi i sistemi di coordinate ge-
ografiche, piane e quelli personalizzati. Per usare un SR, selezionarlo dalla lista espandendo il gruppo
appropriato. Il SR attivo è quello preselezionato.

3. Stringa Proj4 - è la stringa SR usata dal motore di proiezione Proj4. È un testo di sola lettura, a solo scopo
informativo.

4. Filter - if you know the EPSG code, the identifier or the name for a Coordinate Reference System, you can
use the search feature to find it. Enter the EPSG code, the identifier or the name.

5. Sistemi di riferimento usati di recente - se ci sono dei SR che vengono usati frequentemente, essi verranno
visualizzati in questa sezione della finestra di dialogo. Basta fare click su una voce per impostare il SR
associato.

Suggerimento: Finestra di dialogo Proprietà del progetto
Se si apre la finestra di dialogo Proprietà progetto dal menu Modifica (Gnome, OSX) o impostazioni (KDE,
Windows), bisogna fare click sulla scheda Sistema di riferimento (SR) per visualizzare le impostazioni del SR.

La stessa finestra può essere aperta con l’icona Stato SR.
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9.4 Sistemi di riferimento personalizzati

Se in QGIS non si trova il sistema di riferimento di cui si necessita, è possibile definirne uno personalizzato:

selezionare SR personalizzato dal menu Modifica (Gnome, OSX) o Impostazioni (KDE, Windows).I SR per-
sonalizzati sono salvati nel database utente di QGIS. Oltre ai SR personalizzati, questo database contiene anche i
segnalibri geospaziali e altri dati personalizzati dall’utente.

Figura 9.3: Custom CRS Dialog

La definizione di un SR personalizzato in QGIS richiede una buona comprensione delle librerie Proj.4. Per in-
iziare, fare riferimento al documento Cartographic Projection Procedures for the UNIX Environment - A User’s
Manual di Gerald I. Evenden, U.S. Geological Survey Open-File Report 90-284, 1990 (disponibile all’indirizzo
ftp://ftp.remotesensing.org/proj/OF90-284.pdf ).

Questo manuale descrive l’uso di proj.4 e delle relative utilità da riga di comando. I parametri cartografici usati
da proj.4 sono descritti nel manuale e sono identici a quelli usati da QGIS.

La finestra di dialogo Definizione Sistema Riferimento Spaziale Personalizzato richiede solo due parametri per
definire un SR personalizzato:

1. un nome descrittivo e

2. i parametri cartografici in formato PROJ.4.

Per creare un nuovo SR, fare click sul pulsante nuovo e inserire il nome descrittivo e i parametri.

Successivamente salvare il SR facendo click sul pulsante Salva.

Si noti che la voce Parametri deve iniziare con un blocco +proj=, per rappresentare il nuovo SR.

È possibile testare i parametri SR per vedere se danno risultati validi facendo click sul pulsante [Calcola] nella
sezione Prova, dopo aver incollato i parametri SR personalizzati nel campo Parametri. Quindi, inserire dei valori
noti di latitudine e longitudine nel sistema WGS 84 rispettivamente nei campi Nord e Est. Fare click su [Calcola]
e confrontare i risultati con i valori noti nel SR personalizzato.
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CAPITOLO 10

QGIS Browser

QGIS Browser è un nuovo pannello che permette di navigare facilmente nel database. E’ possibile accedere
ai file vettoriali comuni (ESRI shapefile o MapInfo file), ai database (come PostGIS o MMSQL Spatial) e alle
connessioni WMS/WFS. Si possono anche vedere i dati di GRASS (per caricare i dati di GRASS in QGIS vedi
see Integrazione con GRASS GIS).

Figura 10.1: Qgis browser as a standalone application to view metadata, preview and attributes

Si può usare QGIS Browser per vedere un’anteprima dei dati. La funzione di trascinamento rende molto facile la
visualizzazione dei dati nella Legenda e nella Vista mappa.

1. Per attivare QGIS Browser: cliccare con il tasto destro sulla barra degli strumenti e scegliere Browser.

2. Trascinare il pannello nella finestra della Legenda.

3. Cliccare sulla scheda Browser.

4. Navigare nel database e scegliere la cartella contenente i file vettoriali qgis_sample_data.

5. Tenendo premuto il tasto Shift cliccare su airports.shp e alaska.shp .

6. Tenendo premuto il tasto sinistro del mouse, trascinare i file nella mappa.

7. Cliccare con il tasto destro su un layer e scegleire Imposta il SR del progetto dal layer. Per ulteriori
informazione vedi Lavorare con le proiezioni.
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8. Cliccare su Zoom completo per rendere visibili tutti i layer.

E’ possibile avviare QGIS Browser anche come applicazione standalone.

Avviare qgis browser

• Digitare “qbrowser” nella finestra del terminale.

• Avviare QGIS Browser usando il menu Start oppure il collegamento sul desktop oppure facendo doppio
click su un file di progetto di QGIS.

• QGIS browser non è disponibile nella cartella Applicazioni, ma è molto facile
renderlo tale. In Finder usare Vai → Vai alla mappa... e cercare la cartella
/Applications/QGIS.app/Contents/MacOS/bin. Usare la combinazione di tasti option
- command e tenendo premuto il tasto sinistro del mouse, trascinare qbrowser.app nella cartella
Applicazioni. Questo procedimento creerà un collegamento che potrà essere usato per avviare QGIS
Browser.

In figure_browser_standalone_metadata si possono vedere le potenti funzionalità di QGIS Browser. La scheda
Param fornisce i dettagli del percorso dei set di dati come li fornirebbero PostGIS o MSSQL Spatial. La scheda
Metadata contiene le informazioni generali sui file (vedi Scheda Metadati). Con la scheda Preview è possibile
vedere un’anteprima del file prima di importarlo nel progetto di QGIS. E’ infine possibile vedere un’anteprima
degli attributi dei file grazie alla scheda Attributes.
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CAPITOLO 11

Lavorare con i dati vettoriali

11.1 Formati supportati

QGIS usa la libreria OGR per l’accesso in lettura e scrittura a diversi formati di dati vettoriali (il supporto per
i file vettoriali di GRASS e PostgreSQL è fornito da plugin nativi di QGIS), come shapefile ESRI, formati file
MapInfo e Microstation, Postgis, Spatialite, database spaziali Oracle e molti altri. I file vettoriali possono essere
caricati in modalità lettura anche in formato zip e gzip. Alla data di questa guida la libreria OGR supporta 69
formati vettoriali (vedi OGR-SOFTWARE-SUITE Literature and Web References). La lista completa è disponibile
all’indirizzo http://www.gdal.org/ogr/ogr_formats.html.

Nota: Alcuni dei formati elencati all’indirizzo citato potrebbero non essere supportati da QGIS per diverse
ragioni: ad esempio, alcuni richiedono librerie esterne commerciali o l’installazione di GDAL/OGR nel proprio
sistema è avvenuta senza scegliere il supporto per uno specifico formato. Solo i formati adeguatamente testati
appariranno nella lista di tipi di file al momento del caricamento di un vettore dentro QGIS. Altri formati, non
testati, possono essere caricati selezionando *.*.

La sezione Section Integrazione con GRASS GIS illustra come lavorare con i dati di GRASS.

Questa sezione descrive come lavorare con diversi formati comuni: Shapefile ESRI, layer PostGIS e layer Spa-
tialLite. Molti degli strumenti disponibili in QGIS funzionano allo stesso modo con le differenti sorgenti di dati
vettoriali (ad es. l’identificazione, la selezione, le funzioni per le etichette e gli attributi).

11.1.1 Shapefile ESRI

Il formato di file usato come predefinito in QGIS è lo shapefile ESRI. Il supporto al formato è fornito dalla libreria
OGR Simple Feature Library (http://www.gdal.org/ogr/).

Uno shapefile consiste di un minimo di tre file:

1. .shp file contente le geometrie.

2. .dbf file contenente gli attributi in formato dBase.

3. .shx file d’indice.

Idealmente dovrebbe essere presente un altro file con estensione .prj, che contiene le informazioni sulla proiezione
dello shapefile. Ci possono essere ulteriori file che compongono il dataset in formato shape. Peruno sguardo più
ravvicinato al formato shapefile si raccomanda di prendere visione delle specifiche tecniche del formato disponibili
sul sito http://www.esri.com/library/whitepapers/pdfs/shapefile.pdf.

Caricare uno shapefile

Per caricare uno shapefile, avviare QGIS e cliccare sul pulsante Aggiungi vettore o semplicemente digitare
Ctrl+Shift+V. Si aprirà una nuova finestra (vedi figure_vector_1).
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Figura 11.1: Add Vector Layer Dialog

Nella finestra di dialogo successiva selezionare File e cliccare sul pulsante [Sfoglia]. Si aprirà una finestra di
dialogo standard (vedi figure_vector_2) che consente di cercare nel filesystem lo shapefile o qualunque altro dato

vettoriale si intenda caricare. La casella di selezione Tipo file consente di preselezionare alcuni formati
supportati da OGR.

Se lo si desidera, può essere inoltre selezionata la codifica (encoding) da utilizzare per lo shapefile.

Figura 11.2: Open an OGR Supported Vector Layer Dialog

Selezionando uno shapefile dalla lista e cliccando su [Open] esse viene caricato in QGIS. La figura
Figure_vector_3 mostra come appare l’interfaccia di QGIS dopo aver caricato il file alaska.shp.

Suggerimento: Colori dei layer
Quando un layer viene aggiunto alla mappa, gli viene assegnato un colore a caso. Aggiungendo più layer in una
sola volta, ad ognuno di essi viene assegnato un colore differente.

Una volta caricato lo shapefile, si può interagire con la mappa usando gli strumenti di navigazione. Per cambiare la
rappresentazione di un layer, aprire la finestra di dialogo Proprietà layer facendo doppio click sul nome del layer
e quindi sulla scheda Stile o cliccando con il tasto destro sul nome del layer nella legenda e scegliendo Proprietà
dal menu contestuale. Si veda la Sezione Scheda Stile per ulteriori informazioni su come settare la simbologia dei
layer vettoriali.

Suggerimento: Caricare layer e progetti da drive esterni in OS X
In OS X i drive esterni non vengono elencati come atteso selezionando File → Apri progetto. Stiamo lavorando
alla creazione di un dialogo apri/salva nativo OSX; come soluzione temporanea è possibile digitare ’/Volume’
nella casella Nome file e cliccare invio. Sarà così possibile utilizzare i drive esterni.
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Figura 11.3: QGIS with Shapefile of Alaska loaded

Ottimizzare le prestazioni

Per migliorare le prestazioni di disegno di uno shapefile, può essere creato un indice spaziale. Un indice spaziale
migliora la velocità di disegno quando si usano le funzioni di zoom e di spostamento. Gli indici spaziali usati da
QGIS hanno estensione .qix.

Per creare un indice, seguire queste indicazioni:

• Caricare uno shapefile.

• Aprire la finestra di dialogo proprietà layer facendo doppio click sul nome dello shapefile nella legenda o
cliccando su di esso con il tasto destro e scegliendo la voce Proprietà dal menu contestuale.

• Nella scheda Generale cliccare sul pulsante [Crea indice spaziale].

Problemi nel caricare un file .prj

Se si carica uno shapefile con associato un file .prj e QGIS non riesce a leggere le informazioni di proiezione,
è necessario inserire manualmente queste informazioni nella scheda Generale della finestra di dialogo Proprietà
layer. Ciò è dovuto al fatto che spesso i file .prj non forniscono i parametri di proiezione completi, come richiesto
da QGIS ed elencati nella finestra di dialogo SR.

Per cui quando in QGIS si crea un nuovo shapefile, vengono creati due differenti file di proiezione. Un file .prj
con un insieme limitato di parametri compatibile con il software della ESRI, e un file .qpj che memorizza l’insieme
completo di parametri del SR utilizzato. Quando QGIS trova un file .qpj utilizza quest’ultimo invece del file
.prj.

11.1.2 Caricare un layer MapInfo

Per caricare un file Mapinfo, cliccare nella barra strumenti sul pulsante Aggiungi vettore o digitare
Ctrl+Shift+V, cambiare il filtro nel menu a tendina a Tipo file [OGR] MapInfo (*.mif *.tab *.MIF *.TAB)

e selezionare il layer che si intende caricare.
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11.1.3 Caricare una coverage binaria ArcInfo

Per caricare una coverage binaria ArcInfo cliccare nella barra strumenti sul pulsante Aggiungi vettore o dig-
itare Ctrl+Shift+V per aprire la finestra di dialogo Add Vector Layer. Selezionare Cartella e Tipo Cover-

age binaria Arc/info , scorrere il filesystem per individuare la cartella contenente i file della coverage e
selezionarla.

Allo stesso modo è possibile caricare file vettoriali strutturati in cartelle nel formato di trasferimento UK National
Transfer Format o anche nel formato TIGER del US Census Bureau.

11.1.4 Layer PostGIS

I layer PostGIS sono memorizzati in database PostgreSQL. I vantaggi nell’uso di PostGIS stanno nelle capacità
fornite di creazione dell’indice spaziale, di filtraggio e di interrogazione. Usando PostGIS, le fuzioni vettoriali
come la selezione e l’identificazione in QGIS lavorano con maggiore precisione che con i layer OGR in QGIS.

Creare una connessione

La prima volta in cui viene usata una fonte dati PostGIS, bisogna creare una connessione al database Post-

greSQL che contiene i dati. Cliccare nella barra degli strumenti sul pulsante Aggiungi vettore PostGIS oppure se-

lezionare l’opzione Aggiungi vettore PostGIS... dal menu Layer o digitare Ctrl+Shift+D. E’ inoltre pos-
sibile utilizzare la finestra di dialogo Aggiungi vettore e selezionare Database. Si aprirà la finestra di dialogo
Aggiungi tabella(e) PostGIS. Per accedere al gestore della connessione cliccare sul tasto [Nuovo] per far comparire
la finestra di dialogo Crea una nuova connessione PostGIS. I parametri richiesti per la connessione sono:

• Nome: Nome della connessione. Può essere uguale a quello del Database

• Servizio: Parametri del servizio da usare alternativamente a host/porta (e potenzialmente database). Ciò
può essere definito in pg_service.conf

• Host: Nome del server che ospita il database. Deve essere un host con indirizzo raggiungibile, lo stesso
che potrebbe essere usato per aprire una connessione telnet o per fare il ping all’host. Se il database è sullo
stesso computer sul quale è installato QGIS, inserire semplicemente ‘localhost’.

• Porta: Numero della porta sulla quale il database PostgreSQL è in ascolto. La porta predefinita è 5432.

• Database: Nome del database.

• Modalità SSL: Si noti che è possibile ottenere una notevole velocità di visualizzazione dei layer PostGIS
disabilitando la connessione SSL. Sono disponibili le seguenti opzioni:

– disabilitato: connessione SSL non criptata

– permesso: tenta una connessione non SSL, se questa fallisce ne tenta una SSL

– preferito (default): tenta una connessione SSL, se questa fallisce ne prova una non SSL;

– richiesto: solo connessione SSL.

• Nome utente: Nome dell’utente che accede al database.

• Password: Password usata dallo Username per collegarsi al database.

Come opzione, possono essere attivate le seguenti caselle di controllo:

• Salva nome utente

• Salva Password

• Cercare solamente nella tabella geometry_columns
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• Cerca solamente nello schema

• Mostra anche tabelle senza geometria

• Usa i metadati stimati della tabella

Quando tutti i parametri sono impostati, la connessione può essere testata cliccando sul pulsante [Test
Connessione].

Suggerimento: Impostazioni utente e sicurezza
A seconda dell’ambiente informatico, la memorizzazione delle password nelle impostazioni di QGIS può essere
un rischio per la sicurezza. Le impostazioni personalizzate di QGIS sono salvate in modo diverso in base al
sistama operativo:

• , le impostazioni sono salvate nella cartella home dell’utente nel file .qgis/.

• , le impostazioni sono salvate nel registro di sistema.

Caricare un layer PostGIS

Una volta definita una connessione, si possono caricare layer dal database PostgreSQL. Ovviamente questo
richiede avere dati in PostgreSQL. Si veda la Sezione Importare dati in PostgreSQL per informazioni su come
importare dati nel database.

Per caricare layer da PostGIS, seguire i seguenti passaggi:

• Se la finestra di dialogo Aggiungi tabella(e) PostGIS non è già aperta, cliccare nella barra degli strumenti

sul pulsante Aggiungi vettore PostGIS.

• Scegliere la connessione dal menu a tendina e cliccare su [Connetti].

• Selezionare/deselezionare Mostra tabelle senza geometria

• Opzionalmente usare Opzioni ricerca per definire quali elementi caricare dal layer oppure utilizzare
[Crea query] per avviare la finestra di dialogo Query builder.

• Individuare il layer che si vuole aggiungere nella lista di quelli disponibili.

• Selezionare il layer cliccando sul nome. E’ possibile selezionare più layer tenendo premuto il tasto Shift
mentre si seleziona. Si veda la sezione Costruttore di interrogazioni per informazioni su come usare il
Query builder PostgreSQL per definire una selezione al momento del caricamento.

• Cliccare sul tasto [Aggiungi] per aggiungere il layer alla mappa.

Suggerimento: Layer PostGIS
Di solito un layer PostGIS è definito da un record nella tabella geometry_columns. Dalla versione 0.9.0 in avanti,
QGIS può caricare layer che non hanno tale record nella tabella geometry_columns. Ciò vale sia per le tabelle
che per le viste. La definizione di una vista spaziale fornisce un mezzo molto potente per visualizzare i dati. Fare
riferimento al manuale PostgreSQL per informazioni su come creare le viste.

Alcuni dettagli sui layer PostgreSQL

Questa sezione contiene alcuni dettagli su come QGIS accede ai layer PostgreSQL. La maggior parte delle volte
QGIS dovrebbe semplicemente fornire una lista di tabelle del database che possono essere caricate e caricarle
su richiesta. Tuttavia, se avete difficoltà a caricare una tabella di PostgreSQL in QGIS, le informazioni seguenti
possono aiutare a capire tutti i messaggi di QGIS e a dare un’indicazione su come cambiare la definizione di
tabella o di vista di PostgreSQL per permettere a QGIS di caricarla.
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QGIS richiede che i layer di PostgreSQL contengano una colonna che possa essere usata come chiave unica per
il layer. Per le tabelle questo significa che esse devono contenere una chiave primaria o una colonna con un
vincolo unico. QGIS richiede che questa colonna sia di tipo int4 (un numero intero di 4 byte). Le prestazioni
saranno migliori se la colonna è indicizzata (notare che le chiavi primarie sono automaticamente indicizzate in
PostgreSQL).

Se il layer di PostgreSQL è una vista, esistono gli stessi requisiti, ma le viste non hanno chiavi primarie o colonne
con i vincoli unici su di loro. In questo caso QGIS proverà a trovare una colonna nella vista che provenga da
una colonna appropriata della tabella. Ciò viene fatto analizzando la definizione SQL della vista; ci sono diversi
aspetti di SQL che sono ignorati da QGIS (es. l’uso di alias di tabelle e colonne generate da funzioni SQL).

Se non viene trovata alcuna colonna adatta, QGIS non caricherà il layer. Se questo accade, la soluzione è di
alterare la vista in modo che includa una colonna adatta (di tipo int4 e una chiave primaria o un vincolo unico,
preferibilmente indicizzato).

11.1.5 Importare dati in PostgreSQL

I dati possono essere importati in PostgeSQL/PostGIS utilizzando diversi strumenti, come ad esempio il plugin
SPIT oppure attraverso linea di comando shp2pgsql o ogr2ogr.

Plugin SPIT

QGIS include un plugin denominato SPIT (Shapefile to PostGIS Import Tool). SPIT può essere usato per
caricare più shapefile contemporaneamente e include il supporto per gli schemi. La sezione Plugin SPIT fornisce
maggiori informazioni.

shp2pgsql

PostGIS include un programma di utilità chiamato shp2pgsql che può essere usato per importare shapefile in
un database PostGIS. Per esempio, per importare lo shapefile chiamato lakes.shp nel database PostgreSQL
chiamato gis_data, usare il comando seguente:

shp2pgsql -s 2964 lakes.shp lakes_new | psql gis_data

Questo comando crea un nuovo layer chiamato lakes_new nel database gis_data. Il nuovo layer avrà un
identificatore di riferimento spaziale (Spatial Reference Identifier - SRID) di 2964. Si veda la sezione Lavorare
con le proiezioni per ulteriori informazioni sui sistemi di riferimento spaziale e le proiezioni.

Suggerimento: Esportare dati da PostGIS
Oltre allo strumento per l’importazione shp2pgsql, esiste uno strumento per l’esportazione di dati PostGIS come
shapefile: pgsql2shp. Lo strumento è incluso nella versione di PostGIS corrente.

ogr2ogr

Oltre a shp2pgsql e SPIT c’è un altro strumento per caricare dati in PostGIS: ogr2ogr. ogr2ogr fa parte della
versione di GDAL installata.

Per importare uno shapefile in PostGIS con ogr2ogr digitare il seguente comando:

ogr2ogr -f "PostgreSQL" PG:"dbname=postgis host=myhost.de user=postgres \
password=topsecret" alaska.shp

L’espressione importerà lo shapefile alaska.shp nel database PostGIS postgis usando l’utente postgres e la
password topsecret sull’host myhost.it.
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Notare che OGR deve essere compilato con il supporto a PostgreSQL per poter effettuare tale operazione. La
presenza del supporto a PostgreSQL-PostGIS può essere verificata digitando da riga di comando

ogrinfo --formats | grep -i post

Qualora si volesse usare il comando interno di PostgreSQL COPY al posto del metodo predefinito INSERT
INTO, bisogna settare le variabili d’ambiente come segue (su piattaforme e ):

export PG_USE_COPY=YES

ogr2ogr non crea indici spaziali come shp2pgsl. Bisogna crearli manualmente, usando il comando SQL CREATE
INDEX dopo l’importazione, come passaggio aggiuntivo (sezione Migliorare le prestazioni).

Migliorare le prestazioni

Richiamare dati geografici da un database PostgreSQL può richiedere molto tempo, specialmente se il server dei
dati si trova in rete. È possibile migliorare le prestazioni di resa a video di layer PostgreSQL assicurandosi di creare
un indice spaziale PostGIS spatial index su ogni layer nel database. PostGIS supporta la creazione di un indice
GiST (indice dell’albero generalizzato di ricerca, Generalized Search Tree) per velocizzare le ricerche spaziali
di dati (le informazioni su GIST fanno riferimento alla documentazione di PostGIS disponibile all’indirizzo
http://postgis.refractions.net).

La sintassi per la creazione di un indice GiST è:

CREATE INDEX [indexname] ON [tablename]
USING GIST ( [geometryfield] GIST_GEOMETRY_OPS );

Si noti che per tabelle molto grandi, la creazione dell’indice può richiedere parecchio tempo. Non appena l’indice
è stato creato, bisognerebbe effettuare un VACUUM ANALYZE. Si veda la documentazione di PostGIS (POSTGIS-
PROJECT Literature and Web References) per ulteriori informazioni.

Segue un esempio di come creare un indice GiST:

gsherman@madison:~/current$ psql gis_data
Welcome to psql 8.3.0, the PostgreSQL interactive terminal.

Type: \copyright for distribution terms
\h for help with SQL commands
\? for help with psql commands
\g or terminate with semicolon to execute query
\q to quit

gis_data=# CREATE INDEX sidx_alaska_lakes ON alaska_lakes
gis_data-# USING GIST (the_geom GIST_GEOMETRY_OPS);
CREATE INDEX
gis_data=# VACUUM ANALYZE alaska_lakes;
VACUUM
gis_data=# \q
gsherman@madison:~/current$

11.1.6 Layer vettoriali a cavallo dei 180° di longitudine

Molti software GIS non gestiscono appropriatamente le mappe vettoriali, con sistema di riferimento geografico
(lat/lon), a cavallo della linea di longitudine 180 degrees (http://postgis.refractions.net/documentation/manual-
1.4/ST_Shift_Longitude.html). Se si apre una di tali mappe in QGIS vedremmo distanti aree geografiche che
sono in realtà vicine tra di loro.Nella figura Figure_vector_4 il piccolo punto all’estrema sinistra della vista mappa
(Chatham Islands) dovrebbe essere all’interno della griglia subito alla destra dell’isola principale della Nuova
Zelanda.

Come soluzione è possibile trasformare i valori di longitudine utilizzando PostGIS e la funzione
ST_Shift_Longitude. La funzione legge ogni punto/vertice di ogni elemento in una geometria e se la coordi-
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Figura 11.4: Map in lat/lon crossing the 180° longitude line

nata di longitudine è < 0° , gli aggiunge 360° . Il risultato sarà una versione 0° - 360° dei dati, che verranno poi
tracciati su una mappa centrata a 180° .

Figura 11.5: Crossing 180° longitude applying the ST_Shift_Longitude function

Guida all’uso

• Importare i dati in PostGIS (Importare dati in PostgreSQL) utilizzando per esempio SPIT

• Utilizzare l’interfaccia da linea di comando di PostGIS per dare il seguente comando (nell’esempio
-“TABLE” è il nome della tabella PostGIS)

gis_data=# update TABLE set the_geom=ST_Shift_Longitude(the_geom);

• Se il comando ha esito positivo, si riceverà una notifica di conferma circa il numero di elementi aggiornati
e sarà possibile caricare i dati e vedere le differenze (figura Figure_vector_5)

11.1.7 Layer SpatiaLite

Per caricare dei dati da un database SpatiaLite cliccare sullo strumento Aggiungi un layer SpatiaLite o selezionare

l’opzione Aggiungi un layer SpatiaLite... dal menu Layer oppure digitare Ctrl+Shift+L. Si aprirà una
finestra di dialogo che permette di accedere ai dati di un database SpatiaLite già connesso a QGIS oppure
di definire la connessione ad un nuovo database: per connettersi ad un nuovo database cliccare su [Nuovo] e
selezionare il database SpatiaLite, un file con l’estensione .sqlite.

Per salvare, invece, un layer vettoriale in formato SpatialLite, cliccare con il tasto destro del mouse sul layer
nella legenda e selezionare l’opzione Salva con nome..., definire il nome del file in uscita, selezionare SQLite con
formato e il SR, aggiungere SPATIALITE=YES nel riquadro Sorgente dati delle opzioni di creazione OGR. Si
veda inoltre http://www.gdal.org/ogr/drv_sqlite.html.

QGIS supporta anche viste modificabili in SpatiaLite.
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Creare un nuovo layer SpatiaLite

Per creare un nuovo layer SpatiaLite, riferirsi alla sezione Creare un nuovo layer SpatiaLite.

Suggerimento: SpatiaLite data management plugin
Per la gestione dei dati SpatiaLite è inoltre possibile usare diversi plugin Python: SpatiaLite Manager o DB
Manager. Questi possono essere scaricati e installati grazie al menu Recupero plugin Python.

11.1.8 Layer Spatial MSSQL

QGIS fornisce un supporto nativo per MS SQL 2008. Il pulsante Aggiungi un vettore MSSQL fa parte della
nuova barra degli strumenti ed è anche disponibile nel menu di QBrowser, nel quale è possibile importare i dati
semplicemente trascinandoli.

11.2 Proprietà dei layer vettoriali

La finestra di dialogi Proprietà layer fornisce informazioni sul layer, sulla sua rappresentazione grafica (stile) e
sulle opzioni di visualizzazione delle etichette. Inoltre, se il layer vettoriale è stato caricato da un archivio dati
PostgreSQL/PostGIS, è possibile modificare l’espressione SQL che lo ha generato tramite la finestra di dialo-
go Costruttore di interrogazioni nella scheda Generale. Per accedere alla finestra di dialogo Proprietà layer,
fare doppio click sul layer nella legenda o click con il tasto destro sul layer e selezionare Proprietà dal menu
contestuale.

Figura 11.6: Vector Layer Properties Dialog

11.2.1 Scheda Stile

A partire dalla versione 1.4.0 QGIS utilizza una nuova simbologia per migliorare e in prospettiva sostituire
la vecchia simbologia. QGIS 1.8 utilizza in modalità predefinita la nuova simbologia: questa fornisce diversi
miglioramenti e nuove funzionalità.
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Una descrizione della vecchia simbologia è disponibile nella Sezione Vecchia simbologia.

La nuova simbologia utilizza tre tipi di simboli: indicatore (per i punti), linea (per le linee) e riempimento (per i
poligoni). I simboli possono consistere di uno o più layer simbolo. È possibile impostare il colore di un simbolo e
tale colore sarà poi assegnato a tutti i layer simbolo. Alcuni layer possono avere il colore non modificabile; ciò è
utile quando si imposta il colore per un simbolo multi-layer. Allo stesso modo, è possibile impostare lo spessore
per i simboli linea e la dimensione e la rotazione dei simboli indicatore.

Tipi di layer simbolo

• Layer di punti

– Indicatore carattere: visualizzazione tramite caratteri.

– Indicatore semplice: visualizzazione tramite indicatori hard-coded.

– Indicatore SVG: visualizzazione tramite immagini SVG.

– Ellisse: visualizzatore tramite forme geometriche derivanti dagli attributi.

– Campo vettoriale: visualizzazione tramite campi vettoriali derivanti dagli attributi.

• Layer di linee

– Decorazione linea: aggiunge una decorazione alla linea (es. una freccia per indicare la direzione).

– Linea di evidenziazione: una linea visualizzata tramite la ripetizione di simboli indicatore.

– Linea semplice: visualizzazione tipica con spessore, colore e stile del tratto.

• Layer di poligoni

– Riempimento con centroide: visualizza un indicatore semplice sul centroide.

– Riempimento SVG: campisce un poligono con un simbolo SVG.

– Riempimento semplice: campitura tipica con colore, stile e bordo.

– Riempimento a pattern lineare: riempie un poligono con un pattern lineare.

– Riempimento a pattern puntuale: riempie un poligono con un pattern di punti.

– Cornice: Decorazione linea: aggiunge una decorazione alle linee (es. una freccia per indicare la
direzione).

– Cornice: Linea di evidenziazione: usa un indicatore hard-coded come bordo di un’area.

– Cornice: Linea semplice: definisce spessore, colore e stile del tratto per il bordo di un’area.

Scala di colori

Le scale di colori servono a definire il range di colori usati dai visualizzatori. Il colore del simbolo sarà definito in
funzione della scala di colori.

Ci sono tre tipi di scale di colori:

• Gradiente: gradiente lineare.

• Casuale: generazione casuale di colori da un’area specifica dello spazio dei colori.

• ColorBrewer: utilizza uno schema di colori ed un numero definito di classi di colore.

Le scale di colori possono essere create nella scheda Scala di colori dalla finestra di dialogo Gestore stile cliccando
su [Aggiungi] (vedi sezione vector_style_manager ).

Stili

Uno stile raggruppa un insieme di vari simboli e scale di colori. È possibile definire dei simboli personalizzati
ed utilizzarli senza doverli ricreare ogni volta. Gli elementi (simboli e scale di colori) di uno stile hanno sem-
pre associato un nome che ne facilita la ricerca e la gestione. In QGIS è presente almeno uno stile predefinito
(modificabile) e l’utente può crearne dei nuovi. Nella parte bassa della scheda Stile ci sono quattro pulsanti che
permettono di gestire gli stili: usare [Ripristina stile predefinito] per tornare alle impostazioni di default, [Salva
come predefinito] per salvare i propri stili, [Caricamento stile...] per caricare gli stili personali e [Salva stile] per
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salvare gli stili creati. Gli stili possono essere trasferiti anche da un layer all’altro. Attivare un layer e selezionare

Layer → Copia stile. Selezionare un altro layer e scegliere Layer → Incolla stile.

Visualizzatori

Un visualizzatore è responsabile della rappresentazione di un elemento con un simbolo. Ci sono quattro tipi di
visualizzatori: simbolo singolo, categorizzato (colore unico nelle vecchia simbologia), graduato e tramite regole.
Non è presente un visualizzatore di colore continuo in quanto esso è semplicemente un caso speciale del visual-
izzatore graduato. I visualizzatori categorizzato e graduato sono definiti specificando un simbolo ed una scala di
colori. Lavorare con la simbologia di nuova generazione

Nella scheda Stile è posibile selezionare uno dei quattro visualizzatori: simbolo singolo, categorizzato, graduato e
tramite regole. Per ogni categoria di dato (punto, linea e poligono) sono disponibili i diversi tipi di layer simbolo
(vedi vector_symbol_types). In funzione del visualizzatore scelto, scegliendo la scheda Stile, vengono mostrate le
impostazioni e le opzioni differenti, di seguito descritte. Attraverso il pulsante [Gestore di stili] la simbologia di
nuova generazione permette di accedere al Gestore stil con il quale è possibile modificare, rimuovere e aggiungere
altra simbologia.

Suggerimento: Selezionare e cambiare simboli multipli
La simbologia di nuova generazione permette di selezionare simboli multipli e cambiarne il colore, la trasparenza,
la dimensione e lo spessore.

Visualizzatore Simbolo singolo

Il visualizzatore Simbolo singolo rappresenta tutti gli elementi di un layer tramite un unico simbolo definito
dall’utente. Le diverse opzioni della scheda Stile variano in funzione tipo di layer, ma tutti i tipi condividono
la seguente struttura. Nella parte in alto a sinistra della scheda è presente un’anteprima del simbolo. Nella parte
inferiore è presente una lista di simboli già definiti per lo stile in uso. Il simbolo può essere modificato cliccando
su [Cambia] sotto l’anteprima, che apre la finestra di dialogo Proprietà simbolo, oppure cliccando su [Cambia]
a destra dell’anteprima, che apre la finestra di dialogo Colore.

Figura 11.7: Single symbol line properties

Nella scheda Stile è possibile impostare la trasparenza e le unità (millimetri o unità di mappa) per la dimensione
della scala; è inoltre possibile utilizzare una dimensione della scala in funzione dei dati e la rotazione (pulsante
[Avanzato] vicino a [Salva con stile]). Il pulsante Livelli simbolo → permette di abilitare e definire l’ordine in
cui i layer di simboli sono visualizzati (se i simboli consistono di più di un layer).

Fatte tutte le modifiche di interesse, il simbolo può essere aggiunto alla lista degli Stili salvati (tramite il pulsante
[Salva come stile]) e riutilizzato successivamente. Inoltre si può usare il pulsante [Salva come stile] per salvare
il simbolo come un file di stile di QGIS (.qml) oppure come un file SLD (.sld). Con l’attuale versione 1.8 di QGIS
i file SLD possono essere esportati per ogni tipo di visualizzatore: simbolo singolo, categorizzato, graduato o
tramite regole. Tuttavia, quando i file SLD vengono importati, viene creata sia un visualizzatore simbolo singolo
che tramite regole. Questo significa che gli stili categorizzato e graduato vengono convertiti nello stile tramite
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regole. Se si vogliono mantenere quei tipi di visualizzatori, è necessario passare al formato QML. A volte risulta
essere molto comoda la possibilità di convertire cosi facilmente questi stili nello stile tramite regole.

Visualizzatore Categorizzato

Il visualizzatore Categorizzato rappresenta tutti gli elementi di un layer tramite un unico simbolo definito
dall’utente, con i colori che riflettono il valore di un attributo specifico. La scheda Stile permette di selezionare:

• L’attributo (Colonna)

• Il simbolo (Simbolo)

• Il colore (Scala di colori)

Con il pulsante [Avanzato] in basso a destra, è possibile impostare il campo di rotazione e il campo di dimensione
della scala. Per comodità, la lista nella parte inferiore della scheda elenca i valori di tutti gli attributi, inclusi i
siboli con i quali verranno visualizzati.

L’esempio in figura figure_symbology_2 mostra la finestra di dialogo per la visualizzazione categorizzata del layer
rivers dei dati campione di QGIS.

Figura 11.8: Categorized Symbolizing options

È possibile creare una scala di colori personalizzata selezionando Nuova scala di colori dal menu a discesa Scala
di colori. Si aprirà la finestra di dialogo ’Tipo di scala di colori’, con le opzioni: Gradiente, Casuale, ColorBrewer.
Una volta selezionato il tipo, la finestra successiva permette di impostare le varie opzioni della scala di colori. Si
veda figure_symbology_3_per un esempio di una scala di colori personalizzata.

Figura 11.9: Example of custom gradient color ramp with multiple stops

Visualizzatore Graduato
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Il visualizzatore Graduato rappresenta tutti gli elementi di un layer tramite un unico simbolo definito dall’utente,
con i colori che riflettono la classificazione di un attributo di interesse.

Figura 11.10: Graduated Symbolizing options

Come il Visualizzatore Simbolo categorizzato, permette di impostare la rotazione e la dimensione della scala in
base a campi specifici.

La scheda Stile permette di selezionare:

• L’attributo (Colonna)

• Il simbolo (Simbolo)

• I colori (Scala di colori)

Inoltre, è possibile specificare il numero di classi (Classi) ed il tipo di classificazione (Modo). Sono disponibilii
seguenti tipi di classificazione:

• Intervalli uguali

• Quantile

• Natural Breaks (Jenks)

• Deviazione standard

• Pretty Breaks

Il box nella parte inferiore della scheda Stile elenca le classi con i vari range, le etichette ed i simboli con cui
verranno rappresentate.

L’esempio in figura figure_symbology_4 mostra la finestra di dialogo per la visualizzazione categorizzata del layer
rivers deidati campione di QGIS.

Visualizzatore Tramite regole

Il visualizzatore Tramite regole rappresenta tutti gli elementi di un layer tramite simboli basati su regole, con
i colori che riflettono la classificazione di un attributo di interesse. Le regole si basano su istruzioni SQL, che
possono essere create con il Query Builder. È possibile creare raggruppamenti per regole in base ad un filtro o in
funzione della scala ed è possibile definire il comportamento con ’Enable symbol levels’ oppure con ’Use only
first matched’.

L’esempio in figura figure_symbology_5 mostra la finestra di dialogo per la visualizzazione tramite regole del
layer rivers dei dati campione di QGIS.
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Per creare una regola, premere ‘+’ per attivare una riga esistente, cliccare su nuova regola e premere il pulsante

[Modifica]. Nella finestra Proprietà delle regole è possibile impostare un’etichetta per la regola. Cliccare
per aprire il Costruttore di stringhe. Nella Lista delle funzioni cliccare su Campi e valori per vedere tutti gli
attributi della tabella degli attributi. Per aggiungere un attributo nella casella Espressioni, fare doppio click
sul rispettivo nome dalla lista Campi e valori. Si possono usare i vari campi, valori e funzioni per costruire
l’espressione desiderata, oppure è possibile scriverla direttamente nella casella (vedi Calcolatore di campi).

Figura 11.11: Rule-based Symbolizing options

Visualizzatore Spostamento punto

Il visualizzatore Spostamento punto permette di visualizzare gli elementi di un layer di punti anche se hanno la
stessa posizione. I simboli vengono posizionati lungo un cerchio di spostamento intorno al centro del simbolo.

Figura 11.12: Point displacement dialog

Proprietà simbolo

La finestra di dialogo Proprietà simbolo permette di impostare varie proprietà di un simbolo. Nella parte in
basso a sinistra della finestra è disponibile un’anteprima del simbolo, così come apparirà nella vista mappa; sopra
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l’anteprima c’è la lista dei Layer simbolo. Per accedere alla finestra di dialogo Proprietà simbolo, cliccare su [
Cambia...] nella scheda Stile della finestra di dialogo Proprietà layer.

È possibile aggiungere e rimuovere layer simbolo, cambiare al posizione dei layer oppure bloccare i layer ai
cambiamenti di colore. Nella parte destra della finestra di dialogo è possibile gestire le impostazioni di un layer

simbolo selezionato nella lista Layer simbolo. L’impostazione più importante è Tipo layer del simbolo
che permette di scegliere il tipo di layer. Le opzioni dipendono dal tipo di vettore (Punti, Linee, Poligoni). Le
opzioni del tipo layer del simbolo sono descritte nella sezione vector_symbol_types. E’ possible cambiare le
proprietà del layer del layer nella parte destra della finestra. Per esempio se è stato scelto un simbolo SVG per un
layer di punti è possibile cambiarne il colore usando il pulsante Color.

Figura 11.13: Line composed from three simple lines

11.2.2 Gestore stile

Il Gestore stile è una piccola applicazione di supporto alla gestione degli stili e delle loro componenti (simboli e
scale di colori). Il gestore elenca i simboli e le scale di colori di uno stile e permette di modificarli, rimuoverli o
aggiungerne di nuovi. Per aprire il Gestore stile cliccare su Impostazioni → Gestore di stili nel menu principale
oppure è possibile accedervi tramite la scheda Stile.

Figura 11.14: Style Manager to manage symbols and color ramps
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11.2.3 Vecchia simbologia

Nota: QGIS 1.8 supporta ancora la vecchia simbologia, sebbene sia raccomandato l’uso della simbologia di
nuova generazione descritta in vector_new_symbology, la vecchia simbologia sarà rimossa a partire dal prossimo
rilascio di QGIS.

Per utilizzare la vecchia simbologia cliccare su [Vecchia simbologia] nella scheda Stile della finestra di dialogo
Proprietà layer.

E’ possibile usare la vecchia simbologia in modalità predefinita disattivando Utilizza la nuova generazione di
simboli per la visualizzazione nella scheda Visualizzaione in Impostazioni Opzioni.

La vecchia simbologia di QGIS mette a disposizione i seguenti visualizzatori:

• Simbolo singolo - lo stesso stile è applicato a tutti gli elementi del vettore.

• Simbolo graduato - lo stile applicato ai diversi elementi dipende dal valore di un campo particolare della
tabella associata.

• Colore continuo - gli elementi del layer sono mostrati con una gradazione di colori compresa entro due
estremi specificati in base ai valori numerici di uno specifico campo.

• Valore univoco - gli oggetti sono classificati in base ai valori unici di un campo della tabella associata, ad
ogni valore viene assegnata una simbologia differente.

Per modificare la simbologia di un layer, fare semplicemente doppio click sulla relativa voce di legenda per fare
apparire la finestra di dialogo Proprietà layer.

Opzioni per lo stile

In questa finestra di dialogo è possibile scegliere lo stile di rappresentazione del layer vettoriale. Secondo l’opzione
di visualizzazione scelta tra quelle descritte precedentemente si ha la possibilità di classificare anche gli elementi
della mappa.

Le seguenti opzioni dovrebbero essere disponibili per pressoché tutte le simbologie:

• Fill style - Style for filling. Beside the given brushes you can select Fill style: ‘Texture’ and click

the button for selecting your own texture file. Currently the fileformats *.jpeg, *.xpm, and *.png
are supported.

• Colore di riempimento - colore di riempimento degli elementi.

• Opzioni linea esterna

– Stile bordo - tipo di tratteggio del bordo degli elementi. Si può anche impostare l’opzione Nessuno
per escludere la rappresentazione del contorno.

– Colore bordo - colore del bordo degli elementi.

– Spessore bordo - larghezza della linea di contorno.

Lo stile di layer, una volta impostato, può essere salvato in un file (con estensione *.qml): cliccare sul pulsante
[Salva stile...]. Il pulsante [Caricamento stile...], invece, carica un file si stile precedentemente salvato.

Se si desidera usare sempre un particolare stile quando il layer viene caricato, cliccare su [Salva come predefinito]
per rendere predefinito lo stile impostato. Inoltre, se si effettuano modifiche delle quali non si è soddisfatti, cliccare
su [Ripristina stile predefinito] per ritornare allo stile predefinito precedentemente impostato.

Applicare la trasparenza ad un vettore

QGIS permette di impostare la trasparenza per ogni layer vettoriale tramite la barra Trasparenza

nella scheda Stile. La trasparenza permette la visualizzazione di più òayer vettoriali
sovrapposti.
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11.2.4 Scheda Etichette

Così come per la simbologia, anche per le etichette QGIS 1.8 mette a disposizione due modalità di ges-
tione: di vecchia e di nuova generazione. La scheda Etichette ancora contiene l’etichettatura di vecchia gener-
azione. L’etichettatura di nuova generazione è implementata con una nuova applicazione che sostituirà la vecchia
simbologia nella prossima versione di QGIS.

Si raccomanda di utilizzare l’etichettatura di nuova generazione descritta nella Sezione Nuova etichettatura.

La vecchia scheda Etichette consente di abilitare la visualizzazione delle etichette associate agli elementi del layer
e controlla una serie di opzioni legate al posizionamento, allo stile e ad altre caratteristiche delle etichette. Come
esempio visualizzeremo le etichette dello shapefile lakes del QGIS sample dataset:

1. Caricare lo shapefile alaska.shp e il file GML lakes.gml in QGIS

2. Usare lo zoom su un’area a scelta contenente alcuni laghi

3. Rendere attivo il layer lakes cliccando su di esso nella legenda

4. Aprire la finestra di dialogo Proprietà layer

5. Cliccare sulla scheda Etichette

6. Selezionare la casella di controllo Mostra etichette per abilitarne la visualizzazione

7. Choose the field to label with. We will use Field containing label NAMES

8. Inserire un’etichetta di default per gli elementi del layer lakes che non hanno nome. Questa etichetta verrà
quindi usata ogni volta che QGIS dovrà etichettare un lago al quale non corrisponde nessun valore nel
campo NAMES.

9. Nel caso di etichette molto lunghe, selezionare Multiline labels?: QGIS cercherà di posizionare l’etichet-
ta opportunamente. Una nuova linea corrispone al singolo carattere \n, (non a due caratteri separati, come
il simbolo \ seguita dal carattere n). Per inserire una nuova linea in un campo degli attributi configurare il
widget modifica in modo che sia riconosciuto come testo (non come linea).

10. Cliccare su [Applica].

Adesso sono visualizzate le etichette. Il loro aspetto non è probabilmente gradevole, potrebbero essere troppo
grandi e posizionate male in relazione al simbolo dei laghi.

Clicca allora su [Carattere] e [Colore] per impostare il tipo di carattere e il colore. È possibile anche cambiare
l’angolo e la posizione delle etichette testuali.

Per modificare la posizione del testo rispetto agli elementi:

1. Cambiare la posizione selezionando una delle opzioni disponibili nel gruppo Posizionamento. Nel caso
preso in esame, scegliere l’opzione Destra.

2. la voce Dimensione carattere consente di selezionare tra Punti o Unità mappa.

3. Cliccare su [Applica] per visualizzare i cambiamenti senza chiudere la finestra di dialogo.

Ora l’aspetto sarà migliore, ma le etichette appaiono ancora troppo vicine all’indicatore della loro posizione.
Per sistemare il problema è possibile utilizzare l’opzione Offset: aggiungendo uno spostamento in X pari
a 5 le etichette verranno scostate dall’indicatore della loro posizione e rese più leggibili. Ovviamente più è
grandel’indicatore o il carattere, maggiore sarà lo scostamento da applicare.

Aggiungiamo infine un buffer sulle etichette cliccando sulla voce Contorno. In questo modo verrà aggiunto uno
sfondo attorno alle lettere per farle risaltare maggiormente. Per mettere un buffer alle etichette dei laghi procedere
come di seguito:

1. Abilitare la casella di controllo Contorno etichette.

2. Scegliere una dimensione (spessore) del buffer.
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3. Scegliere un colore per il buffer cliccando sul pulsante [Colore]. È inoltre possibile assegnare una
trasparenza in percentuale al buffer.

4. Cliccare su [Applica] per vedere i cambiamenti.

Modificare eventualmente i cambiamenti fino a quando non si è soddisfatti del risultato, cliccando su [Applica]
dopo ogni modifica.

In genere un buffer di 1 punto fornisce risultati esteticamente gradevoli. Si noti che è anche possibile specificare
la dimensione del buffer in unità della mappa se ciò rende più agevole l’impostazione.

Le rimanenti voci della scheda Etichette consentono di controllare l’aspetto delle etichette usando, se adeguata-
mente preparati, gli attributi del layer. Le voci della scheda Avanzato consentono di settare tutti i parametri
delle etichette facendo riferimento a campi della tabella del layer.

Si noti che la scheda Etichette fornisce un’Anteprima nella quale viene mostrata l’etichetta predefinita.

11.2.5 Nuova etichettatura

La nuova applicazione Etichettatura richiede solo pochi parametri, ma gestisce in maniera intelligente l’etichet-
tatura dei layer vettoriali; supporta, inoltre, i layer trasformati al volo. Questa applicazione sostituirà l’etichettatura
di vecchia generazione di QGIS, descritta nella sezione Scheda Etichette e supporta anche le riproiezioni al volo
dei layer.

Utilizzare la nuova etichettatura

1. Avviare QGIS e caricare un vettore.

2. Attivare il layer nella legenda e cliccare sull’icona Etichettatura nel menu degli strumenti di QGIS.

Etichettare layer di punti

Come prima cosa selezionare la casella di controllo Etichetta questo layer e scegliere un campo della tabella

degli attributi da usare per l’etichettatura.Cliccare se si desidera che le etichette si basino su espressioni. Nel-
la scheda Avanzato è possibile definire lo stile del testo e la visibilità in funzione della scala:(vedi Figure_labels_1
). Scegliere la scheda Avanzato per impostare il posizionamento e la priorità delle etichette. E’ anche possibile
scegliere se etichettare ogni parte delle geometrie multi-parte oppure se limitare l’etichettatura in funzione della
grandezza dell’elemento. La scheda Impostazioni definite dai dati permette di definire le etichette in base agli
attributi del layer stesso.

Figura 11.15: Smart labeling of vector point layers

Etichettare layer di linee

Come prima cosa selezionare la casella di controllo Etichetta questo layer e scegliere un campo della tabella
degli attributi da usare per l’etichettatura. Anche in questo caso è possibile scegliere se le etichette si devono
basare su espressioni. Ulteriori opzioni sono disponibili nella scheda Avanzato (vedi Figure_labels_2 ).
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Figura 11.16: Smart labeling of vector line layers

Etichettare layer di poligoni

Come prima cosa selezionare la casella di controllo Etichetta questo layer e scegliere un campo della tabella
degli attributi da usare per l’etichettatura. In seguito è possibile definire il posizionamento dell’etichetta, la dis-
tanza, lo stile del testo, la priorità, la visibilità in funzione della scala, se etichettare ogni parte delle geometrie
multi-parte, e se gli elementi devono comportarsi come ostacoli per le etichette (Figure_labels_3 ).

Figura 11.17: Smart labeling of vector polygon layers

Posizionamento etichette

Cliccando sul pulsante [Impostazioni] nella scheda Avanzato è possibile selezionare la modalità di ricerca per il
posizionamento ottimale delle etichette. Le modalità disponibili sono: Catena, Popmusic tabu, Catena popmusic,
Catena tabu popmusic e FALP.

Figura 11.18: Dialog to change label engine settings

Nella finestra di dialogo è possibile definire il numero di candidati, se mostrare tutte le etichette (incluse quelle
che collidono) e se mostrare le etichette possibili (per debugging).
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Parole chiave in campi attributo per l’etichettatura

È possibile usare alcune parole chiave in campi attributo dedicati per il posizionamento delle etichette.

• Per l’allineamento orizzontale: left, center, right

• Per l’allineamento verticale: bottom, base, half, top

• Colori specificati in motazione SVG, e.g. #ff0000

• Per bold, underlined, strikeout e italic: 0 = false 1 = true

Combinazioni tipo base right oppure bottom left è possibile che funzionino.

11.2.6 Scheda Campi

Con la scheda Campi è possibile gestire gli attributi di un layer. I pulsanti Nuova colonna e Elimina colonna

possono essere usati se il layer è in modalità Modifica.

Allo stato attuale possono essere aggiunte/rimosse solo colonne di layer PostGIS. La libreria OGR supporta
l’aggiunta di nuove colonne e la rimozione, se si ha installata la versione 1.9 o superiore di GDAL.

Widget modifica

Figura 11.19: Dialog to select an edit widget for an attribute column

Nella scheda Campi è presente una colonna widget modifica: questa può essere usata per definire valori o
intervalli di valori permessi per gli attributi. Cliccando su [Modifica valore] si apre una finestra di dialogo dove è
possibile definire diversi widget:

• Modifica valore: widget predefinito. Supporta testo semplice o numeri per attributi numerici.

• Classificazione: visualizza una combo-box contenente i valori utilizzati per la classificazione, qualora il
tipo di legenda (nella scheda Stile) sia stato impostato su ‘valore unico’.

• Intervallo: permette di definire un numero di valori per un intervallo specifico. Il widget di modifica può
utilizzare un cursore o una casella di selezione.

• Valori unici: l’utente può selezionare uno dei valori già utilizzati negli attributi. Se editabile, una linea
modificata ha la possibilità di autocompletamento; in caso contrario viene presentata una combo box.

• Nome file: semplifica la selezione di file attraverso una finestra di dialogo di scelta.
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• Mappa valori: combo-box con oggetti predefiniti. Il valore è archiviato negli attributi, la descrizione
presentata nel combo-box. I valori possono essere definiti manualmente o caricati da un layer o da un file
csv.

• Enumerazione: apre una combo-box con i valori che possono essere utilizzati. È supportato solo dal
provider postgres.

• Immutabile: l’attributo è di sola lettura, non può essere modificato.

• Nascosto: l’attributo è invisibile all’utente.

• Checkbox: mostra una casella di controllo e si può definire quale attributo è aggiunto alla colonna quando
la casella è attivata.

• Modifica testo: apre un campo di modifica di testo che permette di usare linee multiple.

• Calendario: apre un widget calendario per inserire una data. La colonna deve essere di tipo testuale.

• Relazione valore: offre i valori di una tabella in una combobox. Si possono selezionare layer, colonna
chiave e colonna valore.

• Generatore UUID: genera un campo UUID (Universally Unique Idetifiers) di sola lettura, se il campo è
vuoto.

11.2.7 Scheda Generale

The Generale è sostanzialmente simile a quella dei raster. Ci sono diverse opzioni disponibili:

• Cambiare il nome di visualizzazione del layer

• Selezionare un campo di visualizzazione che dovrà essere usato dalla finestra Informazioni elementi

• Definire una precisa Interfaccia di modifica utente per il layer vettoriale scritta con lo strumento Qt Creator
IDE (http://qt.digia.com/Product/Developer-Tools/)

• Creare un indice spaziale (solo per formati supportati da OGR)

• Aggiungere un Init function per il layer. Questi sovrascriveranno i widget di inizializzazione di QGIS se
presenti

• Aggiorna estensione del layer

• Vedere o cambiare la proiezione del layer vettoriale, cliccando su Specifica SR

Inoltre si può attivare la casella Visualizza in funzione della scala, impostare opzioni di codifica e con il
pulsante [Costruttore interrogazioni] si può creare un sottoinsieme di caratteristiche che si vogliono visualizzare
(si veda la sezione Selezione).

11.2.8 Scheda Metadati

The Metadata tab contains general information about the layer, including specifics about the type and lo-
cation, number of features, feature type, and the editing capabilities. The Extents section, providing layer extent
information, and the Layer Spatial Reference System section, providing information about the CRS of the layer.
This is a quick way to get information about the layer.

In aggiunta si possono aggiungere o modificare titoli per il layer e per altre informazioni. Queste informazioni
verranno salvate nel file di progetto di QGIS per sessioni future e saranno utilizzate da QGIS server.
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Figura 11.20: General tab in vector layers properties dialog

Figura 11.21: Metadata tab in vector layers properties dialog
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11.2.9 Scheda Azioni

QGIS offre la possibilità di effettuare azioni sulla base degli attributi associati ai singoli elementi del layer
vettoriale. Questo permette di effettuare un elevato numero di azioni, per esempio, lanciare un programma con
argomenti costruiti tramite gli attributi delle geometrie o passando i parametri ad uno strumento di web reporting.

Figura 11.22: Overview action dialog with some sample actions

Definire delle azioni è utile quando si intende lanciare un’applicazione esterna o la visualizzazione di una pagina
web sulla base di uno o più valori associati al layer vettoriale. Ci sono 6 tipologie di azioni che possono essere
usate nel seguente modo:

• Le azioni Generic, Mac, Windows e Unix fanno partire un processo esterno,

• Le azioni Python eseguno un espressione python,

• Le azioni Generic e Python sono visibili ovuntue,

• Le azioni Mac, Windows e Unix sono visibili sono sulle rispettive piattaforme (cioè è possibile definire tre
azioni, ma l’utente vedrà i risultati solamente sulla piattaforma dalla quale è stato lanciato l’editor).

Ci sono diversi esempi inclusi nel dialogo ed è possibile caricarli cliccando su [Aggiungi azioni predefinite]. Un
esempio è eseguire una ricerca basata su un valore degli attributi. Questo concetto è spiegato nella discussione
seguente.

Definire le azioni

Le azioni legate agli attributi sono definite dalla finestra di dialogo Proprietà layer. Per impostare un’azione,
aprire la finestra di dialogo Proprietà layer e cliccare sulla scheda Azioni. Selezionare ‘Generico’ come tipo e
fornire un nome descrittivo dell’azione. L’azione in sé deve contenere il nome o il percorso di una applicazione
che verrà eseguita quando l’azione viene richiamata. L’azione può venire fatta dipendere da uno o più campi della
tabella attributi. Quando essa è richiamata ogni stringa testuale che inizia con % seguita dal nome di un campo
della tabella attributi verrà rimpiazzata dal valore di quel campo. I caratteri speciali %% saranno rimpiazzati
dal valore del campo nell’elemento selezionato con lo strumento Informazioni elementi disponibile nella barra
strumenti o dalla tabella attributi (vedi il paragrafo using_actions below).Le virgolette (”) possono essere usate
per raggruppare il testo in un singolo argomento da passare al programma, allo scripto al comando che si intende
eseguire. Le virgolette saranno ignorate se precedute dalla barra inversa.
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Se sono presenti nomi di campi che possono essere interpretati come sotto-stringhe di altri nomi di campi (ad es.
col1 e col10) è necessario racchiudere il nome (e il carattere %) tra parentesi quadre (ad es. [%col10]).
Ciò impedirà che il nome di campo %col10 possa essere confuso con %col1 con uno 0 alla fine. Le virgolette
saranno rimosse da QGIS man mano che vengono inseriti i valori del campo al posto dell’espressione. Se si vuole
che i campi sostituiti vengano racchiusi entro parentesi quadre, aggiungere una seconda coppia di parentesi quadre
in questo modo: [[%col10]].

La finestra di dialogo Informazione sui risultati che compare quando si usa lo strumento Informazioni elementi ha
una voce (Derivato) che contiene informazioni dipendenti dal tipo di layer interrogato. Si può accedere ai valori di
questa voce similmente a come si accede ai valori di campo della tabella attributi anteponendo al nome di campo
disponibile alla voce (Derivato) l’espressione (Derivato). Per esempio un layer puntuale ha due sotto-voci X e
Y e il valore di essi può essere usato nell’azione con l’espressione %(Derivato).X e %(Derivato).Y. Gli
attributi derivati sono disponibili solo nella finestra Informazione sui risultati e non dalla finestra Tabella degli
attributi.

Due esempi di azioni sono di seguito indicati:

• konqueror http://www.google.com/search?q=%nam

• konqueror http://www.google.com/search?q=%%

Nel primo esempio, il browser konqueror viene richiamato con un URL da aprire. L’URL crea una ricerca
Google sul valore del campo nam nel layer vettoriale. Si noti che il programma o lo script richiamato dal-
l’azione deve essere nel path impostato come variabile d’ambiente oppure bisogna fornire il percorso completo
all’eseguibile. Per sicurezza, è possibile riscrivere il primo esempio come: /opt/kde3/bin/konqueror
http://www.google.com/search?q=%nam. In questo modo si è sicuri che l’applicazione konqueror
sarà eseguita quando si richiama l’azione.

Nel secondo esempio viene usata la notazione %% che non richiede l’indicazione di un particolare campo. Quando
si richiama l’azione, il %% sarà rimpiazzato dal valore selezionato con lo strumento Informazioni elementi o nella
tabella degli attributi. Uso delle azioni

Le azioni possono essere richiamate sia dalla finestra Informazioni sui risultati che da quella della Tabella degli

attributi. (Si ricorda che queste finestre possono essere aperte rispettivamente cliccando sullo strumento
Informazioni elementi Apri tabella degli attributi o Avvia azione sull’elemento). Per eseguire l’azione, fare click con il tasto
destro del mouse sul record e scegliere azione dal menu contestuale. Le azioni sono indicate nel menu a contestuale
dal nome assegnatogli in fase di definizione dell’azione. Cliccare sull’azione che si vuole eseguire.

Se si vuole eseguire un’azione che usa la notazione %%, cliccare con il tasto destro del mouse sul valore di
campo che si desidera passare all’azione nella finestra di dialogo Informazioni sui risultati o in quella Tabella
degli attributi.

In questo altro esempio viene illustrato come estrarre dati da un layer vettoriale per inserirli in un file usando la

shell di sistema bash e il comando echo (dunque funzionerà solo su e forse su ). Il layer in questione ha i
seguenti campi nella tabella attributi: nome della specie taxon_name, latitudine lat e longitudine long. Si
vuole eseguire una selezione spaziale delle specie (taxon) presenti in determinate posizioni esportando i risultati
in un file di testo per le posizioni selezionate (evidenziate in giallo nella vista mappa di QGIS). L’azione in grado
di assolvere lo scopo è la seguente:

bash -c "echo \"%taxon_name %lat %long\" >> /tmp/species_localities.txt"

Selezionando alcune posizioni, l’esecuzione dell’azione precedente su ognuna di esse genera un file in uscita che
avrà l’aspetto seguente:

Acacia mearnsii -34.0800000000 150.0800000000
Acacia mearnsii -34.9000000000 150.1200000000
Acacia mearnsii -35.2200000000 149.9300000000
Acacia mearnsii -32.2700000000 150.4100000000

Come esercizio si può creare un’azione che generi una ricerca su Google sul layer lakes. Innanzitutto è nec-
essario determinare la sintassi da impiegare nell’URL per eseguire una ricerca basata su una parola chiave. L’e-
spressione si ricava facilmente eseguendo una ricerca dalla pagina di Google, la pagina dei risultati avrà un indi-
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rizzo, visibile nella barra indirizzi del browser, del tipo: http://google.com/search?q=qgis, in cui QGIS è la parola
ricercata. Forniti di questa informazione, si può procedere nel seguente modo:

1. Assicurarsi che il layer lakes sia caricato.

2. Aprire la finestra di dialogo Proprietà layer facendo doppio click sul layer o cliccando su di esso nella
legenda con il tasto destro del mouse e scegliendo Proprietà dal menu contestuale.

3. Cliccare sulla scheda Azioni.

4. Inserire un nome descrittivo per l’azione, ad esempio Google.

5. Fornire il nome di un programma esterno da eseguire nell’azione. In questo caso useremo il browser Firefox.
Se il programma non si trova in uno dei percorsi di sistema definiti dalla variabile d’ambiente PATH, bisogna
specificare il percorso completo all’eseguibile.

6. Far seguire il nome del programma esterno dall’URL usato per la ricerca su Google senza includere la parola
ricercata, ovvero: http://google.com/search?q=

7. A questo punto il testo nel campo Azioni dovrebbe apparire così: firefox
http://google.com/search?q=

8. Cliccare sul menu a tendina contenente i nomi dei campi della tabella associata al layer lakes, posizionato
immediatamente a sinistra del pulsante [Inserisci campo].

9. Dall’elenco apparso scegliere Cattura dell’output select ‘NAMES’ e cliccare su [Insert Field].

10. A questo punto il testo nel campo Azioni dovrebbe apparire così: ‘‘firefox
http://google.com/search?q=%NAMES‘

11. Per completare l’azione cliccare sul pulsante [Inserisci l’azione].

Questo completa la definizione dell’azione che è così pronta per essere usata. La formulazione finale dell’azione
dovrebbe apparire così:

firefox http://google.com/search?q=%NAMES

A questo punto l’azione è pronta per essere usata. Chiudere la finestra Proprietà layer e usare lo zoom su un’area
a scelta. Assicurarsi che il layer lakes sia attivo ed identificare con l’apposito strumento un lago. Nella finestra
risultante dovrebbe essere visibile l’azione:

Figura 11.23: Select feature and choose action

Cliccando sull’azione, viene lanciato Firefox all’URL http://www.google.com/search?q=Tustumena. È anche
possibile aggiungere ulteriori campi all’azione, inserendo un + alla fine della stringa che definisce l’azione,
selezionando quindi un altro campo e cliccando sul pulsante [Inserisci campo]. Nell’esempio seguito finora
semplicemente non c’è alcun altro campo sul quale avrebbe senso fare una ricerca.

È possibile definire più di un’azione per ogni layer, ognuna di esse verrà mostrata nella finestra Informazioni sui
risultati.
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Si possono immaginare molti tipi di azione. Ad esempio se un layer di punti rappresenta le posizioni alle quali
sono state scattate foto o alle quali corrispondono immagini e il nome dei file di tali foto o immagini, è possibile
creare un’azione per lanciare un visualizzatore che mostri l’immagine. Le azioni possono essere usate anche per
lanciare report sul web per uno o più campi della tabella attributo, definendole allo stesso modo dell’esempio per
la ricerca con Google.

Si possono fare esempi anche molto più complicati, per esempio su come usare le azioni Python.

Normalmente quando usiamo un’azione per aprire un file con un’applicazione esterna, si può usare un percorso
assoluto o relativo. Nel secondo caso, il percorso è relativo alla posizione del file eseguibile del programma
esterno. Ma cosa succede se è necessario usare un percorso relativo al layer selezionato (basato su un file, come
uno shapefile o spatialite)? Ecco il trucco:

command = "firefox";
imagerelpath = "images_test/test_image.jpg";
layer = qgis.utils.iface.activeLayer();
import os.path;
layerpath = layer.source() if layer.providerType() == ’ogr’ else \
(qgis.core.QgsDataSourceURI(layer.source()).database() \
if layer.providerType() == ’spatialite’ else None);
path = os.path.dirname(str(layerpath));
image = os.path.join(path,imagerelpath);
import subprocess;
subprocess.Popen( [command, image ] );

bisogna ricordare che l’azione è del tipo Python e per il nostro scopo è necessario cambiare le variabili command
e imagerelpath.

Ma come si procede se il percorso relativo deve essere relativo al file di progetto (salvato)? Il codice per l’azione
Python sarà:

command="firefox";
imagerelpath="images/test_image.jpg";
projectpath=qgis.core.QgsProject.instance().fileName();
import os.path; path=os.path.dirname(str(projectpath)) \
if projectpath != ’’ else None;
image=os.path.join(path, imagerelpath);
import subprocess;
subprocess.Popen( [command, image ] );

Un altro esempio di azione Python è quello che permette di aggiungere nuovi layer al progetto. In questo esempio
aggiungeremo sia un file vettoriale che uno raster. Il nome dei file da aggiungere al progetto e il nome da assegnare
ai layer è fornito dai dati (filename e layname sono nomi di colonne della tabella dagli attributi del vettore dove
l’azione è stata creata):

qgis.utils.iface.addVectorLayer(’/yourpath/[% "filename" %].shp’,’[% "layername" %]’, ’ogr’)

Per aggiungere un raster (in questo esempio un’immagine tif), diventa:

qgis.utils.iface.addRasterLayer(’/yourpath/[% "filename" %].tif’,’[% "layername" %]’)

11.2.10 Scheda Join

La scheda Joins permette di effettuare un join tra una tabella di attributi ed un layer vettoriale, indicando
il layer da unire, il campo unione ed il campo di destinazione. Attualmente QGIS permette il join di tabelle nei
formati supportati da OGR, testo delimitato e del provider PostgreSQL (Figura figure_joins_1).

Il dialogo del join vettoriale fornisce le opzioni:

• Layer unito in memoria virtuale

• Crea un indice nel campo unito
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Figura 11.24: Join an attribute table to an existing vector layer

11.2.11 Scheda Diagrammi

La scheda Diagrammi permette di sovrapporre un grafico ad un layer vettoriale (Figura figure_diagrams_1).

L’implementazione corrente dei diagrammi supporta grafici a torta e diagrammi testo e permette di scalare linear-
mente il grafico in funzione di un attributo. Il posizionamento del grafico interagisce con l’etichettatura di nuova
generazione, in questo modo, eventuali confilitti fra diagrammi ed etichette vengono automaticamente risolti.
Inoltre la posizione dei grafici può essere fissata dall’utente.

Figura 11.25: Vector properties dialog with diagram tab

Segue un esempio di creazione di un grafico delle temperature sovrapposto al layer alaska; entrambi i layer sono
disponibili nei dati campione di QGIS (Sezione Dati campione).
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1. Cliccare sull’icona Aggiungi vettore e caricare i due vettori alaska.shp e climate.shp.

2. Doppio clicl sul layer climate nella legenda per aprire la finestra di dialogo Proprietà layer.

3. Cliaccare sulla scheda Diagrammi, attivare Visualizza diagrammi e dalla combobox Tipo di diagramma

selezionare ‘Diagramma testo’

4. Come colore di sfondo scegliere un blu chiaro e scegliere la grandezza fissa di 18 mm.

5. Si può optare per una posizione intorno al punto.

6. Il grafico dovrà mostrare i valori delle tre colonne: T_F_JAN, T_F_JUL e T_F_MEAN. Selezionare
T_F_JAN come attributo e cliccare sul pulsante verde [+], poi selezionare T_F_JUL ed infine T_F_MEAN.

7. Cliccare su {Applica] per visualizzare il diagramma nella finestra principale di QGIS.

8. Ora è possibile adattare la dimensione del grafico oppure cambiare il colore facendo doppio click sul valore
del colore nel campo degli attributi. La figura Figure_diagrams_2 mostra un esempio.

9. Premere [Ok] per concludere l’operazione.

Figura 11.26: Diagram from temperature data overlayed on a map

Inoltre nella finestra Impostazioni → Opzioni è presente la scheda Sovrapposizione dove è possibile se-
lezionare l’algoritmo di posizionamento del diagramma. Il metodo del punto centrale è quello generico, mentra
gli altri algoritmi usando le librerie PAL. Questi considerano gli oggetti dei diagrammi e le etichette in layer
diversi. Per ulteriori informazioni guardare la sezone Plugin Diagramma sovrapposto.

11.3 Modifica

QGIS supporta la modifica di layer vettoriali OGR, PostGIS e Spatialite.

Nota: The procedure for editing GRASS layers is different - see Section Digitalizzare e modificare layer vettoriali
GRASS for details.

Suggerimento: Modifiche concorrenti
Questa versione di QGIS non effettua alcuna verifica sulla possibilità che più utenti stiano effettuando contem-
poraneamente modifiche sullo stesso layer, è quindi l’ultimo utente che effettua il salvataggio ad apportare le
modifiche definitive.
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11.3.1 Settare la tolleranza dello snapping e il raggio di ricerca degli elementi

Prima di editare vertici, è molto importante sia impostare il livello di snapping che il valore del raggio di ricerca
al fine di gestire in maniera ottimale la modifica delle geometrie di un layer vettoriale.

Tolleranza di snapping

La tolleranza di snapping è la distanza entro la quale QGIS cerca il vertice e/o segmento più vicino al quale si
cerca di agganciarsi quando si crea un nuovo vertice o si sposta un vertice esistente. Se non si è entro la tolleranza
di snapping, QGIS lascerà il vertice creato o spostato nella posizione in cui si rilascia il pulsante del mouse invece
di agganciarlo ad un vertice e/o segmento esistente. La tolleranza di snapping influenza tutti gli strumenti che
lavorano con una tolleranza.

1. La tolleranza di snapping può essere impostata a livello dell’intero progetto scegliendo la voce di menu
Impostazioni → Opzioni. Su Mac andare su QIS → Preferenze..., su Linux: Modifica → Opzioni.
Nella scheda Digitalizzazione è possibile impostare la modalità di snap predefinita tra snap al vertice, al
segmento o entrambe. Si può anche definire una tolleranza di snapping e un raggio di ricerca per la modifica
di un vertice, in unità di mappa o in pixel. Impostando i valori in pixel, invece che in unità di mappa, si evita
di dover modificare la tolleranza in seguito ad operazioni di zoom. Nel nostro progetto di digitalizzazione
(con il dataset Alaska), definiamo la tolleranza di snap in metri. I risultati possono variare, ma alla scala
1:10000 il valore di circa 100 metri dovrebbe andare bene.

2. È anche possibile impostare una tolleranza di snapping per singolo layer scegliendo la voce di menu
Impostazioni → (oppure File →) Opzioni si snap... (figura figure_edit_1 ).

Da notare che la tolleranza di snap per un singolo layer sovrascrive la tolleranza globale impostata nella scheda
Digitalizzazione. Se è necessario modificare un layer ed impostare lo snap per i suoi vertici, allora abilitare la
tolleranza di snap solamente sul layer richiesto. Diminuire la tolleranza di snap globale a un livello più basso ed
assicurarsi che sia selezionatala casella di controllo per il layer.

Figura 11.27: Edit snapping options on a layer basis

Raggio di ricerca

Il raggio di ricerca è la distanza che QGIS usa per cercare il vertice più vicino che si sta provando a spostare
quando si clicca nella mappa. Se non si è entro il raggio di ricerca, QGIS non troverà né selezionerà alcun vertice
e mostrerà un avvertimento in una finestra pop-up. La tolleranza di snapping e il raggio di ricerca sono impostati
in unità di mappa o in pixel e potrebbe essere necessario fare diversi tentativi prima di trovare l’impostazione
migliore. Se si specifica una tolleranza troppo alta, QGIS potrebbe agganciare il vertice sbagliato, specialmente se
si ha a che fare con molti vertici vicini all’area in cui si sta effettuando la modifica. Impostando invece un raggio
di ricerca troppo piccolo impedirà a QGIS di trovare alcuna geometria da spostare.

Il raggio di ricerca per la modifica di vertici può essere definito in unità del layer dalla scheda Digitalizzazione
sotto il menu Impostazioni → Opzioni, sotto lo stesso percorso dal quale è possibile impostare la tolleranza di
snapping a livello di progetto.
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11.3.2 Zoom e spostamento

Prima di editare un layer sarebbe opportuno ingrandire la vista mappa su un’area di interesse, al fine di evitare una
lunga attesa per la visualizzazione di tutti i vertici della mappa.

Oltre ad utilizzare le icone Sposta mappa e Ingrandisci / Rimpicciolisci è possibile interagire con la mappa con
la rotellina del mouse, la barra spaziatrice e i tasti freccia della tastiera.

Zoom e spostamento con la rotella del mouse

Per spostarsi nella mappa cliccare sulla rotella del mouse e trascinare, mentre per lo zoom basta ruotare la stes-
sa. Posizionare il cursore nell’area di mappa e ruotare la rotellina verso di sé per ridurre e verso lo schermo per
ingrandire. La posizione del puntatore del mouse determinerà il centro dell’area da ingrandire. È possibile person-
alizzare il comportamento della rotella del mouse nella scheda Strumenti mappa alla voce di menu Impostazioni
→ Opzioni.

Spostamento con i tasti freccia

È possibile spostare la vista mappa anche con i tasti freccia della tastiera. Posizionare il mouse nella vista mappa
e cliccare la freccia destra per spostarsi verso est, la freccia sinistra per spostarsi verso ovest, la freccia in su per
spostarsi verso nord e la freccia in giù per spostarsi verso sud.

È anche possibile tenere premuta la barra spaziatrice mentre si sposta il mouse per spostare la vista mappa e usare i
tasti PgUp e PgDown per aumentare o ridurre l’ingrandimento senza interrompere la sessione di digitalizzazione.

11.3.3 Modifiche topologiche

Oltre alle opzioni di snap a livello di singolo layer, la finestra di dialogo Opzioni di snap... permette di impostare

altre funzionalità topologiche. È possibile selezionare le opzioni Abilita la modifica topologica e/o Evita
inters.: quest’ultima evita l’intersezione di nuovi poligoni.

Abilitare la modifica topologica

L’opzione Abilita la modifica topologica serve a mantenere bordi comuni tra poligoni adiacenti durante l’ed-
itazione. QGIS individua un bordo condiviso in un insieme di poligoni e tutto ciò che si deve fare è spostare il
vertice una volta sola: QGIS si occuperà di aggiornare i bordi di poligoni adiacenti.

Evitare le intersezioni per i nuovi poligoni

L’opzione Evita inters. impedisce l’intersezione di poligoni adiacenti, rendendone più spedita la digitaliz-
zazione. Se si ha già un poligono, è possibile con questa opzione abilitata, digitalizzare un secondo poligono
in modo che entrambi si intersechino; QGIS taglierà automaticamente il secondo lungo il bordo comune, con il
vantaggio che l’utente non deve digitalizzare tutti i vertici coincidenti.

11.3.4 Modifica di un layer esistente

Al fine di evitare modifiche involontarie, i dati sono caricati in QGIS in modalità solo lettura. Comunque, è sempre
possibile modificare un layer se ciò è consentito dallo specifico fornitore di dati e se il dato medesimo è anche
scrivibile (ovvero i file non sono in modalità sola lettura). Le funzioni di modifica di layer sono più versatili
quando sono applicate a dati immagazzinati in database PostgreSQL/PostGIS.
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In QGIS sono presenti due barre strumenti distinte per la modifica dei vettori, una di base e l’altra avan-
zata, quest’ultima descritta nella Sezione Digitalizzazione avanzata. Entrambe le barre possono essere atti-
vate/disattivate sotto Visualizza → Barra degli strumenti →. Gli strumenti di base offrono le seguenti funzionalità:

Icona Azione Icona Azione

Attiva modifica Aggiunge elementi: Inserisci punto

Aggiunge elementi: Inserisci linea Aggiunge elementi: Inserisci poligono

Muove elementi Strumento vertici

Elimina elementi selezionati Taglia elementi

Copia elementi Incolla elementi

Salva modifiche

Strumenti di base per la modifica di layer vettoriali

Ogni sessione di modifica è inizializzata dall’opzione Modifica, che può essere attivata e disattivata nel menù
contestuale che si apre cliccando con il tasto destro del mouse sul nome del layer nella legenda.

In alternativa, è possibile usare il pulsante Modifica Modifica. Quando il layer è in modalità modifica, i vertici
In alternativa, è possibile usare il pulsante sono contrassegnati da indicatori (croci o cerchi semitrasparenti) e altri
strumenti sono attivati nella barra degli strumenti di modifica.

Suggerimento: Salvataggio ad intervalli regolari

Ricordarsi di usare Salva modifiche regolarmente, in modo da consentire il salvataggio delle modifiche recenti e
per verificare che le stesse siano accettate dalla fonte di dati.

Aggiungere elementi

È possibile usare gli strumenti Inserisci punto, Inserisci linea o Inserisci poligono per porre il puntatore di QGIS
in modalità digitalizzazione.

Per ogni elemento, bisogna dapprima digitalizzare la geometria e successivamente inserire gli attributi. Per digi-
talizzare la geometria, cliccare con il tasto sinistro del mouse nella vista mappa per creare il primo punto del nuovo
elemento.

Per linee e poligoni, continuare a cliccare con il tasto sinistro per ogni ulteriore vertice che si desidera inserire.
Quando è terminato l’inserimento dei vertici o dei punti, cliccare con il tasto destro in qualunque punto della
mappa per confermare di aver terminato l’inserimento della geometria dell’elemento.

Apparirà quindi la finestra degli attributi che consentirà di inserire le informazioni per l’elemento appena creato
(figura Figure_edit_2). Nella scheda Digitalizzazione della voce di menu Impostazioni → Opzioni è possibile

attivare/disattivare le due opzioni Non aprire la finestra degli attributi dopo la creazione di ogni geometria
Ripeti i valori degli attributi usati per ultimi.

Per spostare degli elementi utilizzare lo strumento Muovi elemento/i.

Suggerimento: Tipologie di attributo
Relativamente agli shapefile, la modifica del tipo di attributo è validata durante l’inserimento, per cui non è ovvi-
amente possibile inserire un numero in una colonna testuale quando compare la finestra di dialogo Attributi e
viceversa. Qualora si avesse tale necessità, è necessario modificare gli attributi in un secondo momento per mezzo
della finestra di dialogo Tabella degli attributi.
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Figura 11.28: Enter Attribute Values Dialog after digitizing a new vector feature

Strumento vertici

Sia per i layer PostgreSQL/PostGIS che per gli shapefile, lo Strumento vertici fornisce capacità di modifica dei
vertici simili ai programmi CAD. È possibile selezionare più vertici contemporaneamente e spostarli e/o cancellarli
con un’unica operazione. Lo strumento supporta la modifica topologica e lavora anche con la proiezione al volo
attiva; se non trova nessun elemento apre una finestra di avviso che suggerisce di controllare le impostazioni di
snapping.

Pertanto, è importante impostare Impostazioni → Opzioni → Digitalizzazione → Raggio di ricerca:
ad un valore superiore a zero (per esempio 10). Altrimenti QGIS non è in grado di gestire adeguatemente la
modifica dei vertici.

Suggerimento: Indicatori dei vertici
The current version of QGIS supports three kinds of vertex-markers: Semi transparent circle, Cross and None. To
change the marker style, choose Options from the Settings menu and click on the Digitizing tab and select the
appropriate entry.

Operazioni di base

Attivare lo strumento Strumento vertici e selezionare un elemento cliccandoci sopra: un riquadro rosso apparirà su
ogni vertice dell’elemento.

• Selecting vertices: You can select vertices by clicking on them one at a time, by clicking on an edge to
select the vertices at both ends, or by clicking and dragging a rectangle around some vertices. When a
vertex is selected its color changes to blue. To add more vertices to the current selection, hold down the
Ctrl key while clicking. Hold down Ctrl or Shiftwhen clicking to toggle the selection state of vertices
(vertices that are currently unselected will be selected as usual, but also vertices that are already selected
will become unselected).

• Aggiungere vertici: per aggiungere un vertice fare doppio click nei pressi di un bordo. Si noti che il vertice
apparirà sul bordo e non alla posizione del cursore del mouse.

• Eliminare vertici: per eliminare un vertice selezionato basta premere il tasto Delete. Si noti che non è

possibile eliminare un intero elemento tramite lo strumento Strumento vertici; QGIS manterrà un numero
minimo di vertici per il tipo di elemento su cui si sta lavorando. Per eliminare completamente un elemento,

usare lo strumento Elimina il selezionato.
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• Spostare vertici: selezionare i vertici di interesse, quindi cliccare e trascinare nella direzione verso la quale
si intende spostare i vertici; i vertici saranno spostati tutti insieme. Se lo snap è attivo, l’intera selezionare
può essere agganciata al vertice e/o linea più vicina.

Ogni cambiamento operato con lo strumento vertici è memorizzato nel dialogo Annulla. Tutte le operazioni sup-
portano le modifiche topologiche (se attivate) ed è possibile operare con la proiezione a volo attiva. Lo strumento
vertici offre, inoltre, la possibilità di ottenere informazioni su un vertice lasciando semplicemente il cursore del
mouse sul vertice di interesse.

Tagliare, copiare ed incollare elementi

Gli elementi selezionati possono essere tagliati, copiati ed incollati tra layer dello stesso progetto di QGIS a patto

che anche per il layer di destinazione sia stata abilitata la modalità di modifica tramite l’opzione Modifica.

Gli elementi possono essere anche incollati in applicazioni esterne in formato testo: gli elementi verranno rapp-
resentati nel formato CSV con le informazioni della geometria espresse nel formato testo OGC Well Known Text
(WKT).

Le funzioni di copia/incolla sono utili quando si devono modificare più layer copiando le modifiche effettuate
in uno di questi negli altri. Supponendo, ad esempio, di voler lavorare su un layer contenente solo alcuni laghi,
diventa molto più agevole creare un nuovo layer vuoto nel quale incollare gli elementi dei quali necessitiamo
invece di lavorare sul layer big_lakes contenente 5000 elementi.

Dovremo quindi effettuare le seguenti operazioni:

1. Caricare il layer dal quale vogliamo copiare gli elementi (layer sorgente)

2. Caricare o creare il layer nel quale vogliamo incollare gli elementi copiati (layer di destinazione)

3. Impostare entrambi i layer in modalità modifica

4. Rendere attivo il layer sorgente cliccando sul relativo nome nella legenda

5. Attivare lo strumento Seleziona il singolo elemento per selezionare gli elementi dal layer sorgente

6. Cliccare sullo stumento Copia elementi

7. Rendere attivo il layer di destinazione cliccando sul relativo nome nella legenda

8. Attivare lo strumento Incolla elementi

9. Terminare le modifiche e salvare

Se il layer sorgente e quello di destinazione hanno un diverso schema (nomi e tipi dei campi) QGIS popola, se
presenti, i campi comuni e ignora il resto. Se non è importante che vengano copiati anche gli attributi nel layer
di destinazione, si può non prestare attenzione a come viene definito lo schema della tabella attributi, altrimenti è
necessario definirlo in modo che lo schema del layer sorgente e quello del layer di destinazione combacino.

Suggerimento: Congruenza degli elementi incollati
Se il layer sorgente e quello di destinazione usano lo stesso sistema di proiezione, gli elementi incollati saranno
assolutamente identici a quelli del layer di origine. Nel caso in cui invece la proiezione del layer di destinazione
sia differente QGIS non garantisce che la geometria sia identica a causa del pur ridotto errore di arrotondamento
introdotto nel passaggio da un sistema di proiezione all’altro.

Cancellare elementi selezionati

Se si vuole eliminare un intero poligono, è possibile farlo selezionando dapprima l’elemento che intendi-

amo cancellare con lo strumento Seleziona il singolo elemento: è possibile anche selezionare più poligoni con-

temporaneamente. Una volta definita la selezione, usare lo strumento Elimina il selezionato per cancellare la
selezione.
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Anche lo strumento Taglia geometrie può essere usato per eliminare elementi: tali elementi vengono spostati in un
blocco appunti spaziale. In questo modo è possibile annullare l’operazione incollando nuovamente gli elementi

tagliati con lo strumento Incolla elementi, fornendo in ultima analisi almeno un livello di annullamento. Gli
strumenti taglia, copia e incolla lavorano sugli elementi selezionati, consentendo quindi di lavorare su più di un
elemento alla volta.

Suggerimento: Supporto alla cancellazione di elementi
Quando si modificano shapefile, la cancellazione di elementi funziona solo se QGIS è compilato con una versione
di GDAL pari a 1.3.2 o superiore, come accade per le versioni compilate per OS X e Windows disponibili sul sito.

Salvare i layer modificati

When a layer is in editing mode, any changes remain in the memory of QGIS. Therefore they are not commit-
ted/saved immediately to the data source or disk. If you want to save edits to the current layer but want to continue

editing without leaving the editing mode, you can click the Save Edits button. When you turn editing mode off

with the Toggle editing (or quit QGIS for that matter), you are also asked if you want to save your changes or
discard them.

Se le modifiche non possono essere salvate (ad es. perché il disco di destinazione è pieno o gli attributi contengono
valori esterni agli estremi ammissibili), lo stato della memoria di QGIS è preservato, consentendo dunque di
correggere gli errori e riprovare il salvataggio.

Suggerimento: Integrità dei dati
È buona norma fare un back-up del dato originale prima di procedere alla modifica. Per quando siano stati fatti
molti sforzi da parte dei programmatori di QGIS per preservare l’integrità del dato, non vi è alcuna garanzia che
ciò avvenga.

11.3.5 Digitalizzazione avanzata

Icona Azione Icona Azione

Annulla Ripristina

Semplifica geometrie Aggiungi buco

Aggiungi una parte Elimina buco

Elimina parte Modifica la forma

Curva di offset Spezza elemento

Unisci le geometrie selezionate Ruota i simboli per i punti

Unisci gli sttributi delle geometrie selezionate

Barra degli strumenti di digitalizzazione avanzata

Annullare e rispristinare

Gli strumeti Annulla e Ripristina permettono di annullare/ripristinare le modifiche ad un layer vettoriale. In-
oltre, è disponibile un widget che memorizza e mostra tutte le operazioni annulla/ripristina (Figura Figure_edit_3).
Per attivare il widget cliccare con il tasto destro del mouse sulla barra degli strumenti ed attivare la casella di
controllo Annulla/Ripristina. Annulla/Ripristina è comunque attivo, anche se il widget non è visibile.
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Figura 11.29: Redo and Undo digitizing steps

Cliccando su Annulla, tutti gli elementi e gli attributi vengono riportati al loro stato precedente. Le modifiche
effettuate con strumenti diversi da quelli per la digitalizzazione (es. un plugin), potrebbero non essere annullabili.

Se nel widget Annulla/Ripristina si clicca su una determinata operazione, tutti gli elementi saranno riportati allo
stato successivo all’operazione selezionata.

Semplifica geometrie

Lo strumento Semplifica geometrie permette di ridurre il numero di vertici di un elemento, preservandone la
geometria: un elemento selezionato con lo strumento sarà evidenziato da una linea di semplificazione rossa,
inoltre verrà mostrato a schermo un cursore (Tolleranza linea di semplificazione). Muovendo il cursore, la linea
di semplificazione cambia e mostra la forma che assumerà l’elemento che si sta semplificando. Per memorizzare
la geometria semplificata, cliccare su [OK] . Se una geometria non può essere semplificata (come nel caso di un
multi-poligono), verrà mostrato un messaggio di errore.

Aggiungi buco

Si possono digitalizzare nuovi poligoni all’interno di poligoni esistenti, al fine di creare un buco all’interno di

questi ultimi, scegliendo lo strumento Aggiungi buco. In questo modo solo l’area compresa tra i bordi del
poligono interno e di quello esterno verrà evidenziata come poligono ad anello.

Aggiungi una parte

Lo strumento Aggiungi una parte permette di aggiungere una parte ad un multi-poligono; la nuova parte va
digitalizzata all’esterno del poligono selezionato.

Elimina buco

Lo strumento Elimina buco permette di eliminare un buco all’interno di un poligono. Lo strumento funziona
esclusivamente con layer di poligoni. Nessuna azione viene effettuata se lo strumento viene usato sul bordo esterno
di un poligono. Prima di selezionare i vertici di un buco, impostare adeguatamente la tolleranza.
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Elimina parte

Lo strumento Elimina parte permette di eliminare parti da geometrie multi-parte (multi-punto, multilinea, multi-
poligono); lo strumento non ha effetto sull’ultima parte aggiunta. Prima di selezionare i vertici di una parte,
impostare adeguatamente la tolleranza.

Modifica la forma

Lo strumento Modifica forma permette di modificare la forma di elementi a geometria lineare e poligonale trac-
ciando una nuova linea: la porzione di elemento tra i due punti di intersezione con la nuova linea sarà rimpiazzata
dalla forma di quest’ultima. Prestare particolare attenzione ad utilizzare lo strumento con i poligoni: limitarsi a
piccole porzioni di poligono. La nuova forma non può intersecare più buchi, altrimenti si generano poligoni non
validi.

Per modificare, ad esempio, il bordo di un poligono basta cliccare un primo punto all’interno del poligono, cliccare
un secondo punto all’esterno del poligono, tracciare il profilo della nuova forma, rientrare nel poligono e cliccare
con il tasto destro del mouse per terminare l’operazione. Lo strumento aggiungerà automaticamente nuovi nodi
laddove la nuova linea interseca il bordo del poligono. È, inoltre, possibile rimuovere parte di un poligono inizian-
do la nuova linea all’esterno del poligono, aggiungendo vertici all’interno e terminando la linea all’esterno con il
tasto destro del mouse.

Nota: Lo strumento potrebbe alterare la posizione iniziale di un poligono o di una linea chiusa, per cui nodo
iniziale e nodo finale potrebbero non coincidere. Per molte applicazioni tale fatto non è un problema rilevante, ma
è opportuno tenerne conto.

Dividere elementi

Il nuovo strumento di digitalizzazione Curva di offset sposta parallelamente linee e buchi di poligoni. Lo stru-
mento può essere utilizzato sia per modificare il layer che per effettuare modifiche di sfondo (vengono create cosi
delle copie delle linee / anelli che vengono aggiunte al layer modificato). E’ ideale per creare linee di distanza: la
misura dello spostamento compare nella parte bassa dello schermo.

Spezza elemento

È possibile dividere degli elementi tramite lo strumento Spezza elemento e tracciando una linea attraverso
l’elemento di interesse.

Unire elementi

Lo strumento Unisci le geometri selezionate permette di unire elementi con bordi condivisi e stessi attributi.

Unire attributi di elementi

Lo strumento Unisci gli attributi degli elementi selezionati permette di unire gli attributi di elementi con bordi condivisi e
stessi attributi senza però, unirne i bordi.
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Ruota i simboli per i punti

Attualmente lo strumento Ruota i simboli per i punti è supportato dalla sola simbologia di vecchia generazione. Esso
permette di cambiare la rotazione di un simbolo per punti qualora sia stata definita una colonna rotazione nella
tabella degli attributi di un layer puntuale (scheda Stile della finestra di dialogo Proprietà layer. In caso contrario
lo strumento non è attivo.

Figura 11.30: Rotate Point Symbols

Per modificare la rotazione, selezionare un elemento puntuale nella vista mappa e ruotarlo tenendo premuto il
tasto sinistro del mouse; apparirà una freccia rossa ed il valore di rotazione (Figura Figure_edit_4). Al termine
dell’operazione, il valore di rotazione nella tabella degli attributi sarà aggiornato di conseguenza.

Nota: Se si tiene premuto il tasto Ctrl, la rotazione avverrà per step di 15 gradi.

11.3.6 Creare nuovi layer vettoriali

QGIS permette di creare shapefile e layer SpatiaLite. La creazione di layer GRASS è supportata dal plugin di
GRASS. Per ulteriori informazioni sulla creazione di layer GRASS fare riferimento alla sezione Creare un nuovo
layer vettoriale GRASS.

Creare un nuovo Shapefile

Per creare un nuovo layer shapefile selezionare Nuovo → Nuovo layer shapefile... dal menu Layer. Apparirà
la finestra di dialoto Nuovo vettore mostrata in figura Figure_edit_5. Scegliere il tipo di geometria (Punto, Linea
o Poligono) ed il sistema di riferimento (SR).

Si noti che QGIS non supporta la creazione di elementi 2.5D (ad es. elementi con coordinate XYZ) o il conteggio
degli elementi.

Per completare la creazione del nuovo layer shapefile vanno specificati gli attributi, definendone nome e tipo e
cliccando su [Aggiungi alla lista degli attributi]. La colonna ’id’ è aggiunta automaticamente da QGIS, ma

può essere eliminata. Allo stato attuale sono supportati solo attributi Tipo: Numeri decimali , Type:

Numeri interi , e Type: Testo . in funzione del tipo di attributo è possibile definire larghezza e
precisione. Una volta definiti gli attributi, cliccare su [OK] e assegnare un nome allo shapefile. QGIS aggiungerà
automaticamente l’estensione .shp al nome indicato. Una volta creato il layer, lo stesso sarà aggiunto alla vista
mappa e potrà essere modificato come descritto alla precedente Sezione Modifica di un layer esistente.

Creare un nuovo layer SpatiaLite

Per creare un nuovo layer spatialite selezionare Nuovo → Nuovo layer SpatiaLite... dal menu Layer.Apparirà
la finestra di dialogo Nuovo layer SpatiaLite mostrata in figura Figure_edit_6.
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Figura 11.31: Creating a new Shapefile layer Dialog

Figura 11.32: Creating a New SpatiaLite layer Dialog
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Selezionare un database Spatialite esistente o crearne uno nuovo tramite il pulsante alla destra del campo
’Database’. Indicare un nome per il nuovo layer, definire il tipo di layer ed il sistema di riferimento (EPSG SRID).

Se richiesto, è possibile creare una chiave primaria autoincrementale selezionando Crea una chiave primaria
autoincrementale.

Per definire la tabella degli attributi del nuovo layer, indicare nome e tipo dell’attributo desiderato e cliccare su
[Aggiungi alla tabella degli attributi] quindi cliccare su [OK]. Una volta creato il layer, lo stesso sarà aggiunto
alla vista mappa e potrà essere modificato come descritto alla precedente sezione Modifica di un layer esistente.

I layer Spatialite possono essere gestiti attraverso DB Manager, vedi sezione Plugin DB Manager.

11.3.7 Lavorare con la tabella degli attributi

La tabella degli attributi mostra gli elementi di un layer. Ogni riga nella tabella rappresenta un elemento ed ogni
colonna un attributo. Gli elementi possono essere cercati, selezionati, spostati e modificati.

Per aprire la tabella degli attributi di un layer vettoriale, rendere attivo il layer e selezionare l’opzione Apri
tabella attributi dal menu Layer. Lo stesso risultato si ottiene cliccando con il tasto destro del mouse soprail layer

in legenda e selezionando Apri tabella degli attributi dal menu contestuale.

Si aprirà la finestra di dialogo mostrata in Figura figure_attributes_1: il titolo della finestra, inoltre, mostra il
numero di elementi selezionati sul totale degli elementi del layer.

Figura 11.33: Attribute Table for Alaska layer

Selezionare elementi nella tabella degli attributi

Ogni riga selezionata nella tabella degli attributi mostra gli attributi di un elemento selezionato nel layer. Se
l’insieme di elementi selezionati nella vista mappa viene modificato, la selezione viene aggiornata anche nella
tabella e viceversa. Allo stesso modo, se cambia l’insieme delle righe selezionate nella tabella degli attributi,
cambierà anche la visualizzazione degli elementi nella vista mappa.

Le righe possono essere selezionate cliccando sul numero alla loro sinistra. Si possono selezionare righe multiple
tenendo premuto il tasto Ctrl. È possibile selezionare un sottoinsieme di righe tenendo premuto Shift e
cliccando sulle due righe che delimitano il sottoinsieme di interesse. Spostare il cursore del mouse e cliccare nelle
celle della tabella non modifica la selezione. Cambiare la selezione della vista mappa non modifica la posizione
del cursore nella tabella.
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Le righe della tabella possono essere ordinate in funzione degli attributi. Cliccare sull’intestazione dell’attributo
rispetto al quale si intende ordinare la tabella: una piccola freccia a destra del nome dell’attributo indicherà il
verso dell’ordinamento (freccia in su per ordinamento crescente, freccia in giù per ordinamento decrescente).

Per effettuare una ricerca per attributo su un solo attributo, selezionare la colonna di interesse dal menu a cascata
a sinistra del pulsante Cerca, inserire il testo da ricercare nella casella e cliccare su [Cerca ]. Le righe che soddis-
fano la stringa di ricerca saranno selezionate, mentre il numero totale di righe trovate apparirà nella barra del titolo
della tabella degli attributi e nella barra di stato della finestra principale. Per la ricerca avanzata cliccare su Ricerca
avanzata |browsebutton : il pulsante aprirà il Costruttore di interrogazioni descritto nella sezione Costruttore di
interrogazioni.

Per visualizzare solo le righe selezionate usare l’opzione Mostra solo i selezionati. Per ricercare solo nelle

righe selezionate usare l’opzione Cerca solo i selezionati. La casella di controllo Maiusc/minusc abilita la
ricerca sensibile al carattere. Gli altri pulsanti, in basso a sinistra, hanno le seguenti funzionalità:

• Unselect all anche con Ctrl+U

• Muovi selezione in alto anche con Ctrl+T

• Inverti selezione anche con Ctrl+S

• Copia le righe selezionate nel blocco appunti anche con Ctrl+C

• Zoom mappa alle righe selezionate anche con Ctrl+J

• Zoom mappa alle righe selezionate anche con Ctrl+P

• Modalità modifica per modificare singoli valori della tabella e per abilitare le funzionalità di seguito descritte.
Anche con Ctrl+E

• Elimina gli elementi selezionati anche con Ctrl+D

• Nuova colonna per layer PostGIS ed OGR con GDAL versione >= 1.6. Anche con Ctrl+W

• Elimina colonna per layer PostGIS ed OGR con GDAL versione >= 1.9. Anche con Ctrl+L

• Apri il calcolatore di campi anche con Ctrl+I

Suggerimento: Geometrie WKT

Se si desiderano visualizzare gli attributi in un programma esterno (per esempio Excel), usare il pulsante
Copia le righe selezionate nel blocco appunti. E’ possibile copiare le informazioni senza le geometrie del layer vettoriale disat-

tivando Impostazioni → Opzioni → scheda Generale Copia la geometria in formato WKT dalla tabella degli
attributi.

Salvare elementi selezionati come nuovo layer

Gli elementi selezionati possono essere salvati in uno dei formati vettoriali supportati da OGR, anche con sistema
di riferimento diverso da quello del layer di origine. Cliccare con il tasto destro del mouse sul layer in legenda e
selezionare Salva selezione con nome → dal menu contestuale: quindi definire il nome, il formato ed il sistema di
riferimento del file di output (Sezione Legenda). È anche possibile specificare le opzioni di creazione OGR.

Lavorare con tabelle di attributi non spaziali

QGIS permette di caricare tabelle di dati non spaziali nei formati supportati da OGR, dal fornitore PostgreSQL

e in testo delimitato. Una volta caricata, la tabella viene elencata nella legenda e può essere aperta con
Apri tabella degli attributi ed editata come qualsiasi altra tabella di layer.
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Ad esempio, è possibile usare una colonna di una tabella non spaziale per definire il valore o un intervallo di valori
di attributi ammissibili per un layer vettoriale durante la digitalizzazione. Per ulteriori informazioni riferirsi al
widget di modifica nella Sezione Scheda Campi.

11.4 Costruttore di interrogazioni

Il costruttore di interrogazioni permette di definire un sottoinsieme di una tabella, tramite la clausola di condizione
SQL ’WHERE’, per poi visualizzarlo nella vista mappa ed eventualmente salvarlo come nuovo shapefile.

11.4.1 Interrogazione

Aprire la tabella degli attributi con il pulsante Apri tabella attibuti e cliccare su [Ricerca avanzata] per aprire il
Costruttore di interrogazioni. Si immagini per esempio di avere il layer città con un attributo popolazione
e di essre interessati all’insieme di città con una popolazione superiore a 100000 abitanti. Per ottenere tale in-
sieme di città è sufficiente utilizzare la clausola SQL di condizione popolazione > 100000. La figura
Figure_attributes_2 mostra un esempio del costruttore di query popolato con i dati provenienti da un layer Post-
GIS ed attributi memorizzati in PostgreSQL. Le sezioni Campi, Valori e Operatori aiutano nella costruzione delle
clausole SQL.

Figura 11.34: Query Builder

La sezione Campi elenca gli attributi della tabella: per aggiungere un attributo nella casella delle clausole SQL
fare doppio click sullo stesso, quindi usare le altre sezioni (Valori e Operatori) per completare la clausola. In
alternativa è possibile scrivere direttamente la query nella casella delle clausole.

La sezione Valori Per avere l’elenco di tutti i valori di un attributo, selezionare quest’ultimo nella sezione Campi
e cliccare su [Tutto]. Per avere un elenco dei primi 25 valori univoci di un attributo, selezionare quest’ultimo nella
sezione Campi e cliccare su [Campione]. Per aggiungere un valore nella casella delle clausole SQL fare doppio
click sul suo nome nella sezione Valori.

La sezione Operatori elenca tutti gli operatori utilizzabili. Per aggiungere un operatore nella casella delle clausole
SQL basta un click singolo. Sono disponibili operatori relazionali (=, >, ...), operatori per confrontare stringhe di
testo (LIKE) ed operatori logici (AND, OR, ...).
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Il pulsante [Test] mostra un messaggio contenente il numero di elementi che soddisfano la query impostata oppure
un messaggio di errore se la query non è sintatticamente corretta. Il pulsante [Cancella] elimina in testo inserito
nella casella delle clausole SQL. I pulsanti [Salva] e [Carica] permettono rispettivamente di salvare o caricare
query SQL. Il pulsante [OK] chiude la finestra di dialogo e seleziona gli elementi che soddisfano la query. Il
pulsante [Cancellla] chiude la finestra di dialogo senza modificare la selezione.

Suggerimento: Cambiare la definizione di un layer
È possibile cambiare la definizione di un layer tramite una query SQL. Aprire la finestra di dialogo Proprietà layer
(doppio click sul layer in legenda) a cliccare su [Costruttore di interrogazioni] nella scheda Generale. Vedi la
sezione Proprietà dei layer vettoriali per maggiori informazioni.

11.4.2 Selezione

Con QGIS è possibile selezionare elementi per mezzo di un’interfaccia simile a quella del costruttore di inter-
rogazioni vista in Costruttore di interrogazioni. Lo scopo della selezione mediante interrogazione è di evidenziare
solo gli elementi di un layer che soddisfano particolari criteri.

Un’altra possibilità è quella di selezionare un layer e facendo click con il tasto destro scegliere Interrogazione ....
Costruendo un’interrogazione SQL in questo modo, verranno visualizzati solamente gli elementi che soddisfano i
criteri di ricerca, mentre quelli che non corrispondono ai criteri di ricerca verranno nascosti dalla vista. La stessa
funzione è disponibile dalla finestra di dialogo Proprietà layer, scegliendo la scheda Generale e cliccando sul
pulsante [Costruttore interrogazioni]. Questa modalità di interrogazione può essere usata con tutti i fornitori di
dati vettoriali supportati.

11.4.3 Salvare elementi selezionati come nuovo layer

Gli elementi selezionati possono essere in uno dei formati vettoriali supportati da OGR, anche con sistema di
riferimento diverso da quello del layer di origine. Cliccare con il tasto destro del mouse sul layer in legenda e
selezionare Salva la selezione con nome → dal menu contestuale: quindi definire il nome, il formato ed il sistema
di riferimento del file di output (vedi sezione Legenda). È anche possibile specificare le opzioni di creazione OGR.

11.5 Calcolatore di campi

Il pulsante Apri il calcolatore di campi presente nella tabella degli attributi permette di operare calcoli sulla base di
funzioni definite e/o dei valori degli attributi esistenti, per esempio è possibile calcolare il perimetro o l’area di un
poligono. Il risultato delle operazioni può essere salvato in una nuova colonna attributo oppure essere usato per
aggiornare i valori di una colonna esistente.

Per poter aprire il calcolatore di campi bisogna impostare il layer in modalità di modifica (vedi figura fig-
ure_attributes_3). Nella finestra di dialogo del Calcolatore di campi è possibile scegliere se aggiornare un cam-
po esistente, aggiornare gli elementi selezionati oppure creare un nuovo campo in cui salvare i risultati delle
operazioni di calcolo.

Per aggiungere un nuovo campo bisogna indicare il nome, il tipo di campo (intero, decimale, testo) e la larghezza.
Per il tipo Numero decimale è anche possibile definire la precisione, ossia il numero di cifre dopo la virgola: ad
esempio per un campo con larghezza 10 e precisione 3 si avranno 6 cifre prima della virgola, quindi la virgola ed
infine 3 cifre decimali (see figure_attributes_3).

La Lista delle funzioni contiene, oltre alle funzioni, anche la lista dei campi e valori. La casella Aiuto per la
funzione scelta fornisce una descrizione della funzione selezionata. La casella Espressione mostra l’espressione
creata tramite la Lista delle funzioni. Gli operatori più comuni sono raggruppati nella sezione Operatori.

La sezione Campi e valori presente nella casella Lista delle funzioni elenca tutti gli attributi della tabella. Per ag-
giungere un attributo nella casella Espressioni fare doppio click sullo stesso, quindi usare le altre sezioni (campi
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Figura 11.35: Field Calculator

e valori, operatori e le altre funzioni) per completare l’espressione; alternativamente è possibile scriverla diret-
tamente nella casella. Per visionare i valori di un campo è sufficiente cliccare con il tasto destro sul campo
desiderato. E’ possibile scegliere fra Carica primi 10 valori univoci oppure Carica tutti i valori univoci. Nella
parte destra apparirà la lista dei Valori del campo con i valori univoci elencati. Per aggiungere un valore alla
casella Espressione basta fare doppio click sul suo nome dalla casella Valori del campo.

Le sezioni Operatori, Matematica, Conversioni, Stringa, Geometria e Record contengono molte funzioni. Op-
eratori fornisce operatori matematici. Per funzioni matematiche cercare in Matematica. La sezione Conversioni
permette di convertire un tipo di dato in un altro (per esempio da numero intero a numero reale).Le funzioni
riguardanti le stringhe sono disponibili in Stringa. La sezione Geometria contiene le funzioni per gli oggetti ge-
ometrici mentre grazie alla sezione Record è possibile aggiungere una numerazione al dataset (esempio numero
della riga). Per aggiungere una funzione alla casella Espressione cliccare su > e fare doppio click sulla funzione
scelta.

Segue un breve esempio di utilizzo del calcolatore per calcolare la lunghezza degli elementi del layer railroads
presenti nel dataset di QGIS:

1. Caricare in QGIS lo shapefile railroads.shp e cliccare su Apri tabella attributi.

2. Attivare la modalità Modifica e aprire il Calcolatore di campi.

3. Spuntare Crea un nuovo campo per abilitare la creazione di un nuovo campo.

4. Nominare il campo length, impostare numero decimale come tipo, 10 come larghezza e 3 come
precisione.

5. Cliccare sulla funzione length presente nella sezione Geometria per aggiungerla come ‘‘$lenght‘‘nella
casella espressione e cliccare su [OK].

6. Adesso la nuova colonna length è presente nella tabella degli attributi.

Le funzioni disponibili sono di seguito elencate.
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column name "column name" value of the field column name
’string’ a string value
NULL null value
a IS NULL a has no value
a IS NOT NULL a has a value
a IN (value[,value]) a is below the values listed
a NOT IN (value[,value]) a is not below the values listed
a OR b a or *b* is true
a AND b a and *b* is true
NOT a inverted truth value of a
sqrt(a) square root of a
sin(a) sinus of a
cos(a) cosinus of b
tan(a) tangens of a
asin(a) arcussinus of a
acos(a) arcuscosinus of a
atan(a) arcustangens of a
to int(a) convert string a to integer
to real(a) convert string a to real
to string(a) convert number a to string
lower(a) convert string a to lower case
upper(a) convert string a to upper case
length(a) length of string a
atan2(y,x) arcustangens of y/x using the signs of the two

arguments to determine the quadrant of the result
replace(*a*, replacethis, withthat) replace this with that in string a
regexp_replace(a,this,that) replace the regular expression this with that
substr(*a*,from,len) len characters of string *a* starting from from

(first character index is 1)
a || b concatenate strings a and b
$rownum number current row
$area area of polygon
$perimeter perimeter of polygon
$length length of line
$id feature id
$x x coordinate of point
$y y coordinate of point
xat(n) X coordinate of the point of an n-th line (indeces

start at 0; negative values refer to the line end)
yat(n) y coordinate of the point of an n-th line (indeces

start at 0; negative values refer to the line end)
a = b a and b are equal
a != b and a <> b a and b are not equal
a >= b a is larger than or equal to b
a <= b a is less than or equal to b
a > b a is larger than b
a < b a is smaller than b
a ~ b a matches the regular expression b
a LIKE b a equals b
a ILIKE b a equals b (without regard to case-sensitive)
a |wedge| b a raised to the power of b
a * b a multiplied by b
a / b a divided by b
a + b a plus b
a - b a minus b
+ a positive sign
- a negative value of a

E’ possibile accedere alle varie caselle del calcolatore di camp: Lista delle funzioni, Aiuto per la funzione scelta,
Operatori e Espressione, sia attraverso la visualizzazione tramite regole presente nella scheda stile delle proprietà

del layer, sia attraverso la modalità di impostazione di etichettatura cliccando accessibile dal pulsante
Etichettatura.
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CAPITOLO 12

Lavorare con i dati raster

12.1 Lavorare con i dati raster

Questa Sezione descrive come visualizzare ed impostare le proprietà dei dati raster. QGIS usa la libreria GDAL
per l’accesso in lettura/scrittura a formati raster, tipo Arc/Info Binary Grid, Arc/Info ASCII Grid, GeoTIFF, Erdas
Imagine e molti altri.Il supporto ai raster GRASS è fornito da un plugin nativo di QGIS. Dati raster possono essere
caricati in QGIS in sola lettura da file zip e gzip.

Alla data del presente documento, la libreria GDAL supporta più di 100 formati raster (vedi GDAL-
SOFTWARE-SUITE Literature and Web References). La lista completa è disponibile alla pagina web
http://www.gdal.org/formats_list.html.

Nota: Per varie ragioni, QGIS potrebbe non gestire alcuni dei formati elencati nella pagina web citata. Ad
esempio, alcuni formati richiedono la presenza di librerie commerciali di terze parti oppure l’installazione di
GDAL potrebbe essere avvenuta senza il supporto al formato che si intende usare. Quando si carica un raster
in QGIS solo i formati ben testati appariranno nell’elenco dei tipi di file; altri formati non testati possono essere
caricati selezionando l’opzione [GDAL] Tutti i file (*).

Per caricare e lavorare con dati raster di GRASS, fare riferimento alla Sezione Integrazione con GRASS GIS.

12.1.1 Cosa sono i dati raster?

I dati raster sono matrici di celle discrete che rappresentano elementi della superficie terrestre o dell’ambiente
al di sopra o al di sotto di essa. Ogni cella nella matrice raster ha la stessa dimensione e le celle sono solita-
mente rettangolari (in QGIS saranno sempre rettangolari). Esempi tipici di dati raster sono quelli provenienti dal
telerilevamento come le fotografie aeree, le immagini da satellite e dati modellati come le matrici dell’elevazione.

I dati raster di solito non hanno associato un database contenente i dati descrittivi di ogni cella, diversamente dai
dati vettoriali, e sono geocodificati in base alla risoluzione del pixel e alle coordinate x/y di un angolo del raster.
Questo permette a QGIS il posizionamento corretto dei dati nella vista mappa.

Per posizionare e visualizzare correttamente un raster, QGIS legge le informazioni di georeferenziazione
incorporate nel file del raster (ad es. GeoTiff) o gestite in un apposito file noto come world file.

12.1.2 Caricare dati raster in QGIS

I layer raster possono essere caricati tramite lo strumento Aggiungi Layer o scegliendo la voce di menu:Layer –>

Aggiungi raster. È possibile caricare più di un layer alla volta tenendo premuto il tasto Control o Shift
e selezionando con il mouse più elementi nella finestra di dialogo Apri un raster supportato da GDAL.

Quando il layer è caricato è possibile cliccare sul suo nome nella legenda con il tasto destro del mouse per
selezionare ed attivare opzioni specifiche, o per aprire la finestra per l’impostazione delle proprietà del layer
raster.
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Menu contestuale per layer raster

• Zoom all’estensione del layer

• Zoom alla scala migliore (100%)

• Aggiungi alla panoramica

• Rimuovi

• Set Layer CRS

• Imposta il SR del progetto dal layer

• Proprietà

• Rinomina

• Copia lo stile

• Add New Group

• Espandi tutto

• Comprimi tutto

• Aggiorna l’ordine del disegno

12.2 Proprietà raster

Per visualizzare ed impostare le proprietà di un layer raster, fare doppio click sul nome del raster nella legenda o
cliccare su di esso con il tasto destro e scegliere Proprietà dal menu contestuale:

Verrà così aperta la finestra Proprietà layer, (vedi figura_raster_1).

Ci sono diverse schede nella finestra:

• Stile

• Trasparenza

• Mappa colore

• Generale

• Metadati

• Piramidi

• Istogramma

12.2.1 Scheda stile

QGIS può rendere a video i raster in due modi:

1. Banda singola - una sola banda dell’immagine è resa in scala di grigi, o in pseudo colore o ancora in freak
out.

2. Tre bande di colore - tre bande dell’immagine, ognuna rappresentante la componente rosso o verde o blu,
vengono composte per creare un’immagine a colori.

È possibile invertire i colori in modo che i quelli chiari diventino scuri e viceversa selezionando la casella di

controllo Inverti mappa colore.

Banda singola grigia

Selezionando questa opzione vengono offerte due possibilità tra le quali scegliere. Innanzitutto se il layer è
multibanda è possibile scegliere quale banda si desidera venga impiegata per la resa a video.
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Figura 12.1: Raster Layers Properties Dialog

La seconda opzione offre una selezione di mappe colore preimpostate per la resa a video.

Le scelte possibili disponibili nel menu a tendina sono Mappa colore

• Scala di grigi (predefinito)

• Pseudocolore

• Freak Out

• Scheda Mappa colore

Quando viene selezionata l’opzione Mappa colore , la scheda Mappa colore è abilitata. Si vedano ulteriori
informazioni al Capitolo Scheda Mappa colore.

QGIS restringe la visualizzazione dei dati per mostrare soltanto le celle i cui valori ricadono all’interno di una
deviazione standard definita per il layer.

Ciò può essere utile quando nella griglia raster si hanno una o due celle con valori estremamente alti: questi hanno
un impatto negativo sulla resa a video del raster. Tale opzione è disponibile solo per immagini in pseudo colore o
freak out.

Tra bande di colore

Questa opzione offre un considerevole numero di possibilità di modifica dell’aspetto del raster. Ad esempio è
possibile cambiare il normale ordine RGB delle bande.

È possibile anche applicare una scala di colori in base ai valori min/max del raster.

Suggerimento: Visualizzare una singola banda di un raster multibanda
Il modo corretto di visualizzare ad es. la sola banda rossa di un’immagine multibanda non è quello di impostare le
bande verde e blu a “Non impostato”, ma di impostare il tipo di immagine come scala di grigi e quindi scegliere il
rosso come banda da usare per il grigio.
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Miglioramento contrasto

Nota: Se viene aggiunto un raster di GRASS l’opzione Miglioramento contrasto sarà sempre selezionata
automaticamente su Stira a MinMax anche se le impostazioni generali di QGIS dovessero essere diverse.

12.2.2 Scheda Trasparenza

QGIS offre la possibilità di visualizzare ogni layer raster ad un diverso grado di trasparenza. Per settare una
Trasparenza globale, impostare il cursore a scorrimento al livello di trasparenza desiderato in maniera tale da
consentire la visualizzazione degli eventuali layer sottostanti. L’uso di questa impostazione può essere molto
utile nei casi in cui si desideri sovrapporre più di un layer raster, ad es. ad una mappa delle ombreggiature del
rilievo (shaded relief-map) una mappa raster contenente delle classificazioni, così da dare a quest’ultima un aspetto
tridimensionale.

Inoltre la sezione Nessun valore consente invece di definire la trasparenza per un certo valore del raster, che
sarà quindi letto come un campo privo di dati del tipo NODATA. Ciò può essere fatto manualmente o cliccando

sull’icona Aggiungi un valore dal display.

È possibile definire la trasparenza in maniera ancora più dettagliata e personalizzata nelle sezione Opzioni di
trasparenza personalizzate, nella quale è possibile impostare il grado di trasparenza di ogni singola cella (o pixel).

Ad esempio se si volesse utilizzare quest’ultima sezione per evidenziare l’acqua del raster landcover.tif con
una trasparenza del 20 %, bisognerà seguire la seguente procedura:

1. Caricre il file raster: Load the rasterfile landcover.

2. Aprire la finestra di dialogo guilabel:Proprietà facendo doppio click sul nome del layer nella legenda o
cliccando su di esso con il tasto destro del mouse e scegliendo Proprietà dal menu contestuale.

3. Selezionare la scheda Trasparenza

4. Cliccare sul pulsante Aggiungi un valore manualmente. Nella lista pixel apparirà una nuova riga.

5. Inserire il valore del raster per il quale si desidera modificare la trasparenza (si supponga 0 per questo
esempio) e si imposti la trasparenza al 20%.

6. Cliccare sul pulsante [Applica] per visualizzare il risultato.

È possibile ripetere i passaggi 4 e 5 per impostare ulteriori valori con una trasparenza personalizzata.

Impostare la trasparenza personalizzata è alquanto semplice, ma la procedura può risultare laboriosa specie se si
hanno molti valori da impostare. Per ovviare a tale complicazione, è possibile salvare la lista delle impostazioni di

trasparenza cliccando sul pulsante Esporta su file per non ripetere la procedura. Il pulsante Importa da file, infatti,
carica il file salvato e applica le impostazioni al raster selezionato.

12.2.3 Scheda Mappa colore

La scheda Mappa colore viene abilitata solo quando si imposta la resa a video del raster come Banda singola
grigia nella scheda Stile (Capitolo Scheda stile).

Sono disponibili tre modalità di interpolazione del colore:

1. Discrete

2. Lineare

3. Esatto

Il pulsante [Aggiungi elemento] aggiunge un colore alla tabella dei colori sottostante. [Cancella elemento]
elimina un colore dalla tabella dei colori. [Ordina] ordina la tabella dei colori in funzione dei valori dei pixel
della colonna Valore. Facendo doppio click su un valore della colonna Valore è possibile specificare o modificare
il valore stesso. Facendo doppio click sulla casella colorata a fianco del valore editato (colonna colore) appare la
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finestra di dialogo Seleziona colore che permette di selezionare il colore da applicare a tutte le celle raster (o pixel)
il cui valore corrisponde a quello appena editato. Inoltre è possibile aggiungere o modificare l’etichetta per ogni
colore. Questo valore però non sarà mostrato utilizzando lo strumento Informazioni elementi.

In alternativa è possibile cliccare sul pulsante Carica mappa colore dalla banda,con il quale viene caricata, se viene

trovata o se disponibile, la tabella dei colori dalla banda. Si possono usare i pulsanti Carica mappa colore della banda o
Esporta mappa colore su file rispettivamente per caricare o salvare i colori scelti per una sessione futura.

La sezione Genera nuova mappa colore consente di creare nuove mappe colore per categoria. È sufficiente

impostare il Numero di elementi e cliccare poi su Classifica. Attualmente è supportato il solo Modo di

classificazione ‘Equal Interval’

12.2.4 Scheda generale

La scheda Generale visualizza le informazioni di base sui raster selezionati, incluso il percorso alla sorgente dati e
il nome (modificabile a piacere) visualizzato in legenda. Viene inoltre mostrata una miniatura del layer, la legenda
dei simboli e la gamma di colori.

È qui possibile attivare la funzione che setta la visibilità del layer in base alla scala della mappa, attivando l’ap-
posita casella di controllo ed impostando l’intervallo di scale entro il quale si vuole che il layer venga reso a
video.

Viene inoltre fornita l’indicazione del sistema di riferimento spaziale (SR) impostato per il layer raster in formato
stringa PROJ.4. Il SR è modificabile cliccando sul pulsante [Cambia].

12.2.5 Scheda Metadati

La scheda Metadati mostra una serie di informazioni sul layer raster, come ad es. le statistiche riguardanti
ogni banda. Le statistiche sono disponibili in questa scheda solo dopo averle raccolte cliccando nella scheda
Istogramma e sul pulsante [Aggiorna] in basso a destra (capitolot Scheda Istogramma).

This tab is mainly for information. You cannot change any values printed inside this tab.

12.2.6 Scheda Piramidi

I layer raster ad alta risoluzione possono rallentare notevolmente l’esplorazione della mappa in QGIS. Creando
copie a bassa risoluzione dei dati (piramidi) le prestazioni possono venire incrementate notevolmente in quanto
QGIS sceglierà la risoluzione migliore in funzione del fattore di zoom.

Per creare piramidi è necessario avere i permessi in scrittura nella cartella contenente il dato originale: in questa
cartella verranno salvate le copie a bassa risoluzione.

Sono disponibili i seguenti metodi di ricampionamento:

• Media

• Vicino più prossimo (metodo Nearest Neighbour)

Quando viene attivata la casella di controllo Crea piramidi interne se possibile QGIS crea e memorizza le
piramidi direttamente nel file raster, invece di copie multiple separate.

Si evidenzia che la costruzione delle piramidi può alterare il dato originale in maniera irreversibile, quindi si
raccomanda di fare una copia di backup del raster di partenza prima di eseguire l’operazione.
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12.2.7 Scheda Istogramma

La scheda Istogramma consente di visualizzare la distribuzione delle bande di colore nel layer raster. Tali statis-
tiche sono generate automaticamente nel momento in cui si accede alla scheda Istogramma. È possibile selezionare
quale banda mostrare nel diagramma selezionandola nella lista sulla sinistra della scheda. E’ possibile salvare

l’istogramma come immagine premendo sul pulsante .

12.3 Calcolatore raster

La finestra di dialogo Calcolatore Raster del menu Raster (vedi figure_raster_2) permette di effettuare calcoli
sulla base dei valori dei pixel di raster esistenti. Il risultato viene salvato in un nuovo layer raster in uno dei
formati supportati da GDAL.

Figura 12.2: Raster Calculator

La sezione Bande raster elenca i layer raster caricati in QGIS che possono essere utilizzati. Per aggiungere un
raster nella casella Espressione del calcolatore raster, fare doppio click sul suo nome in Bande raster. Si possono
usare gli operatori per costruire un’espressione o scriverla direttamente nella casella delle espressioni.

Nella sezione Layer di risultato va definito il nome del raster risultato. Si può poi definire l’estensione dell’area
di calcolo che ne determinerà la risoluzione, basandosi sul layer di imput, su coordinate X,Y o sul numero di
colonne e di righe. Se il layer in input ha una risoluzione diversa, i valori saranno ricampionati con l’algoritmo
del vicino più prossimo.

La sezione Operatori elenca gli operatori disponibili. Per aggiungere un operatore alla casella Espressione del
calcolatore raster, cliccare sull’icona ad esso relativa. Sono disponibili operazioni matematiche (+ , - , * . . . ),
funzioni trigonometriche (sin, cos, tan, . . . ), operatori logici (AND, OR). Ulteriori funzioni verranno incluse in
futuro!

Selezionando la casella di controllo Aggiungi al progetto il layer risultato sarà aggiunto alla legenda e potrà
essere visualizzato nella vista mappa.
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12.3.1 Esempi

Convertire calori di elevazione da metri a piedi

Per creare un raster con altimetria in piedi a partire da un raster con altimetria in metri è necessario utilizzare il
fattore di conversione di 3,28 piedi per metro. L’espressione è:

elevation@1 * 3.28

Utilizzare una mascheratura

Se si vuole utilizzare una mascheratura su parte del raster, perchè si è interessati solo ai valori di altezza superiori
allo 0, è possibili utilizzare l’espresisone seguente che crea la maschera e applica i risultati in un solo passaggio.

(elevation@1 >= 0) * elevation@1

Per ogni cella maggiore o uguale a 0 si imposta il valore a 1, altrimenti a 0. Questo crea la maschera al volo.
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CAPITOLO 13

Lavorare con i dati OGC

13.1 Lavorare con i dati OGC

QGIS supporta sorgenti di dati WMS e WFS.

13.1.1 Cosa sono i dati OGC

L’Open Geospatial Consortium (OGC), è un’organizzazione internazionale che raggruppa più di 300 organiz-
zazioni commerciali, governative, nonprofit e di ricerca. I suoi membri sviluppano e implementano standard per
contenuti e servizi geospaziali, analisi GIS e scambio dati.

OGC ha elaborato un numero crescente di specifiche per la descrizione di un modello dati di base per elementi
geografici: le specifiche sono orientate a garantire l’interoperabilità nell’ambito della tecnologia geospaziale.
Ulteriori informazioni all’indirizzo http://www.opengeospatial.org/.

Importanti specifiche OGC sono:

• WMS — Web Map Service

• WFS — Web Feature Service

• WCS — Web Coverage Service

• CAT — Web Catalog Service

• SFS — Simple Features for SQL

• GML — Geography Markup Language

Ad oggi i servizi OGC-sono sempre più di uso comune per scambiare dati geografici fra differenti implementazioni
GIS. QGIS ora può gestire tre delle specifiche esposte sopra, SFS (tramite il supporto a PostgreSQL/PostGIS, vedi
Sezione Layer PostGIS), WFS e WMS come client.

13.1.2 Client WMS

Panoramica sul servizio WMS

QGIS può agire come client WMS, nel rispetto delle specifiche 1.1, 1.1.1 e 1.3. È stato particolarmente testato nei
confronti di server accessibili pubblicamente quali DEMIS e JPL OnEarth.

I server WMS rispondono alle richieste da parte dei client (ad es. QGIS) di una mappa raster di una determinata
estensione, con un determinato insieme di layer, simboli e trasparenze. Il server WMS quindi consulta le sue
risorse (locali o remote), genera il raster e lo invia al client in formato raster, per QGIS tipicamente come immagini
JPEG o PNG.

WMS è un servizio REST (Representational State Transfer) piuttosto che un servizio web completo. Come tale,
si può prendere l’URL (indirizzo del server con specifiche) generato da QGIS e usarlo in un browser web per

109

http://www.opengeospatial.org/


QGIS User Guide, Release 1.8

ottenere la stessa immagine che QGIS usa internamente. Questo può essere utile per identificare le cause di
eventuali problemi, dato che esistono vari tipi di server WMS e ciascuno ha la sua propria interpretazione degli
standard WMS.

I layer WMS possono essere aggiunti molto semplicemente, una volta disponibile l’indirizzo (URL) per accedere
al server WMS, una connessione adatta e posto che il server usi HTTP come meccanismo di trasferimento dati.

Selezionare un server WMS

Al primo utilizzo di un servizio WMS in QGIS non sono presenti server predefiniti.

Si può avviare lo strumento cliccando sul pulsante e Aggiungi layer WMS nella barra strumenti, oppure sulla voce
di menu Layer → Aggiungi layer.WMS....

Si aprirà la finestra di dialogo: Aggiungi Layer da server. È possibile aggiungere alcuni server cliccando sul
pulsante [Aggiungi server predefiniti]. Verranno quindi aggiunti due server WMS, il server di DM Solutions
Group ed il server di Lizardtech. Per definire un nuovo server WMS nella sezione Layer, cliccare su [Nuovo] ed
inserire i parametri di connessione al server WMS desiderato, seguendo le indicazioni della tabella _OGC_1_:

Nome Un nome per la connessione. Tale nome verrà utilizzato nel menù a discesa di scelta dei
server in modo da distinguere i vari WMS.

URL URL del server che fornisce i dati. Deve essere un indirizzo raggiungibile nello stesso
formato che verrebbe usato per aprire una commessione telnet o pingare un host.

Username Nome utente per accedere un WMS protetto. Questo parametro è opzionale.
Password Password per accedere ad un WMS protetto. Questo parametro è opzionale.

Ignora URI
GetMap

Ignora la URI GetMap riportata nelle capabilities. Viene utilizzato URI del campo
URL precedente.

Ignora URI
GetFeatureIn-
fo

Ignora la URI GetFeatureInfo riportata nelle capabilities. Viene utilizzato URI del
campo URL precedente

Table OGC 1: Parametri di connessione WMS

È possibile, se necessario, impostare i parametri di un proxy per ricevere i servizi WMS da internet. Selezionare la
voce di menu Impostazioni → Opzioni e cliccare sulla scheda Rete, nella quale è possibile inserire le impostazioni

abilitando la casella di controllo Utilizza un proxy per l’accesso web. Assicuratevi di scegliere il tipo di proxy

corretto dal menù a discesa Tipo proxy .

Una volta creata la connessione al server WMS, essa sarà memorizzata e disponibile per le successive sessioni di
QGIS.

Suggerimento: A PROPOSITO DI INDIRIZZI DEI SERVER WMS

Quando si inserisce l’indirizzo URL del server assicurarsi di usare l’indirizzo di base. Ad esempio non bisogna
inserire frammenti tipo request=GetCapabilities o version=1.0.0 nell’indirizzo.

Caricare layer WMS

Una volta compilati correttamente i campi, si può premere sul pulsante [Connetti] per ottenere le capabilities
del server: in esse sono inclusi i formati immagine, i layer disponibili e i sistemi di proiezione forniti dal server.
Considerato che si tratta di operazioni in rete, la velocità nella risposta dipenderà dalla qualità della connessione
verso il server WMS. Mentre si scaricano i dati dal server, l’avanzamento dell’operazione viene visualizzato nella
porzione inferiore sinistra della finestra.

Il vostro schermo adesso deve essere simile a quello rappresentato alla figura_OGR_1, che mostra la risposta
fornita dal server WMS di DM Solutions Group.

Codifica immagine
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Figura 13.1: Dialog for adding a WMS server, showing its available layers

La sezione Codifica immagine elenca i formati supportati sia dal client che dal server. La scelta è in funzione dei
propri requisiti di accuratezza.

Suggerimento: Codifica immagine
Un server WMS offre normalmente la scelta fra immagini JPEG o PNG. Il formato JPEG è un formato di
compressione lossy, mentre il formato PNG riproduce fedelmente i dati raster.

È preferibile utilizzare il formato JPEG per dati di natura fotografica e/o se la perdita parziale di qualità dell’im-
magine non causa problemi. Questa scelta riduce normalmente di 5 volte il volume di dati trasferiti rispetto al
fomrato PNG.

L’uso del formato PNG permette una visualizzazione più precisa ed è da utilizzare se non vi sono problemi per
l’incremento dei dati trasferiti.

Opzioni

La sezione Opzioni mette a disposizione il campo testo Nome layer per associare un nome al layer WMS: tale
nome apparirà nella legenda a caricamento avvenuto.

Sotto il nome del layer è possibile definire la Dimensione delle tile, (per esempio 256x256) in modo da dividere
la richiesta WMS in richieste multiple.

Il campo Limite di elementi per GetFeatureInfo definisce quali elementi del server interrogare.

Selezionando un layer WMS dalla lista appare un campo con il sistema di proiezione predefinito dal server. Se il
pulsante [Cambia...] è attivo, allora è possibile selezionare un altro SR fornito dal server.

Ordine dei Layer

La sezione Ordine layer elenca i diversi layer disponibili sul server WMS a cui si è connessi. Si può notare che
alcuni layer sono espandibili e questo significa che quei layer possono essere visualizzati con diversi stili.
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È possibile selezionare più layer in una volta, ma solo uno stile di visualizzazione per layer. Quando più layer
sono selezionati questi vengono combinati dal server ed inviati a QGIS in una sola volta.

Suggerimento: Ordine dei layer WMS
layer WMS caricati sono sovrapposti in base all’ordine in cui sono elencati nella sezione Layer, dall’alto verso il
basso. Se si desidera cambiare l’ordine di visualizzazione, usare la scheda Ordine layer.

Trasparenza

In questa versione di QGIS l’impostazione della Trasparenza globale che si imposta da Layer Proprietà... è
impostata per essere sempre attiva, se disponibile.

Suggerimento: Trasparenza dei layer WMS
La possibilità di rendere trasparenti i layer WMS dipende dalla codifica tramite la quale sono stati caricati: PNG
e GIF gestiscono la trasparenza mentre il JPEG no.

Sistema di Riferimento

Sistema di riferimento delle coordinate (Coordinate Reference System) è il termine OGC per una proiezione in
QGIS.

Ogni layer WMS può essere restituito in molteplici SR, in funzione delle capacità del server.

Per scegliere uno dei SR disponibili, cliccare su [Cambia...] per fare apparire una finestra simile a quella della
Figura Proiezioni 3 in Lavorare con le proiezioni. La differenza principale è che saranno mostrati solo i SR
supportati dal server al quale si è connessi.

Cercare un Server

Con QGIS è anche possibile ricercare server WMS. La Figura_OGC_2 mostra la nuova scheda Cerca server della
finestra di dialogo Aggiungi layer dal server.

Figura 13.2: Dialog for searching WMS servers after some keywords
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Inserire una stringa di ricerca e cliccare sul pulsante [Cerca]: i risultati saranno elencati nella sottostante tabella.
Per utilizzare uno dei risultati, selezionarlo nella tabella e cliccare su [Aggiungi riga alla lista WMS]. Il server
verrà automaticamente aggiunto alla lista dei server nella scheda Layer: cliccare su **[Connetti]**per ottenere la
lista di layer forniti dal server.

Si tratta fondamentalmente di un frontend alle API of http://geopole.org.

Set di tile

Quando si usa un servizio WMS-C (Cached WMS) come ad esempio http://labs.metacarta.com/wms-c/Basic.py si
attiva la scheda Set di tile , che fornisce informazioni sulle dimensione, il formato ed il SR dei tile. In combinazione
con tale opzione è possibile utilizzare la voce di menu Visualizza → Slider per la scala delle tiles, che mette a
disposizione le scale fornite dal server di tile.

Uso dello strumento di identificazione

Una volta aggiunto un server WMS, e se uno dei layer disponibili è interrogabile, è possibile usare lo strumento
Informazioni elementi per selezionare un pixel sulla mappa, determinando una interrogazione verso il server WMS.

La formattazione del risultato dell’interrogazione fatta dipende dal server WMS utilizzato. Proprietà del server

Una volta aggiunto un server WMS, è possibile visualizzarne le proprietà cliccando con il tasto destro sul suo
nome nella legenda e selezionando Proprietà. Scheda Metadati

La scheda Metadati‘mostra molte informazioni sul server WMS: tali informazioni sono fornite dal serv-
er stesso in risposta alla richiesta di GetCapabilities fatta da QGIS quando si connette ad esso. Molte
definizioni possono essere dedotte leggendo gli standard WMS (vediOPOPEN-GEOSPATIAL-CONSORTIUM
:ref:‘literature_and_web). Qui seguono alcune definizioni utili:

• Proprietà del server

– Versione WMS — La versione WMS supportata dal server.

– Formati immagine — Elenco dei tipi MIME che il server può fornire per disegnare la mappa. QGIS
permette l’utilizzo di qualunque formato sia supportato dalle librerie Qt contro le quali è compilato,
che sono solitamente almeno image/png ed image/jpeg.

– Interroga formati — L’elenco dei tipi MIME con i quali il server può fornire risposta quando si usa
lo strumento Informazioni elementi. Attualmente QGIS supporta il tipo text-plain.

• Propertà layer

– Selezionato — Indica se il layer era selezionato quando il server è stato aggiunto al progetto.

– Visibilità — Indica se il layer è stato impostato come visibile in legenda. (funzione non ancora
utilizzata in questa versione di QGIS.)

– Può interrogare —Indica se il layer fornisce o meno informazioni se si usa lo strumento Informazioni
elementi.

– Può essere trasparente — Indica se il layer può essere o meno reso trasparente a video. Questa
versione di QGIS farà sempre uso della trasparenza se questa voce visualizza‘‘ Sì‘‘ e se il formato
immagine la supporta

– Può ingrandire — Indica se il layer può o meno essere ingrandito dal server. Questa versione di
QGIS suppone che tutti i layer WMS abbiano questa opzione settata su ‘‘Sì ‘‘. Layers carenti in
questa impostazione potrebbero essere resi a video in modo anomalo.

– Conteggio a cascata — I server WMS possono fungere da proxy per altri server WMS dai quali
ottengono i dati raster per un certo layer. La voce mostra quindi quante richieste per questo layer
vengono inoltrate ai nodi per ottenere un risultato.

– Larghezza fissa, Altezza fissa — Indica se il layer ha o meno una dimensione del pixel fissata alla
sorgente. Questa versione di QGIS assume che tutti i layer WMS abbiano vuota questa voce. Layers
con impostazioni diverse potrebbero essere resi a video in modo anomalo.
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– Perimetro WGS 84 — Estensione del layer in coordinate WGS84. Alcuni server WMS non settano
questo parametro correttamente (ad es. usano coordinate UTM invece di WGS84). In questo caso
sembrerà che la vista iniziale del layer sia ad uno zoom molto ridotto. Bisognerebbe informare
di questi errori il webmaster del server WMS, il quale li dovrebbe identificare come elementi WMS
XML LatLonBoundingBox, EX_GeographicBoundingBox o SR:84 BoundingBox.

– Disponibilità in CRS — Sistemi di riferimento nel quale il layer può essere rappresentato dal server
WMS, elencati nel formato nativo WMS.

– Disponibile in stile — Stili visuali applicabili al layer dal server WMS.

Limitazioni del client WMS

Non tutte le possibili funzionalità WMS sono state incluse in questa versione di QGIS. Le eccezioni più rilevanti
sono le seguenti.

Modificare le impostazioni del layer WMS

Una volta completata la procedura mostrata dalla finestra Aggiungi layer WMS, non è più possibile modificarne
i parametri. Una possibile soluzione è quella di eliminare il layer completamente e ricaricarlo reimpostando i
parametri.

Server WMS che richiedono un’autenticazione

Attualmente sono accessibili server pubblici e server protetti. È possibile accedere ai server protetti con autenti-
cazione pubblica. Opzionalmente è possibile inserire le proprie credenziali. Si veda Sezione Selezionare un server
WMS per i dettagli.

Suggerimento: Accesso ai layer OCG protetti
Qualora fosse necessario accedere a layer protetti con password, è possibile usare InteProxy come proxy traspar-
ente, che supporta molti metodi di autenticazione. Ulteriori informazioni sono fornite dal manuale di InteProxy al
sito web http://inteproxy.wald.intevation.org.

Suggerimento: WMS Mapserver QGIS
A partire dalla versione 1.7.0, in QGIS è stato implementato un server WMS 1.3.0. Ulteriori informazioni nel
Capitolo QGIS Server.

13.1.3 Client WFS e WFS-T

In QGIS, un layer WFS si comporta come un qualsiasi altro layer vettoriale. È possibile identificare, selezionare
elementi e visualizzare la tabella attributi. A partire da QGIS 1.6.0 è, inoltre, possibile editare il layer se il server
lo supporta (WFS-T).

Normalmente la procedura per l’aggiunta di un layer WFS è molto simile a quella vista per i WMS. La differenza
sta nel fatto che non vi sono server predefiniti, di conseguenza è necessario aggiungere manualmente quelli noti.

Caricare un layer WFS

Come esempio è possibile caricare il server WFS DM Solutions e mostrare un layer. L’indirizzo da inserire è:
http://www2.dmsolutions.ca/cgi-bin/mswfs_gmap

1. Cliccare sullo strumento Aggiungi layer WFS nella barra dei layer ed apparirà la finsetra di dialogo Aggiungi
layer WFS da server

2. Cliccare su [Nuovo]

3. Inserire il nome ‘DM Solutions’

4. Inserire l’indirizzo precedentemente indicato
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5. Cliccare su [OK]

6. Selezionare Connessione server DM Solutions dal menù a tendina

7. Cliccare su [Connetti]

8. Attendere la ricezione dell’elenco dei layer

9. Selezionare dalla lista il layer Parks

10. Cliccare su [Applica] per aggiungere il layer alla mappa

Si noti che i settaggi del proxy impostati nelle preferenze vengono riconosciuti.

Figura 13.3: Adding a WFS layer

Si noti che l’avanzamento della ricezione dei dati viene visualizzato nella parte inferiore sinistra della finestra
principale di QGIS. Quando il layer è caricato, è possibile identificare e selezionare alcuni elementi e visualizzare
la tabella attributi.

Questo significa che attualmente è supportato solo WFS 1.0.0. Al momento non vi sono stati ancora molti test
relativi a versioni di WFS basate su altri server. In caso di problemi con il plugin, non esitare a contattare il team
di sviluppo. Si veda la sezione Le Mailing list per ulteriori informazioni sulle mailinglist.

Suggerimento: Cercare server WFS
È possibile ricercare ulteriori server WFS tramite Google o altro motore di ricerca preferito. Ci sono anche diversi
elenchi di URL pubblici, alcuni dei quali aggiornati e altri non più manutenuti.

13.2 QGIS Server

QGIS Server è un’implementazione WMS 1.3 open source con caratteristiche molto avanzate per la produzione
di carte tematiche. QGIS Server è un’applicazione FastCGI/CGI (Common Gateway Interface) scritta in C++ e
lavora in accoppiata ad un server web (es. Apache, Lighttpd). QGIS Server è supportato dai progetti europei
Orchestra e Sany e dalla città di Uster in Svizzera.

Utilizza QGIS come backend per la restituzione delle mappe e per le operazioni gis. Inoltre viene usata la libreria
Qt per la grafica e per la piattaforma indipendente di programmazione C++. A differenza di altri server WMS,
QGIS Server usa regole cartografiche come linguaggio di configurazione, sia per la configurazione a livello server
che per le configurazioni utente.

Inoltre, QGIS Server mette a disposizione il plugin ‘Pubblica sul web’ che permette di esportare un progetto di
QGIS desktop in un progetto web per QGIS Server, con i layer e i simboli prescelti (con regole di visualizzazione
cartografica espresse in SLD).
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Dato che QGIS desktop e QGIS Server usano le stesse librerie, le mappe pubblicate sul web hanno la stessa
visualizzazione di quelle in locale. Il plugin Pubblica sul Web, al momento, supporta una simbolizzazione di
base, mentre per visualizzazioni cartografiche più complesse, è necessario configurare le regole manualmente.
Dato che la consfigurazione si basa sulle specifiche dello standard SLD e sue estensioni c’è solo un linguaggio da
apprendere, cosa che semplifica enormemente l’operazione complessa di creare mappe per il web.

In uno dei prossimi manuali sarà fornito un esempio per configurare un server QGIS. Per adesso si raccomanda la
lettura dei materiali disponibili ad uno dei seguenti URL:

• http://karlinapp.ethz.ch/qgis_wms/

• http://hub.qgis.org/projects/quantum-gis/wiki/QGIS_Server_Tutorial

• http://linfiniti.com/2010/08/qgis-mapserver-a-wms-server-for-the-masses/

13.2.1 Installazione di esempio su Debian Squeeze

Di seguito è brevemente descritta un’installazione di esempio su Debian Squeeze. Anche molti altri OS hanno
pacchetti precompilati per QGIS Server. Se si ha necessità di compilare da codice sorgente, riferirsi agli indirizzi
web appena citati.

Oltre a qgis e qgis-mapserver, è necessario avere installato un server web, come ad esempio apache2. È possibile
installare tutti i pacchetti necessari, e relative dipendenze, con aptitude o apt-get install. Dopo l’installazione
bisogna verificare il corretto funzionamento del server web e di qgis server. Assicurarsi che apache sia stato
avviato con /etc/init.d/apache2 start, aprire un browser ed andare su URL: http://localhost:
se tutto è correttamente configurato dovrebbe apparire il messaggio ’It works!’.

Passare quindi a testare l’installazione di QGIS server. Il file qgis_mapserv.fcgi, disponibile in
/usr/lib/cgi-bin/qgis_mapserv.fcgi fornisce un WMS standard con visualizzati i confini dell’Alas-
ka. Caricare il WMS in QGIS con l’URL ‘‘http://localhost/cgi-bin/qgis_mapserv.fcgi ‘‘, così come descritto nella
Sezione Selezionare un server WMS.

Figura 13.4: Standard WMS with USA boundaries included in the qgis server (KDE)

13.2.2 Creare un WMS/WFS da un progetto QGIS

Per offrire un servizio WMS/WFS si parte dalla creazione di un progetto QGIS contenente alcuni dati: come es-
empio verranno utilizzati gli shapefile ’regions’ e ’airport’ da qgis_sample_dataset. Caricare in QGIS gli shapefile
e definirne colori, stili e SR.
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Figura 13.5: Definitions for a qgis project WMS/WFS server (KDE)

Aprire la scheda WMS Server sotto Impostazioni → Proprietà progetto e definire i campi generali con ‘Ser-
vice Capabilities’. Per le WMS Capabilities definire le ‘Restrizioni dei sistemi di coordinate’ e l’ ‘Es-

tensione pubblicata’. Inoltre è possibile attivare la casella di controllo Aggiungi geometria WKT alle in-
formazioni di risposta dell’oggetto se si vuole rendere il layer interrogabile. Per WFS Capabilities è
semplicemente necessario selezionare i layer che si intendono caricare come WFS. Salvare la sessione in un
file di progetto alaska.qgs. Per rendere disponibile il progetto come WMS/WFSTo, creare una cartella in
/usr/lib/cgi-bin/project con privilegi di amministratore e aggiungere il file di progetto alaska.qgs
e una copia del file qgis_mapserv.fcgi.

Ora non resta che testare i progetti WMS e WFS; aggiungere il WMS e il WFS come descritto nella sezione in
Caricare layer WMS e Client WFS e WFS-T . L’URL è:

http://localhost/cgi-bin/project/qgis_mapserv.fcgi
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CAPITOLO 14

Lavorare con i dati GPS

14.1 Plugin GPS

14.1.1 Cos’è un GPS?

Il sistema di posizionamento globale GPS è basato sui satelliti, che permettono a chiunque sia dotato di un rice-
vitore GPS, di individuare esattamente la sua posizione in qualunque zona del mondo. Il GPS è utilizzato come
strumento di aiuto nella navigazione, per esempio negli aereoplani, nelle navi e anche dagli escursionisti. Il rice-
vitore GPS sfrutta il segnale dei satelliti per calcolare latitudine, longitudine e (qualche volta) l’altitudine. Alcuni
ricevitori possono memorizzare la posizione (chiamata waypoints), la sequanza di posizioni che costituiscono una
route e una traccia o track dei movimenti che il ricevitore ha effettuato nel tempo. Waypoints, routes, e tracks
sono le tre caratteristiche di base dei dati GPS. QGIS visualizza le posizioni come layer di punti, mentre i percorsi
e le tracce sono visualizzati come layer di linee.

14.1.2 Caricamento dei dati GPS da file

Ci sono una dozzina di formati di file diversi per memorizzare dati GPS. Il formato utilizzato da QGIS è chiamato
GPX (GPs eXchange format), il quale è un formato standard di interscambio che puo contenere svariati numeri di
posizioni, percorsi e tracce nello stesso file.

Per caricare un file GPX è necessario installare il plugin Plugins → Gestione Plugin... aprendo la finestra di

dialogo Gestione Plugin. Spuntare la casella Strumenti GPS. Quando il plugin è installato verranno visualizzati
nella barra degli strumenti due pulsanti che rappresentano dei piccoli palamari GPS. Un esempio di file GPX
è disponibile nel dataset campione qgis_sample_data/gps/national_monuments.gpx vedi sezione
Dati campione per maggiori informazioni sul dataset campione:

• Creazione di un nuovo layer GPX

• Strumenti GPS

Per lavorare con i dati GPS viene formito un file GPX di esempio disponibile nel dataset di QGIS:
file:qgis_sample_data/gps/national_monuments.gpx. Vedi sezione Dati campione per maggiori informazioni sul
data set.

1. Cliccando sull’icona Strumenti GPS verrà aperta la finestra Carica file GPX (vedi figure_GPS_1).

2. Navigare all’interno della cartella qgis_sample_data/gps/, selezionare il file GPX
national_monuments.gpx e cliccare [Apri].

Utilizzare [Browse...] il pulsante per selezionare il file GPX, e poi utilizzare le caselle per selezionare il tipo di
dati che si desidera caricare dal file GPX. Ogni tipo di dato sarà caricato in layer separati quando viene premuto il
pulsante [OK]. Il file national_monuments.gpx include solamente le posizioni dei punti.

Nota: Il dispositivo GPS permette di immagazzinare i dati in diversi sistemi di coordinate. Quando viene
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Figura 14.1: The GPS Tools dialog window

scaricato un file GPX (dal dispositivo GPS o da un sito web) e successivamente viene caricato in Quantum
GIS, è necessario assicurarsi che i dati immagazzinati nel file GPX siano proiettati nel sistema WGS84 (lat-
itudine/longitudine). Questo è quello che si aspetta Quantum GIS ed è la specifica ufficiale dei dati GPX.
Vedere://www.topografix.com/GPX/1/1/

14.1.3 GPSBabel

Dal momento che QGIS utilizza i file GPX è necessario convertire gli altri formati GPS nel formato GPX. Questo
puo essere fatto per un gran numero di formati utilizzando il software gratuito GPSBabel, che è disponibile al sito
http://www.gpsbabel.org. Questo software è in grado inoltre di trasferire dati GPS tra il computer e il disposi-
tivo GPS. QGIS utilizza GPSBabel per eseguire queste operazioni, perciò è raccomandato installare il software.
Tuttavia, se si desidera solamente caricare dati GPS da un file GPX già esistente, non sarà necessario utilizzare il
software. La versione 1.2.3 di GPSBabel lavora bene con QGIS, ma si dovrebbe lavorare senza problemi anche
con le versioni precedenti.

14.1.4 Importare dati GPS

Per importare dati GPS da un file che non ha l’estensione GPX, si utilizza lo strumento Importa altri file nella
finestra Strumenti GPS. Qui è possibile selezionare il file (e il tipo di file), le caratteristiche che si desiderano
importare dal file stesso., dove si desidera salvare il file GPX convertito e rinominare il nuovo layer che verrà
generato. Da notare che alcuni formati di dati GPS non supportano tutte e tre le tipologie di dati, così per alcuni
formati sarà opportuno scegliere tra uno o due tipologie di dati.

14.1.5 Scaricare dati GPS da un dispositivo

QGIS utilizza GPSBabel per scaricare dati da un dispositivo GPS, e caricarli direttamente come nuovi layer
vettoriali. Per questo si utilizza Scarica dal GPS strumento presente nella finestra di dialogo Strumenti GPS
(vedi Figure_GPS_2). Qui, è possibile selezionare il tipo di dispositivo GPS, la porta alla quale il dispositivo è
connesso (o la porta USB se il GPS supporta questa opzione), il tipo di dati che si desidera scaricare, il file GPX
che contiene i dati da scaricare, e il nome del nuovo layer.

GPSBabel comunica con il GPS in base al tipo di dispositivo che viene selezionato nel menu. Se nessuna delle
opzioni disponibili è compatibile con il proprio dispositivo GPS è possibile creare un nuovo tipo (vedi sezione
definisci-nuovo-dispositivo).

La porta potrebbe essere sia il nome del file o qualche altro nome che il sistema operativo del proprio computer
riconosce come porta fisica alla quale è connesso il dispositivo GPS. Questo potrebbe essere semplicemente il
nome di una porta usb, nel caso di dispositivi abilitati per l’usb.

• Nei sistemi Linux è qualcosa di simile a /dev/ttyS0 or /dev/ttyS1

• Su Windows è simile a COM1 or COM2.

Quando si clicca su [OK] i dati saranno scaricati dal dispositivo e appariranno come nuovi layer in QGIS.
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Figura 14.2: The download tool

14.1.6 Caricare dati GPS sul dispositivo

C’è anche la possibilità di caricare dati vettoriali da QGIS al dispositivo GPS utilizzando lo strumento Carica
su GPS presente sempre nella finestra di dialogo Strumenti GPS. Per effettuare questa operazione è necessario
semplicemente selzionare il layer che si desidera caricare (che deve essere un layer GPX), il dispositivo GPS
utilizzato, e la porta (o l’usb) alla quale il dispositivo è collegato. Come per lo scaricamento dei dati, anche per il
caricamento è possible specificare un nuovo tipo di dispositivo se tra quelli della lista non è presente quello che si
sta utilizzando.

Questo strumento è molto utile in combinazione con le capacità di editing dei dati vettoriali di QGIS. Permette di
cariacare una mappa, creare delle posizioni o dei percorsi, e successivamente caricare questi dati nel dispositivo
per poi utilizzarli in campagna.

14.1.7 Definire un nuovo tipo di dispositivo

Ci sono molteplici tipologie di dispositivi GPS. Gli sviluppatori non possono programmare tutti i dispositivi,
perciò se si ha un dispositivo che non è presente nel menu a tendina delle finiestre Scarica dal GPS e Carica su
GPS, è possibile configurare personalmente il proprio dispositivo. Per fare questo è possibile utilizzare l’editor
dei dispositivi GPS, che si avvia cliccando sul bottone [Modifica periferiche] sia nella finestra di download che
in quella di upload.

Per definire un nuovo dispositivo è necessario semplicemente cliccare il pulsante [New device], inserire il nome,
il comando di download e di upload del dispositivo, e cliccare il pulsante [Update device]. Il nome sarà inserito
nella lista delle periferiche GPS sia nella finesta di download che nella finestra di upload e potrà essere selezionato.
Il comando di download è il comando che viene utilizzato per scaricare i dati dal dispositivo come file GPX.
Questo solitamente sarà un comando di GPSBabel, ma è possibile utilizzare altre strighe di comando con le quali
è possibile creare un file GPX. QGIS rimpiazzerà i tasti %type, %in, e %out quando il comando verrà lanciato.

%type sarà interpretato come -w se si stanno scaricando dei waypoints, -r se si stanno scaricando delle routes e
-t se si stanno scaricando dei trcks. Questi sono dei comandi opzionali con i quali è possibile dire a GPSBabel
quali tipologie di file GPS si deisdera scaricare.

%in indica il nome della porta selezionata nella finestra di download mentre %out indica il nome del file GPX nel
quale verranno salvati i dati. Dunque quando viene creato un nuovo dispositivo il seguente comando di download
gpsbabel %type -i garmin -o gpx %in %out (questo è il comando di download per la tipologia di
dispositivi predefiniti ‘Garmin serial’) verrà utilizzato per scaricare waypoints dalla porta /dev/ttyS0 all’in-
terno del file GPX output.gpx, QGIS leggerà la stringa e avvierà il comando gpsbabel -w -i garmin
-o gpx /dev/ttyS0 output.gpx.

Il comando di upload è il comando che viene utilizzato per caricare dati sul dispositivo. Vengono utilizzati i stessi
tasti, ma %in è utilizzato per indicare il nome del file GPX che contiene il layer in caricamento, e %out viene
sostituito dal nome della porta.

E’ possibile avere più informazioni su GPSBabel e sulle opzioni di comando disponibili al sito
http://www.gpsbabel.org.
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Una volta che è stato creato un nuovo dispositivo apparirà nel menù lista dei dispositivi sia nello strumento di
downloads che nello strumento di upload.

14.2 Tracciamento live GPS

Per attivare il tracciamento live del GPS tramite QGIS è necessario selezionare Settings → Informazioni GPS.
Si aprirà una finestra ancorata nella parte sinistra del video.

Ci sono 4 possibili schermate nella finestra di tracciamento GPS:

• Posizione coordinate GPS ed inserimento manuale di vertici e caratteristiche.

• Potenza del segnale di connessione del GPS ai satelliti.

• Schermata delle coordinate polari del GPS che mostrano la posizione dei satelliti.

• Opzioni di visualizzazione GPS (vedi figura_gps_options).

Con un ricevitore GPS collegato(deve essere supportato dal sistema operativo) e con un semplice click su [Con-
netti] il GPS viene collegato a QGIS. Con un secondo click (stavolta [Disconnetti]) il GPS viene disconnesso
dal computer. Per i sistemi GNU/Linux il supporto gpsd è integrato nel sistema di connessione di molti ricevitori
GPS. Perciò è necessario per prima cosa configurare le proprietà di gpsd per connettere il GPS al computer.

Avvertimento: Se si desidera registrare la propria posizione nello schermo è necessario creare un nuovo layer
vettoriale ed entrare nella modalità di editing in modo da registrare il percorso.

14.2.1 Posizione e attributi aggiuntivi

Nel momento in cui il GPS sta ricevendo il segnale dei satelliti è possibile visualizzarne la propria posizione
in termini di latitudine longitudine e quota, insieme ad altri attributi aggiuntivi.

Figura 14.3: GPS tracking position and additional attributes

14.2.2 Potenza del segnale GPS

Con questa schermata è possibile vedere la potenza del seganale dei satelliti dai quali si sta ricevendo il
segnale.

122 Capitolo 14. Lavorare con i dati GPS



QGIS User Guide, Release 1.8

Figura 14.4: GPS tracking signal strength

14.2.3 Finestra delle coordinate polari del GPS

Se si desidera visualizzare la posizione dei satelliti nel cielo, è necessario passare alla visualizzazione polare.
E’ possibile anche vedere il numero identificativo ID dei satelliti dai cui il ricevitore sta ricevendo il segnale.

Figura 14.5: GPS tracking polar window

14.2.4 Opzioni GPS

Nel caso di problemi di connessione, è possibile passare a:

• Autodetect

• Internal,

• Serial device

• gpsd (selzionare l’Host la Porta ai quali è connseeo il dispositivo GPS).

Cliccare nuovamente [Connect] per iniziare la connessione al ricevitore GPS.

You can activate Automatically save added features when you are in editing mode. Or you can can activate

Automatically add points to the map canvas with a certain width and color.

Una volta attivata Cursor è possibile utilizzare un dispositivo di scottimento per ridurre
o aumentare la posizione del cursore nello schermo.

Attivando Map centering è possibile decidere in che modo la schermata dovrà essere aggiornata. Questo
include ‘always’, ‘when leaving’ se le coordinate registrate escono fuori dall’estensione della schermata, o ‘never’
se rientrano nell’estensione della mappa.

Infine è possibile attivare Log file e definire un percorso e un file dove registrare i messaggi a riguardo del
tracciamento GPS.
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Figura 14.6: GPS tracking options window

Se si desidera impostare delle caratteristiche manuali è necessario tornare indietro Position e cliccare su [Add
Point] or [Add track point].
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CAPITOLO 15

Integrazione con GRASS GIS

Il plugin GRASS consente l’accesso ai dati e alle funzioni di GRASS GIS (vedi GRASS-PROJECT Literature
and Web References) , inclusa la visualizzazione di layer raster e vettoriali, la digitalizzazione di layer vettoriali, la
modifica degli attributi, la creazione di nuovi vettori e l’analisi di dati GRASS 2D e 3D tramite più di 300 moduli
GRASS.

Questa sezione contiene un’introduzione sulle funzionalità del plugin e qualche esempio sulla gestione e l’utilizzo
di dati GRASS. Quando viene abilitato il plugin GRASS, come descritto alla Sezione Avviare il plugin GRASS, le
seguenti funzionalità sono disponibili nella barra degli strumenti GRASS:

• Apri mapset

• Nuovo mapset

• Chiudi mapset

• Aggiungi vettore GRASS

• Aggiungi raster GRASS

• Crea nuovo vettore GRASS

• Modifica vettore GRASS

• Apri strumenti GRASS

• Visualizza la regione di GRASS attuale

• Modifica la regione di GRASS attuale

15.1 Avviare il plugin GRASS

Per usare le funzioni GRASS e/o visualizzare layer raster e vettoriali in formato GRASS in QGIS, bisogna prima

selezionare e caricare il plugin GRASS con il gestore di plugin. Cliccare su Plugins → Gestione plugins,

selezionare GRASS e cliccare su [OK].

Ora è possibile caricare layer raster e vettoriali da una LOCATION GRASS esistente (sezione Caricare layer
raster e vettoriali GRASS).È anche possibile creare una nuova LOCATION GRASS in QGIS (sezione Creare una
nuova LOCATION GRASS) e importarci dati raster e vettoriali (sezione Importare dati nelle LOCATION GRASS)
per ulteriori analisi con gli strumenti GRASS (sezione Gli strumenti GRASS).
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15.2 Caricare layer raster e vettoriali GRASS

Con il plugin GRASS, possono essere caricati layer raster o vettoriali usando il pulsante appropriato nella barra
strumenti. Come esempio si consideri il set di dati Alaska (Sezione Dati campione) che contiene una LOCATION
GRASS campione contenente tre layer vettoriali e una mappa di altitudine raster.

1. Creare una nuova cartella grassdata, nella quale scaricare il set di dati Alaska denominato
qgis_sample_data.zip dall’indirizzo web http://download.osgeo.org/qgis/data/ e decomprimere il
file nella cartella grassdata.

2. Avviare QGIS

3. If not already done in a previous QGIS session, load the GRASS plugin clicking on Plugins → Manage

Plugins and activate GRASS. The GRASS toolbar appears in the QGIS main window.

4. Nella barra degli strumenti GRASS, cliccare sull’icona Apri mapset per aprire la finestra Scegli
mapset GRASS.

5. Alla voce Gisdbase inserire il’indirizzo completo o navigare fino alla cartella grassdata appena creata.

6. Dovrebbe ora essere possibile selezionare la LOCATION alaska e il MAPSET demo.

7. Cliccare su [OK]. Si noti che ora alcuni degli strumenti precedentemente disabilitati sono divenuti attivi.

8. Cliccare su Aggiungi raster GRASS, scegliere la mappa denominata gtopo30 e cliccare su [OK]. Verrà
visualizzato il layer delle quote del terreno.

9. Cliccare su Aggiungi vettore GRASS, selezionare la mappa denominata alaska e cliccare su [OK]. Il con-
fine Alaska verrà sovrapposto alla mappa gtopo30. Ora è possibile adattare le proprietà del layer come
descritto nel capitolo Proprietà dei layer vettoriali, ovvero cambiare la trasparenza, il colore di riempimento
e del contorno dell’elemento.

10. Caricare anche gli altri due layer vettoriali denominati rivers e airports e modificarne le proprietà.

As you see, it is very simple to load GRASS raster and vector layers in QGIS. See following sections for editing
GRASS data and creating a new LOCATION. More sample GRASS LOCATIONs are available at the GRASS
website at http://grass.osgeo.org/download/data.php.

Suggerimento: Caricare dati GRASS
Se si presentano problemi nel caricare dati o QGIS termina inaspettatamente, assicurarsi di aver caricato il plugin
GRASS correttamente come descritto alla Sezione Avviare il plugin GRASS.

15.3 LOCATION e MAPSET in GRASS

GRASS organizza i propri dati in cartelle alle quali si fa riferimento con la denominazione GISDBASE. Queste
cartelle, spesso chiamate grassdata, devono essere create prima di iniziare a lavorare con il plugin GRASS
in QGIS. In queste directory, i dati GRASS sono organizzati per progetti inseriti in sottocartelle chiamate
LOCATION. Ogni LOCATION è definita da un sistema di coordinate, da una proiezione e dall’estensione ge-
ografica. La LOCATION può avere a sua volta molte sottocartelle denominate MAPSET usate per suddividere il
progetto in diversi argomenti, sottoregioni o spazi di lavoro per i diversi membri del team che vi sta lavorando
(Neteler & Mitasova 2008 Literature and Web References). Per analizzare layer raster e vettoriali con i mod-
uli GRASS, bisogna importarli in una LOCATION GRASS (tuttavia con i moduli di GRASS r.external e
v.external è possibile creare dei collegamenti a database supportati da GDAL/OGR senza doverli importare.
Questa funzione non è consigliabile a chi si sta avvicinando a GRASS e non verrà descritta di seguito).
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Figura 15.1: GRASS data in the alaska LOCATION

15.3.1 Creare una nuova LOCATION GRASS

Per questo e per tutti i successivi esempi riguardanti GRASS GIS verrà usata la LOCATION alaska campione,
nel sistema di riferimento Albers Equal Area, unità di misura in metri e creata dal set di dati campione di QGIS.
Sarà utile scaricare ed installare il set di dati sul proprio computer (Dati campione).

1. Avviare QGIS e assicurarsi che il plugin GRASS sia caricato

2. Visualizzare lo shapefile alaska.shp (sezione Caricare uno shapefile) dal dataseti di dati alaska Dati
campione.

3. Nella barra strumenti GRASS, cliccare sull’icona Nuovo mapset per avviare la procedura guidata.

4. Selezionare la cartella contenente il database GRASS (GISDBASE) denominata grassdata o crearne una
nuova in cui ospitare la nuova LOCATION usando il gestore di file installato sul proprio computer. Cliccare
su [Next].

5. Per creare un nuovo MAPSET in una LOCATION esistente (sezione Aggiungere un nuovo
MAPSET) o per creare una nuova LOCATION, selezionare l’opzione Crea nuova location (figura
figure_grass_location_2).

6. Inserire il nome della LOCATION - nell’esempio abbiamo usato alaska e cliccare su [Next].

7. Definire la proiezione cliccando sull’opzione Proiezione per abilitare l’elenco delle proiezioni.

8. Scegliere la proiezione Albers Equal Area Alaska (feet). Siccome ne conosciamo l’identificativo EPSG
2964, inserirlo nella casella di ricerca. (Nota: se si vuole ripetere il processo per un’altra LOCATION e non

si è memorizzato l’identificativo EPSG della proiezione, cliccare sull’icona Stato SR a destra della barra
di stato (sezione Lavorare con le proiezioni)).

9. Cliccare su Trova e inserire 2964 per selezionare la proiezione.

10. Cliccare su [Next].

11. Per definire l’estensione della regione predefinita, bisogna inserire i limiti della LOCATION verso nord, sud,
est e ovest. Nel nostro esempio cliccare semplicemente sul pulsante Imposta estensione attuale di QGIS, per
applicare l’estensione del layer caricato alaska.shp come estensione predefinita della regione GRASS.

12. Cliccare su [Next].

13. Abbiamo anche bisogno di definire un MAPSET interno alla LOCATION. Il nome è a scelta, nell’esem-
pio abbiamo usato demo. Quando si crea una nuova LOCATION, GRASS crea automaticamente un
MAPSET speciale chiamato PERMANENT designato a contenere i dati di base del progetto, l’estensione

15.3. LOCATION e MAPSET in GRASS 127



QGIS User Guide, Release 1.8

spaziale predefinita e la definizione del sistema di coordinate (Neteler & Mitasova 2008 Literature and Web
References)

14. Controllare il riassunto per assicurarsi che le impostazioni siano corrette e cliccare su [Finish].

15. La nuova LOCATION alaska e i MAPSETs demo e PERMANENT vengono creati. Il set di lavoro
impostato per il lavoro corrente è il MAPSETs demo.

16. Si noti che alcuni strumenti della barra di GRASS precedentemente disabilitati sono ora attivi.

Figura 15.2: Creating a new GRASS LOCATION or a new MAPSET in QGIS

Per quanto possa sembrare lunga, questa procedura costituisce un modo veloce per creare una LOCATION. La
LOCATION alaska è ora pronta per l’importazione dei dati (sezione Importare dati nelle LOCATION GRASS).
È possibile usare dati raster e vettoriali della LOCATION alaska del set di dati QGIS alaska (Dati campione) e
procedere alla sezione Il modello dati vettoriale di GRASS.

15.3.2 Aggiungere un nuovo MAPSET

Ogni utente ha accesso in scrittura solo ai MAPSET GRASS che ha creato. Ciò implica che oltre ad accedere
ai propri MAPSET, l’utente può anche leggere i dati contenuti nei MAPSET creati da altri, ma può modificare o
rimuovere solo i dati nei suoi MAPSET.

Tutti i MAPSET includono un file denominato WIND nel quale sono memorizzate le coordinate dei limiti della
regione e la risoluzione spaziale impostata per i raster (Neteler & Mitasova 2008 Literature and Web References,
sezione Lo strumento Regione di GRASS)).

1. Avviare QGIS e assicurarsi che il plugin GRASS sia caricato

2. Nella barra degli strumenti GRASS, cliccare sull’icona Nuovo mapset per avviare la procedura guidata di
creazione del MAPSET.

3. Selezionare la cartella GRASS (GISDBASE) grassdata con il nome LOCATION alaska, nel quale si
vuole aggiungere un ulteriore MAPSET, che chiameremo test.

4. Cliccare su [Next].

5. Con questa procedura possiamo creare un nuovo MAPSET all’interno di una LOCATION esistente e creare
anche una nuova LOCATION contemporaneamento. Cliccare sull’opzione Selezionare location (figura
figure_grass_location_2) e cliccare su [Next].

6. Inserire il nome text per il nuovo MAPSET. Più in basso nella finestra è visibile una lista di MAPSETs
esistenti e i relativi proprietari.
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7. Cliccare su [Next], controllare il riassunto per assicurarsi che le impostazioni siano corrette e cliccare su
[Finish].

15.4 Importare dati nelle LOCATION GRASS

Questa Sezione fornisce un esempio su come importare dati raster e vettoriali nella LOCATION GRASS alaska
fornita dal set di dati QGIS alaska. Verrà usata la mappa raster dell’uso del suolo landcover.img e il file
vettoriale GML lakes.gml.

1. Avviare QGIS e assicurarsi che il plugin GRASS sia caricato

2. In the GRASS toolbar, click the Open MAPSET icon to bring up the MAPSET wizard.

3. Select as GRASS database the folder grassdata in the QGIS alaska dataset, as LOCATION alaska,
as MAPSET demo and click [OK].

4. Cliccare ora sullo strumento Apri strumenti GRASS. Apparirà la finestra degli strumenti di GRASS (sezione
Gli strumenti GRASS).

5. Per importare la mappa raster landcover.img, cliccare sul modulo r.in.gdal nella scheda Albero
moduli. Questo modulo GRASS consente l’importazione di file supportati da GDAL in una LOCATION
GRASS. Apparirà la finestra di dialogo del modulo r.in.gdal.

6. Navigare nella cartella raster nel set di dati QGIS alaska e selezionare il file landcover.img.

7. Come nome del raster in uscita inserire landcover_grass e cliccare su [Esegui]. Nel-
la scheda Output è possibile verificare l’avanzamento del comando GRASS r.in.gdal -o
input=/path/to/landcover.img output=landcover_grass.

8. Quando compare la dicitura Operazione conclusa con successo cliccare sul pulsante [Visualizza output].
Il layer raster landcover_grass è ora importato in GRASS e verrà visualizzato nella vista mappa di
QGIS.

9. Per importare il vettore lakes.gml, usare il modulo v.in.ogr nella scheda Albero moduli. Questo
modulo GRASS consente di importare i formati vettoriali supportati da OGR in una LOCATION GRASS.
Apparirà la finestra di dialogo v.in.ogr.

10. Navigare alla cartella gml nel set di dati QGIS alaska e selezionare il file lakes.gml come file OGR.

11. Come nome del vettore in uscita inserire lakes_grass e cliccare su [Esegui].In questo esempio è possi-
bile trascurare altre opzioni. Nella scheda Output è possibile verificare l’avanzamento del comando GRASS
v.in.ogr -o dsn=/path/to/lakes.gml output=lakes_grass.

12. Quando compare la dicitura Operazione conclusa con successo cliccare sul pulsante [Visualizza output].
Il layer vettoriale lakes_grass è ora importato in GRASS e verrà visualizzato nella vista mappa di
QGIS.

15.5 Il modello dati vettoriale di GRASS

È importante comprendere il modello dati vettoriale di GRASS, per gestire nella maniera ottimale le attività di
digitalizzazione.

In generale, GRASS usa un modello dati vettoriale topologico.

Questo significa che le aree non sono rappresentate con poligoni chiusi singoli, ma da uno o più contorni (bound-
ary). Un contorno tra due aree adiacenti è digitalizzato una sola volta e condiviso da entrambe le aree. Perché
un’area sia topologicamente corretta, i contorni devono essere connessi senza soluzione di continuità. Un’area è
identificata (ed etichettata) dal suo centroide.

Oltre a contorni e centroidi, una mappa vettoriale può contenere anche punti e linee. Tutti questi elementi possono
essere compresenti in un singolo layer vettoriale e saranno rappresentati con ’livelli’ differenti in una mappa
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vettoriale GRASS. Quindi in GRASS con ’layer’ non s’intende una mappa raster o vettoriale bensì un livello
all’interno di un dato vettoriale. Questa è una distinzione molto importante da tenere presente (Sebbene sia
possibile mescolare elementi geometrici di diverso tipo (punti, linee, contorni e centroidi), ciò è abbastanza insolito
e perfino in GRASS viene usato solo in casi speciali come ad es. quando si esegue l’analisi di una rete vettoriale.
Di solito è preferibile che elementi geometrici diversi vengano digitalizzati su file distinti).

È possibile salvare più ’livelli’ in un set di dati vettoriale. Per esempio campi, foreste e laghi possono essere salvati
in un vettore. Foreste e laghi adiacenti possono condividere lo stesso contorno, ma avranno tabelle degli attributi
distinte. È anche possibile assegnare attributi ai contorni. Ad esempio se il contorno tra un lago ed una foresta è
una strada, questa può avere una diversa tabella degli attributi.

Il livello di un elemento è definito layer in GRASS. Layer è il numero che indica se c’è più di un gruppo geometrico
nel set di dati vettoriale, ad es. se la geometria è foresta o lago. Attualmente tale indice può essere solo un numero,
in versioni di GRASS successive saranno supportati anche stringhe di testo.

Gli attributi degli elementi geometrici possono essere memorizzati nella LOCATION GRASS in formato DBase o
SQLITE3 o in database esterni come PostgreSQL, MySQL, Oracle, ecc.

Gli attributi contenuti nelle tabelle del database sono collegati alla geometria per il tramite di un valore ’category’.

’Category’ (key, ID) è un valore intero collegato alle primitive geometriche ed è usato come collegamento ad una
colonna chiave nella tabella del database.

Suggerimento: Conoscere il modello dati vettoriale di GRASS
Il miglior modo per capire il modello dati vettoriale di GRASS e le sue capacità è quello di scaricare una
delle molte guide (tutorial) di GRASS nelle quali tale modello è descritto più approfonditamente. Si veda
http://grass.osgeo.org/gdp/manuals.php per informazioni, libri e guide in diverse lingue.

15.6 Creare un nuovo layer vettoriale GRASS

Per creare un nuovo layer vettoriale GRASS tramite il plugin GRASS cliccare sullo strumento
Crea un nuovo vettore GRASS. Inserire un nome nella casella di testo e iniziare la digitalizzazione di punti, linee o
poligoni, seguendo la procedura descritta alla sezione Digitalizzare e modificare layer vettoriali GRASS.

In GRASS è possibile gestire ogni tipo di geometria (punti, linee ed aree) in un singolo layer, in quanto viene imp-
iegato un modello dati vettoriale topologico; di conseguenza non è necessario definire a priori il tipo di geometria
che si intende utilizzare per un nuovo vettore. In questo il modello dati di GRASS si differenzia ad esempio dal
formato shapefile di QGIS, che usa un modello vettoriale denominato Simple Feature (sezione Creare nuovi layer
vettoriali).

Suggerimento: Creare una tabella attributi per un nuovo layer vettoriale GRASS
Se si desidera assegnare attributi alla geometria digitalizzata, accertarsi di definire lo schema della tabella prima
di iniziare a digitalizzare (figura figure_grass_digitizing_5).

15.7 Digitalizzare e modificare layer vettoriali GRASS

Gli strumenti di digitalizzazione per i layer vettoriali GRASS sono accessibili con l’icona|grass_edit|
Modifica vettore GRASS nella barra degli strumenti GRASS. Assicurarsi di caricare un vettoriale GRASS e che esso sia
selezionato nella legenda prima di attivare lo strumento di digitalizzazione. La figura figure_grass_digitizing_2
mostra la finestra di dialogo degli strumenti di digitalizzazione GRASS che viene mostrata quando si clicca sullo
strumento di modifica. Gli strumenti e le impostazioni di questa barra saranno discussi nelle sezioni seguenti.

Suggerimento: Digitalizzare poligoni in GRASS
Per creare poligoni in GRASS, bisogna iniziare con il digitalizzarne i contorni, impostando preliminarmente il
modo Nessuna categoria. Una volta chiuso il poligono, aggiungere un centroide (punto dell’etichetta) all’interno
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del contorno chiuso impostando preliminarmente la modalità Prossimo non in uso. Questa procedura è necessaria
in quanto il modello di dati vettoriale topologico collega le informazioni sull’attributo del poligono sempre al
centroide e non al contorno.

Barra degli strumenti di digitalizzazione

Nella figura figure_grass_digitizing_1 sono mostrate le icone della barra degli strumenti per la dig-
italizzazione del plugin GRASS. La tabella table_grass_digitizing_1 mostra le funzioni disponibili.

Figura 15.3: GRASS Digitizing Toolbar

Icona Strumento Azione

Nuovo
punto

Digitalizza un nuovo punto

Nuova linea Digitalizza una nuova linea

Nuovo
contorno

Digitizalizza nuovo contorno (annullare selezionando un altro strumento)

Nuovo
centroide

Digitalizza un nuovo centroide (imposta l’etichetta per un’area esistente)

Sposta
vertice

Sposta un vertice di una linea o contorno esistente in una nuova posizione

Aggiungi
vertice

Aggiunge un vertice ad una linea o contorno esistente

Elimina
vertice

ancella vertici da linee e contorni esistenti (confermare l’eliminazione del vertice
selezionato cliccando una seconda volta)

Sposta
elemento

Sposta il contorno, la linea, il punto o il centroide selezionato in una nuova posizione

Dividi linea Divide una linea o un contorno in due parti nel punto selezionato

Elimina
elemento

Elimina un contorno, una linea, un punto o un centroide esistente (confermare
cliccando una seconda volta)

Modifica
attributi

Modifica gli attributi dell’elemento selezionato (si noti che ad un elemento possono
essere associati più attributi, si veda sopra)

Chiudi Chiude la sessione e salva lo stato attuale (ricostruisce la topologia)

Tabella Strumenti per la digitalizzazione in GRASS

Scheda Categoria

La scheda Category consente di definire il modo in cui i valori della categoria verranno assegnati al nuovo elemento
geometrico.

• Modalità: modalità con la quale viene assegnata la categoria (colonna cat della tabella) alle geometrie
digitalizzate.

– Prossimo non in uso - applica il primo valore non utilizzato in ordine numerico crescente.

– Inserimento manuale - definizione manuale della categoria da assegnare all’elemento.

– Nessuna categoria - non assegna alcun valore all’elemento. Questa modalità è in genere usata ad
esempio per i contorni dei poligoni ai quali la categoria viene collegata tramite il centroide.

• Categoria- Il numero (ID) inserito o visualizzato viene associato ad ogni elemento digitalizzato. Viene
usato per collegare ogni elemento geometrico ai relativi attributi.
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Figura 15.4: GRASS Digitizing Category Tab

• Layer - Ogni elemento geometrico può essere collegato con molteplici tabelle attributo usando diversi livelli
(“layer”) secondo il modello GRASS: il numero del layer predefinito è 1.

Suggerimento: Creare un livello GRASS aggiuntivo con QGIS
Se si vogliono aggiungere ulteriori livelli al set di dati, inserire semplicemente un numero nel campo ‘Layer’ e
dare invio. Nella scheda Tabella sarà a questo punto possibile creare il nuovo schema degli attributi da associare a
questo livello.

Scheda Preferenze

La scheda Preferenze consente di impostare la tolleranza per l’aggancio automatico tra elementi (snapping) in
pixels dello schermo. La soglia definisce a quale distanza massima nuovi punti o linee sono agganciati ad altri
nodi esistenti. Ciò aiuta ad evitare interruzioni o incroci tra contorni. Il valore preimpostato è 10 pixels.

Figura 15.5: GRASS Digitizing Settings Tab

Scheda Simbologia

La scheda Simbologia consente di visualizzare e impostare la simbologia e i colori dei vari tipi geometrici nei vari
stati topologici (ad es. contorni aperti/chiusi).

Scheda Tabella

La scheda Tabella‘fornisce informazioni sulla struttura della tabella per un determinato livello. È possibile ag-
giungere nuove colonne ad una tabella attributi esistente o creare un nuovo schema tabella per un nuovo layer
vettoriale GRASS o per un nuovo livello (sezione :ref:‘creating_new_grass_vectors).

Suggerimento: Permessi di modifica in GRASS
È necessario essere il proprietario del MAPSET GRASS che si vuole editare. Non è possibile modificare dati in un
MAPSET del quale non si è proprietari, anche se si possiedono su di esso permessi in scrittura.
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Figura 15.6: GRASS Digitizing Symbolog Tab

Figura 15.7: GRASS Digitizing Table Tab

15.8 Lo strumento Regione di GRASS

L’impostazione di una regione (ovvero di una porzione di spazio geografico nella quale operare) è molto impor-
tante in GRASS, specialmente quando si lavora con dati raster. L’analisi vettoriale non è limitata all’impostazione
della regione ma interessa tutta l’estensione del layer. Tutti i raster di nuova creazione avranno l’estensione e la
risoluzione spaziale della regione GRASS definita, indipendentemente dalla loro estensione e risoluzione orig-
inale. L’impostazione corrente della regione GRASS è salvata nel file $LOCATION/$MAPSET/WIND che ne
definisce i limiti nord, sud est e ovest, il numero di righe e colonne e la risoluzione spaziale in senso orizzontale e
verticale.

È possibile abilitare/disabilitare la visualizzazione della regione di GRASS nella vista mappa in QGIS usando il

pulsante Visualizza la regione di GRSS attuale.

Con lo strumento Modifica la regione di GRAS attuale è possibile aprire una finestra di dialogo per cambiare le im-
postazioni correnti della regione e la simbologia con la quale il rettangolo che la rappresenta viene visualizzato
nella vista mappa di QGIS. Inserire i nuovi limiti della regione e la risoluzione e cliccare su [OK] . Lo strumento
consente anche di selezionare l’estensione della regione interattivamente con il mouse nella vista mappa di QGIS.
Cliccando con il tasto sinistro del mouse nella vista mappa si imposta il primo angolo del rettangolo che definirà
la regione e cliccando in un altro punto lo si chiuderà: cliccare su [OK] per confermare.

Il modulo GRASS g.region mette a disposizione molti più parametri per definire l’estensione della regione e la
risoluzione con la quale si vuole condurre l’analisi raster. Si possono usare questi parametri tramite lo strumento
GRASS appropriato Gli strumenti GRASS.
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15.9 Gli strumenti GRASS

Cliccando su Apri strumenti GRASS si ha accesso alle funzionalità dei moduli GRASS con i quali lavorare nella
LOCATION e nel MAPSET impostati. Per usare gli strumenti di GRASS è necessario aprire una LOCATION e un
MAPSET sui quali si abbiano permessi di scrittura (in genere concessi se si è l’utente che ha creato il MAPSET).
Ciò è necessario in quanto i nuovi layer raster o vettoriali creati durante l’analisi devono poter essere scritti nella
LOCATION e nel MAPSET selezionati.

Figura 15.8: GRASS Toolbox and Module Tree

La shell di GRASS fornisce accesso a praticamente tutti gli oltre 330 moduli GRASS in modalità riga di comando.
Per offrire un ambiente di lavoro maggiormente user-friendly, circa 200 di questi moduli e loro relative funzionalità
sono presentati in finestre di dialogo. Questi moduli sono raggruppati in blocchi tematici: è disponibile una
funzione di ricerca.

15.9.1 Lavorare con i moduli GRASS

La shell di GRASS fornisce accesso a praticamente tutti gli oltre 300 moduli GRASS in modalità riga di comando.
Per offrire un ambiente di lavoro maggiormente user-friendly, circa 200 di questi moduli e loro relative funzionalità
sono presentati in finestre di dialogo. Questi moduli sono raggruppati in blocchi tematici: è disponibile una
funzione di ricerca.

È possibile trovare la lista completa dei moduli GRASS accessibili tramite l’interfaccia grafica di QGIS nel wiki
di GRASS: http://grass.osgeo.org/wiki/GRASS-QGIS_relevant_module_list.

È possibile personalizzare il contenuto della finestra di dialogo degli strumenti GRASS: la procedura è descritta
nella sezione Personalizzare gli strumenti GRASS.

Come mostrato in figura figure_grass_toolbox_1 , è possibile ricercare il modulo GRASS desiderato per aree
tematiche nella scheda Albero moduli o nella scheda Lista moduli che permette la ricerca per parola chiave.

Clicking on a graphical module icon a new tab will be added to the toolbox dialog providing three new sub-tabs
Options, Output and Manual.

Opzioni

La scheda Opzioni fornisce una finestra semplificata nel quale di solito è possibile selezionare un layer raster o
vettoriale ed inserire ulteriori opzioni specifiche per l’esecuzione del modulo.

Per mantenere la leggibilità della finestra non sempre sono presenti tutte le opzioni: qualora si volessero usare
ulteriori parametri per il modulo è necessario avviare la shell di GRASS ed eseguire il modulo dalla riga di
comando.
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Figura 15.9: GRASS Toolbox Module Options

Una nuova caratteristica di QGIS 1.8.0 è il supporto per un pulsante Mostra le opzioni avanzate nella scheda
Opzioni della finestra di dialogo semplificata di un modulo. Al momento tale funzionalità è disponibile per pochi
moduli, ma probabilmente sarà estesa ad altri moduli nelle prossime versioni di QGIS. Ciò permetterà di sfruttare
appieno le potenzialità dei moduli di GRASS senza dover usare la shell.

Output

The Output tab provides information about the output status of the module. When you click the [Run] button, the
module switches to the Output tab and you see information about the analysis process. If all works well, you will
finally see a Successfully finished message.

Manuale

La scheda Manuale mostra la pagina di aiuto in formato HTML del modulo GRASS scelto: permette di verificare
la disponibilità di ulteriori parametri o ottenere una conoscenza più approfondita delle operazioni che il modulo
può eseguire. Alla fine di ogni pagina di manuale vi sono ulteriori collegamenti al Main Help index, al
Thematic index o al Full index. Questi link forniscono le stesse informazioni che si avrebbero usando il
modulo g.manual.

Suggerimento: Mostrare i risultati immediatamente
Se si desidera visualizzare il risultato di un’analisi immediatamente nella vista mappa, è possibile cliccare sul
pulsante Visualizza Output nella porzione inferiore della scheda.

15.9.2 Esempi di utilizzo di moduli GRASS

Gli esempi che seguono mostrano le potenzialità di alcuni moduli GRASS.
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Figura 15.10: GRASS Toolbox Module Output

Figura 15.11: GRASS Toolbox Module Manual
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Creare curve di livello

Come primo esempio, deriviamo le curve di livello a partire da un modello digitale di elevazione (DEM): si assume
che la LOCATION Alaska sia impostata come descritto nella sezione Importare dati nelle LOCATION GRASS.

• Aprire la ’location’ Alaska cliccando su Apri mapset .

• Caricare il DEM gtopo30 cliccando su Aggiungi raster GRASS e selezionare gtopo30 dal mapset demo.

• Aprire gli strumenti GRASS con Apri strumenti GRASS.

• Nell’albero dei moduli cliccare su Raster → Gestione superficie → Genera curve di livello vettoriali.

• Cliccando su r.contour si aprirà la finstra di dialogo dello strumento com spiegato in Lavorare con i moduli
GRASS. Il raster gtopo30 dovrebbe apparire in Nome della mappa raster in input.

• Inserire in Incrementa fra le isoipse il valore 100. (per creare curve di livello ad intervalli di 100
metri)

• Inserire in Nome del vettoriale in output il nome ctour_100.

• Cliccare su [Esegui] ed attendere fino alla comparsa del messaggio Operazione conclusa con
successo: quindi cliccare su [Visualizza] risultato e su [Chiudi].

Dal momento che la regione è pittosto estesa, il comando richiede del tempo. Una volta terminata l’operazione è
possibile modificare le proprietà del nuovo layer vettoriale come descritto in Proprietà dei layer vettoriali.

Ingrandendo una porzione della mappa in un’area più montagnosa si potrà notare come le curve di livello appaiano
spigolose. In GRASS è disponibile il modulo v.generalize per alterare leggermente un vettore senza modificarne
la forma generale: il modulo utilizza diversi algoritmi, ognuno per uno scopo specifico. Alcuni algoritmi (es.
Douglas Peuker e Vertex reduction) semplificano una linea rimuovendo alcuni vertici: il risultato sarà più veloce
da caricare. Tale tipo di algoritmo è ad esempio molto utile nel caso in cui si abbia una mappa vettoriale molto
dettagliata, ma si sta lavorando ad una scala molto piccola per cui tanto dettaglio non è necessario.

Suggerimento: Semplifica geometrie
Si noti che lo strumento Semplifica geometrie di fTools opera allo stesso modo dell’algoritmo Douglas-Peuker di
v.generalize.

Ad ogni modo, lo scopo dell’esempio è diverso: le curve di livello create con r.contour hanno angoli molto
acuti che devono essere smussati. Tra gli algoritmi di v.generalize Chaikens (o anche Hermite splines) fa al caso
nostro. Si noti che l’algoritmo potrebbe aggiungere dei vertici, rendendo il caricamento della mappa ancora più
lento.

• Aprire gli strumenti di GRASS e lanciare il modulo Vettore → Elabora mappa → Generalizzazione e
cliccare su v.generalize.

• Controllare che ‘ctour_100’ appaia come Nome della mappa vettoriale in input.

• Scegliere Chaiken’s come algoritmo di generalizzazione ed inserire il Nome del vettoriale in output
‘ctour_100_smooth’ e cliccare su [Esegui].

• Il processo richiederà un po’ di tempo. Una volta che viene visualizzato Operazione conclusa con
successo, cliccare su [Visualizza output] e poi su [Chiudi].

• È possibile modificare il colore del layer vettoriale in modo da renderlo ben visibile sul raster si sfondo. Si
potrà notare come le curve di livello ora appaiano meno spigolose.

Suggerimento: Altri usi di r.contour
La procedura appena descritta può essere usata in situazioni equivalenti. Se si ha un raster delle precipitazioni, ad
esempio, si può usare r.contour per derivare le isoiete (curve a precipitazione costante).
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Figura 15.12: GRASS module v.generalize to smooth a vector map

Creare un rilievo ombreggiato con effetto 3D

Ci sono diversi modi per visualizzare dati di elevazione e dare un effetto 3D alla vista. L’uso delle curve di
livello è uno dei metodi più utilizzato, sopratutto nella produzione di mappe topografiche. Un altro modo consiste
nell’utilizzare l’ombreggiatura. L’ombra viene derivata da un DEM, calcolando prima pendenze ed orientamento,
poi simulando la posizione del sole nel cielo per assegnare un valore di riflettanza per ogni cella del raster: in tal
modo le pendenze in ombra saranno più scure di quelle esposte al sole.

• Caricare il raster gtopo30, aprire gli strumenti di GRASS e lanciare il modulo Analisi spaziali → Analisi
geomorfologica.

• Cliccare r.shaded.relief per aprire il modulo.

• Impostare l’azimuth da 270 a 315.

• Inserire gtopo30_shade per il nuovo raster delle ombreggiature e cliccare su [Esegui].

• Quando il processo sarà completato, aggiungere il raster ombreggiatura alla vista mappa.

• Il nuovo raster verrà visualizzato in scala di grigi: per vedere contemporaneamente l’ombreggiatura ed i
colori di gtopo30, portare gtopo30_shade sotto gtopo30 nella legenda, quindi aprire le Proprietà
di gtopo30, andare nella scheda Trasparenza ed impostare il livello di trasparenza al 25%.

Si dovrebbe vedere gtopo30 sopra la mappa di ombreggiatura in scala di grigi. Per riuscire a visualizzare
appieno gli effetti dell’ombreggiatura, deselezionare gtopo30_shade.

Usare la shell di GRASS

Il plugin GRASS è orientato principalmente agli utenti che non conoscono GRASS ed i suoi moduli, con relative
opzione, per cui molti moduli non mostrano tutte le possibili opzione ed altri non sono affatto presenti. La shell
di GRASS consente di accedere ai moduli che non appaiono nell’interfaccia grafica ed alle opzioni aggiuntive di
quelli che invece ci sono. Il seguente esempio mostra l’uso di un’opzione del modulo r.shaded.relief.

The module r.shaded.relief can take a parameter zmult which multiplies the elevation values relative to the X-Y
coordinate units so that the hillshade effect is even more pronounced.

• Caricare gtopo30 ed aprire la shell di GRASS. Nella shell scrivere il comando r.shaded.relief
map=gtopo30 shade=gtopo30_shade2 azimuth=315 zmult=3 e premere [invio].
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Figura 15.13: The GRASS shell, r.shaded.relief module

• Quando il comando ha terminato, spostarsi nella scheda Browse della finestra di dialogo degli strumenti
GRASS e fare doppio click sul nuovo raster gtopo30_shade2 per visualizzarlo in QGIS.

• Impostare le proprietà del raster così come descritto in precedenza. L’effetto 3D dovrebbe apparire più
pronunciato rispetto alla mappa creata in precedenza.

Figura 15.14: Displaying shaded relief created with the GRASS module r.shaded.relief

Statistiche raster in una mappa vettoriale

Il prossimo esempio tratta di un modulo GRASS che può aggregare dati raster ed aggiungere colonne di statistiche
per ogni poligono di una mappa vettoriale.

• Importare in GRASS lo shapefile trees nella cartella shapefiles Importare dati nelle LOCATION
GRASS.

• Prima di proseguire bisogna aggiungere i centroidi ai poligoni per farne delle aree vettoriali secondo il
modello dati di GRASS.
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• Aprire gli strumenti di GRASS e lanciare il modulo Vettore → Gestisci elementi, e aprire il modulo
v.centroids.

• Inserire come Nome del vettoriale in output ‘forest_areas’ e lanciare il modulo.

• Caricare‘‘forest_areas‘‘ e visualizzare le categorie - deciduous, evergreen, mixed - con colori differenti.

Aprire le Proprietà del layer, andare nella scheda Stile, scegliere Stile ‘Categorizzato’ e impostare
‘VEGDESC’ come campo di classificazione. (sezione sec_symbology).

• Aprire il modulo Vettore → Aggiornamento di un vettore da altre mappe.

• Cliccare su v.rast.stats per aprire il modulo e inserire gtopo30 e forest_areas.

• Inserire column prefix elev, e cliccare su [Esegui]: l’operazione potrebbe durare molto tempo.

• Aprire la tabella degli attributi di forest_areas e verificare come sianto state aggiunte diverse nuove
colonne, come ad esempio elev_min, elev_max, elev_mean per ogni tipo di poligono.

15.9.3 Lavorare con il browser delle LOCATION GRASS

Un’altra utile funzione tra quelle presenti negli strumenti GRASS è il browser delle LOCATION. In figura
figure_grass_module_7 è possibile vedere un esempio che mostra la LOCATION impostata e i relativi MAPSETs.

Nella parte sinistra della finestra del browser si può navigare attraverso tutti i MAPSETs contenuti nella
LOCATION impostata. La porzione di destra mostra invece alcuni metadati del raster o del vettoriale selezionato,
come la risoluzione, l’estensione spaziale, la fonte del dato, il percorso alla tabella attributi associata per i dati
vettoriali e lo storico comandi che ha generato quel dato.

Figura 15.15: GRASS LOCATION browser

La barra degli strumenti nella scheda Browser offre i seguenti strumenti per la gestione della LOCATION:

• Aggiungi la mappa selezionata all’area di lavoro

• Copia la mappa selezionata

• Rinomina la mappa selezionata

• Elimina la mappa selezionata
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• Imposta la regione corrente con la mappa selezionata

• Aggiorna

Gli strumenti Rinomina la mappa selezionata e Elimina la mappa selezionata funzionano solo su mappe
contenute nel MAPSET attivo. Tutti gli altri strumenti funzionano anche con layer raster e vettoriali di altri
MAPSET.

15.9.4 Personalizzare gli strumenti GRASS

Praticamente tutti i moduli GRASS possono essere aggiunti nella finestra di dialogo degli strumenti GRASS. Per
incorporare i file XML di configurazione dei moduli è fornita un’interfaccia XML nella quale è possibile definire
l’aspetto del modulo e i parametri da visualizzare nella finestra di dialogo degli strumenti.

Un esempio di file XML che genera il modulo v.buffer (v.buffer.qgm) ha il seguente aspetto:

<?xml version="1.0" encoding="UTF-8"?>
<!DOCTYPE qgisgrassmodule SYSTEM "http://mrcc.com/qgisgrassmodule.dtd">

<qgisgrassmodule label="Vector buffer" module="v.buffer">
<option key="input" typeoption="type" layeroption="layer" />
<option key="buffer"/>
<option key="output" />

</qgisgrassmodule>

Il parser legge questa definizione e crea una nuova scheda nella finestra di dialogo degli strumenti GRASS
quando si seleziona il modulo. Informazioni più dettagliate su come aggiungere moduli, cambiare i grup-
pi di moduli ecc. sono reperibile sul Wiki di QGIS all’indirizzo http://hub.qgis.org/projects/quantum-
gis/wiki/Adding_New_Tools_to_the_GRASS_Toolbox
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CAPITOLO 16

OpenStreetMap

Il progetto OpenStreetMap (OSM) si sta ampiamente diffondendo, sopratutto in quei paesi dove non si hanno a
disposizione dati geografici liberi. L’obiettivo di OSM è la creazione di una mappa aggiornabile e libera del mondo
a partire da dati GPS, foto aeree e conoscenza locale. Per supportare tale obiettivo, QGIS mette a disposizione un
plugin che permette di lavorare con i dati OSM.

Il plugin offre le principali funzionalità per la manipolazione dei dati OSM; download/upload dei dati, salvataggio,
modifica. Nell’implementare il plugin, il team di sviluppo ha preso ispirazione dagli editor di dati OSM esistenti,
nell’obiettivo di combinare le loro funzionalità in un unico prodotto.

La sezione seguente, fornisce una breve introduzione ai principi del progetto OSM.

Parti del paragrafo che segue sono riprese dal sito web di OpenStreetMap: http://www.openstreetmap.org
<http://www.openstreetmap.org>.

16.1 Il progetto OpenStreetMap

L’obiettivo di OSM è la creazione di una mappa aggiornabile e libera del mondo a partire da dati GPS, foto aeree
e conoscenza locale. Il progetto è stato iniziato perché molti dati geografici hanno restrizioni legali e tecniche, che
impediscono il loro utilizzo in maniera creativa e produttiva. I dati di OSM e le immagini da esse derivate sono,
invece, disponibili sotto la licenza Creative Commons Attribution ShareAlike 2.0.

OpenStreetMap si è ispirato a progetti tipo Wikipedia: la mappa di OSM (Figura Figure_OpenStreetMap_1 )
mostra una ben visibile scheda Edit e viene mantenuto lo storico di tutte le modifiche effettuate. Gli utenti registrati
possono caricare track GPS ed editare dati vettoriali utilizzando gli editor disponibili.

La ’primitiva dati’ di OSM è una classe oggetto che può essere memorizzata via API nel server. I tre tipi di dati
supportati sono: Node (nodo), Way (via) e Relation (relazione).

• Un nodo è una coppia latitudine/longitudine di coordinate: è il punto di partenza per la costruzione di tutti
gli altri elementi ed è un elemento esso stesso (POI - Point of Interest).

• Una via è un elenco di almeno due nodi che descrivono un elemento lineare, es. una strada. I nodi possono
essere parte di più ’vie’.

• Una relazione è un gruppo di zero o più primitive con ruoli associati. È usata per specificare il rapporto tra
oggetti e per modellare un oggetto astratto.

Queste primitive sono usate per definire diversi elementi logici di una mappa (’Point Of Interest’, ’Street’, ’Tram
Line’, ’Bus Stop’ etc.). Gli elementi di mappa sono ben noti nella comunità OSM e sono memorizzati tramite
etichette basate su una chiave ed un valore. I dati OSM sono solitamente distribuiti in formato XML, che è usato
anche per la comunizazione con i server OSM.
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Figura 16.1: OpenStreetMap data in the web

16.2 QGIS - Connessione a OSM

La prima parte di questa sezione descrive come le primitive OSM sono visualizzate QGIS. Come precedentemente
descritto, i dati OSM consistono di ’node’, ’way’ e ’relation’. In QGIS le tre primitive vengono visualizzate con
differenti tipi di layer: punti, linee, poligoni. Non è possibile rimuovere uno di questi layer e lavorare con i
rimanenti.

• Un layer di punti visualizza i soli elementi di tipo ’node’ che non sono parte di ’way’.

• Un layer di linee visualizza gli elementi di tipo ’way’ non chiusi (a formare poligoni): nessuna delle ’way’
inizia e finisce nello stesso ’node’.

• Un layer di poligoni visualizza tutte le ’way’ non incluse nel layer di linee, cioè le linee chiuse.

In aggiunta alle tre primitive OSM appena descLe Relation non sono visualizzate come layer vettoriale in quanto
servono a definire le connessioni tra le altre primitive dati: dopo che un punto/linea/poligono è individuato sulla
mappa, il plugin mostra un elenco delle relazioni di cui l’elemento è parte.

Ha richiesto un notevole impegno tentare di collegare i dati OSM con gli strumenti di modifica standard di QGIS.
Tali strumenti sono fatti per modificare un singolo layer alla volta, a prescindere dal tipo di elemento: ciò significa
che se i dati OSM venissero caricati in QGIS tramite il plugin, sarebbe teoricamente possibile modificare i layer
di punti, di linee, di poligoni separatamente con gli strumenti standard.

Un layer di linee consiste di due diversi tipi di elementi OSM, ’node’ e ’way’. Nel formato OSM, una ’way’ è
composta di ’node’; se si modifica un layer di linee, ad esempio cambiando la forma di qualche elemento, tale
azione influenza anche i ’node’ che sono parte dello stesso.

Gli strumenti di modifica standard di QGIS non sono in grado di gestire tale tipo di relazioni e inviare correttamente
le modifiche alla banca dati OSM. Il layer di linee non tiene traccia di quali ’node’ sono parte di quale ’way’: lo
stesso problema si ha con i layer di poligoni.

Per tale ragione, il plugin OSM necessita dei propri strumenti di modifica, tramite i quali le modifiche ai layer
OSM vengono gestiti correttamente. Gli strumenti di modifica del plugin permettono di creare/muovere/eliminare
punti, linee, poligoni, relazioni.
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Nota: Nota: Per creare una connessione tra il plugin OSM e gli strumenti di modifica standard di QGIS, sarebbero
necessarie modifiche a livello di codice.

16.3 Installazione

Il plugin OpenStreetMap è un plugin core di QGIS. Se il supporto a python è abilitato, il plugin può essere attivato
nel gestore di plugin, come descritto nella Sezione Abilitare un Plugin Core.

16.4 Interfaccia utente di base

In seguito all’attivazione del plugin OSM, ed al caricamento di alcuni dati, nel menu delle barra degli stru-
menti di QGIS appaiono diverse icone OSM, insieme alla nuova componente grafica mostrata in Figura
figure_OpenStreetMap_2.

Figura 16.2: OSM plugin user interface

16.4.1 Pannello Elemento OSM

Il pannello Elemento OSM consente di identificare gli elementi OSM, fornendo informazioni sul tipo di elemento,
sul suo identificatore, su chi l’ha modificato e quando: in esso sono, inoltre, presenti tutti gli strumenti di modifica,
di seguito descritti. Il pannello è inizialmente disabilitato: viene abilitato al caricamento di dati OSM.

16.4.2 Pannello Storico modifiche OSM

Il pannello ’Storico modifiche OSM’ permette di annullare/ripristinare le modifiche più recenti. Oltre ai pulsanti
classici di annulla/ripristina, mostra una lista con una breve descrizione delle operazioni di modifica più recenti.
Il pannello, inizialmente nascosto, può essere attivato con l’apposito pulsante del pannello Elemento OSM.
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16.4.3 Icone nel menu della barra degli strumenti

Load OSM from file permette di caricare dati da file OSM in XML.

Show/Hide OSM Feature Manager permette di visualizzare/nascondere l’Elemento OSM. L’ Elemento OSM è un
pannello che aiuta ad identificare e modificare gli elementi OSM.

Download OSM data per scaricare dati dai server di OpenStreetMap.

Upload OSM data permette di salvare le modifiche ai dati correnti.

Import data from a layer permette di importare dati da layer vettoriali: è necessario caricare almeno un layer vettoriale
e selezionare alcuni dati OSM.

Save OSM to file permette di salvare dati OSM in un file XML.

Informazioni più dettagliate sui vari elementi, comandi e maschere di dialogo, possono essere rinvenute nelle
relative sezioni di questo capitolo, in relazione alla loro funzione (modifica, identificazione, ecc..).

16.5 Caricare dati OSM

La prima azione dopo aver lanciato il plugin consiste nell’aprire alcuni dati da un file OSM: i dati OSM possono
essere importati come shapefile o scaricati dai server di OSM. Qui di seguito ci si riferisce alla prima modalità.

Per caricare dati da un file utilizzare l’icona Load OSM from file: se l’icona non è visualizzata, il plugin potrebbe
essere stato disabilitato durante l’installazione di QGIS. Abilitarlo da Visualizza→ Barre degli strumenti →
OpenStreetMap.

Figura 16.3: Load OSM data dialog

La funzione dei suoi elementi è spiegata di seguito.

File OpenStreetMap da caricare:Cliccare sul pulsante per selezionare il file .‘.osm‘ da cui si vogliono
caricare i dati.

Aggiungi colonne per i tag: permette di creare una connessione tra OSM e QGIS. Ogni elemento OSM ha alcune
etichette (coppia chiave-valore) che ne definiscono le proprietà: anche ogni elemento di un layer vettoriale di
QGIS ha i propri attributi (chiave-valore). Con questa opzione è possibile definire quali proprietà degli oggetti
OSM devono essere visibili quando si visualizzano le informazioni dell’elemento QGIS.
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Sostituisci i dati in uso: attivando l’opzione, i nuovi dati sostituiscono quelli su cui l’utente stava precedentemente
lavorando. Se si sta caricando dati OSM per la prima volta, l’opzione non è attiva.

Usa un visualizzatore personalizzato: consente di determinare quanti dettagli della mappa visualizzare (si può
scegliere tra Small scale, Medium scale, Large scale). Usare Small scale per visualizzare il massimo dei dettagli
e compiere delle modifiche ai dati. QGIS 1.8.0 non supporta il cambiamento dinamico del visualizzatore.

Cliccare su [OK] per caricare i dati: l’operazione potrebbe richiedere alcuni minuti nel caso il file fosse caricato
per la prima volta.

16.6 Visualizzare dati OSM

Una volta caricati i dati è possibile ottenere informazioni sui vari elementi tramite l’icona Informazioni elemento nel
pannello Elemento OSM. In questo modo è possibile esplorare facilmente tutte gli oggetti sulla mappa. Posizio-
nando il cursore del mouse su un elemento di interesse, le informazioni relative vengono mostrate nel pannello
suddetto: nella vista mappa l’elemento risulta evidenziato. Un collegamento dinamico sulla mappa consente
inoltre all’utente di identificare facilmente l’ elemento correntemente selezionato.

La scheda Proprietà del pannello Elemento OSM contiene tutte le etichette dell’elemento: la scheda Relazioni
mostra, invece, tutte le relazioni connesse all’elemento in questione.

Si noti che allontanando il cursore del mouse dall’elemento di interesse, le relative informazioni scompaiono: clic-
cando con il tasto sinistro del mouse sull’elemento, invece, le informazioni restano visibili sino ad un successivo
click.

Spesso nel punto in cui si clicca potrebbero essere presenti più elementi, specialmente nel caso di incroci di
strade. In questa situazione, anche se sono mostrate le informazioni di un solo elemento (marcato dal collegamento
dinamico), il plugin mantiene in memoria le informazioni di tutti: E’ quindi possibile (sempre in modalità “pausa”)
scorrere le informazioni degli altri elementi con cliccando con il tasto-destro e selezionando i successivi.

16.7 Modificare dati OSM

Si intendano per “dati di base” gli elementi OSM ’node’ e ’way’ non relazionali. Per le modifiche di elementi
relazionali fare riferimento alla sezione dedicata.

La modifica dei dati di base è una delle caratteristiche sostanziali del plugin OSM. È possibile rimuo-
vere/aggiungere elementi di base, modificarne le proprietà, la posizione, la forma. Tutti i cambiamenti sono
elencati nel pannello ’Storico modifiche OSM’ e possono essere facilmente caricati sui server di OSM.

16.7.1 Cambiare l’etichetta di un elemento

Il cambiamento dell’etichetta di un elemento OSM viene fatto direttamente nella tabella delle etichette: tale
tabella si trova nel pannello Elemento OSM, ma per visualizzarla bisogna preventivamente usare lo strumento

Informazioni elemento. Ricordarsi di selezionare preventivamente l’elemento.

Per cambiare il valore di un’etichetta, fare doppio-click in una casella della colonna ’Value’ ed inserire, o se-

lezionare, il nuovo valore. Per rimuovere un’etichetta selezionarne la riga e cliccare su Remove selected tags in
fondo alla tabella sulla destra.

Per inserire una nuova etichetta, inserire chiave e valore nell’ultima riga della tabella, dove appare la scritta ‘<next
tag value>’: non è possibile cambiare la chiave di un coppia ’key/value’ esistente. Una serie di menu a tendina
permettono di selezionare tra i valori tipici di una specifica chiave.
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Figura 16.4: Changing an OSM feature tag

16.7.2 Creare punti

Per creare un nuovo punto, cliccare su Crea punto, quindi sulla mappa. Se il cursore del mouse passa sopra
qualche elemento della mappa, l’elemento viene evidenziato e le sue informazioni appaiono nel pannello Elemento
OSM; se si clicca sulla mappa quando una linea o un poligono sono evidenziati, il nuovo punto viene creato
direttamente su questi elementi e sarà, quindi, parte di essi (è attiva una funzionalità di snap). Non si può creare
un punto su un punto esistente: il plugin mostrerà il seguente messaggio:

Figura 16.5: OSM point creation message

Il meccanismo che aiuta l’utente a selezionare una linea o un poligono si chiama “snap”. Se si intende creare un
punto molto vicino ad un elemento esistente, ma non su di esso, bisogna disabilitare la funzionalità di snap: tenere
premuto Ctrl prima di cliccare sulla mappa.

16.7.3 Creare linee

Per creare una nuova linea, cliccare su Crea linea, quindi sulla mappa. Ogni click con tasto sinistro crea un
vertice della nuova linea: per terminare la creazione di una linea basta cliccare con il tasto destro.

Nota: Nota: Non è possibile creare una linea con meno di due vertici: in tal caso l’operazione viene ignorata. Se
si clicca con il tasto destro del mouse dopo un solo click con il tasto sinistro, nessuna linea viene creata.
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Lo snap è attivo su ogni vertice della mappa - punti del layer di punti e tutte le componenti delle linee e dei
poligoni. Per disattivare lo snap tenere premuto Ctrl prima di cliccare sulla mappa.

16.7.4 Creare poligoni

Per creare un nuovo poligono, cliccare su|osm_createPolygon| Create polygon, quindi sulla mappa. Ogni click con
tasto sinistro sarà un vertice del nuovo poligono: per terminare la creazione di una linea basta cliccare con il tasto
destro. Non possono essere creati poligoni con meno di tre vertici. Lo snap è attivo su ogni vertice della mappa
- punti (su un layer di punti) e su tutte le componenti delle linee e dei poligoni. Per disattivare lo snap tenere
premuto Ctrl prima di cliccare sulla mappa.

16.7.5 Spostare un elemento

Per spostare un elemento cliccare su Muovi elemento: posizionarsi nella mappa, portare il cursore del mouse sul-
l’elemento che si intende spostare, cliccare con il tasto sinistro, portare l’elemento nella nuova posizione e cliccare
di nuovo con il tasto sinistro. Nel caso si fosse selezionato l’elemento sbagliato, non effettuare il secondo click
con il tasto sinistro: cliccando con il tasto destro, l’elemento sarà automaticamente riportato nella sua posizione
originale.

Se si sposta una elemento connesso con altri elementi, le loro relazioni non saranno modificate: gli altri elementi
si autoadatteranno alla nuova posizione dell’elemento cui sono relazionati.

Anche per questa operazione è disponibile la funzionalità di snap:

• – quando si muove un punto singolo (cioè che non è parte di una linea/poligono), lo snap è attivo su tutti i
vertici ed i segmenti in mappa.

• – quando si muove un punto che è parte di una linea/poligono, lo snap è attivo su tutti i vertici ed i segmenti
in mappa, tranne i vertici degli elementi di cui il punto fa parte.

• – quando si muove una linea/poligono, lo snap è attivo su tutti i vertici in mappa. Si noti che il plugin cerca
di basare lo snap sui 3 vertici della linea/poligono da spostare più vicini al cursore del mouse, altrimenti
l’operazione sarebbe estremamente lenta. Per disattivare lo snap tenere premuto Ctrl prima di cliccare
sulla mappa.

16.7.6 Eliminare un elemento

Per eliminare un elemento selezionarlo con Informazioni elemento e cliccare su Rimuovi elemento . Rimuoven-
do una linea/poligono, vengono rimossi anche tutti i punti che ne fanno parte (ma che non fanno parte di altre
linee/poligoni).

Quando si rimuove un punto che fa parte di una linea/poligono, il punto è rimosso e la forma degli elementi cui
apparteneva si modifica: la nuova geometria avrà meno vertici della precedente.

Se il punto da eliminare fa parte di un poligono con soli tre vertici, la nuova geometria del poligono avrà due vertici;
ma siccome non possono esistere poligoni con due vertici, il tipo di elemento viene modificato automaticamente
convertito in linea.

Se il punto faceva parte di una linea con due vertici, la nuova geometria della linea avrà un solo punto. E siccome
non possono esistere linee di un solo punto, il tipo di elemento viene modificato in punto.

16.8 Modificare le relazioni

Le relazioni permettono di organizzare più elementi in gruppi ed assegnare loro proprietà comuni, in modo da
poter modellare qualsiasi oggetto di mappa: es. confini di una regione come gruppo di ’way’ (linee) e ’node’
(punti), percorsi di un bus, etc. Ogni membro di una relazione ha un suo ruolo specifico. Il plugin di QGIS offre
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un buon supporto alle relazioni OSM. Di seguito viene riportato come esaminare, creare, aggiornare o rimuovere
una relazione.

16.8.1 Esaminare una relazione

Per esaminare una relazione, selezionare prima un suo membro, quindi aprire la scheda Relazioni del pannello
Elemento OSM, dove saranno elencate tutte le relazioni di cui l’elemento è parte. Selezionare una di esse per
avere il dettaglio delle informazioni. Nella prima tabella, ’Tag relazione’, sono visualizzate le proprietà della
relazione selezionata. Nella tabella ’Membri della relazione’ sono elencati i membri della relazione, cioè tutti gli
elementi connessi dalla relazione selezionata. Cliccando su uno dei membri, lo stesso viene evidenziato in mappa.

16.8.2 Creare una relazione

Vi sono due modalità con cui è possibile creare una relazione:

1. Usare il pulsante Crea relazione del pannello Elemento OSM.

2. Usare il pulsante Aggiungi relazione nella scheda Relazioni del pannello Elemento OSM.

In entrambi i casi apparirà una finestra di dialogo. Nel secondo caso, l’elemento selezionato è automaticamente
considerato il primo membro della relazione ed il dialogo è precompilato in minima parte. Selezionare un tipo di
relazione, tra quelle predefinite e disponibili nel menu a tendina, o crearne una nuova, quindi inserire le etichette
della relazione e selezionare i suoi membri.

Una volta selezionato un tipo di relazione, cliccare su Genera i tags: nel riquadro ’Proprietà’ saranno elencate le
etichette tipiche per il tipo di relazione. Inserire i valori nella colonna ’Value’ Per inserire i membri della relazione

è possibile scrivere direttamente i loro identificatori, tipi e ruoli oppure usare il pulsante Scegli un membro sulla mappa.
Cliccare su Crea per terminare l’operazione.

Solo una volta scelto il tipo, etichetta e membro, la finestra di dialogo può ricevere conferma. Il plugin creerà
quindi una nuova relazione.

16.8.3 Modificare una relazione

Per modificare una relazione esistente, selezionarla innanzitutto come visto nella precedente sezione ’Esaminare

una relazione’, quindi cliccare su Modifica relazione. Nella finestra di dialogo Edit OSM relation è possibile
modificare le etichette, i membri o il tipo di relazione: cliccare su Save per salvare i cambiamenti.

16.9 Scaricare dati OSM

Per scaricare dati dal server di OpenStreetMap cliccare su Download OSM data. Qualora il pulsante non fosse
disponibile nell’interfaccia di QGIS, la barra degli strumenti OpenStreetMap potrebbe essere stata disattivata
durante l’installazione di QGIS. Per attivarla cliccare su: menuselection:Visualizza –> Barre degli Strumenti –
>OpenStreetMap . Apparirà quindi la finestra di dialogo Download dati OSM per fornire le seguenti funzionalità:

Estensione: permette di impostare l’area da scaricare, indicando le coordinate i gradi di latitudine e longitudine.
Prestare attenzione a non indicare un’area troppo vasta: il server di OpenStreetMap ha delle restrizioni sulla

quantità di dati scaricabili. Ulteriori informazioni sull’estensione dei dati sono disponibili cliccando su ?.

Download in: il percorso alla cartella in cui salvare i dati. Niente panico nel caso in cui non ci si ricordi la struttura

dell’.hard disk.il bottone di navigazione è pronto per aiutarvi.
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Figura 16.6: OSM download dialog

Apri i dati automaticamente una volta scaricati: permette di definire se caricare i dati non appena scaricati. Se
non si desidera caricare subito i dati disattivare l’opzione: i dati potranno essere caricati in un secondo momento

cliccando su Load OSM from file.

Sostituisci i dati in uso: l’opzione è disponibile solo se lo è anche Apri i dati automaticamente una volta
scaricati. Attivando l’opzione, i dati scaricati andranno a sostituire quelli presenti nella vista mappa di QGIS: i
layer presenti nella vista mappa saranno rimossi e sostituiti dai nuovi. Quando si avvia QGIS e si scaricano dati
OSM per la prima volta, l’opzione non è attiva, in quanto non c’è nulla da sostituire.

Usa un visualizzatore personalizzato:l’opzione è attiva solo se lo è anche Apri i dati automaticamente una
volta scaricati. Determinare quanti dettagli della mappa visualizzare (scelta tra Small scale, Medium scale, Large
scale). Usare Small scale per visualizzare il massimo dei dettagli e compiere delle operazioni di modifica. QGIS
1.8.0 non supporta il cambiamento dinamico dello stile del visualizzatore.

Cliccare su [Download] per avviare il processo di download dei dati.

Una finestra di dialogo mostra la percentuale di download. Qualora ci fossero errori, un’ulteriore finestra mostra
il tipo di errore occorso. A completamento del download, le varie finestre di chiudono automaticamente.

16.10 Caricare i dati sul server OSM

Il caricamento dei dati sul server OSM riguarda i dati visualizzati nella vista mappa di QGIS: prima di caricare i
dati assicurarsi che nella vista mappa siano visualizzati i dati corretti.

Per caricare i dati sul server OSM, cliccare su Upload OSM data. Qualora il pulsante non fosse disponibile nel-
l’interfaccia di QGIS, la barra degli strumenti OpenStreetMap potrebbe essere disattivata: per attivarla cliccare su
Visualizza → Barre degli Strumenti → OpenStreetMap. Verrà aperta la finestra di dialogo [Invia dati a OSM].

In alto nella finestra è possibile verificare la correttezza dei dati che si sta caricando. Nella tabella vengono
elencati i cambiamenti che si stanno apportando, mentre sono riportate separatamente delle statistiche per ogni
tipo di elemento.

In ’Commenti alle tue modifiche’ è possibile inserire delle informazioni aggiuntive: elencare brevemente le mod-
ifiche apportate. Compilare i campi ’Account OSM’ per l’autenticazione sul server: per creare un account OSM
visitare la pagina web http://www.openstreetmap.org <http://www.openstreetmap.org>. Infine, cliccare [Upload]
per avviare il processo di invio dei dati.
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Figura 16.7: OSM upload dialog

16.11 Salvare i dati OSM

Per salvare dati in un file XML, cliccare su Save OSM to file. Qualora il pulsante non fosse disponibile nell’in-
terfaccia di QGIS, la barra degli strumenti OpenStreetMap potrebbe essere disattivata: per attivarla cliccare su
Visualizza → Barre degli Strumenti → OpenStreetMap. Verrà aperta la finestra di dialogo [Salva OSM].

Figura 16.8: OSM saving dialog

Selezionare gli elementi da salvare come file XML, ed il file stesso cui salvarli, dopodichè cliccare su [Ok] per
avviare il processo. La versione OSM del file XML è la 0.6: gli elementi non vengono ordinati.

Si noti che verranno salvati i soli dati non solo dalla vista mappa. Linee e poligoni sono salvati interamente, anche
se sono visualizzati solo in parte: per ogni linea/poligono anche tutti i suoi vertici sono salvati.
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16.12 Importare dati in OSM

Per importare dati in OSM da un layer vettoriale non-OSM seguire le seguenti istruzioni: selezionare i dati OSM,

cliccando su uno dei layer, e cliccare su Import data from a layer. Qualora il pulsante non fosse disponibile nell’in-
terfaccia di QGIS, la barra degli strumenti OpenStreetMap potrebbe essere disattivata: Per attivarla cliccare su
Visualizza → Barre degli Strumenti → OpenStreetMap.

Potrebbe apparire la seguente finestra di dialogo:

Figura 16.9: OSM import message dialog

In questo caso la finestra informa che non sono attualmente disponibili in QGIS layer vettoriali da cui importare
dati. L’importazione può infatti avvenire solamente da layer caricati. Caricare quindi un layer vettoriale e riprovare
(ricordandosi di selezionare il layer OSM in legenda):

Figura 16.10: Import data to OSM dialog

Cliccare su [OK] per avviare il processo o su [Cancel] per annullare.
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CAPITOLO 17

SEXTANTE

17.1 Introduzione

Questo capitolo introduce SEXTANTE, la potente infrastruttura di QGIS per l’analisi geospaziale. SEXTANTE
è un ambiente di elaborazione geografica che può essere usato per richiamare algoritmi nativi o prodotti da terze
parti all’interno di QGIS, rendendo la vostra analisi spaziale maggiomrnte produttiva e facile da portare a termine.

Nelle sezioni che seguono vedremo come usare gli elementi grafici di SEXTANTE e sfruttare al massimo le loro
potenzialità

17.1.1 Elementi di base dell’interfaccia grafica di SEXTANTE

Ci sono quattro elementi fondamentali nell’interfaccia grafica di SEXTANTE che potete usare per eseguire gli
algoritmi disponibili per scopi diversi. La scelta di uno strumento o l’altro dipenderà dal tipo di analisi da eseguire
e dalle peculiaritàdi ogni progetto e ogni utente. Tutti [gli algoritmi] (ad esclusione dell’interfaccia per i processi
non interattivi che è chiamata dalla cassetta degli attrazzi, come vedremo nel seguito) possono essere selezionati
dal menu SEXTANTE (vedrete più di quattro elementi. Quelli rimanenti non servono per eseguire algoritmi e
verranno spiegati di seguito).

• La cassetta degli attrezzidi SEXTANTE. É l’elemento principale dell’interfaccia grafica di SEXTANTE, è
usata per eseguire singoli algoritmi o avviare processi non interattivi su quell’algoritmo.

Figura 17.1: SEXTANTE Toolbox

• IL modellatore grafico di SEXTANTE. Molteplici algoritmi possono essere combinati graficamente us-
ando il modellatore per definire un flusso di lavoro creando una singola procedura che contiene diversi
sottoprocessi
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Figura 17.2: SEXTANTE Models

• Il gestore della cronologia di SEXTANTE. Tutte le azioni eseguite usando uno degli elementi precedente-
mente menzionati sono salvati in un registro cronoloogico e possono essere facilmente riprodotti in qualsiasi
momento mediante questo gestore

Figura 17.3: SEXTANTE History

• Il gestore dell’interfaccia per le procedure non interattive. Questa interfaccia vi consente di eseguire processi
non interattivi e/o automatizzare l’esecuzione di un singolo algoritmo su molteplici insiemi di dati.

Nelle sezioni seguenti rivedremo in dettaglio ciascuno di questi elementi.

17.2 La cassetta degli attrezzi di SEXTANTE

17.2.1 Introduzione

La cassetta degli attrezzi (Toolbox) è l’elemento principale della interfaccia grafica di SEXTANTE e quello che
probabilmente userete quotidianamente nella vostra attività. Esso mostra la lista degli algoritmi disponibili rag-
gruppati in differenti blocchi ed è il punto di partenza per eseguire singoli processi o (batch) processi che implicano
l’esecuzione dello stesso algoritmo su diversi insiemi di dati di ingresso.
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Figura 17.4: SEXTANTE Batch Processing

Figura 17.5: SEXTANTE Toolbox
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La cassetta degli attrezzi (toolbox) contiene tutti gli algoritmi disponibili divisi in gruppi. Ogni gruppo rappresenta
un cosiddetto fornitore di algoritmi che è un insieme di algoritmi provenienti dalla stessa sorgente, ad esempio
una applicazione di terze parti con capacità di elaborazione geospaziale. Alcuni di questi gruppi presentano
algoritmi di una di queste applicazioni di terze parti (come SAGA, GRASS, o R),mentre altre contengono algoritmi
codificati direttamente con elementi di SEXTANTE. Attualmente questi gestori usano tutti codice di plugins già
esistenti di QGIS (più specificatamente della libreria vettoriale fTools distribuita con QGIS e del plugin mmqgis
che potete installare con il Plugin Manager),rendendoli più utili in quanto possono essere eseguiti da elementi
quali il modellatore o il (batch processing interface) che descriveremo fra breve.

Inoltre potete trovare due altri fornitori, precisamente ‘Modelli’ e ‘Scripts’.Questi fornitori contengono gli algorit-
mi creati dall’utente e vi consentono di definire il vostro flusso di lavoro e le attività di elaborazione. Destineremo
una sezione intera a loro fra poco.

Nella parte superiore della cassetta degli attrezzi (toolbox) trovate una casella di testo; per ridurre il numero degli
algoritmi elencati e rendere più agevole la ricerca di quello che state cercando, potete digitare una parola o una
frase nella casella; vedrete che appena digitate il numero degli algoritmi in elene si riduce solo a quelli il cui nome
contiene il testo che avete digitato.

Per eseguire un algoritmo è sufficiente cliccare due volte sul nome nella cassetta degli attrezzi (toolbox).

17.2.2 La configurazione dell’algoritmo

Eseguito il doppio click sul nome dell’algoritmo che volete eseguire, apparirà una finestra di dialogo come
quella mostrata sotto (in questo caso si tratta della finestra di dialogo corrispondente all’algoritmo “indice di
convergenza” di SAGA).

Figura 17.6: Parameters Dialog

La finestra serve a definire i valori di ingresso di cui l’algoritmo ha bisogno per la sua esecuzione. Esso mostra
una tabella dove occorre definire i valori di ingresso ed i parametri di configurazione. La finestra ovviamente ha
contenuto diverso in dipendenza delle richieste dell’algoritmo da eseguire ed è creata automaticamente in base a
queste necessità. A sinistra è indicato il nome del parametro, sulla destra il valore assegnato allo stesso.

Nonostante il numero e tipo dei parametri dipende dalle caratteristiche dell’algoritmo, la struttura è simile per
tutti. I parametri che trovate nella tabella possono essere uno dei seguenti tipi.

• Layer raster, da selezionare da una lista di quelli disponibili (correntemente aperti) in QGIS. Il selettore
contiene anche un bottone all’estremità destra per consentirvi di selezionare nomi di files relativi a layers al
momento non caricati in QGIS.
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• Layer vettoriali, da selezionare dalla lista di quelli disponibili in QGIS. Possono essere selezionati, esat-
tamente come per i layers raster, anche layers al momento non caricati inQGIS, purchè l’algoritmo non
richieda la selezione di un attributo dalla relativa tabella; in tal caso possono essere selezionati solo layers
aperti poichè la loro apertura è necessaria per disporre del nomi disponibili dei campi.

Vedrete un bottone per ogni selettore di layer; se l’algoritmo ne contiene parecchi, sarete in grado di attivarne
uno. Se il bottone di un layer è attivato l’algoritmo sarà eseguito iterativamente su ognuno degli oggetti del
layer. Vedremo meglio questo tipo di esecuzione alla fine di questa sezione.

• Tabella, da scegliere fra tutte quelle disponibili in QGIS. Tabelle contenenti dati non geografici sono caricate
in QGIS come layer vettoriali e di fatto sono trattate come tali dal programma. Attualmente l’elenco delle
tabelle disponibili visualizzato perchè richiesto dall’algoritmo diSEXTANTE che state eseguendo, si limita
a tabelle contenute in file dei formati dBase (.dbf) o Comma-Separated Values (.csv).

• Opzione, da scegliere in una lista di possibili opzioni.

• Valore numerico, da inserire nella casella di testo. Vedrete un pulsante a fianco; premendolo apparirà
una finestra di dialogo che vi permette di inserire un’espressione matematica, così potete usarlo come un
piccolo calcolatore. Potrete aggiungere alle vostre espressioni alcune opportune variabili di QGIS, questo
vi consentirà di selezionare valori provenienti da ogni variabile quali ad es. dimensioni di cella di un layer
o l’estrema coordinata settentrionale di un altro.

Figura 17.7: Number Selector

• Un intervallo con i suoi valori minimo e massimo da inserire in due caselle di testo.

• Stringa di testo, da inserire nell’apposita casella.

• Campo, da scegliere fra gli attributi di un layer vettoriale o una singola tabella selezionata con un altro
parametro.

• Sistema di Riferimento delle Coordinate (CRS). Potete digitare il codice EPSG direttamente nella casella di
testo, o selezionarlo dall’elenco che apparirà quando premete il pulsante sul lato destro

• Regione, da inserire mediante i suoi estremi xmin, xmax, ymin, ymax.Premendo il pulsante sulla destra
apparirà una finestra a discesa che vi consentirà le due possibilità di usare la regione attualmente definita
nella finestra grafica o di modificarla descrivendo un rettangolo con il mouse.

Se scegliete la prima opzione verrà mostrata una finestra come la seguente.

Se scegliete la seconda la finestra dei parametri sparirà, così da consentirvi il trascinemanto del mouse sulla
finestra grafica. Una volta selezionato il rettangolo, la finestra di dialogo riapparirà completa dei limiti della
regione appena definita.
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Figura 17.8: SEXTANTE Extent

Figura 17.9: SEXTANTE Extent List

Figura 17.10: Extent Drag
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• Lista di elementi (sia layer raster, layer vettoriali o tabelle), fra quelli disponibili in QGIS da cui selezionare.
Per eseguire la selezione premere il piccolo pulsante sul lato sinistro della riga corrispondente per far
apparire una finestra di dialogo come la seguente.

Figura 17.11: Multiple Selection

• Piccola tabella da completare a cura dell’utente. Queste sono usate per definire parametri tipo tabelle di
riferimento o [convolution kernels] adesempio.

Cliccare il bottone sul lato destro per vedere la tabella e aggiornare i suoi valori.

Figura 17.12: Fixed Table

A seconda dell’algoritmo in uso, il numero delle righe può essere modificato o no, usando i pulsanti sul lato
destro della finestra.

Troverete un pulsante di [Help] nella parte bassa della finestra di parametri. Se disponible, verrà mostrato un file
di aiutoper darvi informazioni ulteriori sugli algoritmi e descrizioni dettagliate del significato di ogni parametro.
Sfortunatamente molti algoritmi difettano di buona documentazione per cui se avete voglia di contribuire al
progetto, questo è un buon punto di partenza.

Nota sulle proiezioni

SEXTANTE — ed anche molte delle applicazioni esterne di cui SEXTANTE mette a disposizione gli algoritmi
—- non eseguono alcuna riproiezione e presumono che tutti loro siano già in un sistema di riferimento comune,
pronti per essere elaborati. Ogni volta che usate molteplici layer in ingresso, sia vettoriali che raster, è vostro
compito assicurarvi che siano nello stesso sistema di coordinate.

Fate attenzione che, a causa della capacità di riproiezione al volo di QGIS, per quanto due layer potrebbero
sovrapporsi e combaciare, questo potrebbe non essere vero se si usano i loro sistemi di riferimento originari senza
trasformarli in un sistema comune. Questa trasformazione va fatta manualmente dopo di che occorre usare il
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risultato come layer di ingresso per SEXTANTE. Ricordate che l’operazione di trasformazione può essere eseguita
in SEXTANTE che contiene gli strumenti adeguati.

17.2.3 Dati generati dagli algoritmi di SEXTANTE

I dati generati da SEXTANTE possono essere dei seguenti tipi:

• Layer raster

• Layer vettoriale

• Tabella

• File HTML (usato per risultati testuali e grafici)

Sono tutti salvati su disco (non ci sono risultati in memoria) e la tabella dei parametri contiene caselle di testo
per ognuno di essi dove potete digitare il percorso di salvataggio. Il percorso contiene le informazioni necessarie
per salvare il risultato da qualche parte. Nella maggior parte dei casi salverete in un file, però l’architettura di
SEXTANTE vi permette qualsiasi altro metodo di salvataggio; ad es. un layer vettoriale può essere salvato in un
database o inviato ad un server remoto mediante il servizio WFS-T. Benchè tali soluzioni non siano completamente
implementate, SEXTANTE è pronto per usarle e ci aspettiamo di aggiungere nuove funzionalità nel breve futuro.

Per selezionare un percorso di salvataggio premete il pulsante a destra della casella di testo. Questo aprirà una
finestra di dialogo dove potete selezionare il percorso desiderato. Le estensioni di file previste sono visualizzate
nel selettore di formato della finestra di dialogo, a seconda del tipo di risultato e di algoritmo impiegato.

Il formato del risultato è definito dall’estensione del file. I file disponibili dipendono da quelli previsti dallo stesso
algoritmo. Per selezionare un formato basta evidenziare la corrispondente estensione (o aggiungerla se state
digitando direttamente il percorso). Se l’estensione non corrisponde a nessuna di quelle previste, sarà aggiunta
una estensione prefissata (normalmente file:.dbf per le tabelle, .tif per layer raster e .shp per quelli vettoriali)
e la tabella o il layer saranno salvati nel corrispondente formato.

Se non fornite nessun nome di file, il risultato sarà salvato in un file provvisorio nel corrispondente formato; il file
sarà cancellato alla chiusura di QGIS (assicuratevi di ciò quando salvate il vostro progetto e questo contiene dei
file provvisori).

Potete definire una cartella standard per i dati in uscita. Andate nella finestra di configurazione (potete accedervi
dal menu SEXTANTE) e nel gruppo Generale troverete il parametro Cartella di uscita ; questa cartella sarà usata
come percorso predefinito ogni volta che fornite un nome di file senza percorso (ad es. mio_file.shp) ad un
algoritmo.

Oltre ai layer raster ed alle tabelle, SEXTANTE genera anche grafici e testi come file HTML. Questi risultati
sono visualizzati alla fine dell’elaborazione in a nuova finestra.Questa finestra conterrà i risultati prodotti da SEX-
TANTE nella sessione in corso e possono essere visualizzati in ogni momento selezionando dal menu SEXTANTE
→ SEXTANTE visualizzatore di risultati.

Alcune applicazioni esterne possono avere file di uscita (senza limitazioni particolari sulle estensioni), ma questi
non appartengono a nessuna delle categoria precedenti. Questi file non saranno elaborati da QGIS (aperti e/o
inclusi nel progetto corrente), perchè corrispondenti il più delle volte a formati non adatti a QGIS. Questo è, per
esempio, il caso dei file LAS usato per i dati LiDAR; i file saranno creati, ma questi non saranno visualizzati nella
vostra sessione di lavoro QGIS.

Per tutti gli altri tipi di file, avete una casella di spunta per dire a SEXTANTE se il file, una volta generato
dall’algoritmo, deve essere aperto o no; in condizioni normali tutti i file sono aperti.

SEXTANTE non gestisce i risultati in file opzionali, pertanto tutti saranno salvati su disco; ma se non siete inter-
essati ad un particolare risultato, potete lasciare vuota la sua casella di spunta in modo che si comporti come un
file opzionale (per quanto il layer è comunque creato, se lasciate la casella di testo vuota, il risultato sarà salvato
in un file provvisorio e cancellato alla chiusura di QGIS)
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17.2.4 La configurazione di SEXTANTE

Come è stato detto, il menu di configurazione dà accesso ad una nuova finestra dove potete configurare il modo di
lavorare di SEXTANTE. I parametri di configurazione sono raggruppati in blocchi che potete selezionare sul lato
sinistro della finestra.

Oltre alla già ricordata casella Cartella di uscita, il blocco Generale contiene parametri per definire le modalità
di visualizzazione dei layer di SEXTANTE (cioè i layer generati usando gli algoritmi delle varie componenti di
SEXTANTE). Dovete creare lo stile che volete usare con QGIS, salvarlo in un file ed inserire il percorso di questo
file nell’apposito parametro in modo che SEXTANTE lo usi. Ogni volta che SEXTANTE carica un layer e lo
aggiunge alla finestra grafica di QGIS, il layer sarà visualizzato con quello stile.

Gli stili di visualizazione possono essere configurati singolarmente per ogni algortimo e per ogni risultato. Basta
premere sul nome dell’algoritmo nella cassetta degli attrezzi e selezionare Modifica degli stili di restituzione ;
vedrete apparire una finestra di dialogo come la seguente.

Figura 17.13: Rendering Styles

Selezionate il file di stile (.qml) che volete assegnare ad ogni risultato e premete [OK].

Altri parametri di configurazione nel gruppo Generale sono spiegate sotto:

• Usate i nomi di file come nomi di layer. Il nome di ogni risultato creato da SEXTANTE è definito dal-
l’algoritmo che lo genera. In alcuni casi si può usare un nome fisso in modo che sarà usato lo stesso file
indipendentemente dal layer in ingresso. In altri casi il nome può dipendere dal nome del file in ingresso o
da qualche parametro usato nell’esecuzione dell’algoritmo. Se la casella di spunta è attivata, il nome sarà
preso invece dal nome del file di uscita. Attenzione che se il risultato è salvato su un file provvisorio, questo
avrà un nome lungo e senza significato apparente, questo per evitare collisioni con altri file esistenti.

• Usate solo oggetti selezionati. Se è attivata questa opzione, ogni volta che usate un layer vettoriale come
ingresso per un algoritmo, solo i suoi oggetti selezionati saranno presi in considerazione. Se il layer non ha
oggetti selezionati, verranno considerati tutti.

Oltre al blocco Generale nella finestra di dialogo, ne troverete uno per ogni gestore di algoritmi. Essi contengono
una casella Attivazione che potete usare per far apparire o meno gli algoritmi nella cassetta degli attrezzi. Inoltre
alcuni gestori di algoritmi hanno elementi specifici di configurazione che saranno spiegati successivamente quando
saranno trattati praticolari gestori.
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17.3 Il modellatore grafico di SEXTANTE

17.3.1 Introduzione

Il modellatore grafico consente di creare modelli complessi mediante un’interfaccia semplice e facile. Quando
lavorate con un GIS, molte operazioni di analisi non sono isolate, ma inserite in una catena di operazioni. Mediante
il modellatore grafico questa catena di processi può essere combinata in un solo processo; in questo modo è più
facile e conveniente eseguirlo come singolo processo invece di successivi processi basati su differenti dataset di
input. Indipendentemente dal numero di passaggi e dai differenti algoritmi coinvolti, esso è eseguito come un
singolo algoritmo, risparmiando quindi tempo e fatica, specialmente nel caso di modelli di grandi dimensioni.

Il modellatore può essere aperto dal menu SEXTANTE, ma anche dalla cassetta degli attrezzi. Nel ramo Modella-
tore dell’albero degli algoritmi troverete un gruppo denominato Attrezzi che contiene una opzione chiamata Crea
un nuovo modello.

Il modellatore ha un’area grafica di lavoro dove sono visualizzati la struttura del modello ed il flusso delle oper-
azioni che lo rappresenta. Si può usare un pannello con due riquadri sulla sinistra della finestra per aggiungere
nuovi elementi al modello.

Figura 17.14: Modeler

La creazione di un modello comporta due passaggi:

1. Definizione dei dati di ingresso necessari. Queste informazioni saranno aggiunte alla finestra dei parametri
in modo che l’utente possa configurare valori appropriati durante l’esecuzione del modello. Il modello
stesso è un algoritmo di SEXTANTE, per cui la finestra dei parametri è generata automaticamente come
accade per tutti gli algoritmi inclusi in SEXTANTE.

2. Definizione del flusso operativo. Usando i dati di ingresso configurati per il modello, il flusso è definito
aggiungendo gli algoritmi e decidendo quali fra questi dati usare o se invece usare dati prodotti da algoritmi
precedentemente inseriti nel modello.

17.3.2 Definizione dei dati di ingresso

Il primo passo per creare un modello è definire i dati in ingresso di cui necessita. Nella casella inputs alla sinistra
della finestre del modellatore si trovano questi elementi:

• Layer raster

• Layer vettoriali

• Stringhe di testo
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• Campi di tabelle

• Tabelle

• Valori numerici

• Valori logici (booleani)

Premendo due volte con il mouse su uno di questi elementi, apparirà una finestra di dialogo per definire le sue
caratteristiche. A seconda del parametro stesso, la finestra conterrà un solo elemento (la descrizione che è quello
che l’utente vede durante l’esecuzione del modello) o più elementi. Ad esempio, aggiungendo un valore numerico,
come si può vedere nella figura seguente, oltre alla descrizione del parametro, dovrete definire un valore di partenza
ed un intervallo di valori validi.

Figura 17.15: Model Parameters

Per ogni dato di ingresso aggiunto, appare un nuovo elemento nel pannello grafico del modellatore.

Figura 17.16: Model Parameters

17.3.3 Definizione del flusso operativo

Una volta definiti i dati ingresso, occorre decidere gli algoritmi da applicare ad essi. Gli algoritmi si trovano nella
casella Algoritmi, raggruppati allo stesso modo come nella cassetta degli attrezzi.

Per aggiungere un algoritmo, premete due volte con il mouse sul suo nome. Verrà mostrata una finestra di dialogo
con un contenuto simile a quello della finestra che SEXTANTE fa apparire quando si esegue l’algoritmo dalla
cassetta degli attrezzi. Quello che vedete di seguit si riferisce all’algoritmo ‘Indice di convergenza’ di SAGA, lo
stesso di cui abbiamo parlato nel capitolo dedicato alla cassetta degli attrezzi di SEXTANTE.

Come potete vedere, esistono alcune differenze. Al posto della casella usata per definire il percorso del file per
i layer risultanti, appare una semplice casella di testo. Se il layer generato dall’algoritmo è solo un risultato
temporaneo da usare come dato di ingresso per un altro algoritmo e non deve essere conservato come risultato
finale, non modificate la casella. Digitando qualcosa nella stessa significa che è un risultato finale ed il testo che
avete fornito sarà la descrizione del risultato, quello che l’utente vedrà durante l’esecuzione dell’algoritmo.

Anche la selezione dei valori di ogni parametro è un po’ diversa, in quanto vi sono importanti differenze fra il
contesto del modellatore e quello della cassetta degli attrezzi. Vediamo come introdurre il valore per ogni tipo di
parametro.
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Figura 17.17: Model Parameters

Figura 17.18: Model Parameters
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• Layer (raster e vettoriali) e tabelle. Devono essere selezionate da una lista, ma in questo caso i valori
possibili non sono i layer o le tabelle correntemente aperte in QGIS, bensì la lista dei dati di ingresso del
modello corrispondente per tipo, o altri layer e tabelle generate da algoritmi già aggiunti al modello.

• Valori numerici. Si possono inserire valori direttamente nella casella, ma si possono anche scegliere da
una lista i valori numeri di ingresso per il modello. In questo caso, il parametro prenderà il valore inserito
dall’utente quando esegue il modello.

• Stringhe. Come nel caso dei valori numerici, si possono inserire stringhe o selezionarle (da un elenco).

• Campi di tabelle. I campi della tabella principale o del layer sono ignoti al momento del progetto, in quanto
dipendono dalle scelte dell’utente nel momento di esecuzione del modello. Per definire il valore di questo
parametro, digitate il nome del campo direttanente nella casella di testo, oppure selezionate un campo di
tabella già esistente nel modello. La validità del campo selezionato sarà controllato da SEXTANTE in fase
di esecuzione.

Una volta assegnati valori corretti a tutti i parametri, premete [OK] e l’algoritmo sarà aggiunto al pannello
grafico. Sarà collegato a tutti gli altri elementi del pannello, sia algoritmi sia dati, che forniscono oggetti usati
dall’algoritmo come dati di ingresso.

Figura 17.19: Model Parameters

Gli elementi possono essere spostati nel pannello grafico per modificare la visualizzazione della struttura del
modello e renderla più chiara ed intuitiva. I collegamenti fra gli elementi vengono aggiornati automaticamente.

Potete eseguire il vostro algoritmo in ogni momento premendo il pulsante [Run]. Tuttavia, per poterlo usare dalla
cassetta degli attrezzi, occorre salvarlo e chiudere la finestra di dialogo del modellatore in modo da consentire al
sistema di aggiornare la configurazione.

17.3.4 Salvataggio e caricamento di modelli

Usate il pulsante [Salvataggio] per salvare il modello corrente ed il pulsante [Apri] per aprire un modello esistente.
I modelli sono salvati con l’estensione .model. Se il modello è già stato salvato [dalla finestra del modellatore]
non vi sarà chiesto il nome del file perchè esiste già un file associato al modello e verrà usato quello.

Prima di salvare un modello, dovete inserire un nome ed un gruppo per esso usando le caselle di testo nella parte
alta della finestra.

I modelli salvati nella cartella modelli (quella predefinita quando vi si chiede il nome del file dove salvare il
modello) appariranno nella cassetta degli attrezzi, nel corrispondente gruppo. Quando si attiva la cassetta degli
attrezzi, SEXTANTE cerca nella cartella modelli i file con l’estensione .model e carica il modello che con-
tengono. Poichè un modello è anch’esso un algoritmo di SEXTANTE, può essere aggiunto alla cassetta degli
attrezzi come qualsiasi altro algoritmo.
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La cartella del modellatore può essere definita nella finestra di configurazione di SEXTANTE, sotto il gruppo
Modellatore.

I modelli presenti nella cartella dei modelli appariranno non solo nella cassetta degli attrezzi, ma anche nell’albero
degli algoritmi nel pannello Algoritmi della finestra del modellatore. Questo significa che potete incorporare un
modello come parte di un modello più grande, esasttamente come aggiungete qualsiasi altro algoritmo.

In alcuni casi, SEXTANTE potrebbe non essere in grado di caricare un modello perchè non trova tutti gli algorit-
mi inclusi nella sua definizione. Se usate un certo algoritmo come parte del vostro modello, questo deve essere
disponibile (cioè deve apparire nella cassetta degli attrezzi) per essere in grado di caricare quel modello. La dis-
attivazione di un gestore di algoritmi nella finestra di configurazione di SEXTANTE renderà tutti quegli algoritmi
inusabili, creando problemi nel caricamento dei modelli. Ricordatevene quando avete delle noie nel caricamento
o nella esecuzione di modelli.

17.3.5 Aggiornare il modello

Potete modificare il modello mentre lo state creando, ridefinendo il flusso e le relazioni fra gli algoritmi e i dati
che definiscono il modello stesso.

Se premete il tasto destro del mouse su un algoritmo nel grafico che rappresenta il modello, apparirà un menu
come quello sotto riportato:

Figura 17.20: Modeler Right Click

Selezionando l’opzione Cancella si cancellerà l’algoritmo selezionato. Un algoritmo può essere cancellato soltan-
to se non vi sono altri algoritmi dipendenti. Cioè se il risultato dell’algoritmo non è usato da un altro algoritmo.
Se provate a rimuove un algoritmo da cui ne dipendono altri, SEXTANTE mostrerà un messaggio di avviso come
quello che vedete sotto:

Figura 17.21: Cannot Delete ALG

Selezionando l’opzione Modifica o semplicemente premendo due volte sull’icona dell’algoritmo apparirà la fines-
tra dei parametri dell’algoritmo in modo che possiate cambiarne i valori. Non tutti i valori disponibili nel modello
appariranno in questo caso come dati disponibili. Layer o valori generati ad un passaggio successivo del flusso
del modello che possono causare dipendenze circolari non saranno disponibili.

Selezionate i nuovi valori e premete il pulsante [OK] come al solito. La connessione fra gli elementi del modello
cambieranno di conseguenza anche nel pannello grafico.

168 Capitolo 17. SEXTANTE



QGIS User Guide, Release 1.8

17.3.6 Abilitare e disabilitare gli algortimi

Gli algoritmi possono essere disattivati nel modellatore, così non saranno eseguiti quando il modello sarà lanciato.
Questo può essere sfruttato per mettere a punto una parte del modello o quando non avete bisogno di tutti i risultati
generati dal modello.

Per disattivare un algoritmo, premete il tasto destro del mouse sulla sua icona nel pannello grafico e spuntate
l’opzione Disattivazione. Vedrete che ora l’algoritmo sarà presentato con un’etichetta rossa sotto il nome che
indica che questo non è attivo.

Figura 17.22: Deactivate

Anche gli algoritmi dipendenti (direttamente o indirettamente) da quell’algoritmo appariranno come disattivati in
quanto non possono ora essere eseguiti.

Per abilitare un algoritmo basta premere sulla sua icona col pulsante destro del mouse e selezionare l’opzione
Abilitare.

17.3.7 Informazioni ed aiuto per l’aggiornamento del modello

Potete documentare i vostri modelli in SEXTANTE. Premete il pulsante [Edit model help] ed apparirà una finestra
di dialogo come la seguente.

Figura 17.23: Help Edition

Sul lato destro vedrete una semplice pagina HTML, creata usando la descrizione dei parametri di ingresso e di
uscita dell’algoritmo, oltre ad informazioni integrative come una descrizione generale o il suo autore. La prima
volta che aprite il gestore di aiuto tutte queste descrizioni sono vuote, ma potete modificarle usando gli elementi
sul lato sinistro della finestra. Selezionate un elemento nella parte alta e quindi scrivete la sua descrizione nella
casella sotto.

L’informazione di aiuto del modello è salvata nella stessa cartella insieme al modello stesso. Non dovete
preoccuparvi del suo salvataggio perchè è eseguito automaticamente.
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17.3.8 A proposito degli algoritmi disponibili

Noterete che alcuni algoritmi che potete eseguire dalla cassetta degli attrezzi non appaiono nella lista di quelli
disponibili quando state creando un modello. Per essere incluso in un modello, un algoritmo deve avere una
semantica corretta, così come essere correttamente collegato con gli altri nel flusso di lavoro. Se un algoritmo non
ha una semantica corretta (ad esempio, se il numero dei layer generati non può essere conosciuto anticipatamente)
allora non è possibile usarlo all’interno del modello e quindi non può apparie nella lista di quelli che potere trovare
nella finestra del modellatore.

Inoltre, vedrete nel modellatore qualche algoritmo che non trovate nella cassetta degli attrezzi. Questi algoritmi
sono fatti per essere usati esclusivamente come parte di un modello e non sono utili in altri contesti. L’algoritmo
‘Calcolatore’ è un esempiodi questi. Esso è un semplice calcolatore aritmetico che potete usare per modificare
valori numerici (inseriti dall’utente o generati da qualche altro algoritmo). Questi strumenti sono utili all’interno
di un modello, ma al di fuori di quel contesto non hanno molto senso.

17.3.9 I modelli di SEXTANTE come codice Python

Questa funzionalità non è al momento disponibile

Vicino al pannello che contiene lo schema grafico del modello, ne vedrete un altro contenente un codice Python
che esegue lo stesso compito del modello. Usando quel codice, potete creare delle istruzioni a linea di comando
(le spiegheremo più tardi in questo stesso manuale) e modificarle per inserire azioni e funzioni disponibili nel
modellatore grafico, come iterazioni e strutture condizionali.

Questa caratteristica è anche molto utile per imparare ad usare SEXTANTE da linea di comando e come creare
algoritmi di SEXTANTE usando codice Python, così potete usarla come strumento di apprendimento quando
cominciate a creare le vostre istruzioni per SEXTANTE.

Troverete un pulsante sotto il testo che contiene il codice Python. Premetelo per creare direttamente un nuovo
comando da quel codice, senza doverlo copiare ed incollare nel gestore dei comandi di SEXTANTE.

17.4 L’interfaccia di SEXTANTE per eseguire processi in modalità
“batch”

17.4.1 Introduzione

Gli algoritmi di SEXTANTE (compresi i modelli) possono essere eseguiti come un processo batch. Questo sig-
nifica che possono essere eseguiti usando non un singolo set di input ma anche più di uno, eseguendo l’algoritmo
tutte le volte che è necessario. Ciò si rivela utile quando si ha bisogno di processare grandi quantità di dati, dal
momento che non è necessario lanciare ogn volta l’algoritmo dalla toolbox.

Per eseguire un algoritmo come un processo batch, selezionarlo e col pulsante di destra del mouse scegliere la
voce Execute as batch process dal menu che apparirà.

Figura 17.24: Batch Processing Right Click

17.4.2 La tabella dei parametri

Eseguire un processo batch è un’operazione simile ad un’esecuzione singola di un algoritmo. Devono essere
definiti i valori dei parametri, ma in questo caso, è necessario definire non solo un singolo valore per ciascunodi
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essi, ma invece un set di valori, uno per ogni volta che l’algoritmo deve essere eseguito. I valori sono introdotti
per mezzo di una tabella del tipo di quella mostrata oltre.

Figura 17.25: Batch Processing

Ogni riga di tale tabella rappresenta una sinola esecuzione dell’algoritmo ed ogni cella contiene il valore di uno dei
parametri caratteristici dell’algoritmo. In un certo senso, è simile alla finestra di dialogo dei parametri utilizzata
quando si lancia un algoritmo dalla toolbox, ma organizzata in maniera differente.

Come impostazione predefinita, la tabella contiene solo due righe. E’ possiile aggiungere o cancellare righe
utilizzando i pulsanti posti nella parte inferiore della finestra.

Una volta definita la dimensione della tabella, deve essere riempita coi valori desiderati.

17.4.3 Compilazione della tabella dei parametri

Per la maggior parte dei parametri, scegliere il valore appropriato è banale. Basta semplicemente scrivere il valore
o selezionarlo dalla lista delle opzioni disponibili, a seconda del tipo di parametro stesso.

Le principali differenze si hanno per parametri che sono layer o tabelle e per il percorso di salvataggio dei risul-
tati. Per quanto riguarda input rappresentati da layer e tabelle, quando un algoritmo è eseguito come parte di un
processo batch, i dati di input sono caricati direttemente da file e non a partire dai temi già aperti in QGIS. Per
questo motivo, qualunque algoritmo può essere eseguito in modalità batch anche se nessun tema è stato ancora
caricato e l’algoritmo non può essere lanciato dalla toolbox.

Il nome dei file per i dati di input può essere digitato direttamente oppure, meglio, cliccando sul pulsante sul lato
destro della cella che apre una classica finestra di dialogo per la scelta di un file. Possono essere selezionati più
file insieme. Se il parametro di input rappresenta un dato singolo e sono selezionati diversi file, ciascuno di essi
sarà inserito in righe separate, aggiungendone di nuove se necessario. Se il parametro di input prevede più dati,
tutti i file selezionati saranno aggiunti in un’unica cella, separati da punto e virgola (;).

I risultati sono sempre salvati in un file permanente e, a differenza di quando un algoritmo è lanciato dalla toolbox,
non è permesso il loro salvataggio in un file temporaneo. E’ possibile digitare direttamente il nome del file di
output oppure utilizzare la finestra di dialogo della scelta dei file che compare quando si clicca sul buttone di
accompagnamento.

Una volta selezionato il file di output, appare una nuova finestra di dialogo che permette l’autocompletamento
delle altre celle nella stessa colonna (stesso parametro).

Se si mantiene il valore predefinito (‘Do not autocomplete’), SEXTANTE metterà il nome del file selezionato nella
cella selezionata dalla tabella dei parametri. Se viene selezionata una qualunque delle altre opzioni, tutte le celle
sottostanti quella selezionata saranno riempite automaticamente basandosi sul criterio definito. In questo modo, è
molto più agevole riempire la tabella e il processo batch può essere definito con meno sforzo.
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Figura 17.26: Batch Processing Save

Il riempimento automatico può essere fatto semplicemente aggiungendo numeri correlati al percorso del file se-
lezionato o aggiungendo il valore di un altro campo alla stessa riga. Ciò è particolarmente utile per dare un nome
ai dati di output che sia in accordo con quello dei dati di input.

Figura 17.27: Batch Processing File Path

17.4.4 Esecuzione di un processo batch

Per eseguire un processo batch, una volta introdotti tutti i valori necessari, semplicemente cliccare su [OK].
SEXTANTE mostrerà l’avanzamento del processo di batch globale nella barra di avanzamento posta nella parte
inferiore della finestra di dialogo.

17.5 Uso di SEXTANTE dalla console

17.5.1 Introduzione

La console permette ad utenti esperti di aumentare la propria produttività e di eseguire operazioni complesse che
non possono essere eseguite utilizzando uno qualsiasi degli altri elementi dell’interfaccia grafica di SEXTANTE.
I modelli che richiamano diversi algoritmi possono essere definiti utilizzando l’interfaccia della riga di comando,
e le operazioni aggiuntive, come i loop e le frasi condizionali possono essere aggiunte per creare flussi di lavoro
più flessibili e potenti.

Non c’è una console di SEXTANTE in QGIS, ma tutti i comandi di SEXTANTE sono disponibili invece dalla
console Python interna presente in QGIS. Ciò significa che è possibile incorporare quei comandi nella console di
lavoro e connettere gli algoritmi di SEXTANTE a tutte le altre funzioni (compresi i metodi derivanti dalle API di
QGIS) da lì disponibili.

Il codice che è possibile eseguire dalla console Python, anche se chiama un qualsiasi modulo di SEXTANTE, può
essere convertito in un nuovo algoritmo di SEXTANTE che in seguito sarà possibile chiamare dalla finestra degli
strumenti, il modellatore grafico o qualsiasi altro componente di SEXTANTE, proprio come si fa con qualunque
algoritmo di SEXTANTE. Infatti, alcuni algoritmi che si possono trovare nella casella degli strumenti, come tutti
quelli del gruppo mmqgis, sono semplici script.
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In questo capitolo si spiegherà come utilizzare SEXTANTE dalla console Python di QGIS ed anche come scrivere
un algoritmo in Python.

17.5.2 Chiamata di SEXTANTE dalla console Python

La prima cosa da fare è importare le funzioni di SEXTANTE con la seguente istruzione:

>>> import sextante

Fondamentalmente, c’è solo una cosa (interessante) che si può fare con SEXTANTE dalla console: eseguire un
algoritmo. Ciò viene fatto usando il comando ‘‘ runalg () ‘‘ , che prende il nome dell’algoritmo da eseguire
come primo parametro, e poi un numero variabile di parametri aggiuntivi che dipendono da ciò che è richiesto
dall’algoritmo. Quindi la prima cosa da sapere è il nome dell’algoritmo da eseguire. Questo non è il nome che è
riportato nella finestra degli strumenti, ma un nome univoco da richiamare nella da riga di comando. Per trovare
il nome corretto dell’algoritmo, è possibile utilizzare il comando ‘‘ algslist () ‘‘. Digitare la seguente istruzione:

>>> sextante.alglist()

Il risultato dovrebbe essere.

Accumulated Cost (Anisotropic)---------------->saga:accumulatedcost(anisotropic)
Accumulated Cost (Isotropic)------------------>saga:accumulatedcost(isotropic)
Add Coordinates to points--------------------->saga:addcoordinatestopoints
Add Grid Values to Points--------------------->saga:addgridvaluestopoints
Add Grid Values to Shapes--------------------->saga:addgridvaluestoshapes
Add Polygon Attributes to Points-------------->saga:addpolygonattributestopoints
Aggregate------------------------------------->saga:aggregate
Aggregate Point Observations------------------>saga:aggregatepointobservations
Aggregation Index----------------------------->saga:aggregationindex
Analytical Hierarchy Process------------------>saga:analyticalhierarchyprocess
Analytical Hillshading------------------------>saga:analyticalhillshading
Average With Mask 1--------------------------->saga:averagewithmask1
Average With Mask 2--------------------------->saga:averagewithmask2
Average With Thereshold 1--------------------->saga:averagewiththereshold1
Average With Thereshold 2--------------------->saga:averagewiththereshold2
Average With Thereshold 3--------------------->saga:averagewiththereshold3
B-Spline Approximation------------------------>saga:b-splineapproximation
...

Questa è la lista di tutti gli algoritmi disponibili in ordine alfabetico, con il corrispondente nome da utilizzare nella
riga di comando.

È possibile utilizzare una stringa come parametro per questo comando. Invece di restituire l’elenco completo
degli algoritmi, verranno visualizzati solo quelli che includono tale stringa. Se, per esempio, si sta cercando un
algoritmo per calcolare la pendenza da un DEM, si digiti ‘‘alglist (“slope”) ” per ottenere il seguente risultato:

DTM Filter (slope-based)---------------------->saga:dtmfilter(slope-based)
Downslope Distance Gradient------------------->saga:downslopedistancegradient
Relative Heights and Slope Positions---------->saga:relativeheightsandslopepositions
Slope Length---------------------------------->saga:slopelength
Slope, Aspect, Curvature---------------------->saga:slopeaspectcurvature
Upslope Area---------------------------------->saga:upslopearea
Vegetation Index[slope based]----------------->saga:vegetationindex[slopebased]

Il risultato potrebbe cambiare a seconda degli algoritmi che sono disponibili.

È più facile ora trovare l’algoritmo che si sta cercando e il suo nome da utilizzare nella riga di comando, in questo
caso ‘‘ saga: slopeaspectcurvature ‘‘.

Una volta che si conosce il nome dell’algoritmo da utilizzare nella riga di comando, la prossima cosa da fare è
conoscere la giusta sintassi per eseguirlo. Ciò significa conoscere quali sono i parametri necessari e l’ordine in
cui essi devono essere dichiarati quando si esegue il comando ‘‘ runalg () ‘‘ . SEXTANTE ha un comando per
descrivere un algoritmo in dettaglio, che può essere usato per ottenere un elenco dei parametri che un algoritmo
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richiede e gli output che genererà. È possibile utilizzare il comando ‘‘ alghelp (nome_algoritmo) ‘‘. Utilizzare il
nome dell’algoritmo nella riga di comando, non il nome descrittivo completo.

Chiamando la funzione saga:slopeaspectcurvature come parametro, si otterrà la seguente descrizione.

>>> sextante.alghelp("saga:slopeaspectcurvature")
ALGORITHM: Slope, Aspect, Curvature

ELEVATION <ParameterRaster>
METHOD <ParameterSelection>
SLOPE <OutputRaster>
ASPECT <OutputRaster>
CURV <OutputRaster>
HCURV <OutputRaster>
VCURV <OutputRaster>

Ora si ha tutto il necessario per eseguire qualsiasi algoritmo. Come già accennato, vi è solo un unico comando per
eseguire algoritmi: ‘‘ runalg () ‘‘. La sua sintassi è la seguente:

>>> sextante.runalg{name_of_the_algorithm, param1, param2, ..., paramN,
Output1, Output2, ..., OutputN)

L’elenco dei parametri e degli output da aggiungere dipende dall’algoritmo che si desidera eseguire, ed è
esattamente la lista che il comando ‘‘ alghelp () ‘‘ restituisce, nello stesso ordine, come mostrato.

A seconda del tipo di parametro, i valori vengono introdotti in modo diverso. Di seguito, una rapida rassegna di
come introdurre i valori per ciascun tipo di parametro di input

• Layer raster, layer vettoriale o tabella. Basta usare una stringa con il nome che identifica l’oggetto da
utilizzare (il nome che ha nell’area di legenda di QGIS ) o il nome di un file (se il layer corrispondente non
è aperto, sarà aperto, ma non aggiunto alla mappa ). Se si dispone di un’istanza di un oggetto di QGIS che
rappresenta il layer, è anche possibile utilizzarla come parametro. Se l’input è opzionale e non si desidera
utilizzare alcun dato, utilizzare ‘‘None ‘‘.

• Selezione. Se un algoritmo ha un parametro di selezione, il valore di tale parametro deve essere inserito
come valore intero. Per conoscere le opzioni disponibili, è possibile utilizzare il comando ‘‘algoptions ‘‘,
come mostrato nel seguente esempio:

>>> sextante.algoptions("saga:slopeaspectcurvature")
METHOD(Method)

0 - [0] Maximum Slope (Travis et al. 1975)
1 - [1] Maximum Triangle Slope (Tarboton 1997)
2 - [2] Least Squares Fitted Plane (Horn 1981, Costa-Cabral & Burgess 1996)
3 - [3] Fit 2.Degree Polynom (Bauer, Rohdenburg, Bork 1985)
4 - [4] Fit 2.Degree Polynom (Heerdegen & Beran 1982)
5 - [5] Fit 2.Degree Polynom (Zevenbergen & Thorne 1987)
6 - [6] Fit 3.Degree Polynom (Haralick 1983)

In questo caso, l’algoritmo ha uno di questi parametri con 7 opzioni, ordinate a partire da zero.

• Input multipli. Il valore è una stringa con i descrittori degli input separati da virgola. Come nel caso di
singoli layer o tabelle, ogni descrittore di input ingresso può essere il nome dell’oggetto, o il suo percorso
sul disco.

• Campo di una Tabella da XXX. Inserire una stringa con il nome del campo da utilizzare. Il parametro è
sensibile alle lettere maiuscole

• Tabella fissa. Digitare l’elenco di tutti i valori della tabella, separati da virgole e racchiusi tra virgolette. I
valori iniziano dalla riga superiore e vanno da sinistra a destra. È inoltre possibile utilizzare una matrice 2D
dei valori che rappresenta la tabella.

• Sistema di Riferimento per le Coordinate (Coordinate Reference System, CRS). Inserire il codice EPSG per
indicare il sistema di riferimento desiderato.

• Estensione. È necessario utilizzare una stringa con i valori di xmin, xmax, ymin e ymax separati da
virgole.
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Parametri booleani, di file, di stringa e numerici non hanno bisogno di ulteriori spiegazioni.

I parametri di input, come stringhe o valori numerici o booleani hanno valori di default. Per utilizzarli, usare
‘‘None ‘‘nella voce del parametro corrispondente.

Per per salvare i dati di output, digitare il percorso del file da utilizzare, così come viene fatto nella finestra degli
strumenti. Se si desidera salvare il risultato in un file temporaneo, utilizzare ‘‘None ‘‘. L’estensione del file
determina il formato del file. Se si immette un’estensione del file non inclusa tra quelle supportate dall’algoritmo,
verrà utilizzato il formato di file predefinito per il tipo di output e sarà aggiunta al percorso del file specificato la
sua estensione corrispondente .

A differenza di quando un algoritmo viene eseguito dalla finestra degli strumenti, se si esegue lo stesso algoritmo
dalla console Python, gli output non vengono aggiunti alla vista mappa. Se si desidera aggiungere un output alla
vista, bisogna farlo dopo l’esecuzione dell’algoritmo. Per fare ciò, è possibile utilizzare i comandi API QGIS, o,
ancora più semplicemente, utilizzare uno dei comandi forniti da SEXTANTE per tale compito.

Il comando ‘‘ runalg () ‘‘ restituisce un dizionario con i nomi di output (quelli indicati nella descrizione dell’algo-
ritmo) come chiavi e i percorsi dei file di quegli output come valori. Per aggiungere tutti gli output generati da un
algoritmo, si può utilizzare il comando ‘‘ loadFromAlg () ‘‘ che processa il dizionario. È anche possibile caricare
un singolo layer passando il suo percorso del file al comando ‘‘ load() ‘‘.

17.5.3 Creare script e lanciarli dalla finestra degli strumenti

È possibile creare i propri algoritmi, scrivendo il relativo codice Python e aggiungendo qualche riga in più per
fornire ulteriori informazioni necessarie a SEXTANTE. Il comando Create new script si trova sotto il gruppo
strumenti nel blocco degli Script, nella finestra degli strumenti. Fare doppio clic su di esso per aprire la finestra
di dialogo dell’editor di script. È lì che si deve digitare il codice. Salvando lo script nella cartella scripts (è
quella di default quando si apre la finestra di dialogo Salva file), con estensione .py , automaticamente si creerà
l’algoritmo corrispondente.

Il nome dell’algoritmo (quello si vedrà nella finestra degli strumenti) viene creato dal nome del file, rimuovendo
la sua estensione e sostituendoi trattini bassi con spazi vuoti.

Ad esempio, quello seguente è il codice che calcola l’Indice di Umidità Topografica (Topographic Wetness Index,
TWI) direttamente da un DEM

##dem=raster
##twi=output
ret_slope = sextante.runalg("saga:slopeaspectcurvature", dem, 0, None,

None, None, None, None)
ret_area = sextante.runalg("saga:catchmentarea(mass-fluxmethod)", dem,

0, False, False, False, False, None, None, None, None, None)
sextante.runalg("saga:topographicwetnessindex(twi), ret_slope[’SLOPE’],

ret_area[’AREA’], None, 1, 0, twi)

Come si può vedere, si tratta di tre algoritmi, tutti provenienti da SAGA. L’ultimo calcola il TWI, ma ha bisogno
del layer dell’inclinazioe e del layer della flow accumulation. Non essendo disponibili direttamente ed avendo a
disposizione il DEM, possono essere calcolati richiamando i corrispondenti algoritmi di SAGA.

La parte del codice in cui avviene questo processo non è difficile da capire, una volta lette le sezioni precedenti
di questo capitolo. Le prime linee, tuttavia, hanno bisogno di qualche spiegazione aggiuntiva. Esse forniscono a
SEXTANTE le informazioni di cui ha bisogno per trasformare il codice in un algoritmo che può essere eseguito
da uno dei suoi componenti, come la finestra degli strumenti o il modellatore grafico.

Queste linee iniziano con un doppio simbolo di commento Python ed hanno la seguente struttura:

[parameter_name]=[parameter_type] [optional_values]

Ecco un elenco di tutti i tipi di parametri che SEXTANTE supporta nei suoi scrpt, la loro sintassi ed alcuni esempi.

• raster. Un layer raster

• vector. Un layer vettoriale
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• table. Una tabella

• number. Un valore numerico. Deve essere indicato un valore di default. Ad esempio, depth=number
2.4

• string. Una stringa di testo. Come nel caso dei valori numerici, deve essere indicato un valore di default.
Ad esempio, name=string Victor‘‘‘‘number

• boolean. Un valore booleano. Aggiungere True o False dopo di esso per indicare il valore di default.
Ad esempio, verbose=boolean True

• multiple raster. Un insieme di layer raster di input.

• multiple vector. A set of input vector layers.

• field. Un campo nella tabella degli attributi di un layer vettoriale. Il nome del layer deve essere aggiunto
dopo il tag field. Ad esempio, una volta dichiarato il layer vettoriale di input con mylayer=vector,
si può usare myfield=field mylayer per aggiungere come parametro un campo di quel layer.

• folder. Una cartella

• file. Un nome di un file

Il nome del parametro è il nome che verrà mostrato all’utente durante l’esecuzione dell’algoritmo, ed è anche il
nome della variabile da utilizzare nel codice dello script. Il valore immesso dall’utente per quel parametro sarà
assegnato a una variabile con quel nome.

Quando mostra all’utente il nome del parametro, SEXTANTE lo modifica per migliorare il suo aspetto, sostituendo
i trattini bassi con spazi vuoti. Così, per esempio, se si desidera che l’utente visualizzi un parametro denominato
‘‘ Un valore numerico‘‘, è possibile utilizzare il nome della variabile ‘‘ Un_valore_numerico ‘‘.

I valori dei layer e delle tabelle sono stringhe contenenti il percorso del file dell’oggetto corrispondente. Per
trasformarle in un oggetto di QGIS, è possibile utilizzare la funzione ‘‘sextante.getObjectFromUri () ‘‘ funzione.
Anche input multipli hanno un valore della stringa, che contiene il percorso di gli oggetti selezionati, separati da
punto e virgola.

Gli output sono definiti in maniera simile, usando i seguenti tag:

• output raster

• output vector

• output table

• output html

• output file

• output number

• output string

Il valore assegnato alle variabili di otput è sempre una stringa con un percorso file. Esso corrisponde al percorso
di un file temporaneo nel caso in cui l’utente non ha specificato alcun file di output.

Quando si dichiara un output, SEXTANTE cercherà di aggiungerlo QGIS una volta che l’algoritmo è finito. Questa
è la ragione per cui, anche se il comando ‘‘ runalg () ‘‘ non carica i layer che produce, il layer finale del TWI verrà
caricato, poiché è salvato nel file scelto dall’utente, che è il valore dell’output corrispondente.

Non usare il comando ‘‘ load() ‘‘ negli algoritmi di script, ma solo quando si lavora con la linea di comando. Se
un layer viene creato come output di un algoritmo, esso dovrebbe essere dichiarato come tale. In caso contrario,
l’algoritmo nel modellatore non potrà essere utilizzato correttamente, dal momento che la sua sintassi (come
definita dai tag spiegato sopra) non corrisponde a ciò che l’algoritmo in realtà crea.

Output nascosti (numeri e stringhe) non hanno un valore. È invece l’utente che deve assegnare loro un valore.
Per farlo, è sufficiente impostare il valore di una variabile con il nome utilizzato per dichiarare quell’output. Per
esempio, se è stata usata questa dichiarazione,

##average=output number

176 Capitolo 17. SEXTANTE



QGIS User Guide, Release 1.8

la riga seguente imposterà il valore dell’output a 5:

average = 5

Oltre ai tag per i parametri e gli output, è anche possibile definire il gruppo in cui verrà mostrato l’algoritmo,
utilizzando il tag ‘‘ group ‘‘.

Se l’algoritmo impiega molto tempo per elaborare, è una buona idea informare l’utente. Si dispone di due comandi
globali denominati ‘‘progress ‘‘con due metodi disponibile : ‘‘ setText (testo) ‘‘ e ‘‘ setPercentage (percent) ‘‘ per
modificare il testo e la barra di avanzamento.

Con SEXTANTE sono forniti diversi esempi. Si prega di controllarli per vedere alcuni esempi reali di come creare
algoritmi che utilizzano questa funzione di SEXTANTE. È possibile fare clic destro su un qualsiasi algoritmo di
script e selezionare select Edit script per modificare il codice o solo per vederlo.

17.5.4 Documentare gli script

Come nel caso dei modelli, è possibile creare una documentazione aggiuntiva per gli script, per spiegare che cosa
fanno e come usarli. Nella finestra di modifica dello script si trova un pulsante [Edit script help]. Fare clic su di
esso e si aprirà una finestra di editing dell’help. Controllare il capitolo sul modellatore grafico per sapere di più su
questa finestra di dialogo e come usarla.

I file della guida vengono salvati nella stessa cartella dello stesso script, aggiungendo l’estensione .help al nome
del file. Si noti che è possibile modificare la guida dello script prima di salvarlo per la prima volta. Se in seguito
si chiude la finestra di modifica dello script senza salvare lo script (cioè la si scarta), il contenuto già scritto
della guida verrà perso. Se lo script è già stato salvato ed è associato ad un nome di file, il salvataggio è fatto
automaticamente.

17.6 Il gestore della cronologia di SEXTANTE

17.6.1 La cronologia di SEXTANTE

Ogni volta che eseguite un algoritmo di SEXTANTE, le informazioni sul processo sono salvate dal gestore della
cronologia (di SEXTANTE). Insieme sono salvati anche i parametri usati, la data ed il tempo di esecuzione.

In questo modo è comodo tenere traccia, controllare tutto il lavoro sviluppato usando SEXTANTE e riprodurlo in
tutta facilità.

Il gestore della cronologia di SEXTANTE è un insieme di registri raggruppati per data di esecuzione, ciò che rende
facile trovare l’informazione su uno specifico algoritmo eseguito in un particolare momento.

Figura 17.28: History
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L’informazione sul processo è conservata come una espressione a linea di comando, anche se l’algoritmo è stato
avviato dalla cassetta degli attrezzi. Questo lo rende utile anche per coloro che stanno imparando come usare
l’interfaccia a linea di comando, in quanto possono richiamare un algoritmo usando la cassetta degli attrezzi e
poi controllare il gestore cronologico per vedere come lo stesso algoritmo dovrebbe essere invocato dalla linea di
comando.

Oltre a poter scorrere la lista del registro, è possibile rieseguire i processi semplicemente premendo due volte il
loro nome con il mouse.

Durante l’esecuzione degli algoritmi, SEXTANTE comunica con l’utente usando altri gruppi del registro, specifi-
catamente Errori, Avvertenze e Informazioni. Nel caso qualcosa non funzioni correttamente, uno sguardo a Errori
può aiutarvi a capire cosa sta succedendo. Se contattate uno sviluppatore di SEXTANTE per riportare un difetto
o un errore, l’informazione di questo gruppo gli sarà molto utile per trovare quello che non funziona.

Se eseguite algoritmi di terze parti, questo è fatto normalmente richiamando la loro interfaccia a linea di comando
che comunica con l’utente attraverso il video. Per quanto questa informazione (in SEXTANTE) non è visualizzata
, una copia completa è salvata nel gruppo Informazioni ogni volta che lanciate quell’algoritmo. Se ad esempio,
avete dei problemi eseguendo un algoritmo di SAGA cercate nella voce ‘SAGA uscita di controllo dell’esecuzione’
per controllare tutti i messaggi generati da SAGA e cercare di trovare la spiegazione del problema.

Alcuni algoritmi, anche se possono produrre un risultato con i dati di ingresso forniti, possono aggiungere com-
menti o informazioni aggiuntive a Avvertenze nel caso riscontrino potenziali problemi derivanti da quei dati, in
modo da avvertirvi. Assicuratevi di controllare questi messaggi ogni volta che ricevete risultati inaspettati.

17.7 Configurazione di applicazioni esterne

17.7.1 Introduzione

SEXTANTE può essere esteso usando applicazioni aggiuntive richiamate dall’interno di SEXTANTE; al momento
sono supportati: SAGA, GRASS,OrfeoToolBox e R oltre a qualche altra applicazione a linea di comando che
fornisce funzionalità di analisi spaziale; Algoritmi che si appoggiano ad applicazoni esterne sono gestite dal
proprio gestore.

Questo capitolo vi mostrerà come configurare SEXTANTE per includere queste applicazioni addizionali e vi
spiegherà alcune prestazioni particolari degli algoritmi basati su di esse. Una volta configurato il sistema, sarete
in grado di eseguire algoritmi esterni da ogni componente di SEXTANTE tipo il toolbox o il modellatore grafico,
esattamente come ogni altro geoalgoritmo di SEXTANTE.

Inizialmente tutti gli algoritmi contenuti in applicazioni esterne non distribuite con QGIS non sono abilitate.
Potete abilitarle nella finestra di configurazione di SEXTANTE. Assicuratevi che la corrispondente applicazione
sia installata sul vostro sistema; l’abilitazione del gestore dell’algoritmo senza aver installato la corrispondente
applicazione farà apparire l’algoritmo nella toolbox, ma genererà un errore quando cercherete di eseguirlo.

Questo dipende dal fatto che le descrizioni degli algoritmi (necessari a creare i parametri di configurazione ed
a fornire a SEXTANTE le necessarie informazioni sugli stessi) non sono incluse nelle applicazioni ma in SEX-
TANTE; cioè sono parte di SEXTANTE, così le avete nella vostra installazione anche se non avete installa-
to nessun altro software, tuttavia per il funzionamento è necessario aver installato sul vostro sistema i binari
dell’applicazione.

Nota sui formati dei files

Quando si usa un software esterno, l’apertura di un file in QGIS non garantisce che il file venga aperto e trattato
esattamente come nell’altro software. Nella maggior parte dei casi il file sarà letto in QGIS,ma in alcuni casi
potrebbe non esserlo. Quando si usano databases o formati di files particolari, sia raster che vettoriali, potrebbe
capitare qualche problema. Se ciò accade, assicuratevi di usare file in formati noti e riconosciuti da entrambi i
programmi e controllate nella console (nello storico dei comandi o nel registro di controllo) per approfondire ciò
che è andato storto.
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L’uso di mappe raster di GRASS, ad esempio, è uno dei casi in cui potreste avere problemi e non riuscire a
concludere il vostro lavoro nel caso doveste usare un algoritmo esterno per elaborare tale mappa. Per questo
motivo queste mappe non appariranno disponibili per gli algoritmi di SEXTANTE (stiamo lavorando per risolvere
questo problema, abbiate fiducia che arriverà presto).

D’altra parte non dovreste aver alcun problema con le mappe vettoriali in quantoSEXTANTE provvede automati-
camente alla conversione in un formato adatto al programma esterno prima di passare la mappa. Questo aumenta il
tempo di elaborazione che potrebbe diventare significativo con mappe di grande dimensione, quindi non stupitevi
se richiede più tempo elaborare una mappa fornita da una connessione DB rispetto ad una di pari dimensione in
formato SHP.

I gestori che non usano applicazioni esterne possono elaborare ogni mappa compatibile con QGIS perchè usano
questo per aprirla.

Per quanto riguarda i formati di uscita le mappe raster posso essere salvate come files TIFF (.tif) mentre le
mappe vettoriali sono salvate come files SHP. Questi sono stati scelti come “lingua franca” fra le applicazioni
esterne e QGIS. Se scegliete un nome di file diverso dai precedenti, sarà modificato nel formato standard con
l’aggiunta del suffisso adatto.

Nel casodi GDAL il numero di formati di uscita supportati è maggiore. Quando aprite la finestra di dialogo vedrete
che avete a disposizione più formati (con le corrispondenti estensioni). Per maggiori informazioni sui formati di
file supportati controllate la documentazione di GDAL.

Nota sulla selezione con mappe vettoriali

Normalmente quando un programma esterno tratta una mappa vettoriale,elabora tutti gli oggetti presenti, anche nel
caso sia stata attivata una selezione parziale in QGIS. Potete limitare l’esecuzione del programma solo agli oggetti
selezionati spuntando la casella Usa i comandi esterni sugli oggetti selezionati presente nel gruppo Generale. In
tal caso ogni volta che eseguirete un programma esterno che usa mappe vettoriali gli oggetti selezionati saranno
esportati in una nuova mappa; sarà questa ad essere elaborata dal programma.

Ricordate che selezionando questa opzione una mappa senza selezione attiva verrà tratta come una mappa con
tutti gli oggetti selezionati, non come una mappa vuota.

17.7.2 SAGA

Per poter eseguire gli algoritmi di SAGA attraverso SEXTANTE dovete avere SAGA installato nel vostro sistema
e configurato opportunamente SEXTANTE in modo che possa trovare gli eseguibili di SAGA. In particolare per
eseguire gli algoritmi di SAGA sono necessari i suoi eseguibili a linea di comando. Gli eseguibili di SAGA non
sono inclusi in SEXTANTE, quindi dovete scaricare ed installare il software direttamente. Controllate il sito web
di SAGA per maggiori informazioni. E’ necessaria la versione SAGA 2.0.8.

Una volta installallato SAGA e nel caso stiate usando Windows, aprite la finestra di configurazione di SEXTANTE;
nella casella SAGA troverete una casella cartella di SAGA; inserite il percorso della cartella dove avete installato
SAGA; chiudete la finestra di configurazione ed avete SAGA pronto per essere usato in SEXTANTE.

Nel caso stiate usando Linux, questo non è necessario e non vedrete queste cartelle; al contrario dovrete assicurarvi
che SAGA sia correttamente installato nel vostro sistema e che la cartella di installazione sia aggiunta alla variabile
di ambiente PATH; aprite una console e date l’istruzione saga_cmd per controllare che il sistema riesca a trovare
la cartella dove SAGA è stato installato.

Le limitazioni del sistema di griglia di Saga

Numerosi algoritmi di SAGA che operano su diversi layers raster, richiedono che gli stessi abbiano la stessa
griglia, cioè che abbiano la stessa estensione geografica e la stessa dimensione di cella, in modo che la loro griglia
coincida. Quando usate algoritmi SAGA da SEXTANTE non dovete preoccuparvi della loro estensione e della
loro cella; quando date in pasto a SAGA parecchi layers raster SEXTANTE li ricampiona ad una griglia comune
e quindi li passa a SAGA, a meno che gli algoritmi di SAGA siano in grado di operare direttamente su layer con
griglie diverse.
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La definizione della griglia comune è controllata dall’utente, troverete parecchi parametri nello gruppo SAGA
della finestra di configurazione; ci sono due modi definire la griglia voluta:

• Configurazione manuale: potete definire i valori dei seguenti parametri:

– dimensione minima della cella in X

– dimensione massima della cella in X

– dimensione minima della cella in Y

– dimensione massima della cella in Y

– Ricampionamento della dimensione di cella

Attenzione: SEXTANTE ricampionerà il layer in ingresso a questa griglia anche se non coincidente.

• Configurazione automatica in funzione del layer in ingresso: per selezionare questa opzione basta spuntare
la casella Usa la minima griglia che copre i layers per il ricampionamento; tutte gli altri parametri di
configurazione verranno trascurati e verrà usata l’estensione minima che ingloba tutti il ayers (inviluppo);
la dimensione di cella sarà quella massima dei layers in ingresso.

Per gli algoritmi che non operano su molteplici layers o che non necessitano di un’unica griglia, non verrà operato
alcun campionamento.

Limitazioni per i raster multi-banda

Diversamente da QGIS, SAGA non ha supporto per i raster multibanda. Per usare raster multibanda (ad es.
come immagini RGB o multispettrali) dovete prima scomporli in raster mono banda; per farciò potete usare
l’algoritmo ‘SAGA/Grid - Tools/Split RGB image’ (che crea 3 immagini da un RGB) o l’algoritmo ‘SAGA/Grid
- Tools/Extract band’ (per estrarre una singola banda).

Limitazioni nella dimensionedi cella

SAGA presume che i layers raster abbiano la stessa dimensione di cella sia in direzione X che in Y, se state
lavorando con layer di cella rettangolare, potreste ottenere risultati inaspettati; in tal caso SEXTANTE emetterà un
avviso nel log di SEXTANTE per indicare che il layer in ingresso potrebbe non essere adatto per essere elaborato
da SAGA.

Registrazioni di controllo

Quando SEXTANTE chiama SAGA, lo fa attraverso l’interfaccia a linea di comando , passando una lista di
istruzioni per completare tutte le operazioni richieste. SAGA mostra la progressione dell’attività visualizzando in-
formazioni sulla console compresa la stima percentuale dell’attività già eseguita, insieme ad informazioni aggiun-
tive; queste informazioni sono filtrate da SEXTANTE e usate per aggiornare la barra di stato durante l’esecuzione
dei comandi.

Sia i comandi impartiti da SEXTANTE che le informazioni emesse da SAGA possono essere registrate insieme alle
altre registrazioni di controllo di SEXTANTE; queste potrebbero rivelarsi utili per seguire in dettaglio quello che
avviene mentre SEXTANTE esegue gli algoritmi di SAGA; troverete due caselle di spunta Stampa dei messaggi
in console e Rigestrazione della esecuzione dei comandi per attivare il meccanismo di registrazione.

Alcuni altri gestori che usano applicazioni esterne mediante istruzioni a linea di comando hanno opzioni simili,
quindi le potreste trovare in altre situazioni della configurazione di SEXTANTE.

17.7.3 R e gli scripts R

R è integrato in SEXTANTE in modo diverso da SAGA perchè non c’è un insieme predefinito di algoritmi che
potete lanciare (salvo alcuni casi); al contrario dovete scrivere i vostri scripts e chiamare i comandi di R esatta-
mente come fareste in R e in modo molto simile a quanto abbiamo detto nel capitolo dedicato agli scripts diSEX-
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TANTE. Questo capitolo vi mostra la sintassi da usare per chiamare i comandi di R dall’interno di SEXTANTE e
come usare gli oggetti di SEXTANTE (layers,tabelle) in questo.

La prima cosa da fare,come abbiamo già detto per SAGA, è dire a SEXTANTE dove sono installati gli eseguibili di
R. Potete farlo usando la casella cartella di R nella finestra di configurazione di SEXTANTE. Una volta configurato
questo parametro potete cominciare a creare i vostri scripts per R ed a eseguirli.

Ancora una volta, la cosa è diversa in Linux e dovete solo assicurarvi che la cartelladiR sia inclusa nella variabile
di ambiente PATH; se eseguendo il comando R in una console, R si avvia, allora siete pronti per partire.

Per aggiungere un nuovo algoritmo che chiama una funzione di R (o un più complesso script che avete sviluppato
e vorreste averlo disponibile in SEXTANTE) dovete creare uno script che dica a SEXTANTE come eseguire
quell’operazione ed attivare i corrispondenti comandi di R.

I files di script hanno l’estensione .rsx e crearliè molto facile se avete la conoscenza basilare della sintassi di Re
delle sue regole di scripting; devono essere salvati nella cartella di R; potete configurare tale cartella nel gruppo
di configurazione di R (disponibile nella finestra di dialogo di SEXTANTE), esattamente come per la cartella dei
normali script di SEXTANTE.

Diamo uno sguardo ad uno script molto semplice che chiama la funzione di R “spsample” per creare una griglia
casuale all’interno dei confini dei poligoni (di un polygon layer); questa funzione appartiene al pacchetto “map-
tools”. Poichè la gran parte degli algoritmi che vorrete incorporare in SEXTANTE useranno o genereranno dati
spaziali, la conoscenza dei pacchetti spaziali tipo “maptools” e specialmente “sp” è obbligatoria.

##polyg=vector
##numpoints=number 10
##output=output vector
##sp=group
pts=spsample(polyg,numpoints,type="random")
output=SpatialPointsDataFrame(pts, as.data.frame(pts))

Le prime linee, che partono con una coppia di simboli di commento del Python (##) comunicano a SEXTANTE i
valori di ingresso degli algoritmi descritti nel file ed i valori di uscita che genereranno. Essi usano la stessa sintassi
degli script di SEXTANTE che abbiamo già visto, quindi non li ripeteremo quì; controllate la corrispondente
sezione per maggiori ragguagli.

Quando dichiarate un parametro di ingresso, SEXTANTE usa quell’informazione per due scopi:creare l’interfaccia
per la richiesta all’utente del valore di quel parametro e creare una corrispondente variabile di R che può essere
passata successivamente ai comandi di R.

Nel precedente esempio abbiamo dichiarato un valore di ingresso di tipo “vettore” chiamato “polyg”. Nell’ese-
cuzione dell’algoritmo SEXTANTE aprirà in R il layer selezionato dall’utente e lo memorizzerà in una variabile
di nome “polyg”, quindi il nome del parametro è anche il nome della variabile che si usa in R per accedere al
valore del parametro (di conseguenza evitate di usare parole riservate di R come nomi di parametro).

Elementi spaziali tipo layer vettoriali e raster sono letti usando i comandi readOGR() e readGDAL() (non
dovete preoccuparvene in quanto ci penserà SEXTANTE ad aggiungere tali comandi al vostro file di descrizione)
e salvati come oggetti ‘‘Spatial*DataFrame‘‘I campi di una tabella sono salvati come stringhe contenenti il nome
del campo selezionato.

Le tabelle sono aperte usando il comando read.csv().Se la tabella non è in formato CSV sarà preventivamente
convertita in tale formato prima di essere importata in R.

Detto ciò, ora possiamo capire la prima linea del nostro script di esempio (la prima senza il segno di commento in
Python).

pts=spsample(polyg,numpoints,type="random")

La variabile polygon contiene un oggetto SpatialPolygonsDataFrame così può essere usato per chia-
mare la funzione spsample o similmente la funzione numpoints che indica il numero di punti da aggiungere
alla griglia creata.

Avendo dichiarato un risultato di tipo vettore chiamato out, dobbiamo creare una variabile di nome out e mem-
orizzarvi un oggetto Spatial*DataFrame (in questo caso un SpatialPointsDataFrame). Potete usare
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qualsiasi nome per le variabili intermedie, assicuratevi però che la variabile contenente il risultato finale abbia lo
stesso nome con cui l’avete dichiarata e che contenga un valore appropriato.

In questo caso il risultato ottenuto dalla funzione spsample deve essere convertito esplicitamente in un oggetto
SpatialPointsDataFrame in quanto è nativamente un oggetto di classe ppp che non è una classe adatta
per SEXTANTE.

Se il vostro algoritmo non genera un layer ma un risultato testuale, dovete dire a SEXTANTE che volete attivare
la console una volta finita l’elaborazione. Per farlo iniziate la linea di comando che produce il risultato che volete
visualizzare con il carattere > (maggiore di); il risultato di tutti gli altri comandi non sarà mostrato. Ad esempio
quì c’è il file di descrizione di un algoritmo che esegue un test di normalità su un dato campo (colonna) degli
attributi di un layer vettoriale:

##layer=vector
##field=field layer
##nortest=group
library(nortest)
>lillie.test(layer[[field]])

Il risultato dell’ultima linea sarà stampato,ma il risultato della prima no (e nemmeno quelli delle altre linee
aggiunte automaticamente da SEXTANTE).

Se il vostro algoritmo produce qualche tipo di risultato grafico (usando la funzione plot()) dovete aggiungere
la linea seguente:

##showplots

Questo provocherà la redirezione di tutti i risultati grafici di R verso un file temporaneo che potrà essere aperto ad
avvenuta esecuzione di R.

I risultati sia grafici che testuali saranno visualizzati nel gestore dei risultati di SEXTANTE.

Per maggiori informazioni controllate gli script forniti con SEXTANTE; la maggior parte di essi sono molto
semplici e vi aiuteranno moltissimo a capire come costruire i vostri.

17.7.4 GRASS

La configurazione di GRASS non è molto differente da quella di SAGA. Per prima cosa occorre definire, ma
solo nel caso di Windows, il percorso della cartella di GRASS; Inoltre occorre definire la shell di interfaccia
normalmente msys.exe che si trova in molte distribuzioni di GRASS per Windows) ed il suo percorso.

Normalmente SEXTANTE cerca di configurare il suo connettore per GRASS per usare la distribuzione inclusa in
QGIS; questo dovrebbe funzionare senza problemi nella maggior parte dei casi, ma se riscontrate dei problemi,
avete la possibilità di agire manualmente. Inoltre se volete usare una versionedi GRASS differente, potete cam-
biare la configurazione per indirizzarla verso il percorso della cartella dove avete salvato la versionedi GRASS
che volete usare. Per un corretto funzionamento degli algoritmi è richiesta la versione 6.4 d iGrass.

Se state usando Linux dovete solo assicurarvi che GRASS è correttamente installato e che può essere attivato
senza problemi da una console.

Gli algoritmi di GRASS usano una regione per le loro elaborazioni.Questa regione può essere definita manual-
mente, usando valori simili a quelli usati per la configurazione di SAGA, o automaticamente, prendendo ogni
volta la minima estensione geografica che contiene i layers usati per il calcolo. Se preferite questo funzionamento
spuntate la casella Usa la minima regione disponibile nei parametri di configurazione di GRASS.

GRASS contiene dei files di aiuto che descrivono ogni algoritmo. Se spuntate la casella GRASS cartella di aiuto
SEXTANTE l’aprirà quando userete il bottone [Visualizza aiuto] della finestra dei parametri dell’algoritmo.

L’ultimo parametro da configurare è legato al mapset. È necessanio un mapset. per eseguire GRASS e SEX-
TANTE ne crea uno provvisorio per ogni esecuzione. Dovete segnalare a SEXTANTE se state usando coordinate
geografiche (lat/lon) o proiettate.
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17.7.5 GDAL

Per eseguire GDAL non è necessaria alcuna configurazione perchè è già incorporato in QGIS e SEXTANTE
preleva da lì la propria configurazione.

17.7.6 Orfeo ToolBox

Gli algoritmi di Orfeo ToolBox (OTB) possono essere usatiin SEXTANTE seavete OTB installato sul vostro
sistema e configurato opportunamente SEXTANTE in modo che possa trovare tutti i files necessari (comandi a
linea e librerie). Prendete nota che gli eseguibili di SEXTANTE non sono inclusi in SEXTANTE,per cui dovete
scaricarli ed installarli da soli. Controllate il sito di OTB per maggiori informazioni.

Una volta installato OTB, avviate QGIS, aprite la finestra di configurazione di SEXTANTE e inserite il gestore
degli algoritmi di OTB. Nella casella Orfeo Toolbox (analisi di immagini) troverete ogni parametro relativo a OTB;
per prima cosa assicuratevi che gli algoritmi di OTB sono abilitati.

Quindi configurate il percorso della cartella che contiene i comandi e le librerie di OTB:

• normalmente OTB cartella dell’applicazione punta a /usr/lib/otb/applications e OTB
cartella dei comandi è /usr/bin

• se usate l’installatore OSGeo4W allora installate il pacchetto otb-bin ed inserite
C:\OSGeo4W\apps\orfeotoolbox\applications come OTB cartella dell’applicazione e
C:\OSGeo4W\bin come OTB cartella dei comandi

17.7.7 TauDEM

Per installare questo gestore dovete installare gli strumenti di TauDEM a linea di comando.

Windows

Per le istruzioni di installazione e gli eseguibili precompilati per sistemi a 32bit e 64bit visitate il sito Tau-
DEM <http://hydrology.usu.edu/taudem/taudem5.0/downloads.html>. IMPORTANTE: servono gli eseguibili
della versione 5.0.6, la versione 5.2 non è al momento supportata.

Linux

Per molte distribuzioni Linux non sono disponibili pacchetti precompilati così dovete compilare TauDEM da soli.
Poichè TauDEM usa MPICH2, per prima cosa dovete installarlo mediante il vostro gestore dei pacchetti preferito.
TauDEM lavora bene anche con OpenMPI, quindi potete usare questo in sostituzione di MPICH2.

Scaricate i sorgenti di TauDEM 5.0.6 dal sito <http://hydrology.usu.edu/taudem/taudem5.0/TauDEM5PCsrc_506.zip>‘
e scompattate i files in qualche cartella.

Aprite il file linearpart.h ed aggiungete dopo la linea

#include "mpi.h"

aggiungete una nuova linea con

#include <stdint.h>

così avrete

#include "mpi.h"
#include <stdlib.h>

Salvate le modifiche e chiudete il file. Ora aprite il file tiffIO.h, cercate la linea #include "stdint.h"
e sostituite gli apostrofi ("") con <>, così avrete
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#include <stdint.h>

Salvate le modifiche e chiudete il file.Create la cartella di compilazione e spostatevi in essa

mkdir build
cd build

Preparate la vostra compilazione con il comando

CXX=mpicxx cmake -DCMAKE_INSTALL_PREFIX=/usr/local ..

e quindi compilate

make

Infine per installare TauDEM in /usr/local/bin eseguite

sudo make install
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CAPITOLO 18

Compositore di stampe

Il compositore di stampe fornisce funzionalità per la creazione di layout di stampa in continua evoluzione. Con-
sente di aggiungere al layout elementi come la vista mappa, la legenda, la barra di scala, immagini esterne, forme
e campi testuali. È possibile cambiare le dimensioni, raggruppare, allineare e spostare ogni elemento e regolarne
le proprietà. Il risultato può essere stampato (anche come Postscript e PDF), esportato come immagine o come
disegno vettoriale in formato SVG. Il layout, inoltre, può essere salvato come modello e caricato in altre sessioni
di QGIS. Si veda l’elenco degli strumenti nella tabella table_composer_1:

Icona Azione Icona Azione

Caraica da modello Salva come modello

Esporta come immagine Esporta come PDF

Esporta come SVG Stampa

Vista ad estensione massima Ingrandisci

Rimpicciolisci Aggiorna la vista

Annulla l’ultimo cambiamento Rispristina l’ultimo cambiamento

Aggiungi mappa Aggiungi immagine

Aggiungi etichetta Aggiungi nuova legenda vettoriale

Aggiungi nuova barra di scala Aggiungi forma base

Aggiungi freccia Aggiungi tabella attributi

Scegli/Sposta oggetto Sposta contenuto elemento

Raggruppa oggetti Rimuovi raggruppamento

Muovi in alto Muovi in basso

Porta in cima Porta in fondo

Allinea a sinistra Allinea a destra

Allinea su asse verticale Allinea su asse orizzontale

Allinea in alto Allinea in basso

Strumenti del Compositore di Stampe

Tutti gli strumenti di Composizione di Stampa sono accessibili sia dai menu che dalla barra degli strumenti. La
barra degli strumenti può essere disattivata cliccando con il tasto destro del mouse direttamente sulla barra.
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18.1 Aprire un nuovo modello di stampa

Prima di iniziare a lavorare con il compositore di stampe, è necessario caricare alcuni layer raster e vettoriali
nella vista mappa di QGIS e regolarne le proprietà secondo le proprie esigenze. Una volta effettuate tutte le

impostazioni e applicata la simbologia cliccare sul pulsante Nuova composizione di stampa oppure cliccare su File →
Nuova composizione di stampa.

18.2 Usare il compositore di stampe

Aprendo il compositore di stampe viene visualizzato un foglio bianco al quale aggiungere mappa, legenda, barra
di scala, immagini, forme e testo. La figura Figure_composer_1 mostra la vista iniziale del compositore di stampe

prima dell’aggiunta di un qualunque elemento, con la modalità Snap alla griglia attivata.

Figura 18.1: Print Composer

Il compositore di stampe presenta tre schede:

• La scheda Generale consente di impostare la dimensione del foglio, l’orientamento e la qualità di stampa del

file in uscita in dpi e le modalità di snap. Si noti che la casella di controllo Snap alla griglia funziona

solo se si è impostata una risoluzione > 0. Inoltre, è possibile attivare la casella di controllo Stampa
come raster: tutti gli elementi saranno rasterizzati prima della stampa o del salvataggio come Postscript o
PDF.

• La scheda Oggetto mostra le proprietà dell’elemento selezionato nel layout di stampa.Cliccare sull’icona
Seleziona/Sposta oggetto per selezionare un elemento (ad es. legenda, barra di scala o etichetta testuale) nel

layout. Cliccare dunque sulla scheda Oggetto e personalizzare le impostazioni dell’elemento selezionato.

• La scheda Storico comandi mostra la storia di tutti i cambiamenti attuati nel layout di stampa. È possibile
cancellare e ripristinare più cambiamenti con un semplice click del mouse.

Possono essere aggiunti diversi elementi al compositore ed è anche possibile avere più di una mappa o legenda
o barra di scala nel layout di stampa. Ogni elemento ha le sue proprietà e, nel caso delle viste mappa, la propria
estensione. Per eliminare un elemento dal layout di stampa usare i tasti e Canc o Backspace.
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18.3 Aggiungere una mappa al layout nel compositore di stampe

Per aggiungere una mappa, cliccare sul pulsante Aggiungi mappa nella barra strumenti del compositore di stampe
e tracciare sul layout un rettangolo in cui inserire la mappa. La modalità di visualizzazione della mappa può essere
impostata nella scheda Oggetto:

• Rettangolo visualizza un rettangolo vuoto con la scritta ‘La mappa verrà stampata Rettangolo qui’.

• Cache disegna la mappa alla risoluzione corrente dello schermo. Se si ingrandisce/rimpiccolisce la finestra
del compositore, la mappa non viene ridisegnata, ma l’immagine viene scalata.

• Visualizza a differenza del metodo cache, in questo caso se si ridimensiona la finestra del compositore, la
mappa viene ridisegnata.

Cache è la modalità predefinita per ogni nuovo compositore di mappe.

È possibile ridimensionare la mappa in un momento successivo cliccando sul pulsante Seleziona/Sposta oggetto,
selezionando un elemento e trascinando una delle maniglie blu agli angoli della mappa. Una volta selezionata una
mappa, è possibile regolarne ulteriori proprietà nella scheda Opzioni.

Per spostare l’area visualizzata nella vista mappa, cliccare sul pulsante Sposta contenuto oggetto e spostare la vista

nella cornice della vista mappa trascinando con il tasto sinistro del mouse premuto. È possibile bloccare/sbloccare

la posizione di un elemento nel layout di stampa selezionando e facendo click sullo stesso con il tasto destro del

mouse, oppure attivando la casella di controllo Blocca i layer per la mappa nella seziona Mappa della scheda
Oggetto.

Nota: QGIS permette di utilizzare le etichette del nuovo plugin etichette anche nel compositore di stampe, anche
se le stesse non vengono scalate correttamente: in alcuni casi potrebbe essere necessario utilizzare le etichette di
vecchia generazione.

18.3.1 Oggetto Mappa — Mappa ed Estensione mappa

Finestra di dialogo Mappa

La finestra di dialogo Mappa presente nella scheda Oggetti fornisce le seguenti funzionalità (figura
figure_composer_2):

Figura 18.2: Map Dialog

• La sezione [Anteprima] permette di impostare la modalità di anteprima come descritto precedentemente.
Cliccare su [Aggiorna] anteprima per salvare le modifiche.

• La sezione Mappa permette di dimensionare gli elementi della mappa specificandone altezza e larghezza o

la scala. Il campo Rotazione permette di ruotare il contenuto dell’elemento mappa in senso orario
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per gradi. Si noti che è possibile aggiungere un reticolato delle coordinate solo se il valore di rotazione è

impostato a 0. Si possono, inoltre, attivare le caselle di controllo Blocca i layer per la mappa e
Disegna elementi sulla mappa.

Se si apportano delle modifiche nella vista mappa di QGIS, è possibile aggiornare la vista nel compositore di
stampe cliccando sul pulsante [Aggiorna anteprima] .

Finestra di dialogo Estensione mappa

La finstra di dialogo Estensione mappa fornisce le seguenti funzionalità (figura figure_composer_3)):

Figura 18.3: Extents Dialog

• La sezione [Estensione mappa] permette di impostare l’estensione della mappa tramite valori
minimo/massimo in X e Y o cliccando sul pulsante [Imposta all’estensione della mappa].

Se si apportano delle modifiche nella vista mappa di QGIS, è possibile aggiornare la vista nel compositore di
stampe selezionando l’elemento mappa e cliccando sul pulsante [Aggiorna anteprima] della sezione Mappa
della scheda Oggetto (figura figure_composer_2 a)).

18.3.2 Oggetto Mappa — Reticolato ed Opzioni generali

Finestra di dialogo Reticolato

La finestra di dialogo Reticolato fornisce le seguenti funzionalità (figura Figure_composer_4):

Figura 18.4: Grid Dialog

• La casella di controllo Mostra reticolato permette di sovrapporre una griglia sull’elemento mappa,
specificandone tipo (Solido o Croce), intervallo ed offset in X e Y, spessore, colore.

• La casella di controllo Scrivi le coordinate permette di aggiungere le coordinate alla cornice del-
la griglia. Le coordinate possono essere visualizzate all’interno o all’esterno della cornice, in verticale
e/o n orizzontale; è inoltre possibile specificare il carattere, la distanza dalla mappa e la precisione delle
coordinate.

188 Capitolo 18. Compositore di stampe



QGIS User Guide, Release 1.8

Finestra di dialogo Opzioni generali

La finestra di dialogo Opzioni generali fonrisce le seguenti funzionalità (figura Figure_composer_5):

Figura 18.5: General Options Dialog

• E’ possibile impostare colore e spessore esterno della cornice e colore ed opacità dello sfondo dell’elemento
mappa. Il pulsante [Posizione e dimensione] apre la finestra di dialogo Definisci posizione oggetto che
permette di impostare la posizione dell’elemento mappa tramite punti di riferimento o tramite coordinate.

La casella di controllo Mostra cornice permette di definire se visualizzare o meno la cornice di un
elemento. L’opzione ID oggetto permette creare un collegamento con altri oggetti di altri compositori di
stampa.

18.4 Aggiungere altri elementi al compositore di stampa

Oltre ad aggiungere una mappa al layout di stampa, è anche possibile aggiungere, spostare e personalizzare
legenda, barra di scala, immagini ed etichette.

18.4.1 Oggetto etichetta - Etichetta ed Opzioni generali

Per aggiunger un’etichetta, cliccare su Aggiungi etichetta, posizionare gli elementi con il tasto sinistro del mouse
sul layout di stampa e personalizzarli nella scheda Etichette.

Finestra di dialogo Etichetta

La finestra di dialogo Etichetta fornisce le seguenti funzionalità:

Figura 18.6: Label Options Dialog
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• La finestra di dialogo Etichetta permette di inserire un testo al layout di stampa. È possibile impostare
allineamento, carattere, colore e margine dell’etichetta.

Finestra di dialogo Opzioni generali

La finestra di dialogo Opzioni generali fornisce le seguenti funzionalità:

Figura 18.7: General Options Dialog

• E’ possibile impostare colore e spessore per la cornice dell’etichetta, impostare un colore di sfondo e l’opac-
ità. Il pulsante Posizione e dimensione apre la finestra di dialogo Definisci posizione oggetto che permette di
impostare la posizione dell’etichetta tramite punti di riferimento o tramite coordinate. La casella di controllo

Mostra cornice permette di definire se visualizzare o meno la cornice di un elemento.

18.4.2 Oggetto immagine - Opzioni immagine ed Opzioni generali

Per aggiungere un’immagine, cliccare su Aggiungi immagine, posizionare gli elementi con il tasto sinistro del
mouse sul layout di stampa e personalizzarli nella relativa sezione nella scheda Oggetto.

Finestra di dialogo Opzioni immagine

La finestra di dialogo Opzioni immagine fornisce le seguenti funzionalità (figura figure_composer_5 a):

Figura 18.8: Picture Options Dialog Dialog

• Il campo Anteprima mostra le immagini memorizzate nella cartella selezionata.

• La sezione Options permette di impostare larghezze, altezza e rotazione dell’immagine. È anche possibile

inserire un percorso ad un file immagine. Attivando la casella di controllo Sincronizza con la mappa, si
sincronizza la rotazione dell’immagine con quella dell’oggetto mappa.
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• La sezione Cerca cartelle permettere di selezionare ed aggiungere alla banca dati delle immagini le cartelle
contenenti immagini in formato SVG.

Finestra di dialogo Opzioni generali

La finestra di dialogo Opzioni generali fornisce le seguenti funzionalità:

Figura 18.9: General Options Dialog Dialog

• E’ possibile impostare colore e spessore per la cornice dell’immagine, impostare un colore di sfondo e
l’opacità. Il pulsante [Posizione e dimensione] apre la finestra di dialogo Definisci posizione oggetto che
permette di impostare la posizione dell’etichetta tramite punti di riferimento o tramite coordinate. La casella

di controllo Mostra cornice permette di definire se visualizzare o meno la cornice di un elemento.

18.4.3 Oggetto legenda - Generale, Oggetti legenda ed Opzioni oggetto

Per aggiunger una legenda, cliccare su Aggiungi nuova legenda vettoriale, posizionare gli elementi con il tasto sinistro
del mouse sul layout di stampa e personalizzarli nella relativa sezione nella scheda Oggetto.

Finestra di dialogo Generale

La finestra di dialogo Generale fornisce le seguenti funzionalità (figura figure_composer_10):

Figura 18.10: General Dialog

• E’ possibile inserire un titolo per la legenda ed impostare i caratteri del titolo stesso, oltre che dei vari
elementi della legenda (layer, gruppi, etc.). È possibile cambiare dimensione ai simboli di legenda ed
inserire layer, simboli, etichette.Dalla versione 1.8 di QGIS è possibile modificare il carattere del titolo
della legenda.

Finestra di dialogo Oggetti legenda
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La finestra di dialogo Oggetti legenda fornisce le seguenti funzionalità (figura figure_composer_11):

Figura 18.11: Legend Items Dialog

• La finestra elenca tutti gli elementi della legenda e permette di modificare (ordine e nome), rimuovere e
ripristinare gli elementi stessi. Se si apportano delle modifiche alla simbologia nella vista mappa di QGIS,
è possibile aggiornare la legenda nel compositore di stampe cliccando sul pulsante [Aggiorna]. L’ordine
degli elementi può essere cambiato con i pulsanti [Su] e [Giù] oppure trascinandoli con il mouse.

Finestra di dialogo Opzioni generali

La finestra di dialogo Opzioni generali fornisce le seguenti funzionalità (figura figure_composer_12):

Figura 18.12: General Options Dialog

• E’ possibile impostare colore e spessore per la cornice della legenda, impostare un colore di sfondo e
l’opacità. Il pulsante [Posizione e dimensione] apre la finestra di dialogo Definisci posizione oggetto che
permette di impostare la posizione dell’etichetta tramite punti di riferimento o tramite coordinate. La casella

di controllo Mostra cornice permette di definire se visualizzare o meno la cornice di un elemento.

18.4.4 Oggetto Scala - Barra di scala ed Opzioni generali

Per aggiungere una barra di scala, cliccare su Aggiungi nuova barra di scala , posizionare gli elementi con il tasto
sinistro del mouse sul layout di stampa e personalizzarli nella relativa sezione nella scheda Oggetto.

Finestra di dialogo Barra di scala

La finestra di dialogo Barra di scala fornisce le seguenti funzionalità (figura figure_composer_13):

• Permette di impostare la dimensione del segmento della barra di scala, le unità di mappa e quanti segmenti
unitari usare a sinistra e a destra dello 0.

• È possibile definire lo stile della barra come riquadro singolo o doppio, con tacche verticali o numerico.
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Figura 18.13: Scalebar Options Dialog

• È possibile definire altezze, spessore linee, etichette e riquadro della barra, aggiungere etichette per l’unità
di misura ed impostare carattere e colore.

Finestra di dialogo Opzioni generali

La finestra di dialogo Opzioni generali fornisce le seguenti funzionalità (figura figure_composer_7 b)):

Figura 18.14: General Options Dialog

• E’ possibile impostare colore e spessore per la cornice della barra di scala, impostare un colore di sfondo e
l’opacità. Il pulsante [Posizione e dimensione] apre la finestra di dialogo Definisci posizione oggetto che
permette di impostare la posizione dell’etichetta tramite punti di riferimento o tramite coordinate. La casella

di controllo Mostra cornice permette di definire se visualizzare o meno la cornice di un elemento.

18.5 Strumenti per l’esplorazione del layout di stampa

Per l’esplorazione del layout nel compositore di stampe sono forniti quattro strumenti:

• Ingrandisci

• Rimpicciolosci

• Vista ad estensione massima

• Aggiorna la vista, che serve nel caso in cui la vista nel layout non rispecchi quanto presente nella vista mappa
di QGIS
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18.6 Strumenti Annulla e Ripristina

Durante la creazione di un layout di stampa è possibile annullare e ripristinare dei cambiamenti tramite gli
strumenti:

• Annulla l’ultimo cambiamento

• Ripristina l’ultimo cambiamento

oppure tramite la scheda Storico dei comandi (figura figure_composer_9).

Figura 18.15: Command history in the Print Composer

18.7 Aggiungere forme di base e frecce

È possibile aggiungere al layout di stampa forme geometriche (Ellisse, Rettangolo, Triangolo) e frecce.

La finestra di dialogo Forma permette di tracciare un’ellisse, un rettangolo o un triangolo sul layout di stampa. È
possibile impostare bordo, colore di riempimento e rotazione.

Figura 18.16: Shape Dialog

La finestra di dialogo Freccia permette di tracciare una freccia sul layout di stampa. È possibile impostare colore,
bordo, spessore, indicatore. Inoltre si possono usare simboli SVG dopo averli selezionati da una specifica cartella.
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Figura 18.17: Arrow Dialog

18.8 Aggiungere valori dalla tabella degli attributi

È possibile aggiungere parti di una tabella attributi al layout di stampa.

Finestra di dialogo Tabella

La finstra di dialogo Tabella fornisce le seguenti funzionalità (figura figure_composer_20):

Figura 18.18: Table Dialog

• Permette di selezionare un layer vettoriale e le colonne della tabella degli attributi. È possibile visualizzare
le colonne attributo in ordine crescente o decrescente.

• È possibile impostare il numero massimo di righe da visualizzare e scegliere se mostrare solo gli attributi
degli elementi visibili nella mappa sul layout di stampa.

• È, infine, possibile impostare le caratteristiche della griglia della tabella, l’intestazione ed il carattere.

Finestra di dialogo Opzioni generali

La finestra di dialogo Opzioni generali fonrisce le seguenti funzionalità (figura Figure_composer_21):

• E’ possibile impostare colore e spessore esterno della cornice e colore ed opacità dello sfondo dell’elemento
mappa. Il pulsante [Posizione e dimensione] apre la finestra di dialogo Definisci posizione oggetto che
permette di impostare la posizione dell’elemento mappa tramite punti di riferimento o tramite coordinate.

La casella di controllo Mostra cornice permette di definire se visualizzare o meno la cornice di un
elemento. L’opzione ID oggetto permette creare un collegamento con altri oggetti di altri compositori di
stampa.
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Figura 18.19: General Options Dialog

18.9 Muovere in alto, muovere in basso ed allineare elementi

Le funzionalità per muovere in alto o in basso gli elementi del layout di stampa sono nel menu
Muovi gli oggetti selezionati: selezionare un elemento dal layout di stampa e scegliere la funzionalità richiesta dal menu
citato (tabella table_composer_1).

Diverse funzionalità di allineamento sono presenti nel menu Allinea gli oggetti selezionati (tabella table_composer_1):
selezionare alcuni elementi dal layout di stampa e scegliere la funzionalità richiesta dal menu citato.

18.10 Creazione di file in uscita

Figure_composer_22 mostra il compositore di stampe con un layout di stampa completo di ognuno degli elementi
precedentemente descritti.

Figura 18.20: Print Composer with map view, legend, scalebar, coordinates and text added

Il compositore di stampe consente di creare diversi formati in uscita ed è possibile definirne la risoluzione (qualità
di stampa) e il formato pagina:

• L’ciona Stampa consente di stampare il layout su una stampante collegata o su un file PDF o Postscript.

• L’icona Esporta come immagine esporta il layout in diversi formati immagine come PNG, BPM, TIF, JPG,...
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• L’icona Esporta come PDF esporta il layout in formato PDF.

• L’icona Esporta come SVG salva il layout di stampa in formato SVG (Scalable Vector Graphic).

Nota: Attualmente il supporto SVG è ad un livello molto iniziale. Il problema non è di QGIS, ma nella sottostante
libreria Qt. Ci si augura che questo problema venga risolto nelle prossime versioni della libreria.

18.11 Salvare e caricare un layout di stampa

L’icona Salva come modello consente di salvare lo stato della sessione del compositore di stampe come modello in

un file con estensione .qpt. L’icona Carica da modello consente di caricare il modello salvato in un’altra sessione.

Il pulsante Gestore di stampe nel menu File permette di aggiungere un nuovo modello di stampa e di gestire i
modelli esistenti.

Figura 18.21: The Print Composer Manager

18.11. Salvare e caricare un layout di stampa 197



QGIS User Guide, Release 1.8

198 Capitolo 18. Compositore di stampe



CAPITOLO 19

Plugin di QGIS

19.1 Plugin di QGIS

QGIS è stato progettato con un’architettura estensibile tramite plugin. Ciò permette di aggiungere nuove caratter-
istiche e funzioni all’applicazione. Molte delle caratteristiche in QGIS sono in effetti implementate come plugin
di base Core o Esterni.

• I Plugin Core sono mantenuti dal team di sviluppo di QGIS e fanno automaticamente parte di ogni dis-
tribuzione QGIS. Sono scritti in uno dei due seguenti linguaggi: C++ o Python. Ulteriori informazioni
riguardanti i plugin core sono disponibili nella sezione Uso dei plugin di base di QGIS

• Plugin Esterni sono scritti in Python. Sono memorizzati in archivi esterni e mantenuti dai singoli autori.
Possono essere aggiunti a QGIS usando l’Installatore di plugin Python. Ulteriori informazioni riguardanti i
plugin esterni sono disponibili nella sezione Caricamento di un plugin esterno.

19.1.1 Gestione dei plugin

La gestione dei plugin consiste nella loro abilitazione o disabilitazione usando il Gestore plugin. I plugin esterni
devono prima essere installati usando l’Installatore di plugin Python. Per attivare/disattivare i plugin esterni, una
volta installati, si usa Gestore plugin.

Abilitare un Plugin Core

L’abilitazione di un Plugin Core si ottiene dal menu principale Plugins → Gestione plugins

The Plugin Manager lists all the available plugins and their status (loaded or unloaded), including all core plugins
and all external plugins that have been installed and automatically activated using the Python Plugin Installer (see
Section Caricamento di un plugin esterno). Those plugins that are already loaded have a check mark to the left of
their name. Figure_plugins_1 shows the Plugin Manager dialog.

Per abilitare un plugin cliccare sulla casella di controllo e cliccare su [OK]. Lo stato dei plugin, attivo/disattivo,
viene memorizzato quanto si termina una sessione di QGIS, in modo tale che al successivo riavvio, i plugin
vengano automaticamente caricati.

Suggerimento: Blocco dei plugin
Se QGIS si blocca all’avvio, la colpa potrebbe essere di un plugin. È possibile disabilitare il caricamento dei plugin
modificando il file delle impostazioni (sezione Opzioni dell’interfaccia grafica (GUI)). Una volta individuate le
impostazioni dei plugin, bisogna impostare il valore di ognuno su false in modo da impedirne il caricamento.

Per esempio per disabilitare il plugin Testo delimitato, la modifica da effettuare sul file
$HOME/.config/QuantumGIS/qgis.conf in Linux dovrebbe apparire così: Add Delimited
Text Layer=false.
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Figura 19.1: Plugin Manager

Eseguire l’operazione per tutti i [Plugin] della sezione, avviare successivamente QGIS ed aggiungere i plugin uno
alla volta tramite il Gestore plugin per determinare quale stia causando il problema.

Caricamento di un plugin esterno

I plugin Esterni sono scritti in Python e risiedono negli archivi ‘Ufficiali’ di QGIS, oppure in vari archivi esterni
mantenuti dai singoli autori. Gli archivi ‘Ufficiali’ di QGIS sono aggiunti in modo predefinito in Recupero Plugin
Python.

Documentazione dettagliata, versione minima di QGIS richiesta, pagina web, autori ed altro sono disponibili per
gli archivi ‘Ufficiali’ di QGIS all’indirizzo http://plugins.qgis.org/plugins/. Per gli archivi esterni, le informazioni
potrebbero essere fornite insieme al plugin stesso. In linea generale non è inclusa in questo manuale.

Nota: Aggiornamenti dei plugin Core potrebbero essere forniti in archivi esterni.

Nota: fTool, Mapserver Export e l’Installatore dei plugin sono plugin Python, ma sono anche parte del codice
di QGIS, quindi vengono automaticamente caricati e abilitati nel gestore di plugin (sezione Caricamento di un
plugin esterno).

Attualmente sono disponibili 150 plugin esterni dagli archivi ‘Ufficiali’ di QGIS. Alcuni di questi plugin offrono
funzionalità comuni richieste da molti utenti (es. visualizzare e modificare dati Open Street Map o caricare layer di
Google Map), mentre altri plugin offrono funzionalità molto specialistiche (es. Calculate economic pipe diameters
for water supply networks).

È oltremodo intuitivo cercare plugin esterni tramite parola chiave, scegliere un archivio o impostare un filtro in
funzione dello stato dei plugin (installato o non installato). La ricerca e il filtraggio vengono fatti nel gestore dei
plugin (Figura figure_plugins_2).

Suggerimento: Aggiungere ulteriori archivi
Per aggiunger un archivio esterno, aprire l’installatore di plugin (Plugins → Recupero Plugin Python), andare
nella scheda Repositories, e cliccare su [Aggiungi]. Per modificare/eliminare un archivio cliccare rispettivamente
sui pulsanti [Modifica...] e [Elimina].
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Per integrare un plugin esterno in QGIS è necessario:

• Scaricare il plugin dall’archivio tramite l’Installatore Plugin Python (sezione Uso dell’installatore di
Plugin Python): il plugin verrà aggiunto alla lista dei plugin disponibili nel Gestore Plugin e caricato
automaticamente.

Uso dell’installatore di Plugin Python

Per scaricare ed installare un plugin python esterno, cliccare su Plugins → Recupero Plugin Python: si aprirà
la finestra di dialogo Installatore plugin (figura figure_plugins_2) con la scheda Plugins, contenente la lista sia di
tutti i plugin python disponibili negli archivi remoti sia di quelli installati.

Figura 19.2: Installing external python plugins

Ogni plugin può essere:

• non installato - significa che il plugin è disponibile nell’archivio remoto, ma non ancora installato. Per
installarlo, selezionarlo dalla lista e cliccare su [Installa plugin].

• nuovo - significa che il plugin è nuovo tra quelli disponibili nell’archivio.

• installato - il plugin è installato. Se è anche disponibile in qualsiasi archivio remoto il pulsante [Reinstalla
plugin] è abilitato. Se la versione disponibile in remoto è più vecchia di quella installata, appare invece il
pulsante [Downgrade plugin].

• aggiornabile - il plugin è installato, ma è disponibile in una versione più recente. I pulsanti [Aggiorna
plugin] e [Aggiorna tutti] sono abilitato.

• non valido - il plugin è installato, ma è inutilizzabile. La ragione è spiegata nella descrizione del plugin.

Scheda plugin

Per installare un plugin, selezionarlo dalla lista e cliccare su [Installa plugin]. Il plugin è attivato ed installato
nella sua propria directory.

• Linux ed altri Unix

– /share/qgis/python/plugins

– $HOME/.qgis/python/plugins

• Mac OS X

– /Contents/MacOS/share/qgis/python/plugins

– /Users/$USERNAME/.qgis/python/plugins

• Windows

– C:\Program Files\QGIS\python\plugins

19.1. Plugin di QGIS 201



QGIS User Guide, Release 1.8

– C:\Documents and Settings\$USERNAME\.qgis\python\plugins

Se l’installazione va a buon fine, compare un messaggio di conferma.

Se l’installazione fallisce ne viene indicata la ragione. I problemi più frequenti sono correlati a errori di con-
nessione e/o moduli Python mancanti. Nel primo caso basta attendere e riprovare in un secondo momento, nel
secondo è necessario installare nel sistema operativo i moduli Python mancanti. In Linux, i moduli più richiesti
dovrebbero essere disponibili nel gestore dei pacchetti. Per istruzioni sull’installazione in Windows, visitare la
pagine web del modulo.

Se si usa un proxy, può essere necessario configurarlo in Modifica → Opzioni (Gnome, OSX) o Impostazioni →
Opzioni (KDE, Windows)‘, scheda Rete.

Il pulsante [Disinstalla] il plugin è abilitato solo se il plugin selezionato è installato e non è un plugin Core. Da
notare che se si è installato un aggiornamento di un plugin core, si può sempre disinstallare tale aggiornamento
con il pulsante [Disinstalla] il plugin e ritornare alla versione contenuta nel pacchetto di installazione di Quantum
GIS, ma il plugin non può essere disinstallato.

Scheda Repository

La scheda Repositories, contiene una lista di archivi di plugin disponibili per l’installazione. Come impostazione
predefinita viene usato solamente l’archivio ufficiale di QGIS. Si possono aggiungere archivi messi a disposizione
dagli utenti, incluso l’archivio centrale QGIS Contributed Repository ed altri archivi esterni, usando il pulsante
[Aggiungi...] . Questi archivi contengono un gran numero di plugin non mantenuti dal Team di Sviluppo di QGIS,
pertanto quest’ultimo non se può assumere la responsabilità. Si può anche gestire la lista dei plugin manualmente,
cioè aggiungere, rimuovere o editare le singole voci. È possibile disabilitare temporaneamente un particolare
archivio usando il pulsante [Modifica...].

Scheda Opzioni

Nella scheda Opzioni si possono configurare le impostazioni dell’ Installatore di plugin. La casella di controllo
Controlla aggiornamenti all’avvio indica a QGIS di cercare automaticamente aggiornamenti di plugin e novità.
Se questa opzione è abilitata, tutti i repository elencati e abilitati nella scheda Repositories vengono controllati
ogni volta che il programma viene avviato. È possibile modificare la frequenza di controllo degli aggiornamenti
usando il menu a cascata: sono disponibili le opzioni una volta al giorno e una volt al mese. Se è disponibile un
nuovo plugin o un aggiornamento di quelli installati, compare una notifica nella barra di stato. Se la casella di
controllo non è attivata, la ricerca di aggiornamenti e novità avviene solo quando viene lanciato l’Installatore di
plugin.

Sebbene l’installatore di plugin sia in grado di gestire porte diverse dalla 80, alcune connessioni internet possono
causare degli errori nel tentativo di controllare automaticamente gli aggiornamenti. In questo caso, può esser
visibile durante l’intera sessione di QGIS un indicatore Looking for new plugins... nella barra di stato che può
causare il blocco del programma alla chiusura. Per aggirare il problema, disattivare gli aggiornamenti automatici.

Inoltre, è possibile specificare il tipo di plugin da elencare nell’ Installatore di plugin. Sotto Plugin disponibili, si
può specificare:

• Mostra solo i plugin provenienti da repository ufficiali

• Mostra tutti i plugin esclusi quelli marcati come sperimentali

• Mostra tutti i plugin, compresi quelli marcati come sperimentali

Suggerimento: Utilizzo dei plugin sperimentali
I plugin sperimentali non sono generalmente adatti al lavoro produttivo. Questi plugin sono in fase prematura di
sviluppo e sono da considerare ‘incompleti’ o quali ‘idee concettuali’. Il team di sviluppo di QGIS sconsiglia
l’installazione di questi plugin, a meno che non si intenda usarli per attività di test.
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19.1.2 Fornitori di dati

I Fornitori dati sono plugin ‘speciali’ che danno accesso ad un archivio di dati. Di default, QGIS supporta i layer
PostGIS e gli archivi di dati su disco supportati dalla libreria GDAL/OGR: un plugin fornitore di dati estende la
capacità di QGIS di utilizzare altre fonti di dati.

Tali plugin sono registrati automaticamente all’avvio di QGIS. Non sono gestiti dal gestore di plugin, ma usati
dietro le quinte quando un tipo di dati viene aggiunto come layer in QGIS.
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19.2 Uso dei plugin di base di QGIS

Icona Plugin Descrizione Riferimento guida

Aggiungi layer
testo delimitato

Carica e mostra file di testo delimitato che contengono
coordinate X e Y

Plugin Testo
Delimitato

Cattura Coordinate Cattura le coordinate del mouse usando un SR diverso Plugin Cattura
coordinate

DB Manager Gestisce i database con QGIS Plugin DB Manager
Diagramma
sovrapposto

Un plugin che disegna un diagramma sopra un layer
vettoriale

Plugin Diagramma
sovrapposto

Convertitore
DXF2Shape

Converte da dxf a shp Plugin Dxf2Shp
Converter

eVis Uno strumento di visualizzazione di eventi. Visualizza
immagini associate agli elementi di un vettore

Plugin eVis

fTools Strumenti per l’analisi e la gestione di dati vettoriali Plugin fTools

Strumenti GPS Strumenti per caricare e importare dati GPS Plugin GPS

GRASS Attiva i potenti strumenti di GRASS Integrazione con
GRASS GIS

Strumenti GDAL Strumenti raster: interfaccia grafica semplificata per
l’utilizzo dei programmi GDAL più comuni

Plugin GDALTools

Georeferenziatore
raster (GDAL)

Georeferenzia raster tramite GDAL Plugin
Georeferenziatore

Mappa di
concentrazione

Crea una mappa raster di concentrazione a partire da un
vettore di punti

Plugin Mappa di
concentrazione

Plugin di
interpolazione

Un plugin per l’interpolazione basata sui vertici di un
vettore

Plugin
Interpolazione

Plugin MapServer
Export

Esporta un progetto QGIS in un file mappa MapServer Plugin MapServer
Export

Offline Editing Consente l’editing offline e la sincronizzazione con il
database

Plugin Offline
Editing

OpenStreetMap Visualizza e modifica dati OpenStreetMap OpenStreetMap

Oracle Spatial
Georaster

Accede a Oracle Spatial GeoRasters Plugin Oracle
Spatial GeoRaster

Installatore di
plugin

Scarica ed installa i plugin python di QGIS Uso dell’installatore
di Plugin Python

Plugin per l’analisi
geomorfologica

Un plugin per l’analisi geomorfologica basata su raster Plugin Analisi
geomorfologica

Plugin grafo strade Trova il percorso più breve Plugin grafo strade

SPIT Shapefile PostGIS Import Tool: strumento per
importare shapefile in PostGIS

Importare dati in
PostgreSQL

Plugin SQL
Anywhere

Salva vettori in un database SQL anywhere Plugin SQL
Anywhere

Plugin di
interrogazione
spaziale

Un plugin per effettuare interrogazioni spaziali su dati
vettoriali

Plugin Spatial Query

Statistiche zonali Calcola statistiche raster per ogni poligono di un vettore Plugin Statistica
zonale
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19.3 Plugin Cattura coordinate

Il plugin Cattura Coordinate permette di mostrare sulla mappa coordinate in due sistemi di riferimento distinti.

Figura 19.3: Coordinate Capture Plugin

1. Avviare QGIS, aprire le proprietà del progetto Proprietà progetto nel menu Impostazioni (KDE, Win-
dows) o File (Gnome, OSX) e scegliere la scheda Sistema di riferimento (SR). In alternativa, cliccare

sull’icona Stato SR nell’angolo in basso a destra della barra di stato.

2. Attivare Abilita la riproiezione al volo e selezionare un sistema di coordinate proiettate a scelta (sezione
Lavorare con le proiezioni).

3. Attivare il plugin Cattura Coordinate nel nel Gestore dei plugins (sezione Abilitare un Plugin Core) ed

assicurarsi che il dialogo sia visibile verificando che Cattura coordinate, in Visualizza → Pannelli, sia
selezionato. La finestra di dialogo Cattura Coordinate è mostrata in figura figure_coordinate_capture_1.

4. Cliccare su Clicca per selezionare il SR da usare durante la visualizzazione delle coordinate e selezionare un SR diverso da
quello selezionato precedentemente.

5. Cliccare su [Start capture] per iniziare la cattura delle coordinate. Cliccare un punto nella mappa e il plugin
mostrerà le coordinate espresse nei due SR selezionati.

6. Per abilitare la tracciatura via mouse delle coordinate selezionate l’icona Clicca per abilitare la tracciatura mouse....

7. Le coordinate selezionate possono essere copiate negli appunti.

19.4 Plugin DB Manager

Il plugin DB Manager fa parte dei plugin core di QGIS e in futuro prenderà il posto dei plugin SPIT e PostGIS

Manager, inoltre integra tutti i formati database supportati da QGIS in un’unica interfaccia grafica. Il plugin
DB Manager ha diverse caratteristiche. E’ possibile trascinare i layer da QGIS Browser direttamente in DB Manager
e questo importerà i layer nel database spaziale. Si possono spostare tabelle fra diversi database spaziali che in
seguito verranno importate. Si può usare DB Manager per lanciare interrogazioni SQL e aggiungere i risultati in
QGIS come layer di interrogazioni.

Il menu Database permette di collegarsi a un database esistente, di lanciare la finestra SQL e di uscire dal plugin
DB Manager. Il menu Schema include strumenti per creare o eliminare schemi (vuoti) e, se la topologia è disponi-
bile (es. PostGIS 2), di iniziare una Vista topologica.Il menu Table permette di creare, modificare ed eliminare
tabelle e viste. Inoltre è anche possibile svuotare tabelle e muoverle verso un altro schema. Infine si può lanciare
una “Vacuum Analyze” e aggiungere una “Versioning Support” a una tabella.

La finestra Tree elenca tutti i database supportati da QGIS. E’ possibile collegarsi al database con un doppio click.
Con il tasto destro del mouse si possono rinominare ed eliminare schemi e tabelle esistenti. Le tabelle possono
essere aggiunte in QGIS anche dal menu contestuale.

Se si è connessi a un database, compaiono tre schede nella finestra principale di DB Manager. La scehda Info
fornisce informazioni sulla tabella e sulle geometrie. Permette inoltre di effettuare una “Vacuum Analyze” e di
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Figura 19.4: DB Manager dialog (KDE)

creare un indice spaziale, se non è presente, pe la tabella selezionata. La scheda Table mostra tutti gli attributi e
con la scheda Preview si può vedere un’anteprima della geometria.

19.5 Plugin Testo Delimitato

Il plugin permette di caricare un file di testo delimitato come layer in QGIS.

19.5.1 Requisiti

Per visualizzare un file di testo delimitato come layer, il testo deve contenere:

1. Una riga di intestazione per i nomi dei campi. Questa deve essere la prima riga del file di testo.

2. La riga di intestazione deve contenere un campo X ed uno Y. Questi campi possono avere qualsiasi nome.

3. Le coordinate x e y devono essere specificate come numeri. Il sistema di coordinate non è importante.

Come esempio di un file di testo valido importiamo il file di punti quotati elevp.csv presente nel dataset
campione di QGIS (sezione Dati campione):

X;Y;ELEV
-300120;7689960;13
-654360;7562040;52
1640;7512840;3
[...]

Alcune note circa il file di testo:

1. Il file di testo usato come esempio usa ; (punto e virgola) come delimitatore. Qualsiasi carattere può essere
usato per delimitare i campi.

2. La prima riga è la riga intestazione. Essa contiene i campi X, Y e ELEV.

3. Nessun tipo di virgoletta (") dev’essere usata per delimitare i campi di testo.

4. Le coordinate x sono contenuto nel campo X.

5. Le coordinate y sono contenuto nel campo Y.

19.5.2 Utilizzo del plugin

Attivare il plugin come descritto nella sezione Gestione dei plugin.
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Cliccare sulla nuova icona della barra dei plugin Aggiungi layer di testo delimitato per aprire la finestra di dialogo
Delimited Text, mostrata in figura figure_delimited_text_1.

Figura 19.5: Delimited Text Dialog

Selezionare il file qgis_sample_data/csv/elevp.csv da importare cliccando su [Sfoglia]. Una volta
caricato il file, il plugin cerca di processarlo usando l’ultimo delimitatore utilizzato, in questo caso un punto e
virgola (;). È fondamentale selezionare il giusto delimitatore. Per cambiare delimitatore usare \t (questa è
un’espressione per il carattere tab).

Selezionare i campi X e Y dai menu a tendina ed il campo WKT per le informazioni sul sistema di riferimento (se
disponibile). Assegnare un nome al layer (es. elevp) ed aggiungere il layer alla vista mappa cliccando su [OK]
(figura figure_delimited_text_1).

19.6 Plugin Diagramma sovrapposto

Il plugin Diagramma sovrapposto permette di sovrapporre un grafico su un file vettoriale (figura fig-
ure_overlay_1). Il plugin fornisce caratteristiche non ancora implementate nella scheda Diagrammi, descritta
nella sezione Scheda Diagrammi.

Il plugin Diagramma sovrapposto deve essere attivato dal Gestore plugin (vedi Abilitare un Plugin Core) prima
di poter essere utilizzato. Comparirà quindi come scheda Overlay nella finestra di dialogo Proprietà layer vicino
all’altra scheda Diagrammi.

La scheda Overlay supporta grafici a torta, istogrammi e simboli SVG.

In modo simile alla scheda Diagrammi è riportato un esempio in cui il layer alaska viene sovrapposto con un
diagramma a torta di dati climatici provenienti da un altro layer vettoriale. Entrambi i layer provengono dal
dataset di esempio di QGIS (sezione Dati campione).
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Figura 19.6: Vector properties dialog with overlay tab

1. Per prima cosa cliccare su Aggiungi vettore e caricare i due file alaska.shp e climate.shp dal dataset
di QGIS.

2. Aprire la finestra di dialogo Proprietà layer facendo doppio click su layer climate.

3. Cliccare sulla scheda Overlay, attivare Visualizza diagrammi e scegliere ‘Grafico a torta’ dalla combo-

box Tipo di diagramma .

4. I dati si riferiscono alle tre colonne T_F_JAN, T_F_JUL e T_F_MEAN. Selezionare come attributo
T_F_JAN e cliccare sul pulsante [Aggiungi] poi effetuare la stessa procedura con T_F_JUL e T_F_MEAN.

5. La dimensione del diagramma è basata sulla scala di classificazione degli attributi. Scegliere T_F_JUL,
cliccare su [Trova valore massimo] e impostare 20. Scegliere ‘millimetri’ da Unità della dimensione

.

6. Cliccare su [Applica] per vedere i diagrammi nella finestra principale di QGIS.

7. E’ possibile adattare la grandezza del diagramma oppure cambiar il colore facendo doppio click sulla barra
del colore. un esempio è data dalla figura Figure_overlay_2.

8. Cliccare su [OK].

Si può scegliere l’algoritmo di posizionamento del diagramma dalla scheda Overlay nel menu Impostazioni →
Opzioni. Il metodo ‘Punto centrale’ è un metodo generico, se ne possono scegliere altri della libreria PAL. Questi
ultimi tengono in considerazione gli oggetti del diagramma e le etichette dei diversi layers.

19.7 Plugin Dxf2Shp Converter

Il plugin dxf2shape permette di convertire dati vettoriali dal formato DXF al formato shapefile. Vanno impostati i
seguenti parametri:

• File DXF in Input: il percorso del file DXF da convertire

• File di output: il nome dello shapefile in output

• Tipo di file in output: il tipo di file in output (scelta tra polilinea, poligono o punto).

• Esporta le etichette di testo: se selezionata, viene creato uno shapefile di punti. La tabella dbf associata
conterrà informazioni circa i campi “TESTO” trovati nel file dxf e le stringhe di testo stesse.
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Figura 19.7: Pie chart diagram from temperature data overlayed on a map

Figura 19.8: Dxf2Shape Converter Plugin
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19.7.1 Utilizzo del plugin

1. Avviare QGIS, attivare il plugin Dxf2Shape dal gestore dei plugin (sezione Abilitare un Plugin Core) e

cliccare sull’icona Convertitore Dxf2Shape che compare nella barra dei plugin. La finestra di dialogo del
plugin Dxf2Shape appare come mostrato in figura Figure_dxf2shape_1.

2. Caricare il file DXF da convertire, inserire un nome per lo shapefile in output ed il tipo.

3. Abilitare la casella di controllo Esporta le etichetto di testo , se si vuole creare un layer addizionale di
punti con le etichette.

4. Cliccare su [OK].

19.8 Plugin eVis

Il plugin eVis è stato sviluppato dalla ’Biodiversity Informatics Facility’ del ’American Museum of Natural His-
tory’s (AMNH) Center for Biodiversity and Conservation (CBC) (questa sezione è derivata da Horning, N., K.
Koy, P. Ersts. 2009. eVis (v1.1.0) User’s Guide. American Museum of Natural History,Center for Biodiversi-
ty and Conservation. Disponibile all pagina web http://biodiversityinformatics.amnh.org/, rilasciato con licenza
GNU FDL). Il plugin permette di collgare fotografie geocodificate (ovvero provviste di informazioni su latitudine
e longitudine) e altri documenti con i dati vettoriali in QGIS.

Nella nuova versione di QGIS, eVis è installato automaticamente; come tutti gli altri plugin può essere
abilitato/disabilitato tramite il gestore dei plugin (sezione Gestione dei plugin).

Il plugin consta di tre moduli, Connessione Database, ID evento, Browser evento che permettono di collegare a
vettori in QGIS foto ed altri documenti geocodificati (es. con coordinate X,Y o lat/long).

19.8.1 Browser evento

Il modulo mette a disposizione le funzionalità per visualizzare foto geocodificate collegate ad elementi vettoriali
della vista mappa di QGIS, come un layer di punti creati direttamente in QGIS o il risultato di una query. Gli ele-
menti vettoriali devono avere associati attributi che ne descrivono la localizzazione ed il nome del file contenente
le foto: opzionalmente l’orientamento della macchina fotografica. Il layer vettoriale deve essere caricato in QGIS
prima di poter usare il Browser evento.

Aprire il modulo Browser evento

Per aprire la finestra di dialogo del modulo, cliccare sul pulsante Sfoglia evento eVis oppure Database → eVis →
Sfoglia evento eVis. Si aprirà una finestra generica Browser evento.

Sono presenti tre schede nella parte alta della finestra Browser evento. La scheda Visualizza serve a visualizzare le
foto ed i relativi attributi. La scheda Opzioni contiene una serie di impostazioni del plugin. La scheda Configura
applicazioni esterne serve a gestire una tabella di estensioni di file ed applicazioni associate per permettere ad
eVis di visualizzare documenti ed altre immagini.

Scheda Visualizza

La scheda Visualizza è usata per visualizzare le foto ed i relativi attributi.

1. Area di visualizzazione dell’immagine: è il riquadro inferiore della scheda.

2. Ingrandisci: ingrandisce l’immagine per avere più dettagli. Se l’immagine è troppo grande per l’area di
visualizzazione, compaiono delle barre di scorrimento.

3. Rimpicciolisci: rimpicciolisce l’immagine.

4. Zoom completo: visualizza tutta l’immagine.
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Figura 19.9: The eVis display window

5. Finestra degli attributi: è il riquadro superiore della finestra. Qui sono mostrate le informazioni del punto
associato alla foto che si sta visualizzando. Se il file associato al punto non è un’immagine ed il tipo di
file è definito nella scheda Configura applicazioni esterne, facendo doppio-click sul suo percorso viene
avviata l’applicazione adatta a gestire quel tipo di file. Se l’estensione del file è riconosciuta, l’attributo sarà
mostrato in verde.

6. Pulsanti per la navigazione: usare i pulsanti Precedente all’altro.

7. Indicatore elemento: l’intestazione indica quale elemento è visualizzato ed il numero di elementi
disponibili.

Scheda Opzioni

1. Percorso file: menu a tendina che permette di selezionare l’attributo contenente il percorso o l’URL della

foto o altro documento da visualizzare. In caso di percorso relativo, attivare la casella di controllo
Il percorso è relativo: il percorso di base del percorso relativo può essere indicato nella casella di testo
’Percorso base’. Informazioni di dettaglio sulle diverse opzioni per specificare la localizzazione di un file
sono disponibili nella sezione Specificare la localizzazione ed il nome di una foto.

2. Informazioni bussola: menu a tendina che permette di selezionare l’attributo contenente l’orientamento
della macchina fotografica.

3. Offset bussola: può essere usato per compensare la declinazione. Attivare Manuale per inserire i
valori di offset nella casella di testo oppure attivare Da Attributo per selezionare l’attributo contenente i
valori di offset. La declinazione est deve essere inserita usando valori positivi: in valori negativi, invece, la
declinazione ovest.

4. Percorso base: il percorso di base utilizzato dal percorso relativo definito in Figura Figure_eVis_2 (A).

5. Sostituisci percorso: se attivo, soltanto il nome del file in A sarà aggiunto al percorso di base.

6. Applica il percorso dell’immagine se attivo, le stesse regole di percorso definito per le foto saranno
applicate a documenti tipo video, testo, audio.
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Figura 19.10: The eVis Options window

7. Ricorda questa impostazione: se attivo, i valori associati saranno salvati per la sessione successiva quando
la finestra verrà chiusa o quando verrà premuto il pulsante [Salva].

8. Ripristina: reimposta il campo al valore predefinito.

9. Restore defaults: riporta tutti i campi alle impostazioni predefinite.

10. Salva: salva le impostazioni senza chiudere la scheda Opzioni.

Configura applicazioni esterne

Figura 19.11: The eVis External Applications window

1. Tabella riferimento file: una tabella contenente i vari tipi di file utilizzati da eVis. Ogni tipo file necessita
di un’estensione e di un percorso all’applicazione in grado di gestirlo. Ciò permette di aprire diversi tipi di
file come filmati, suoni e documenti testuali, oltre che solo immagini.

2. Aggiungi nuovo tipo file: aggiunge un nuovo tipo di file (estensione ed applicazione).

3. Elimina riga corrente: elimina il tipo di file selezionato in tabella.
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19.8.2 Specificare la localizzazione ed il nome di una foto

La localizzazione ed il nome di una foto possono essere memorizzati tramite un percorso relativo o assolu-
to o tramite un URL se la foto risiede su un server web: seguono degli esempi dei vari approcci (Tabella
evis_examples).

X Y FILE BEARING
780596 1784017 C:\Workshop\eVis_Data\groundphotos\DSC_0168.JPG 275
780596 1784017 /groundphotos/DSC_0169.JPG 80
780819 1784015 http://biodiversityinform.org/testdata/DSC_0170.JPG 10
780596 1784017 pdf:http://www.test.com/attach.php?attachment_id-12 76

19.8.3 Specificare la localizzazione ed il nome di altri documenti

Altri documenti come testo, video e audio possono essere visualizzati e gestiti da eVis, basta assicurarsi di aver
impostato per ogni tipo di file estensione e applicazione nella scheda Configura applicazioni esterne della finestra
di dialogo Browser evento; è, inoltre, necessario disporre del percorso o URL del file nella tabella attributi di un
layer vettoriale. Come regola addizionale, se l’URL non contiene l’estensione del tipo file, è possibile anteporre
l’estensione all’URL secondo il formato estensione:URL. L’URL è preceduto dall’estensione file e dal segno
: (due punti) (Tabella evis_examples).

19.8.4 Utilizzo del Browser evento

Se tutto è correttamente impostato, lanciando il Browser evento verrà visualizzata una foto. Se la foto non appare
è necessario aggiustare qualche parametro nella finestra Opzioni.

Se nella tabella attributi si fa riferimento ad un documento (o ad un’immagine in un formato non supportato
da eVis) ed il tipo di file è stato configurato nella scheda Configura applicazioni esterne, il campo contente il
percorso al file è evidenziato in verde: per aprire il documento, fare doppio-click sul testo evidenziato in verde. Se
un documento è configurato nella tabella degli attributi, ma il testo non appare evidenziato in verde, è necessario
aggiustare il nome del file nella scheda Configura applicazioni esterne. Se invece l’evidenziatura è presente, ma
facendo doppio click il file non si apre, allora è necessario aggiustare qualche parametro nella scheda Opzioni.

Se non si è specificato l’orientamento della fotocamera, nella scheda Opzioni compare un asterisco rosso sul
vettore associato alla fotografia. Se l’orientamento è specificato, allora comparirà una freccia che punterà nella
direzione indicata dal valore della bussola. La freccia sarà centrata sul punto associato con la fotografia o con altri
documenti.

Pe chiudere la finestra Browser evento cliccare sul pulsante [Chiudi] presente nella scheda Visualizza.

19.8.5 Strumento ID evento

Il modulo ’ID evento’ permette di visualizzare una foto cliccando su un elemento nella vista mappa di QGIS.
L’elemento vettoriale deve avere associati gli attributi contenenti la localizzazione ed il nome del file della foto: il
layer deve essere caricato in QGIS prima di aprire il modulo.

Aprire ID Evento

Per aprire il modulo cliccare su Strumento ID evento oppure Plugins → eVis → Strumneto ID evento: sul cursore
del mouse apparirà una ‘i’, ad indicare che lo strumento è attivo.

Per visualizzare le foto associate agli elementi vettoriali presenti nella vista mappa di QGIS, cliccare su un ele-
mento di interesse; la foto verrà mostrata nel ’Browser evento’. Nel caso fossero disponibili più foto per lo stesso
punto, è comunque possibile scorrerle tutte tramite i pulsanti [Precedente] e [Avanti]. Altre opzioni di controllo
sono presenti nella sezione ref:evis_browser.

214 Capitolo 19. Plugin di QGIS



QGIS User Guide, Release 1.8

19.8.6 Connessione database eVis

Il modulo Connessione Database permette di connettersi ed interrogare un database o altre risorse ODBC, es. un
foglio di calcolo.

eVis può connettersi direttamente a quattro tipi di database: Microsoft Access, PostgreSQL, MySQL, SQLITE.
Può leggere dati da connessioni ODBC (es. una tabella Excel): in tal caso è necessario configurare il driver ODBC
per il sistema operativo in uso.

Aprire Connessione Database

Per aprire il modulo cliccare su Connessione database eVis oppure Plugins → eVis → Connessione database eVis. La
finestra di dialogo Connessione Database presenta tre schede: Query predefinite, Connessione Database e Query
SQL. La Console di Output mostra lo stato di un’azione avviata da altra sezioni del modulo.

Connessione Database

Aprire la scheda Connessione Database, cliccare su Tipo Database e selezionare il tipo di database al
quale ci si vuole collegare. Se necessario, si possono inserire Username e Password.

Inserire il server del database in Host Database: l’opzione non è disponibile per i database “MSAccess”. Se il
database si trova sul desktop, allora inserire “localhost”.

Inserire il nome del database in Nome Database. In caso di connessione “ODBC” è necessario inserire il nome
della fonte dati.

Una volta configurati tutti i parametri cliccare su [Connetti]: la Console di Output informa dell’esito
dell’operazione, sia positivo che negativo.

Figura 19.12: The eVis Database connection window

19.8. Plugin eVis 215



QGIS User Guide, Release 1.8

1. Tipo di Database: per specificare il tipo di database cui connettersi.

2. Host Database: nome host del database.

3. Porta: numero della porta di connessione in caso di database MYSQL o PostgreSQL.

4. Nome Database: nome del database.

5. Connetti: pulsante di connessione.

6. Console di Output: finestra dei messaggi sullo stato della connessione.

7. Nome utente: nome utente in caso di database protetto.

8. Password: password in caso di database protetto.

9. Query Predefinite: scheda “Query Predefinite”.

10. Connessione Database: scheda “Connessione Database”.

11. Query SQL: scheda “Query SQL”.

12. Help: mostra la guida in linea.

13. OK: chiude Connessione Database .

Eseguire query SQL

Le query SQL permettono di estrarre informazioni da un database o da una risorsa ODBC. In eVis il risultato di una
query è una layer vettoriale aggiunto alla vista mappa di QGIS. Cliccare su Query SQL‘per visualizzare l’interfac-
cia per le query. Un utile tutorial sulla sintassi SQL è disponibile alla pagina web http://www.w3schools.com/sql.
Ad esempio, per estrarre tutti i dati da una tabella Excel: ‘‘select * from [sheet1$]‘ dove sheet1 è il nome del
foglio di lavoro.

Per eseguire una query cliccare su [Esegui Query] : in caso di esito positivo si aprirà la finestra di dialogo Scegli
file Database altrimenti la Console di Output mostrerà un messaggio di errore.

Nella finestra Scegli file Database assegnare un nome al nuovo layer che sarà creato dai risultati della query.

1. Query SQL: è il riquadro per inserire le query SQL.

2. Esegui Query: pulsante per mandare in esecuzione una query.

3. Console di Output: mostra i messaggi relativi all’esecuzione delle query.

4. Help: mostra la guida in linea.

5. OK: chiude Connessione Database.

Usare Coordinata X e Coordinata Y per selezionare i campi del database che contengono le
coordinate X (o longitudine) e Y (or latitudine). Cliccare su [OK] per visualizzare il nuovo layer nella vista mappa
di QGIS.

Per salvare il nuovo layer è possibile usare il comando QGIS ‘Salva come...’ (click tasto-destro sul nome del layer
in legenda)

Suggerimento: Creare un layer vettoriale da un foglio di lavoro Microsoft Excel
Quando si crea un layer vettoriale da un file Excel potrebbero notarsi degli (“0”) non voluti in alcune righe
nella tabella degli attributi: la causa è da rilevarsi nell’abitudine di cancellare valori in Excel tramite il tasto
Backspace. Per correggere il problema, bisogna aprire il Excel e usare Modifica → Elimina per rimuovere le
righe non necessarie dal file. Per evitare il problema si possono semplicemente eliminare le righe dal foglio di
lavoro Excel usando Modifica → Elimina prima di salvare il file.
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Figura 19.13: The eVis SQL query tab

Eseguire query predefinite

Nella scheda Query Predefinite è possibile caricare query da file esterni in XML. Questa possibilità è molto utile
se non si ha molta dimestichezza con il linguaggio SQL.

Per caricare query predefinite, cliccare su Apri File: quando una query è caricata, il titolo della stessa appare nel
menu a tendina sotto Apri File e una breve descrizione è visualizzata nella casella di testo sottostante.

Selezionare la query che si intende usare e aprire la scheda Query SQL per vedere che la query è stata caricata
nella finestra. Se è la prima volta che si sta lanciando una query, assicurarsi di essere connessi al database.

Cliccare su [Esegui Query] nella scheda Query SQL per eseguire il comando. Se la query ha avuto successo si
aprirà la finestra Seleziona file Database. Al contrario, se la query non ha avuto successo, apparirà un messaggio
di errore nella Console di Output.

1. Apri File: permette di selezionare il file XML contenente le query predefinite.

2. Query predefinite: elenco delle query disponibili nel file XML.

3. Descrizione query: breve descrizione della query derivata dal file XML.

4. Console di Output: mostra i messaggi relativi all’esecuzione delle query.

5. Help: mostra la guida in linea.

6. OK: chiude Connessione Database .

Formato XML per le query predefinite di eVis

Tag XML letti da eVis
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Figura 19.14: The eVis Predefined queries tab

Tag Descrizione
query Definisce l’inizio e la fine di una istruzione di query.
shortde-
scription

Breve descrizione della query che viene mostrata nel menu a tendina di eVis.

descrip-
tion

Descrizione più dettagliata che viene mostrata nella casella ’Descrizione query’ di eVis.

database-
type

Tipo di database come definito in ’Tipo Database’ nella scheda Connessione Database .

database-
port

La porta di connessione come definito in ’Porta’ nella scheda Connessione Database .

database-
name

Il nome del database come definito in ’Nome Database’ nella scheda Connessione Database.

databaseuser-
name

Nome utente come definito in ’Nome utente’ nella scheda Connessione Database.

databasep-
assword

Password come definito in’Nome utente’nella scheda Connessione Database

sqlstate-
ment

Il comando SQL.

autocon-
nect

Valore “true”(vero) o “false”(falso): in caso di “true”, i tag sopra elencati saranno usati per
connettersi automaticamente al database, senza avviare la procedura di Connessione Database .

Segue un esempio completo di file XML contenente tre query:

<?xml version="1.0"?>
<doc>
<query>
<shortdescription>Import all photograph points</shortdescription>
<description>This command will import all of the data in the SQLite database to QGIS

</description>
<databasetype>SQLITE</databasetype>
<databasehost />
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<databaseport />
<databasename>C:\textbackslash Workshop/textbackslash

eVis\_Data\textbackslash PhotoPoints.db</databasename>
<databaseusername />
<databasepassword />
<sqlstatement>SELECT Attributes.*, Points.x, Points.y FROM Attributes LEFT JOIN

Points ON Points.rec_id=Attributes.point_ID</sqlstatement>
<autoconnect>false</autoconnect>

</query>
<query>
<shortdescription>Import photograph points "looking across Valley"</shortdescription>
<description>This command will import only points that have photographs "looking across

a valley" to QGIS</description>
<databasetype>SQLITE</databasetype>
<databasehost />
<databaseport />
<databasename>C:\Workshop\eVis_Data\PhotoPoints.db</databasename>
<databaseusername />
<databasepassword />
<sqlstatement>SELECT Attributes.*, Points.x, Points.y FROM Attributes LEFT JOIN

Points ON Points.rec_id=Attributes.point_ID where COMMENTS=’Looking across
valley’</sqlstatement>

<autoconnect>false</autoconnect>
</query>
<query>

<shortdescription>Import photograph points that mention "limestone"</shortdescription>
<description>This command will import only points that have photographs that mention

"limestone" to QGIS</description>
<databasetype>SQLITE</databasetype>
<databasehost />
<databaseport />
<databasename>C:\Workshop\eVis_Data\PhotoPoints.db</databasename>
<databaseusername />
<databasepassword />
<sqlstatement>SELECT Attributes.*, Points.x, Points.y FROM Attributes LEFT JOIN

Points ON Points.rec_id=Attributes.point_ID where COMMENTS like ’%limestone%’
</sqlstatement>

<autoconnect>false</autoconnect>
</query>

</doc>

19.9 Plugin fTools

Il plugin fTools fornisce una risorsa comprensiva delle più comuni operazioni GIS basate su vettori, senza la ne-
cessità di software addizionale, librerie e soluzioni complesse: il plugin mette a disposizione una suite di funzioni
di analisi veloci e funzionali.

Tools è installato di default nelle nuove versioni di QGIS e, come tutti gli altri plugin, può essere disabilitato
nel gestore dei plugin (sezione Abilitare un Plugin Core). Se abilitato, fTools aggiunge il nuovo menu Vettore
all’interfaccia di QGIS: questo nuovo menu offre funzioni di ricerca, analisi, geoprocessamento, gestione.

19.9. Plugin fTools 219



QGIS User Guide, Release 1.8

19.9.1 Strumenti di Analisi

IconaStrumento Azione

Matrice di
distanza

Misura le distanze tra due layer di punti e fornisce il risultato come a) Matrice di
distanza lineare, b) Matrice di distanza standard, c) Sintesi matrice di distanza. Può
limitare i calcoli ai ’k’ punti più vicini.

Somma
lunghezze
linee

Calcola la somma della lunghezza di tutte le linee per ogni poligono di un layer di
poligoni.

Punti nel
poligono

Calcola il numero di punti che ricadono all’interno di ogni poligono di un layer di
poligoni.

Lista valori
unici

Elenca i valori unici di un campo di un layer vettoriale

Statistiche di
base

Calcola statistiche di base, es. media, deviazione standard, somma, di un campo di un
layer vettoriale.

Analisi vicino
più prossimo

Calcola delle statistiche per valutare il livello di clustering in un layer vettoriale di
punti

Media
coordinata(e)

Calcola il centro medio (media normale o pesata) di un layer vettoriale o di
un’insieme di elementi ed in funzione di un campo con ID unico.

Intersezioni
linee

Calcola l’intersezione tra linee e restituisce il risultato in uno shapefile di punti. Utile
per localizzare intersezioni fra strade e ponti; ignora le intersezioni con una lunghezza
> 0.

fTools - Strumenti di Analisi

19.9.2 Strumenti di Ricerca

Icona Strumento Azione

Selezione casuale Seleziona in maniera casuale n o n% di elementi

Selezione casuale
con un sottoinsieme

Selezione casuale in un sottoinseme tramite campo ID unico.

Punti casuali Genera punti pseudo-random.

Punti regolari Genera una griglia regolare di punti su un’area specifica e la esporta come
shapefile di punti.

Reticolo vettoriale Genera una griglia di linee o di poligoni con spaziatura definita dall’utente.

Seleziona per
posizione

Seleziona elementi in base alla loro posizione relativa ad un altro layer: crea
una nuova selezione oppure aggiunge/sottrae alla selezione corrente.

Poligono
dall’estensione del
layer

Crea un poligono rettangolare dall’estensione di un layer raster o vettoriale.

fTools - Strumenti di Ricerca
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19.9.3 Strumenti di Geoprocessing

Icona Strumento Azione

Poligono/i
convesso/i

Crea il poligono minimo convesso di un layer vettoriale o poligoni minimi convessi
sulla base di un campo in input.

Buffer Crea buffer intorno ad un elemento in funzione di una distanza impostata o di un
campo in input.

Intersezione Sovrappone due layer e ne restituisce uno nuovo contenente la superficie di
intersezione dei layer di input.

Unione Sovrappone due layer e ne restituisce uno nuovo contenente la superficie totale dei
layer di input.

Differenza
simmetrica

Sovrappone due layer e ne restituisce uno nuovo contenente la superficie dei layer
di input tranne la loro intersezione.

Clip Sovrappone due layer e ne restituisce uno nuovo contenente la superficie che
interseca il clip layer.

Differenza Sovrappone due layer e ne restituisce uno nuovo contenente la superficie che non
interseca il clip layer.

Dissolvenza Unisce elementi sulla base di un campo in input: gli elementi con lo stesso valore
sono combinati in un elemento unico.

fTools - Strumenti di Geoprocessing

19.9.4 Strumenti di Geometria

Icona Strumento Azione

Controlla validità
geometria

Controlla poligoni per verificare la presenza di intersezioni e buchi chiusi e
risolvere l’ordine dei nodi.

Estrai/Aggiungi
colonne geometriche

Aggiunge informazioni sulla geometria a layer di punti (XCOORD,
YCOORD), di linee (LENGTH), di poligoni (AREA, PERIMETER).

Centroidi di poligoni Calcola i centroidi per ogni poligono di un layer di input.

Triangolazione di
Delaunay

Calcola la triangolazione di Delaunay per un layer di punti in input.

Poligoni di Voronoi Calcola i poligoni di Voronoi per un layer di punti in input.

Semplifica geometrie Generalizza linee e/o poligoni con un algoritmo modificato di
Douglas-Peucker.

Infittisci geometrie Infittisce linee o poligoni aggiungendo dei vertici

Da parti multiple a
parti singole

Converte elementi multi-parte in più elementi semplici. Crea linee e poligoni
semplici.

Da parti singole a
parti multiple

Unisce più elementi in un elemento multi-parte sulla base di un campo in
input.

Da poligoni a linee Converte poligoni in linee, poligoni multi-parte in linee semplici.

Da linee a poligoni Converte linee in poligoni, linee multi-parte in poligoni semplici.

Estrai vertici Estrae vertici da layer di linee e poligoni e restituisce un nuovo layer di punti.

fTools - Strumenti di Geometria

Nota: Lo strumento Semplifica geometrie può essere usato per rimuovere vertici doppi in layer di linee o di
poligoni. Il trucco è impostare il valore 0 per il parametro Tolleranza di semplificazione.
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19.9.5 Strumenti di Gestione Dati

IconaStrumento Azione

Definisci
proiezione in
uso

Specifica il SR per gli shapefile senza SR associato.

Unisci
attributi per
posizione

Aggiunge attributi ad un layer vettoriale sulla base di relazioni spaziali. Attributi di
un layer vengono aggiunti alla tabella attributi di un altro layer: il risultato è salvato
come nuovo shapefile.

Dividi vettore Divide il layer di input in più layer separati sulla base di un campo in input.

Unisci
shapefile

Unisce più shapefile in un unico shapefile sulla base del tipo di layer (punti, linee,
poligoni).

Crea indice
spaziale

Crea un indice spaziale per i formati supportati da OGR.

fTools - Strumenti di Gestione Dati

19.10 Plugin GDALTools

19.10.1 Cos’è GDALTools?

Il plugin GDALTools fa da interfaccia grafica ad una collezione di strumenti GDAL (Geospatial Data Abstraction
Library), http://gdal.osgeo.org: es. strumenti per interrogare, riproiettare, unire raster in vari formati. Sono inclusi
strumenti per derivare da un DEM dati tipo curve di livello, pendenze, ombreggiature o anche per collegare in un
raster virtuale diversi file raster (Virtual Raster Tile in XML). Tutti questi strumenti sono disponibili quando il
plugin è installato e attivato.

La libreria GDAL

La libreria GDAL consiste di un insieme di programmi da linea di comando, ognuno con una vasta lista di opzioni.
Gli utenti che si trovano a loro agio lavorando con un terminale preferiranno usare gli strumenti GDAL da riga di
comando ed avranno cosi accesso a tutte le opzioni. Il plugin GDALTools offre anche una semplice interfaccia
per utilizzare tali programmi, visualizzando solo le opzioni più utilizzate.

19.10.2 Lista degli strumenti GDAL

Figura 19.15: The GDALTools menu list
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Proiezioni

Riproiezione
Questo programma permette di riproiettare in uno qualsiasi dei sistemi supportati: può,
inoltre, utilizzare i GCP memorizzati in un’immagine. Per ulteriori informazioni visitare la
pagina web di GDAL website http://www.gdal.org/gdalwarp.html

Assegna
proiezione

Questo strumento permette di assegnare una proiezione a un file raster georeferenziato che
però manca di questa informazione. E’ anche possibile cambiare la proiezione a un file che ne
ha già una. Inoltre è possibile lavorare su un singolo file oppure su un’intera cartella. Per
ulteriori informazioni visitare http://www.gdal.org/gdalwarp.html

Estrai
proiezione

Grazie a questo strumento è possibile estrarre le informazioni sulla proiezione sia di un
singolo file che di un’intera cartella. Viene creato sia il .prj che il .wld.

Conversione

Rasteriz-
zazione

This program burns vector geometries (points, lines and polygons) into the raster band(s) of a
raster image. Vectors are read from OGR supported vector formats. Note that the vector data
must in the same coordinate system as the raster data; on the fly reprojection is not provided.
For more information see http://www.gdal.org/gdal_rasterize.html

Poligo-
nizzazione

Questo programma crea poligoni vettoriali a partire da insiemi di pixel connessi di un raster
che hanno lo stesso valore. Ogni poligono creato porta un attributo corrispondente al valore
dei pixel che lo hanno generato. Il formato file predefinito per l’output è lo shapefile (vedi
anche http://www.gdal.org/gdal_polygonize.html)

Conversione
formati

Questo programma converte raster tra formati diversi: il processo può comprendere
operazioni di ricampionamento, ridimensionamento etc. Per ulteriori informazioni visitare
http://www.gdal.org/gdal_translate.html

Da RGB
a PCT

Questo programma calcola la mappa colore pseudo-colore ottimale per un’immagine RGB:
l’immagine viene convertita in pseudo-colore utilizzando la mappa colore calcolata. Tale
conversione usa l’algoritmo di Floyd-Steinberg per massimizzare la qualità visuale
dell’output (vedi anche http://www.gdal.org/rgb2pct.html)

Da PCT
a RGB

Questo programma converte una banda pseudo-colore in un file RGB, in un formato a scelta.
Per ulteriori informazioni vedere http://www.gdal.org/pct2rgb.html

Estrazione

Curve
di livello

Questo programma deriva un file vettoriale di curve di livello a partire da un DEM. Ulteriori
informazioni su http://www.gdal.org/gdal_contour.html.

Clipper
Questo strumento permette di estrarre una porzione di un raster; è possibile scegliere
l’estensione oppure la porzione estratta può essere ritagliata su un altro layer (mask). Altre
informazioni su http://www.gdal.org/gdal_translate.html.
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Analisi

Filtro Questo programma rimuove poligoni raster più piccoli di un dato valore soglia (in pixel)
e li sostituisce con il valore del pixel del poligono vicino più grande: il risultato può
essere salvato nel raster esistente o in un nuovo file. Ulteriori informazioni su
http://www.gdal.org/gdal_sieve.html .

Sposta al
nero/bianco

Questo programma scansiona un’immagine e cerca di impostare tutti i pixel sui bordi che
sono “quasi neri” (o “quasi bianchi”) in modo che siano del tutto neri (o bianchi). Spesso
viene utlizzato per “correggere” le foto aeree “lossy compressed” in modo che i pixel
colorati siano visti come trasparenti durante la mosaicizzazione. Informazioni su
http://www.gdal.org/nearblack.html .

Riempimento
nullo

Questo strumento riempie la regione raster selezionata (aree nodata) con valori di pixel
interpolat da aree vicino all’area. Ulteriori informazioni su
http://www.gdal.org/gdal_fillnodata.html.

Prossimità Questo programma genera una mappa raster di prossimità, che mostra la distanza dal
centro di ogni pixel al centro del pixel più vicino scelto come target. Visitare
http://www.gdal.org/gdal_proximity.html per ulteriori informazioni.

Interpolazion
Questo programma crea una griglia raster da dati sparsi OGR. I dati di input saranno
interpolati al fine di individuare i nodi della griglia raster: sono disponibili vari metodi di
interpolazione. Lo strumento è descritto sulla pagina http://www.gdal.org/gdal_grid.html
.

DEM analisi
geomorfologica

Questo programma permette operazioni di analisi e visualizzazione di DEM. Può
generare un rilievo ombreggiato, la pendenza, l’orientamento, oppure calcolare l’indice
di asperità del terreno e l’indice di posizione geografica per tutti i formati raster di
elevazione supportati da GDAL. Altre informazioni su
http://www.gdal.org/gdaldem.html

Miscellanea

Crea
raster
virtuale

Questo programma costruisce un VRT (Virtual Raster), ovvero un mosaico di vari raster.
Vedi anche http://www.gdal.org/gdalbuildvrt.html .

Unione Questo programma mosaica un insieme di raster: tutti i raster devono essere nello stesso
sistema di riferimento ed avere lo stesso numero di bande, anche se possono parzialmente
sovrapporsi ed essere a diversa risoluzione. Nelle aree di sovrapposizione, l’ultima immagine
sarà copiata sopra la precedente. Lo strumento è descritto anche su
http://www.gdal.org/gdal_merge.html .

Informazioni
Questo programma elenca una serie di informazioni su un raster. Informazioni su
http://www.gdal.org/gdalinfo.html.

Crea
panoramica

Questo programma -gdaladdo- permette di creare anteprime -piramidi- di immagini con
diversi metodi di ricampionamento. Altre informazioni su http://www.gdal.org/gdaladdo.html
.

Indice
delle tile

Questo programma genera uno shapefile con un record per ogni file raster in input, un
attributo contenente il nome del file e una geometria poligonale che delinea il raster. Ulteriori
informazioni su http://www.gdal.org/gdaltindex.html .
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19.11 Plugin Georeferenziatore

Il Plugin Georeferenziatore è uno strumento per generare file di georeferenziazione (world file) per i raster. Per-
mette di georeferenziare raster in sistemi di coordinate geografiche e proiettate, creando un GeoTiff oppure as-
sociandogli un world file. L’approccio di base del plugin è quello di individuare punti del raster per i quali sia
possibile determinare accuratamente le coordinate.

Features
Icona Azione Icona Azione

Carica un raster Avvia la georeferenziazione

Genera uno script GDAL Carica punti GCP (Ground Control Point)

Salva punti GCP Imposta la trasformazione

Aggiunge un nuovo punto Elimina un punto

Sposta un punto GCP Sposta la vista

Ingrandisce la vista Rimpicciolisce la vista

Zoom sul layer Zoom precedente

Zoom successivo Collega il georeferenziatore a QGIS

Collega il georeferenziatore a QGIS

Strumenti del georeferenziatore

19.11.1 Utilizzo del plugin

Per le coordinate X e Y (espresse in gradi, primi e secondi) oppure per le coordinate poriettate (espresse in metri),
che corrispondono ai punti selezionati sull’immagine, possono essere usate due procedure alternative:

• Inserire manualmente le coordinate: solitamente nei raster sono presenti punti con le coordinate scritte
sull’immagine.

• Usare un layer già georiferito (vettoriale o raster) contenente le stesse entità/oggetti del raster da georiferire.
In questo caso le coordinate vengono inserire cliccando sul layer di riferimento nella vista mappa.

Una procedura meno usuale consiste nel selezionare più punti del raster, specificarne le coordinate e scegliere
un metodo di trasformazione. Sulla base dei parametri inseriti, il plugin calcola i parametri del world file. Più
coordinate vengono fornite, migliore sarà il risultato.

Avviare QGIS, caricare il plugin (sezione Abilitare un Plugin Core) e cliccare sull’icona Georeferenziatore nella
barra dei plugin. Si aprirà la finestra di dialogo Georeferenziatore mostrata in figura figure_georeferencer_1.

Come esempio si può provare a georiferire la carta topografica del South Dakota scaricabile da:
http://grass.osgeo.org/sampledata/spearfish_toposheet.tar.gz. Sarà possibile visualizzare la carta anche con i dati
di GRASS della location spearfish60.

Aggiungere punti GCP

1. Per iniziare a georiferire un raster, caricarlo cliccando sul pulsante . Il raster sarà visualizzato nel
riquadro principale della finestra di dialogo. Caricato il raster, è ora possibile iniziare ad inserire i punti di
riferimento.

2. Usare il pulsante Aggiungi punto per aggiungere punti sul raster ed inserire le coordinate (see Figure
figure_georeferencer_2). Per inserire le coordinate si hanno tre opzioni:
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Figura 19.16: Georeferencer Plugin Dialog

• Cliccare su un punto del raster ed inserire le coordinate X/Y manualmente.

• Cliccare su un punto del raster ed usare il pulsante Dalla mappa per inserire le coordinate X/Y con
l’aiuto di layer già georeferenziato caricato nella vista mappa di QGIS.

• Se necessario usare il pulsante per spostare i punti in entrambe le finestre.

3. Bisogna inserire almeno 4 GCP: più punti vengono inseriti, migliore sarà il risultato. Aiutarsi con gli altri
strumenti del plugin per spostarsi nell’area di lavoro.

Figura 19.17: Add points to the raster image

I punti inseriti vengono salvati in un file di testo ([filename].points), solitamente all’interno della cartel-
la contenente l’immagine raster: in tal modo sarà possibile riaprire il plugin con gli stessi dati per aggiun-
gere/rimuovere punti al fine di ottimizzare il risultato. Il file dei punti contiene valori nella forma: mapX, mapY,

pixelX, pixelY: tali file possono essere gestiti con i pulsanti Carica punti GCCP e Salva punti GCP come.

Nella tabella dei punti GCP è possibile ordinare i punti (per esempio in base al numero); la lista dei punti viene
automaticamente aggiornata.

Impostare una trasformazione

Una volta aggiunti i GCP, è necessario definire le impostazioni di trasformazione del processo di
georeferenziazione.
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Figura 19.18: Defining the georeferencer transformation settings

Algoritmi di trasformazione disponibili

Sono disponibili diversi algoritmi di trasformazione: la scelta dipende dal numero di GCP a disposizione, dal
tipo e dalla qualità dei dati di input e dall’entità di distorsione geometrica che si accetta di introdurre nel risultato
finale.

Sono disponibili i seguenti algoritmi:

• L’Algoritmo Lineare genera un word file, quindi non trasforma fisicamente il raster a differenza degli altri
metodi: non è un algoritmo efficiente in caso di mappe provenienti da scansione di materiale cartaceo.

• La Trasformazione di Helmert opera una rototraslazione.

• Gli Algoritmi Polinomiali (1-3) sono molto usati: ognuno differisce in funzione del grado di distorsione
introdotto nell’accoppiamento dei GCP. La trasformazione polinomiale più utilizzata è quella di secondo
ordine: tiene conto della curvatura. La trasformazione polinomiale del primo ordine (affine) preserva la
collinearità e permette la rototraslazione.

• L’Algoritmo Thin plate spline (TPS) permette di introdurre deformazioni locali nei dati. L’algoritmo è
particolarmente efficace nel caso i dati da georiferire siano di scarsa qualità.

• La Trasformazione Proiettiva applica una rototraslazione delle coordinate.

Metodo di ricampionamento

La scelta del metodo di ricampionamento dipende dai dati in input e da alcuni requisiti utente. Se, ad esempio,
non si accettano modifiche alle statistiche dell’immagine, allora il metodo del vicino più prossimo sarà più adatto.
Se, invece, si richiede un risultato più ‘liscio’ (smoothed) si utilizzerà il metodo cubico.

Sono disponibili 5 diversi metodi di ricampionamento.

1. Vicino più prossimo

2. Lineare

3. Cubico

4. Spline cubica

5. Lanczos
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Altre impostazioni di trasformazione

Bisogna definire varie altre opzioni per l’output.

• La casella di controllo Crea il file di georeferenziazione è attiva solo se si è scelta la trasformazione
lineare, appunto quando il raster non viene fisicamente traformato: in tal caso, quindi, la casella Raster in
output non è attiva perché viene creato solo un nuovo file world.

• Per tutti gli altri tipi di trasformazione bisogna defnire un Raster in output.Come modalità predefinita, viene
creato un nuovo file ([nomefile]_modificato) nella stessa cartella del raster di partenza.

• Bisogna, poi, scegliere il SR (Sistema di riferimento) (sezione Lavorare con le proiezioni).

• Volendo si possono creare delle mappe pdf e anche dei report pdf. Il report fornisce informazioni sui
parametri di informazione utilizzati, un immagine dei residui e una lista con tutti i punti GCP con il loro
errore standard.

• La casella di controllo imposta risoluzione finale permette di definire la risoluzione del raster di output:
il valore predefinito è 1.

• Attivando la casella di controllo Utilizzare 0 per la trasparenza dove necessario, i pixel con valore 0
saranno trasparenti.

• La casella di controllo Carca in QGIS una volta eseguito, carica l’output nella vista mappa di QGIS a
trasformazione terminata.

Proprietà del raster

Cliccando su Proprietà raster nel menu Preferenze, si apre la finestra di dialogo Proprietà del layer - Raster.

Configurare il georeferenziatore

• Definire se visualizzare coordinate e/o ID dei GCP.

• mpostare le unità dei residui.

• Impostare i margini per i rapporti pdf e le dimensioni per le mappe pdf.

• E’ possibile attivare la casella di controllo Mostra la finestra del georeferenziatore agganciata.

Eseguire la trasformazione

Una volta acquisiti i GCP necessari ed impostati i vari parametri della trasformazione, cliccare su
Inizia georeferenziazione per creare il nuovo raster georeferenziato.

19.12 Plugin Interpolazione

Il plugin di interpolazione permette di generare un TIN (Triangulated Irregular Network) o un’interpolazione
IDW (Inverse Distance Weighting) a partire da un layer vettoriale di punti: è molto semplice da usare grazie
all’interfaccia grafica intuitiva mostrata in Figura Figure_interpolation_1. Il plugin richiede l’impostazione dei
seguenti parametri:

• Layer vettoriale in input: permette di selezionare un layer vettoriale di punti tra quelli caricati in QGIS.
È anche possibile utilizzare dati provenienti da più layer. Nota: è possibile utilizzare linee e poligoni come
vincoli per la triangolazione, specificando “punti”, “Linee struttura” o “Linee di interruzione” nel menu a

discesa Tipo .
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• Attributo interpolazione: selezionare la colonna attributo contenente i valori da utilizzare per

l’interpolazione o attivare la casella di controllo Usa la coordinata Z per l’interpolazione.

• Metodo di interpolazione: permette di selezionare il metodo di interpolazione, che può essere
‘Triangulated Irregular Network (TIN)’ o ‘Inverse Distance Weighted (IDW)’.

• Numero di colonne/righe: specifica il numero di colonne e di righe del raster di output.

• File di output: nome del raster di output.

Figura 19.19: Interpolation Plugin

19.12.1 Utilizzo del plugin

1. Avviare QGIS e caricare un layer vettoriale di punti (es. elevp.csv).

2. Caricare il plugin di Interpolazione nel gestore dei plugin (sezione Abilitare un Plugin Core) e cliccare su
Interpolazione nella barra dei plugin. La finestra di dialogo del plugin di Interpolazione appare come in

figura Figure_interpolation_1.

3. Selezionare un layer in imìnput (es. elevp ) e una colonna per l’interpolazione (e.g., ELEV).

4. Selezionare un metodo di interpolazione (es. ‘Triangulated Irregular Network (TIN)’), impostare 5000 come
dimensione delle celle e elevation_tin come nome del raster di output.

5. Cliccare su [OK].

6. Fare doppio click su elevation_tin per aprire la finestra di dialogo Proprietà layer e selezionare ‘Pseu-

docolor’ come Mappa di colore nella scheda Stile.Oppure è possibile definire una nuova tavola di
colori come descritto nella sezione Lavorare con i dati raster.

19.13 Plugin MapServer Export

Si può usare QGIS per comporre la propria mappa, aggiungendo e arrangiando i layer, simbolizzandoli,
personalizzando i colori, e infine creare un map file per Mapserver per la pubblicazione sul web.

Nota: Attualmente il plugin funziona solamente con la ‘Vecchia simbologia’, la ‘Nuova simbologia’ non è ancora
supportata.

19.13.1 Creare il file Progetto

Il Plugin MapServer Export opera su un progetto QGIS salvato e non sui contenuti correnti della vista mappa
e della legenda: questo ha generato confusione in diversi utenti. Prima di cominciare ad utilizzare il plugin, è
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necessario predisporre i layer vettoriali e raster che si intende usare in MapServer e salvare queste impostazioni in
un file di progetto QGIS.

Figura 19.20: Arrange raster and vector layers for QGIS project file

L’esempio seguente mostra brevemente come creare un semplice progetto da usare per il mapfile di MapServer.
Vengono usati file vettoriali e raster dal dataset campione di QGIS Dati campione.

1. Aggiungere il layr raster landcover.tif cliccando su Aggiungi raster.

2. Aggiungere gli shapefile lakes.shp, majrivers.shp e airports.shp cliccando su
Aggiungi vettore.

3. Cambiare lo stile dei layer (come esempio, vedere figure_mapserver_export_1)

4. Salvare un nuovo progetto con un nome mapserverproject.qgs usando File → Salva progetto.

19.13.2 Creazione del Map File

Per usare il plugin Mapserver Export da QGIS è necessario attivarlo usando il Gestore QGIS Plugin (sezione
ref:load_core_plugin).
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Figura 19.21: Export to MapServer Dialog

Map file Scegliere un nome per il mapfile da creare. Si può anche usare il tasto sulla destra e cercare la
cartella in cui si vuole salvare il mapfile.

Progetto
QGIS

Inserire il percorso del file di progetto di QGIS (.qgs) che si vuole esportare. Si può anche
utilizzare il pulsante sulla destra e selezionare il file manualmente.

Nome
mappa

Un nome per la mappa. Questo nome è usato come prefisso per tutte le immagini generate dal
mapserver.

Larghezza
mappa

Larghezza dell’immagine di output in pixel.

Altezza
della
mappa

Altezza dell’immagine di output in pixel.

Unità della
mappa

Unità di misura per l’output.

Tipo di
immagine

Formato dell’immagine di output generata da MapServer

Modello Percorso completo al template Mapserver che sarà usato con il mapfile
Titolo Percorso completo al file intestazione di Mapserver che sarà usato con il mapfile
Piè di
pagina

Percorso completo al file piè di pagina di Mapserver che sarà usato con il mapfile

Soltanto Map file e progetto QGIS ono richiesti per creare un mapfile, tuttavia omettendo gli altri parametri ci si
potrebbe ritrovare con un mapfile non funzionante. Nonostante QGIS sia capace di creare un mapfile da un file di
progetto, potrebbe essere necessario qualche successivo aggiustamento per raggiungere il risultato ottimale. Nel-
l’esempio che segue, viene mostrato come creare un mapfile a partire dal progetto mapserverproject.qgs
precedentemente salvato (figura Figure_mapserver_export_2):

1. Aprire la finestra di dialogo Esporta per MapServer cliccando sull’icona MapServer Export (vedi figura
Figure_mapserver_export_2).

2. Assegnare il nome (e.g., qgisproject.map) al nuovo mapfile.

3. Selezionare il progetto QGIS (es. mapserverproject.qgs) precdentemente salvato.

4. Assegnare un nome alla mappa (es. MyMap).

5. Inserire la larghezza e l’altezza (es. 600 per la larghezza e 400 per l’altezza).

6. Impostare le unità di misura in metri.

7. Scegliere png come tipo di immagine.

8. Cliccare su [OK] per generare il mapfile qgisproject.map.
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Figura 19.22: Export to MapServer Succesfull Dialog

Si può visualizzare il mapfile con qualsiasi editor o visualizzatore di testo. Se si apre il file, si noterà che lo
strumento d’esportazione aggiunge i metadati necessari per rendere il nostro servizio web compatibile con le
specifiche WMS.

19.13.3 Risoluzione dei problemi

Se si riceve un errore da mapserver del tipo:

loadSymbolSet(): Unable to access file. (./symbols/symbols.txt)

oppure:

msLoadFontset(): Unable to access file. Error opening fontset ./fonts/fonts.txt.

Significa che sono stati usati font o simboli nel mapfile che Mapserver non è in grado di decodificare.

Si possono commentare le linee contenenti gli errori (possibile se non sono presenti etichette oppure usando stili
provenienti da symbols.txt). Oppure si possono creare questi file (vedi sotto).

Il semplice file fonts.txt (arial è usato nei mapfile generati da QGIS) contenente la seguente linea

# either relative to the map file or a full path:
arial /usr/share/fonts/truetype/msttcorefonts/arial.ttf

Il semplice file symbols.txt file contenente la definizione di un simbolo circolare (perché un simbolo circolare
è usato per i layer di punti)

SYMBOLSET
SYMBOL
NAME "circle"
TYPE ellipse
FILLED true
POINTS
1 1
END
END

END

19.13.4 Testare il File Mappa

E’ possibile testare il lavoro.

Se il mapfile è accessibile da un server cgi, si può usare uno degli url della finestra di dialogo.
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Un’altra opzione è usarelo strumento shp2img per creare un’immagine dal mapfile. shp2img è parte di MapServer
e FWTools. Per creare un’immagine dalla mappa:

• Aprire un terminale

• Navigare nella cartella cui è stata salvato il mapfile.

• Lanciare shp2img -m qgisproject.map -o mapserver\_test.png e visualizzare l’immag-
ine

Il comando crea un file PNG con tutti i layer inclusi nel progetto QGIS: l’estensione spaziale dell’immagine sarà
la stessa di quella del progetto. Come si vede in Figura figure_mapserver_export_4, tutte le informazioni eccetto
i simboli degli aeroporti sono incluse.

Figura 19.23: Test PNG created by shp2img with all MapServer Export layers

19.13.5 Usare il mapfile

Se si prevede di usare il mapfile per richieste WMS standard, probabilmente non sarà necessario alcun adatta-
mento. Se invece si prevede di usarlo con un modello di mappa o un’interfaccia personalizzata, potrebbe essere
necessario del lavoro manuale. Per vedere come è facile utilizzare QGIS per offrire servizi di webmapping, si
veda il video di Christopher Schmidt flash video. Egli usa una vecchia versione di QGIS (0.8), ma le operazioni
sono facilmente adattabili ad una qualsiasi versione più nuova.

19.14 Plugin Offline Editing

In progetti di acquisizione dati è situazione comune trovarsi a lavorare sul campo con computer portatili e palmari:
i dati in tal modo acquisiti vanno, poi, sincronizzati con la banca dati principale, es. un database PostGIS. Se più
persone lavorano simultaneamente sullo stesso set di dati, risulta difficile aggiornare la banca dati principale
manualmente.

Il plugin Offline Editing permette di automatizzare l’attività di sincronizzazione, copiando il contenuto della ban-
ca dati principale (solitamente un database PostGIS o un WFS-T) in un database Spatialite e memorizzando le
modifiche non in linea in tabelle dedicate: le modifiche, poi, vengono sincronizzate una volta riconnessi alla rete.

19.14.1 Utilizzo del plugin

• Aprire alcuni layer vettoriali, es. da PostGIS o da un WFS-T
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• Salvare il progetto

• Cliccare su Converti ad un progetto offline e selezionare i layer da salvare. Il contenuto dei layer viene salvato
in una tabella SpatiaLite.

• Modificare il layer in modalità non in linea.

• Riconnettersi alla rete e caricare le modifiche con Sincronizza.

Figura 19.24: Create an offline project from PostGIS or WFS layers

19.15 Plugin Oracle Spatial GeoRaster

Nei database Oracle i dati raster possono essere gestiti come oggetti SDO_GEORASTER messi a disposizione

dall’estensione Oracle Spatial. In QGIS il Plugin Oracle Geo Raster è supportato da GDAL e le sue funzionalità
dipendono dal database Oracle installato sulla propria macchina. Il software Oracle è proprietario, sebbene il suo
utilizzo sia libero per attività di sviluppo e test. Il comando seguente:

$ gdal_translate -of georaster input_file.tif geor:scott/tiger@orcl

carica un raster nella tabella predefinita GDAL_IMPORT in una colonna con nome RASTER.

19.15.1 Gestire le connessioni

Assicurarsi che il plugin sia abilitato nel gestore dei plugin (Sezione Abilitare un Plugin Core). Pri-
ma di caricare un GeoRaster bisogna creare una connessione al database Oracle contente i dati: L’icona

Aggiungi layer Oracle GeoRaster nella barra dei plugin apre la finestra di dialogo Scegli Oracle Spatial Geo-
Raster. In Connessioni server cliccare su [Nuovo] ed inserire i parametri di connessione al database (figura
Figure_oracle_raster_1):

• Nome: inserire un nome per la connessione

• Istanza database: inserire in nome del database cui si intende connettersi

• Nome utente: inserire il nome utente

• Password: inserire la password
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Figura 19.25: Create Oracle connection dialog

Cliccando su [OK] parametri della connessione vengono salvati e si ritorna nella finestra di dialogo per la scelta del
georaster (figura Figure_oracle_raster_2), Selezionare la connessione appena impostata e cliccare su [Connetti]
per modificare la connessione cliccare su [Modifica], per rimuoverla cliccare su [Elimina].

19.15.2 Selezionare un GeoRaster

Stabilita la connessione, il riquadro ’Sottoinsieme di dati’ elencherà le tabelle del database contenenti colonne
georaster compatibili con GDAL.

Selezionare una tabella con il mouse e cliccare su [Seleziona]: apparirà un nuovo elenco con i nomi delle colonne
GeoRaster della tabella selezionata.

Selezionare una colonna con il mouse e cliccare su [Seleziona]: apparirà un nuovo elenco contenente gli oggetti
GeoRaster.

In ogni momento è possibile modificare la selezione per raggiungere direttamente un GeoRaster noto o per
selezionare un’altra tabella.

Figura 19.26: Select Oracle GeoRaster dialog

Il testo mostrato nella casella ’Selezione’ può essere usato in una clausola SQL
WHERE, es: geor:scott/tiger@orcl,gdal_import,raster,geoid=. Si veda
http://www.gdal.org/frmt_georaster.html per ulteriori informazioni.
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19.15.3 Visualizzare un GeoRaster

Selezionando un GeoRaster dalla lista appena descritta, esso sarà visualizzato in QGIS.

La finestra di dialogo Scegli Oracle Spatial GeoRaster per la scelta dei georaster può ora essere chiusa: riapren-
dola, essa mostrerà la medesima connessione e lo stesso elenco di georaster, rendendo semplice la scelta di una
nuova immagine dallo stesso contesto.

Nota: I GeoRaster con piramidi vengono visualizzati molto più rapidamente. Le piramidi possono essere generate
con Oracle PL/SQL oppure con gdaladdo.

Segue un esempio di utilizzo di gdaladdo:

gdaladdo georaster:scott/tiger@orcl,georaster\_table,georaster,georid=6 \
-r nearest 2 4 6 8 16 32

Questo è, invece, un esempio con PL/SQL:

$ sqlplus scott/tiger
SQL> DECLARE
gr sdo_georaster;

BEGIN
SELECT image INTO gr FROM cities WHERE id = 1 FOR UPDATE;
sdo_geor.generatePyramid(gr, ’rLevel=5, resampling=NN’);
UPDATE cities SET image = gr WHERE id = 1;
COMMIT;

END;

19.16 Plugin Analisi geomorfologica

Il plugin Analisi geomorfologica (Raster Terrain Modelling) consente di calcolare la pendenza, l’espo-
sizione, l’indice di asperità e la curvatura totale da un DEM (Digital Elevation Model). È semplice da usare
grazie ad un’interfaccia grafica intuitiva: i risultati dell’analisi sono salvati in un nuovo layer raster (Figura
Figure_raster_terrain_1).

Descrizione delle analisi:

• Pendenza: calcola l’angolo di pendenza per ogni cella espresso in gradi.

• Esposizione: 0 gradi per nord e continuando in senso orario.

• Ombreggiatura: crea una mappa dell’ombreggiatura del terreno con un effetto tridimensionale fornito dal
gioco luce - ombra.

• Indice di asperità: una misura quantitativa dell’eterogeneità del terreno descritta da Riley et al (1999).
Viene calcolata per ogni area sommando il cambiamento di elevazione all’interno della griglia di pixel 3x3.

• Rilievo: cra una mappa di ombreggiatura partendo da un DEM. E’ implementato un metodo che permette
di scegliere i colori dell’elevazione analizzando la distribuzione delle frequenze.

19.16.1 Usare il plugin

1. Avviare QGIS e caricare il file raster gtopo30 dalla location di GRASS.

2. Caricare il plugin Analisi geomorfologica dal Gestore plugin (sezione Abilitare un Plugin Core)

3. Selezionare un metodo di analisi dal menu (es. Raster → Analisi geomorfologica → Pendenza). Si aprirà
cosi la finestra di dialogo Pendenza come in figura Figure_raster_terrain_1.

4. Specificare nome, percorso e formato del file di output.

5. Cliccare su [OK].
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Figura 19.27: Raster Terrain Modelling Plugin (slope calculation)

19.17 Plugin Mappa di concentrazione

Il plugin Mappa di concentrazione permette di creare una mappa di concentrazione partendo da un layer di punti. Una
mappa di concentrazione è una mappa raster di densità o di magnitudo dell’informazione selezionata. Il risultato
permette di identificare facilmente degli “hotspots”.

19.17.1 Attivare il plugin Mappa di concentrazione

Prima di poter essere utilizzato, il plugin deve essere attivato dal Gestore plugin (sezione Abilitare un Plugin

Core). Dopo l’attivazione l’icona è accessibile dalla barra degli strumenti Raster.

Se non è già presente, attivare la barra degli strumenti Raster dal menu Vista → Barra degli strumenti → Raster.

19.17.2 Utilizzo del plugin

Il pulsante Mappa di concentrazione fa partire il plugin (figura figure_heatmap_2).

La finestra di dialogo ha le seguenti opzioni:

• Vettore punti in input: permette di selezionare il vettore di punti.

• Output Raster: si può scegliere la cartella e il nome della mappa raster di concentrazione usando il pulsante

. Non è necessario specificare l’estensione del file

• Formato in output: specifica il formato in output. Nonostante siano presenti tutti i formati supportati da
GDAL, il formato GeoTIFF è in molti casi la scelta migliore.

• Raggio: permette di scegliere il raggio di azione in metri o in unità di mappa. Se il raggio è troppo piccolo, il
risultato non sarà ottimale. Nelle zone dove si sovrappongono i cerchi, è possibile invece cedere chiaramente
gli hotspots.

• Decay Ratio: serve per impostare il tasso con il quale la concentrazione decade rispetto al centro.
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– Se si imposta 0 (valore minimo) la concentrazione è massima nel centro e scompare completemente
sui bordi.

– Se si imposta 10 (valore massimo) la concentrazione è massima ai bordi ed è completamente assente
nel centro. E’ possibile inserire valori più alti, ma non ci saranno altri effetti.

– Se si imposta 1 la concentrazione è equamente distribuita in tutto il cerchio.

– Se si imposta un valore negativo, verrà generata l’opposto di una mappa di concentrazione!

Se si attiva la casella di controllo Avanzato si avrà accesso a diverse opzioni avanzate.

• Riga e Colonna possono essere utlizzate per cambiare la dimensione dei pixel della mappa in output.
Impostando un numero maggiore di righe e colonne la dimensione dei pixel diminuisce e di coseguenza
aumenta la dimensione della mappa. L’elaborazione richiede più tempo. Raddoppiando il numero delle
righe verrà automaticamente raddoppiato il numero delle colonne e quindi la dimensione delle celle risulterà
essere dimezzata. Infatti l’area di output del raster rimane la stessa!

• Cell Size X e Cell Size Y influenzano la dimensione dei pixel in output e quindi cambierà anche il numero
di righe e di colonne.

Il layer di punti può avere degli attributi che possono essere usati per creare una mappa di concentrazione:

• Use Radius from Field: il raggio viene determinato da un campo degli attributi.

• Use Weight from field: serve per impostare il peso dalla tabella degli attributi.

Una volta dato il raster di outpur, premere [OK] per creare la mappa di concentrazione. Il primo risultato è una
mappa grigia che necessita di modifiche affinché il risultato sia ottimale.

Avvertimento: Cambiare le proprietà dimensionali del raster
Cambiando le dimensioni dei pixel, cambia anche l’output finale. Gli hotspot saranno più grandi.

19.17.3 Creare una Mappa di concentrazione

Per questo esempio verrà usato il layer di punti airports presente nel dataset di esempio di QGIS (vedi
Dati campione). Si può trovare un altro ottimo tutorial sulla creazione di mappe di concentrazione all’indirizzo
http://qgis.spatialthoughts.com.

In figura Figure_Heatmap_1 sono visualizzati gli aeroporti dell’Alaska.

Figura 19.28: Airports of Alaska

1. Premere il pulsante Mappa di concentrazione per aprire la finestra di dialogo (vedi Figure_Heatmap_2).

2. Nel campo Vettore punti in input selezionare airpoirt dalla lista dei layer presenti nel progetto.
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3. Nel campo Output Raster scegliere il nome e la posizione del raster in output usando il pulsante .
Inserire il nome heatmap_airports senza aggiunger un’estensione al file.

4. Selezionare GeoTIFF nel campo Formato in output.

5. Inserire 1000000 metri come Raggio.

6. Il valore predefinto 0.1 per il Decay Ratio è perfetto.

7. Cliccare su [OK] per creare la nuova mappa raster (figura Figure_Heatmap_3).

Figura 19.29: The Heatmap Dialog

Probabilmente il risultato caricato non è quello che ci si aspettava; infatti è solo una superficie grigia e non sembra
esserci nessuna tendenza. E’ necessario effetturare alcune configurazioni sul layer per rendere presentabile la
mappa di concentrazione.

Figura 19.30: The heatmap after loading looks like a grey surface

1. Aprire la finestra delle priprietà del layer heatmap_airports (selezionare il layer
heatmap_airports, fare click con il tasto desto e scegliere Proprietà).

2. Selezionare la scheda Simbologia.

3. Cambiare la Mappa colore da ‘Grayscale’ a ‘Pseudocolor’.

4. Premere il pulsante [Applica].

5. Cliccare sulla scheda Trasparenza e impostare la Trasparenza globale al 40%.

6. Premere [OK]
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Il risultato finale è mostrato nella figura Figure_Heatmap_4.

Figura 19.31: Final result of heatmap created of airports of Alaska

19.18 Plugin grafo strade

Il plugin Road Graph è un plugin scritto in C++ che calcola il percorso minimo tra punti su una polilinea e traccia
tale percorso sul grafo delle strade.

Figura 19.32: Road Graph Plugin

Caratteristiche principali:

• Calcola il percorso, la sua lunghezza ed il tempo di percorrenza

• Ottimizza la lunghezza ed il tempo di percorrenza

• Esporta il percorso in un layer vettoriale

• Evidenzia la direzione delle strade (tale funzionalità è lenta e dovrebbe essere usata solo in fase di test)

Come layer di strade è possibile usare un layer vettoriale di polilinee in uno dei formati supportati da QGIS. Due
linee con un punto in comune vengono considerate connesse. Si noti che è richiesto di impostare il SR del progetto
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sul SR del layer qualora si intenda modificare quest’ultimo: il ricalcolo delle coordinate in differenti SR introduce
degli errori che inficiano la qualità dei dati, anche se si opera con lo snap attivato.

Nella tabella degli attributi del layer si possono usare i seguenti campi:

• Velocità su sezione di strada — numerico

• Direzione — testo (avanti, inversa, a doppio senso)

Se alcuni campi non hanno valori, o non esistono, vengono utilizzati dei valori predefiniti. Si possono cambiare
alcune impostazioni predefinite nel menu impostazioni del plugin.

19.18.1 Utilizzo del plugin

Una volta caricato il plugin, impostarne le opzioni nella finestra di dialogo Impostazioni del pugin grafo strade
dal menu :menuselection:‘Vettore –> Grafo strade.

Selezionare un punto di partenza ed un punto di arrivo sul grafo delle strade e cliccare su [Calcola].

19.19 Plugin Spatial Query

Il plugin Spatial Query permette di definire una query spaziale di selezione in un layer target con riferimento ad
un altro layer. La funzionalità si basa sulla libreria GEOS e dipende dalle caratteristiche del layer selezionato.

Gli operatori spaziali sono:

• Contiene

• E’ uguale a

• Sovrappone

• Attraversa

• Interseca

• E’ disgiunto

• Tocca

• E’ contenuto

19.19.1 Come usare il plugin

L’esempio che segue mostra come individuare le regioni dell’Alaska che contengono degli aeroporti:

1. Avviare QGIS e caricare i layer vettoriali regions.shp e airports.shp.

2. Caricare il plugin Spatial Query dal Gestore plugin (sezione Abilitare un Plugin Core) e cliccare sull’icona
Spatial Query nella barra degli strumenti plugin: si aprirà cosi la finestra di dialogo Interrogazione spaziale.

3. Selezionare regions come sorgente degli oggetti e airports come riferimento.

4. Selezionare ’Contiene’ come operatore e cliccare su [Apply].

A questo punto appare un riquadro che elenca gli ID degli elementi che soddisfano la query; si hanno diverse
opzioni per utilizzare i risultati come si può vedere dalla figura figure_spatial_query_1.

• Cliccare su Crea layer con lista di oggetti

• Selezionare un elemento dalla lista e cliccare Crea layer con selezionato

• Selezionare ‘Rimuovi dalla sessione corrente’ nel campo E usa il risultato per .
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• Opzionalmente è possibile selezionare le caselle di controllo Zoom all’oggetto e Messaggi di log.

Figura 19.33: Spatial Query analysis - regions contain airports

19.20 Plugin SPIT

QGIS include un plugin denominato SPIT (Shapefile to PostGIS Import Tool). SPIT può essere usato per caricare
più shapefile contemporaneamente e include il supporto per gli schemi. Per usare SPIT, aprire il gestore dei plugin

dal menu Plugin, selezionare la casella di controllo SPIT and click [OK]. L’icona di SPIT verrà aggiunta alla
barra degli strumenti plugin.

Per importare uno shapefile, cliccare sull’icona SPIT nella barra degli strumenti per aprire la finestra di
dialogo SPIT - Shapefile to PostGIS Import Tool . Selezionare il database PostGIS al quale si desidera connettersi
e cliccare su [Connetti ]. Ora è possibile aggiungere uno o più file alla coda cliccando su [Aggiungi]. Per
processare i file selezionati, cliccare su [OK]. L’avanzamento dell’importazione ed eventuali errori/avvertimenti
saranno mostrati mentre ciascuno shapefile viene elaborato.

Figura 19.34: Using SPIT Plugin to import Shape files to PostGIS
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Suggerimento: Importare shapefile contenenti parole riservate in PostgreSQL
Se alla coda d’importazione viene aggiunto uno shapefile contenente campi con parole riservate per il database
PostgreSQL, comparirà una finestra di dialogo che darà informazioni sullo stato di ogni campo. È necessario
modificare i nomi dei campi contenenti tali parole (ed è possibile eventualmente editare anche il nome degli altri
campi) prima dell’importazione, altrimenti il processo di importazione non andrà a buon fine.

19.21 Plugin SQL Anywhere

SQL Anywhere è un database relazionale proprietario (RDBMS) prodotto da Sybase. Fornisce supporto ai dati
geospaziali, es. OGC e shapefile, e consente di esportare nei formati KML, GML e SVG.

Figura 19.35: SQL Anywhere dialog (KDE)

Il fornitore dati SQL Anywhere SQL Anywhere presente in QGIS è rilasciato con licenza GPL v3. La finestra di
dialogo Aggiungi un layer SQL Anywhere è simile a quella di PostGIS e a quella SpatiLite.

19.22 Plugin Statistica zonale

Con il plugin Stastica zonale è possibile di analizzare i risultati di una classificazione tematica. Il plugin per-
mette di calcolare diversi valori dei pixel di un raster con l’aiuto di un layer vettoriale di poligoni(figura fig-
ure_zonal_statistics). E’ possibile calcolare la somma, la media e il numero totale dei pixel che ricadono dentro
un poligono. Il plugin crea una colonna aggiuniva con un prefisso predefinito nella tabella degli attributi del layer
vettoriale.

Figura 19.36: Zonal statistics dialog (KDE)
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CAPITOLO 20

Aiuto e supporto

20.1 Le Mailing list

QGIS è in continuo sviluppo e, come tale, non funzionerà sempre come ci si aspetta. Il miglior modo di ottenere
aiuto è unirsi a una mailing list di qgis. Le vostre domande raggiungeranno una audience più ampia e le risposte
ottenute saranno anche a beneficio di altri.

20.1.1 qgis-users

Questa mailing list è usata per discussioni su QGIS in generale, così come per domande speci-
fiche sulla sua installazione ed uso. Potere sottoscrivere la maling list qgis-users al seguente URL:
http://lists.osgeo.org/mailman/listinfo/qgis-user

20.1.2 fossgis-talk-liste

Per l’utenza di lingua tedesca, FOSSGIS e.V. mette a disposizione la mailing list fossgis-talk-liste. Questa mailing
list è usata per discussioni sul GIS open source in generale, incluso QGIS. Potete sottoscrivere la mailing list
fossgis-talk-liste al seguente URL: https://lists.fossgis.de/mailman/listinfo/fossgis-talk-liste

20.1.3 qgis-developer

Gli sviluppatori con problemi di natura più tecnica possono unirsi alla mailing list qgis-developer andando qui:
http://lists.osgeo.org/mailman/listinfo/qgis-developer

20.1.4 qgis-commit

Ogni volta che viene inserito un ‘commit’ al codice di QGIS, viene inviata una email a questa mailing list.
Se desiderate essere aggiornati su ogni cambiamento all’attuale codice, potete sottoscrivere questa mailing lista
all’URL: http://lists.osgeo.org/mailman/listinfo/qgis-commit

20.1.5 qgis-trac

Questa mailing list notifica email collegate alla gestione del progetto, inlcusi i bug report, i compiti assegnati e le
richieste di nuove caratteristiche. Potete sottoscriverla all’URL: http://lists.osgeo.org/mailman/listinfo/qgis-trac
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20.1.6 qgis-community-team

Questa mailin list si occupa di argomenti come la documentazione, l’aiuto contestuale, la guida utente, l’es-
perienza d’uso online inclusi i siti web, e i lavori di traduzione. Se volete lavorare anche sulla guida utente,
questa mailing list è un buon punto di partenza per fare le vostre domande. Potete sottoscriverla all’URL:
http://lists.osgeo.org/mailman/listinfo/qgis-community-team

20.1.7 qgis-release-team

Questa mailing list si occupa di argomenti quali il processo di rilascio, i pacchetti binari per i
vari sistemi operativi e l’annuncio delle nuove release in generale. Potete sottoscriverla all’URL:
http://lists.osgeo.org/mailman/listinfo/qgis-release-team

20.1.8 qgis-tr

Questa lista si occuopa delle traduzioni. Chi desidera lavorare alla traduzione dei manuali o dell’intefaccia grafica
(GUI) trova in questa lista un buon punto di partenza per le proprie domande. La lista può essere sottoscritta
all’URL http://lists.osgeo.org/mailman/listinfo/qgis-tr

20.1.9 qgis-edu

Questa lista si occupa degli aspetti educativi di QGIS. Chi desidera lavorare su materiali educativi tro-
va un questa lista un buon punto di partenza per le proprie domande. Può essere sottoscritta all’URL
http://lists.osgeo.org/mailman/listinfo/qgis-edu

20.1.10 qgis-psc

Questa mailing list viene usata per discutere argomenti relativi al Comitato di Coordinamento e alla gestione
complessiva di Quantum GIS. Potete sottoscriverla all’URL: http://lists.osgeo.org/mailman/listinfo/qgis-psc

Siete invitati a sottoscrivere qualunque mailing list desideriate fra queste. Ricordate che potete contribuire rispon-
dendo alle domande e condividendo le vostre esperienze. Notate che le mailing list qgis-commit e qgis-trac sono
riservate alle sole notifiche e non sono dedicate allo scambio di comunicazioni fra gli utenti.

20.2 IRC

Siamo anche presenti su IRC - ci si può registrare al canale #qgis su irc.freenode.net. Per favore, aspettate pazien-
temente le risposte alle vostre domande, dato che molte persone sul canale IRC sono al lavoro su altre cose,
e potrebbero impiegare un po’ di tempo prima di notare la vostra richiesta. E’ inoltre disponibile un supporto
commerciale a QSIG. Per maggiori informazioni, visitate il sito web http://qgis.org/en/commercial-support.html .

Se avete perso una discussione su IRC, non c’è problema! Noi registriamo tutte le discussioni, cosicchè possiate
mettervi in pari semlicemente leggendo i log salvati su http://logs.qgis.org .

20.3 BugTracker

Sebbene la mailing list qgis-users sia utile per domande del tipo ‘come si fa XYZ su QGIS’, potreste voler-
ci comunicare qualche bug. Potete inviare le vostre segnalazioni utilizzando il bug tracker di QGIS, all’URL
http://hub.qgis.org/projects/quantum-gis/issues. Nql creare un nuovo ticket, per favore fornite anche un indirizzo
email al quale potervi contattare per ulteriori informazioni.

246 Capitolo 20. Aiuto e supporto

http://lists.osgeo.org/mailman/listinfo/qgis-community-team
http://lists.osgeo.org/mailman/listinfo/qgis-release-team
http://lists.osgeo.org/mailman/listinfo/qgis-tr
http://lists.osgeo.org/mailman/listinfo/qgis-edu
http://lists.osgeo.org/mailman/listinfo/qgis-psc
http://qgis.org/en/commercial-support.html
http://logs.qgis.org
http://hub.qgis.org/projects/quantum-gis/issues


QGIS User Guide, Release 1.8

Ricordate che un bug da voi segnalato potrebbe ricevere una priorità diversa da quella che vi aspettereste (a seconda
della serietà del problema). Alcuni errori richiedono un significativo sforzo allo sviluppatore e non sempre ci sono
abbastanza risorse umane disponibili.

Le richieste per nuove caratteristiche possono essere sottoposte tramite lo stesso sistema di segnalazioni usato per
i bug. Assicuratevi di aver prima selezionato il tipo Feature.

Se doveste aver trovato il modo di risolvere un errore da voi individuato, potete sottomettere anche la relativa
patch. Anche qui, il sistema di segnalazione presente in http://hub.qgis.org/projects/quantum-gis/issues ha una
sezione dedicata. Selezionate Patch supplied e allegate la vostra patch prima di sottomettere l’errore. Uno
sviluppatore la verificherà e la applicherà a QGIS. Non è il caso di allarmarsi se la patch non viene subito applicata
— gli sviluppatori potrebbero essere impegnati con altre priorità.

20.4 Blog

LA comunità QGIS ha anche un blog all’URL http://www.qgis.org/planet che contiene articoli interessanti per
utenti e sviluppatori. Siete tutti invitati a contribuire!

20.5 Plugins

Il sito web http://plugins.qgis.org è il portale ufficiale per i plugin QGIS. Qui si può trovare una lista di tutti i
plugin stabili e sperimentali disponibili tramite il ‘Repository Ufficiale dei Plugin di QGIS’.

20.6 Wiki

Infine, è disponibile una WIKI al sito http://hub.qgis.org/projects/quantum-gis/wiki dove’è possibile trovare un
assortimento di informazioni utili sullo sviluppo di QGIS e sui piani di rilascio, collegamenti ai siti per il download,
suggerimenti per le traduzioni e così via. Visitatelo, troverete molte cose utili!
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CAPITOLO 21

Appendix

21.1 GNU General Public License

Version 2, June 1991

Copyright (C) 1989, 1991 Free Software Foundation, Inc. 59 Temple Place - Suite 330, Boston, MA 02111-1307,
USA

Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it is not
allowed.

Preamble

The licenses for most software are designed to take away your freedom to share and change it. By contrast,
the GNU General Public License is intended to guarantee your freedom to share and change free software–to
make sure the software is free for all its users. This General Public License applies to most of the Free Software
Foundation’s software and to any other program whose authors commit to using it. (Some other Free Software
Foundation software is covered by the GNU Library General Public License instead.) You can apply it to your
programs, too.

When we speak of free software, we are referring to freedom, not price. Our General Public Licenses are designed
to make sure that you have the freedom to distribute copies of free software (and charge for this service if you
wish), that you receive source code or can get it if you want it, that you can change the software or use pieces of
it in new free programs; and that you know you can do these things.

To protect your rights, we need to make restrictions that forbid anyone to deny you these rights or to ask you to
surrender the rights. These restrictions translate to certain responsibilities for you if you distribute copies of the
software, or if you modify it.

For example, if you distribute copies of such a program, whether gratis or for a fee, you must give the recipients
all the rights that you have. You must make sure that they, too, receive or can get the source code. And you must
show them these terms so they know their rights.

We protect your rights with two steps: (1) copyright the software, and (2) offer you this license which gives you
legal permission to copy, distribute and/or modify the software.

Also, for each author’s protection and ours, we want to make certain that everyone understands that there is no
warranty for this free software. If the software is modified by someone else and passed on, we want its recipients
to know that what they have is not the original, so that any problems introduced by others will not reflect on the
original authors’ reputations.

Finally, any free program is threatened constantly by software patents. We wish to avoid the danger that redis-
tributors of a free program will individually obtain patent licenses, in effect making the program proprietary. To
prevent this, we have made it clear that any patent must be licensed for everyone’s free use or not licensed at all.

The precise terms and conditions for copying, distribution and modification follow. TERMS AND CONDITIONS
FOR COPYING, DISTRIBUTION AND MODIFICATION

0. This License applies to any program or other work which contains a notice placed by the copyright holder
saying it may be distributed under the terms of this General Public License. The “Program”, below, refers to
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any such program or work, and a “work based on the Program” means either the Program or any derivative
work under copyright law: that is to say, a work containing the Program or a portion of it, either verbatim
or with modifications and/or translated into another language. (Hereinafter, translation is included without
limitation in the term “modification”.) Each licensee is addressed as “you”.

Activities other than copying, distribution and modification are not covered by this License; they are outside
its scope. The act of running the Program is not restricted, and the output from the Program is covered only
if its contents constitute a work based on the Program (independent of having been made by running the
Program). Whether that is true depends on what the Program does.

1. You may copy and distribute verbatim copies of the Program’s source code as you receive it, in any medium,
provided that you conspicuously and appropriately publish on each copy an appropriate copyright notice
and disclaimer of warranty; keep intact all the notices that refer to this License and to the absence of any
warranty; and give any other recipients of the Program a copy of this License along with the Program.

You may charge a fee for the physical act of transferring a copy, and you may at your option offer warranty
protection in exchange for a fee.

2. You may modify your copy or copies of the Program or any portion of it, thus forming a work based on the
Program, and copy and distribute such modifications or work under the terms of Section 1 above, provided
that you also meet all of these conditions:

(a) You must cause the modified files to carry prominent notices stating that you changed the files and the
date of any change.

(b) You must cause any work that you distribute or publish, that in whole or in part contains or is derived
from the Program or any part thereof, to be licensed as a whole at no charge to all third parties under
the terms of this License.

(c) If the modified program normally reads commands interactively when run, you must cause it, when
started running for such interactive use in the most ordinary way, to print or display an announcement
including an appropriate copyright notice and a notice that there is no warranty (or else, saying that
you provide a warranty) and that users may redistribute the program under these conditions, and telling
the user how to view a copy of this License. (Exception: if the Program itself is interactive but does
not normally print such an announcement, your work based on the Program is not required to print an
announcement.)

These requirements apply to the modified work as a whole. If identifiable sections of that work are not
derived from the Program, and can be reasonably considered independent and separate works in themselves,
then this License, and its terms, do not apply to those sections when you distribute them as separate works.
But when you distribute the same sections as part of a whole which is a work based on the Program, the
distribution of the whole must be on the terms of this License, whose permissions for other licensees extend
to the entire whole, and thus to each and every part regardless of who wrote it.

Thus, it is not the intent of this section to claim rights or contest your rights to work written entirely by you;
rather, the intent is to exercise the right to control the distribution of derivative or collective works based on
the Program.

In addition, mere aggregation of another work not based on the Program with the Program (or with a work
based on the Program) on a volume of a storage or distribution medium does not bring the other work under
the scope of this License.

3. You may copy and distribute the Program (or a work based on it, under Section 2) in object code or
executable form under the terms of Sections 1 and 2 above provided that you also do one of the following:

(a) Accompany it with the complete corresponding machine-readable source code, which must be dis-
tributed under the terms of Sections 1 and 2 above on a medium customarily used for software
interchange; or,

(b) Accompany it with a written offer, valid for at least three years, to give any third party, for a charge no
more than your cost of physically performing source distribution, a complete machine-readable copy
of the corresponding source code, to be distributed under the terms of Sections 1 and 2 above on a
medium customarily used for software interchange; or,
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(c) Accompany it with the information you received as to the offer to distribute corresponding source
code. (This alternative is allowed only for noncommercial distribution and only if you received the
program in object code or executable form with such an offer, in accord with Subsection b above.)

The source code for a work means the preferred form of the work for making modifications to it. For an
executable work, complete source code means all the source code for all modules it contains, plus any
associated interface definition files, plus the scripts used to control compilation and installation of the ex-
ecutable. However, as a special exception, the source code distributed need not include anything that is
normally distributed (in either source or binary form) with the major components (compiler, kernel, and
so on) of the operating system on which the executable runs, unless that component itself accompanies the
executable.

If distribution of executable or object code is made by offering access to copy from a designated place, then
offering equivalent access to copy the source code from the same place counts as distribution of the source
code, even though third parties are not compelled to copy the source along with the object code.

4. You may not copy, modify, sublicense, or distribute the Program except as expressly provided under this
License. Any attempt otherwise to copy, modify, sublicense or distribute the Program is void, and will
automatically terminate your rights under this License. However, parties who have received copies, or
rights, from you under this License will not have their licenses terminated so long as such parties remain in
full compliance.

5. You are not required to accept this License, since you have not signed it. However, nothing else grants you
permission to modify or distribute the Program or its derivative works. These actions are prohibited by law
if you do not accept this License. Therefore, by modifying or distributing the Program (or any work based
on the Program), you indicate your acceptance of this License to do so, and all its terms and conditions for
copying, distributing or modifying the Program or works based on it.

6. Each time you redistribute the Program (or any work based on the Program), the recipient automatically
receives a license from the original licensor to copy, distribute or modify the Program subject to these terms
and conditions. You may not impose any further restrictions on the recipients’ exercise of the rights granted
herein. You are not responsible for enforcing compliance by third parties to this License.

7. If, as a consequence of a court judgment or allegation of patent infringement or for any other reason (not
limited to patent issues), conditions are imposed on you (whether by court order, agreement or otherwise)
that contradict the conditions of this License, they do not excuse you from the conditions of this License.
If you cannot distribute so as to satisfy simultaneously your obligations under this License and any other
pertinent obligations, then as a consequence you may not distribute the Program at all. For example, if a
patent license would not permit royalty-free redistribution of the Program by all those who receive copies
directly or indirectly through you, then the only way you could satisfy both it and this License would be to
refrain entirely from distribution of the Program.

If any portion of this section is held invalid or unenforceable under any particular circumstance, the balance
of the section is intended to apply and the section as a whole is intended to apply in other circumstances.

It is not the purpose of this section to induce you to infringe any patents or other property right claims or
to contest validity of any such claims; this section has the sole purpose of protecting the integrity of the
free software distribution system, which is implemented by public license practices. Many people have
made generous contributions to the wide range of software distributed through that system in reliance on
consistent application of that system; it is up to the author/donor to decide if he or she is willing to distribute
software through any other system and a licensee cannot impose that choice.

This section is intended to make thoroughly clear what is believed to be a consequence of the rest of this
License.

8. If the distribution and/or use of the Program is restricted in certain countries either by patents or by copy-
righted interfaces, the original copyright holder who places the Program under this License may add an
explicit geographical distribution limitation excluding those countries, so that distribution is permitted only
in or among countries not thus excluded. In such case, this License incorporates the limitation as if written
in the body of this License.

9. The Free Software Foundation may publish revised and/or new versions of the General Public License from
time to time. Such new versions will be similar in spirit to the present version, but may differ in detail to
address new problems or concerns.
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Each version is given a distinguishing version number. If the Program specifies a version number of this
License which applies to it and “any later version”, you have the option of following the terms and conditions
either of that version or of any later version published by the Free Software Foundation. If the Program
does not specify a version number of this License, you may choose any version ever published by the Free
Software Foundation.

10. If you wish to incorporate parts of the Program into other free programs whose distribution conditions are
different, write to the author to ask for permission. For software which is copyrighted by the Free Software
Foundation, write to the Free Software Foundation; we sometimes make exceptions for this. Our decision
will be guided by the two goals of preserving the free status of all derivatives of our free software and of
promoting the sharing and reuse of software generally.

NO WARRANTY

11. BECAUSE THE PROGRAM IS LICENSED FREE OF CHARGE, THERE IS NO WARRANTY FOR THE
PROGRAM, TO THE EXTENT PERMITTED BY APPLICABLE LAW. EXCEPT WHEN OTHERWISE
STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR OTHER PARTIES PROVIDE THE
PROGRAM “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND
FITNESS FOR A PARTICULAR PURPOSE. THE ENTIRE RISK AS TO THE QUALITY AND PER-
FORMANCE OF THE PROGRAM IS WITH YOU. SHOULD THE PROGRAM PROVE DEFECTIVE,
YOU ASSUME THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.

12. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING WILL
ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY AND/OR REDIS-
TRIBUTE THE PROGRAM AS PERMITTED ABOVE, BE LIABLE TO YOU FOR DAMAGES, IN-
CLUDING ANY GENERAL, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING
OUT OF THE USE OR INABILITY TO USE THE PROGRAM (INCLUDING BUT NOT LIMITED
TO LOSS OF DATA OR DATA BEING RENDERED INACCURATE OR LOSSES SUSTAINED BY
YOU OR THIRD PARTIES OR A FAILURE OF THE PROGRAM TO OPERATE WITH ANY OTH-
ER PROGRAMS), EVEN IF SUCH HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE
POSSIBILITY OF SUCH DAMAGES.

Quantum GIS Qt exception for GPL

In addition, as a special exception, the QGIS Development Team gives permission to link the code
of this program with the Qt library, including but not limited to the following versions (both free
and commercial): Qt/Non-commerical Windows, Qt/Windows, Qt/X11, Qt/Mac, and Qt/Embedded
(or with modified versions of Qt that use the same license as Qt), and distribute linked combinations
including the two. You must obey the GNU General Public License in all respects for all of the code
used other than Qt. If you modify this file, you may extend this exception to your version of the file,
but you are not obligated to do so. If you do not wish to do so, delete this exception statement from
your version.

21.2 GNU Free Documentation License

Version 1.3, 3 November 2008

Copyright 2000, 2001, 2002, 2007, 2008 Free Software Foundation, Inc

<http://fsf.org/>

Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it is not
allowed.

Preamble

The purpose of this License is to make a manual, textbook, or other functional and useful document “free” in the
sense of freedom: to assure everyone the effective freedom to copy and redistribute it, with or without modifying
it, either commercially or noncommercially. Secondarily, this License preserves for the author and publisher a
way to get credit for their work, while not being considered responsible for modifications made by others.
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This License is a kind of “copyleft”, which means that derivative works of the document must themselves be free
in the same sense. It complements the GNU General Public License, which is a copyleft license designed for free
software.

We have designed this License in order to use it for manuals for free software, because free software needs free
documentation: a free program should come with manuals providing the same freedoms that the software does.
But this License is not limited to software manuals; it can be used for any textual work, regardless of subject
matter or whether it is published as a printed book. We recommend this License principally for works whose
purpose is instruction or reference.

1. APPLICABILITY AND DEFINITIONS

This License applies to any manual or other work, in any medium, that contains a notice placed by the copyright
holder saying it can be distributed under the terms of this License. Such a notice grants a world-wide, royalty-free
license, unlimited in duration, to use that work under the conditions stated herein. The Document, below, refers
to any such manual or work. Any member of the public is a licensee, and is addressed as “you”. You accept the
license if you copy, modify or distribute the work in a way requiring permission under copyright law.

A “Modified Version” of the Document means any work containing the Document or a portion of it, either copied
verbatim, or with modifications and/or translated into another language.

A “Secondary Section” is a named appendix or a front-matter section of the Document that deals exclusively
with the relationship of the publishers or authors of the Document to the Document’s overall subject (or to related
matters) and contains nothing that could fall directly within that overall subject. (Thus, if the Document is in part
a textbook of mathematics, a Secondary Section may not explain any mathematics.) The relationship could be
a matter of historical connection with the subject or with related matters, or of legal, commercial, philosophical,
ethical or political position regarding them.

The “Invariant Sections” are certain Secondary Sections whose titles are designated, as being those of Invariant
Sections, in the notice that says that the Document is released under this License. If a section does not fit the
above definition of Secondary then it is not allowed to be designated as Invariant. The Document may contain
zero Invariant Sections. If the Document does not identify any Invariant Sections then there are none.

The “Cover Texts” are certain short passages of text that are listed, as Front-Cover Texts or Back-Cover Texts, in
the notice that says that the Document is released under this License. A Front-Cover Text may be at most 5 words,
and a Back-Cover Text may be at most 25 words.

A “Transparent” copy of the Document means a machine-readable copy, represented in a format whose specifi-
cation is available to the general public, that is suitable for revising the document straightforwardly with generic
text editors or (for images composed of pixels) generic paint programs or (for drawings) some widely available
drawing editor, and that is suitable for input to text formatters or for automatic translation to a variety of formats
suitable for input to text formatters. A copy made in an otherwise Transparent file format whose markup, or ab-
sence of markup, has been arranged to thwart or discourage subsequent modification by readers is not Transparent.
An image format is not Transparent if used for any substantial amount of text. A copy that is not “Transparent” is
called Opaque.

Examples of suitable formats for Transparent copies include plain ASCII without markup, Texinfo input for-
mat, LaTeX input format, SGML or XML using a publicly available DTD, and standard-conforming simple
HTML, PostScript or PDF designed for human modification. Examples of transparent image formats include
PNG, XCF and JPG. Opaque formats include proprietary formats that can be read and edited only by proprietary
word processors, SGML or XML for which the DTD and/or processing tools are not generally available, and the
machine-generated HTML, PostScript or PDF produced by some word processors for output purposes only.

The “Title Page” means, for a printed book, the title page itself, plus such following pages as are needed to hold,
legibly, the material this License requires to appear in the title page. For works in formats which do not have any
title page as such, “Title Page” means the text near the most prominent appearance of the work’s title, preceding
the beginning of the body of the text.

The “publisher” means any person or entity that distributes copies of the Document to the public.

A section “Entitled XYZ” means a named subunit of the Document whose title either is precisely XYZ or contains
XYZ in parentheses following text that translates XYZ in another language. (Here XYZ stands for a specific
section name mentioned below, such as “Acknowledgements”, “Dedications”, “Endorsements”, or “History”.)
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To “Preserve the Title” of such a section when you modify the Document means that it remains a section “Entitled
XYZ” according to this definition.

The Document may include Warranty Disclaimers next to the notice which states that this License applies to the
Document. These Warranty Disclaimers are considered to be included by reference in this License, but only as
regards disclaiming warranties: any other implication that these Warranty Disclaimers may have is void and has
no effect on the meaning of this License.

2. VERBATIM COPYING

You may copy and distribute the Document in any medium, either commercially or noncommercially, provided
that this License, the copyright notices, and the license notice saying this License applies to the Document are
reproduced in all copies, and that you add no other conditions whatsoever to those of this License. You may not
use technical measures to obstruct or control the reading or further copying of the copies you make or distribute.
However, you may accept compensation in exchange for copies. If you distribute a large enough number of copies
you must also follow the conditions in section 3.

You may also lend copies, under the same conditions stated above, and you may publicly display copies.

3. COPYING IN QUANTITY

If you publish printed copies (or copies in media that commonly have printed covers) of the Document, numbering
more than 100, and the Document’s license notice requires Cover Texts, you must enclose the copies in covers
that carry, clearly and legibly, all these Cover Texts: Front-Cover Texts on the front cover, and Back-Cover Texts
on the back cover. Both covers must also clearly and legibly identify you as the publisher of these copies. The
front cover must present the full title with all words of the title equally prominent and visible. You may add other
material on the covers in addition. Copying with changes limited to the covers, as long as they preserve the title
of the Document and satisfy these conditions, can be treated as verbatim copying in other respects.

If the required texts for either cover are too voluminous to fit legibly, you should put the first ones listed (as many
as fit reasonably) on the actual cover, and continue the rest onto adjacent pages.

If you publish or distribute Opaque copies of the Document numbering more than 100, you must either include
a machine-readable Transparent copy along with each Opaque copy, or state in or with each Opaque copy a
computer-network location from which the general network-using public has access to download using public-
standard network protocols a complete Transparent copy of the Document, free of added material. If you use the
latter option, you must take reasonably prudent steps, when you begin distribution of Opaque copies in quantity, to
ensure that this Transparent copy will remain thus accessible at the stated location until at least one year after the
last time you distribute an Opaque copy (directly or through your agents or retailers) of that edition to the public.

It is requested, but not required, that you contact the authors of the Document well before redistributing any large
number of copies, to give them a chance to provide you with an updated version of the Document.

4. MODIFICATIONS

You may copy and distribute a Modified Version of the Document under the conditions of sections 2 and 3 above,
provided that you release the Modified Version under precisely this License, with the Modified Version filling the
role of the Document, thus licensing distribution and modification of the Modified Version to whoever possesses
a copy of it. In addition, you must do these things in the Modified Version:

1. Use in the Title Page (and on the covers, if any) a title distinct from that of the Document, and from those of
previous versions (which should, if there were any, be listed in the History section of the Document). You
may use the same title as a previous version if the original publisher of that version gives permission.

2. List on the Title Page, as authors, one or more persons or entities responsible for authorship of the modifi-
cations in the Modified Version, together with at least five of the principal authors of the Document (all of
its principal authors, if it has fewer than five), unless they release you from this requirement.

3. State on the Title page the name of the publisher of the Modified Version, as the publisher.

4. Preserve all the copyright notices of the Document.

5. Add an appropriate copyright notice for your modifications adjacent to the other copyright notices.

6. Include, immediately after the copyright notices, a license notice giving the public permission to use the
Modified Version under the terms of this License, in the form shown in the Addendum below.
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7. Preserve in that license notice the full lists of Invariant Sections and required Cover Texts given in the
Document’s license notice.

8. Include an unaltered copy of this License.

9. Preserve the section Entitled “History”, Preserve its Title, and add to it an item stating at least the title, year,
new authors, and publisher of the Modified Version as given on the Title Page. If there is no section Entitled
“History” in the Document, create one stating the title, year, authors, and publisher of the Document as
given on its Title Page, then add an item describing the Modified Version as stated in the previous sentence.

10. Preserve the network location, if any, given in the Document for public access to a Transparent copy of the
Document, and likewise the network locations given in the Document for previous versions it was based
on. These may be placed in the “History” section. You may omit a network location for a work that was
published at least four years before the Document itself, or if the original publisher of the version it refers
to gives permission.

11. For any section Entitled “Acknowledgements” or “Dedications”, Preserve the Title of the section, and
preserve in the section all the substance and tone of each of the contributor acknowledgements and/or
dedications given therein.

12. Preserve all the Invariant Sections of the Document, unaltered in their text and in their titles. Section
numbers or the equivalent are not considered part of the section titles.

13. Delete any section Entitled “Endorsements”. Such a section may not be included in the Modified Version.

14. Do not retitle any existing section to be Entitled “Endorsements” or to conflict in title with any Invariant
Section.

15. Preserve any Warranty Disclaimers.

If the Modified Version includes new front-matter sections or appendices that qualify as Secondary Sections and
contain no material copied from the Document, you may at your option designate some or all of these sections
as invariant. To do this, add their titles to the list of Invariant Sections in the Modified Version’s license notice.
These titles must be distinct from any other section titles.

You may add a section Entitled “Endorsements”, provided it contains nothing but endorsements of your Modified
Version by various parties—for example, statements of peer review or that the text has been approved by an
organization as the authoritative definition of a standard.

You may add a passage of up to five words as a Front-Cover Text, and a passage of up to 25 words as a Back-Cover
Text, to the end of the list of Cover Texts in the Modified Version. Only one passage of Front-Cover Text and one
of Back-Cover Text may be added by (or through arrangements made by) any one entity. If the Document already
includes a cover text for the same cover, previously added by you or by arrangement made by the same entity you
are acting on behalf of, you may not add another; but you may replace the old one, on explicit permission from
the previous publisher that added the old one.

The author(s) and publisher(s) of the Document do not by this License give permission to use their names for
publicity for or to assert or imply endorsement of any Modified Version.

5. COMBINING DOCUMENTS

You may combine the Document with other documents released under this License, under the terms defined in
section 4 above for modified versions, provided that you include in the combination all of the Invariant Sections
of all of the original documents, unmodified, and list them all as Invariant Sections of your combined work in its
license notice, and that you preserve all their Warranty Disclaimers.

The combined work need only contain one copy of this License, and multiple identical Invariant Sections may be
replaced with a single copy. If there are multiple Invariant Sections with the same name but different contents,
make the title of each such section unique by adding at the end of it, in parentheses, the name of the original author
or publisher of that section if known, or else a unique number. Make the same adjustment to the section titles in
the list of Invariant Sections in the license notice of the combined work.

In the combination, you must combine any sections Entitled “History” in the various original documents, forming
one section Entitled “History”; likewise combine any sections Entitled “Acknowledgements”, and any sections
Entitled “Dedications”. You must delete all sections Entitled “Endorsements”.

6. COLLECTIONS OF DOCUMENTS
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You may make a collection consisting of the Document and other documents released under this License, and
replace the individual copies of this License in the various documents with a single copy that is included in the
collection, provided that you follow the rules of this License for verbatim copying of each of the documents in all
other respects.

You may extract a single document from such a collection, and distribute it individually under this License,
provided you insert a copy of this License into the extracted document, and follow this License in all other respects
regarding verbatim copying of that document.

7. AGGREGATION WITH INDEPENDENT WORKS

A compilation of the Document or its derivatives with other separate and independent documents or works, in
or on a volume of a storage or distribution medium, is called an “aggregate” if the copyright resulting from the
compilation is not used to limit the legal rights of the compilation’s users beyond what the individual works permit.
When the Document is included in an aggregate, this License does not apply to the other works in the aggregate
which are not themselves derivative works of the Document.

If the Cover Text requirement of section 3 is applicable to these copies of the Document, then if the Document
is less than one half of the entire aggregate, the Document’s Cover Texts may be placed on covers that bracket
the Document within the aggregate, or the electronic equivalent of covers if the Document is in electronic form.
Otherwise they must appear on printed covers that bracket the whole aggregate.

8. TRANSLATION

Translation is considered a kind of modification, so you may distribute translations of the Document under the
terms of section 4. Replacing Invariant Sections with translations requires special permission from their copyright
holders, but you may include translations of some or all Invariant Sections in addition to the original versions of
these Invariant Sections. You may include a translation of this License, and all the license notices in the Document,
and any Warranty Disclaimers, provided that you also include the original English version of this License and the
original versions of those notices and disclaimers. In case of a disagreement between the translation and the
original version of this License or a notice or disclaimer, the original version will prevail.

If a section in the Document is Entitled “Acknowledgements”, “Dedications”, or “History”, the requirement
(section 4) to Preserve its Title (section 1) will typically require changing the actual title.

9. TERMINATION

You may not copy, modify, sublicense, or distribute the Document except as expressly provided under this License.
Any attempt otherwise to copy, modify, sublicense, or distribute it is void, and will automatically terminate your
rights under this License.

However, if you cease all violation of this License, then your license from a particular copyright holder is reinstated
(a) provisionally, unless and until the copyright holder explicitly and finally terminates your license, and (b)
permanently, if the copyright holder fails to notify you of the violation by some reasonable means prior to 60 days
after the cessation.

Moreover, your license from a particular copyright holder is reinstated permanently if the copyright holder notifies
you of the violation by some reasonable means, this is the first time you have received notice of violation of this
License (for any work) from that copyright holder, and you cure the violation prior to 30 days after your receipt
of the notice.

Termination of your rights under this section does not terminate the licenses of parties who have received copies
or rights from you under this License. If your rights have been terminated and not permanently reinstated, receipt
of a copy of some or all of the same material does not give you any rights to use it.

10. FUTURE REVISIONS OF THIS LICENSE

The Free Software Foundation may publish new, revised versions of the GNU Free Documentation License from
time to time. Such new versions will be similar in spirit to the present version, but may differ in detail to address
new problems or concerns. See http://www.gnu.org/copyleft/.

Each version of the License is given a distinguishing version number. If the Document specifies that a particular
numbered version of this License “or any later version” applies to it, you have the option of following the terms
and conditions either of that specified version or of any later version that has been published (not as a draft) by the
Free Software Foundation. If the Document does not specify a version number of this License, you may choose
any version ever published (not as a draft) by the Free Software Foundation. If the Document specifies that a
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proxy can decide which future versions of this License can be used, that proxy’s public statement of acceptance
of a version permanently authorizes you to choose that version for the Document.

11. RELICENSING

“Massive Multiauthor Collaboration Site” (or “MMC Site”) means any World Wide Web server that publishes
copyrightable works and also provides prominent facilities for anybody to edit those works. A public wiki that
anybody can edit is an example of such a server. A “Massive Multiauthor Collaboration” (or “MMC”) contained
in the site means any set of copyrightable works thus published on the MMC site.

“CC-BY-SA” means the Creative Commons Attribution-Share Alike 3.0 license published by Creative Commons
Corporation, a not-for-profit corporation with a principal place of business in San Francisco, California, as well as
future copyleft versions of that license published by that same organization.

“Incorporate” means to publish or republish a Document, in whole or in part, as part of another Document.

An MMC is “eligible for relicensing” if it is licensed under this License, and if all works that were first published
under this License somewhere other than this MMC, and subsequently incorporated in whole or in part into the
MMC, (1) had no cover texts or invariant sections, and (2) were thus incorporated prior to November 1, 2008.

The operator of an MMC Site may republish an MMC contained in the site under CC-BY-SA on the same site at
any time before August 1, 2009, provided the MMC is eligible for relicensing.

ADDENDUM: How to use this License for your documents

To use this License in a document you have written, include a copy of the License in the document and put the
following copyright and license notices just after the title page:

Copyright © YEAR YOUR NAME. Permission is granted to copy, distribute and/or modify this
document under the terms of the GNU Free Documentation License, Version 1.3 or any later version
published by the Free Software Foundation; with no Invariant Sections, no Front-Cover Texts, and no
Back-Cover Texts. A copy of the license is included in the section entitled “GNU Free Documentation
License”.

If you have Invariant Sections, Front-Cover Texts and Back-Cover Texts, replace the “with ... Texts.” line with
this:

with the Invariant Sections being LIST THEIR TITLES, with the Front-Cover Texts being LIST, and
with the Back-Cover Texts being LIST.

If you have Invariant Sections without Cover Texts, or some other combination of the three, merge those two
alternatives to suit the situation.

If your document contains nontrivial examples of program code, we recommend releasing these examples in
parallel under your choice of free software license, such as the GNU General Public License, to permit their use
in free software.
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